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Introduction

Symbols

The following symbols may appear in the product documentation or on the product.

eXQ-PLATFORM

&Only

Device

by or on the order of a licensed healthcare
practitioner

Prescription Devices

Symbol |Symbol Name |Symbol Description Standard Number Symbol
and Name Reference
Number

Manufacturer Indicates the name and address of the I1SO 15223-1:2021 5.1.1
manufacturer

Authorized Indicates the Authorized Representative, ISO 15223-1:2021 5.1.2

Representative in | responsible for the device in the European

the European Economic Area (EEA).

Economic Area

(EEA)

Date of Indicates the date when the device was 1SO 15223-1:2021 5.1.3

Manufacture manufactured.

Caution Indicates information that is important for I1SO 15223-1:2021 5.4.4
preventing loss of data or misuse of the
software.

LOT Batch Code Indicates the full Software Release / Version 1SO 15233-1:2021 5.1.5

number

Serial number Indicates the manufacturer’s serial number so 1SO 15233-1:2021 5.1.7

SN that a specific medical device can be identified
Catalogue Indicates the manufacturer’s catalogue number | ISO 15233-1:2021 5.1.6
H E F Number so that the device can be identified

Consult Indicates the need for the user to consult the 1SO 15233-1:2021 5.4.3

instructions for instructions for use

use

Prescription Caution: Federal law restricts this device to sale| 21 CFR 801.109(b)(1) | N/A

BS EN ISO 15223-1:2021 Medical devices - Symbols to be used with information to be supplied by the
manufacturer - Part 1: General requirements
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Indications for use

EXA™ is a software device that receives digital images and data from various sources (i.e. CT scanners,
MR scanners, ultrasound systems, R/F Units, computed & direct radiographic devices, secondary capture
devices, scanners, imaging gateways or other imaging sources). Images and data can be stored,
communicated, processed, and displayed within the system and or across computer networks at
distributed locations. Lossy compressed mammographic images are not intended for diagnostic review.
Mammographic images should only be viewed with a monitor cleared by FDA for viewing mammographic
images. For primary diagnosis, post process DICOM "for presentation" images must be used. Typical users
of this system are trained professionals, nurses, and technicians.

Training
Users of this software must have received adequate training on its safe and effective use before

attempting to operate the product described in this Instructions for Use. Users must make sure they
receive adequate training in accordance with local laws or regulations.

Regulatory and compliance

Konica Minolta Healthcare Americas, Inc.
2217 U.S. Highway 70 East
Garner, NC 27529 USA

Tel: 1-800-366-5343

500-000594A 4
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System requirements

The following are the minimum system requirements for clients of Exa PACS/RIS. The workstation

requirements are based on typical usage scenarios. For the recommended requirements of your specific
implementation, contact your Konica Minolta representative.

/N

RECOMMENDED: To avoid loss of functionality and data during a power loss, connect an uninterruptible
power supply. When running the system by the UPS alone, save data immediately after modifying.

REQUIRED: Install anti-virus software on the server and each client.

Server

Specification

Processor Intel® Xeon® Gold 5120 CPU @ 2.20GHz
Cores 14
Memory 32 GB

Archive Storage

1 TB partition DAS

7,200 RPM hard disk drive

oS Microsoft Server 2012 R2 (64-bit)
C:/ 250 GB SAS mirrored OS drive

Cache 500 GB SSD

Database 500 GB SSD

NIC Single 1000 MB/s

Workstation - User

Specification

CPU Intel® Core™ i5 or later
RAM 8 GB or more

NIC Single 1000 MB/s
Storage HDD, 500 GB or more
(0] Windows 10 Pro, 64-bit
Monitor 20 inch, 1600 x 1200

Workstation — Reading Radiologist

CPU

Intel Xeon® E-2176G (3.70 GHz, 12 MB) or later

500-000594A
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Graphics Cards 2 NVIDIA® Quadro® P1000 cards
RAM 32 GB or more

NIC Single 1000 MB/s

Storage SDD, 500 GB or more

(0] Windows 10 Pro, 64-bit

Monitor Diagnostic displays

500-000594A
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Calibration and measurement accuracy

Measurement accuracy partially depends on image quality, which is subject to various factors including
the skill of the technologist, the precision of the modalities, and image resolution. However, clinical users
of Exa PACS/RIS can help ensure diagnostic image quality and accurate measurements by using
appropriate viewer settings (such as window/level and zoom) and by calibrating monitors (see "Calibrate
monitors").

The clinical user is responsible to judge the accuracy of the measurements based on the image quality
and based on the accuracy of placed measurement points. For a table of measurement accuracies, see
"Measurement Accuracy Limits" in the appendix.

Help us improve!

If you find any errors in this manual, would like us to explain something better, or would like us to cover a
new topic, please let us know by visiting our online portal.

https://support.kmhapub.com/PremierCustomer/Home.aspx

Monitored: 8:00 AM-8:00 PM EST

YA

For urgent issues, please call the Hotline.

500-000594A 7
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New in version 1.4.32 P5

The following is a partial list of new or updated major features in version 1.4.32_P5. For more
information, see the release notes.

o Symmetry PACS now supports opening images in Ultra
Acquire.

e In the Alberta configuration, you can now perform a
query/retrieve of the AHS database by ULI or Exa
PACS/RIS account number, and you can search for all
patients or only patients in the Exa PACS/RIS database.

e The Exa platform now supports duplicate Provider ID
values for Imagine Software.

e Opallmport offers more relevant choices of AE Title.

500-000594A 8
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Getting started

Configure your working environment

Before using Exa PACS/RIS, you must configure settings and information used in various parts of the
program. This section helps with the most common areas of basic configuration. For help with other
detailed settings, contact your Konica Minolta representative.

Set up credentials, browser, and monitors

Configure the language in Chrome

You must configure the browser language of your client computer as follows.

Procedure

1. In Chrome, select the customize : button, and then select Settings.

2. On the left pane, select Languages.

3. Ifthe local language and culture does not appear in the list, select Add languages, and then add
the language.
Note: The culture must be correct. For example, in Canada, ensure that English (Canada) is
installed.

4. Select the more actions : button for the local language, and then select the Display Google
Chrome in this language checkbox.

5. Select the more actions : button again, and then select Move to Top.

6. Select Relaunch.

Sign in to the Exa platform

You can sign in to the main application, the patient portal, the physicians’ portal, the ordering facility

portal, or the attorney portal.

Procedure

1. In Chrome, go to the URL given to you by your Konica Minolta representative.
2. Enter your sign-in credentials.

3. Select the I agree to HIPAA Privacy Notice checkbox.

4. Do one of the following:

500-000594A 9
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e To sign in to Exa PACS/RIS, select LOGIN.

e To sign in to a portal, select a portal button.

See also:

About two-factor authentication

Sign in using 2FA with email
Sign in using 2FA with Google Authenticator

About two-factor authentication

If your facility purchased two-factor authentication (2FA), administrators can use it to increase security
by requiring an additional sign-in procedure. During sign-in, Exa PACS/RIS sends a character string called
an authentication token to your email address, or one is generated by a mobile app called Google
Authenticator. You then enter that authentication token on the Exa PACS/RIS sign-in screen to finish
signing in.

Administrators: To make two-factor authentication available for a user, you must configure the user’s
email address.

See also:

Create a user

Sign in using 2FA with email
Sign in using 2FA with Google Authenticator

Sign in using 2FA with email

If your administrator made two-factor authentication available, you will receive an email from the server
with a verification code. Using that code, follow these steps.

Procedure
1. Signin to Exa PACS/RIS in the usual manner.
2. Inthe EMAIL VERIFICATION PENDING box, paste the verification code and select VERIFY.
Result: Exa PACS/RIS signs you out.

3. Sign back in to Exa PACS/RIS, select REQUEST TOKEN, type the token sent to the email address,
and then select LOGIN.

Note: Every time you sign in in the future, you must repeat this step, using a different token each
time.

See also:

Sign in to the Exa platform
About two-factor authentication

500-000594A 10
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Sign in using 2FA with Google Authenticator

Sign in using 2FA with Google Authenticator

After you have signed in using 2FA the first time, if you prefer, you can use Google Authenticator to sign
in in the future rather than an email token. To use Google Authenticator to sign in, follow these steps.

Procedure

1. Download the Google Authenticator app onto your mobile device.

2. In Exa PACS/RIS, on the burgerE menu, select the blue Konica-Minolta = globe.

3. Inthe My Profile dialog, in the Two Factor Authentication box, type your sign-in password, and
and then select the Enter key.

4. Select SHOW QR CODE.

5. In Google Authenticator, tap Scan a QR Code, and then scan the QR code displayed by Exa
PACS/RIS.

6. In Exa PACS/RIS, in the One-Time Password box, enter the code from your new Google
Authenticator profile, and then select VERIFY.

See also:

About two-factor authentication
Sign in using 2FA with email

Reset your password

If you forgot your password, contact your Exa PACS/RIS administrator for instructions on how to reset
your password.

Change your password
You can change your sign-in password.

Procedure

1. Select the burgerE button.
2. At the top of the burger menu, select the blue

Konica Minolta globe:
% or (user avatar).

500-000594A 11
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3. In the My Profile dialog, select CHANGE PASSWORD.

4. Enter current and new passwords, and then select SAVE PASSWORD.

Add an avatar
An avatar is an image such as a photo that represents you in various parts of the program.
Prerequisites: Prepare a PNG image to use as the avatar.

Procedure
1. Atthe top of the burgerE menu, select the blue Konica Minolta = globe.
In the My Profile dialog, select Choose File.

2
3. Browse for and select your avatar image, and then select Open.
4

Select SAVE.

Edit your user profile

Each user of Exa PACS/RIS has a profile with sign-in credentials and other information. After signing in,
you can view and edit your information.

Procedure

1. Select the burgerE button.

2. At the top of the burger menu, select the blue Konica Minolta globe or user’s avatar:

% or (user avatar).

Result: The My Profile screen appears.

500-000594A 12
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My Profile EXA Version 1.4.32-p3-1

uDI (01)0081710002019

User Name viztak

Mame * Paes M Viztek

Mobile Phane / Email | Mobile Phone

Default Davice * + | Auto Open Dictation on Device
DefaultLocation *  yu company » [ Always Open Schedule Book in a Mew Tab
Rows to Display 50 « Themes default -~ Culture English-Us w

O rpin Burger Menu O Hide Warklist lcons [ Hide Order Menu

E

Bandwidth Select hd
Session Interval 300 mn (10-600)

Default Scheduling (@) Radiclogy

3. Enter the following settings.

User Name Type a user name for sign-in purposes.
Name Type your true name.
Mobile Phone/Email Type your mobile phone number and/or email address. An email address is

required for two-factor authentication.

Default Device [Unused]

Auto Open Dictation on Device | [Unused]

Default Location Select a facility as your default location. When you sign in, this facility
appears in various parts of the program by default. You must configure
the facilities that you want to make available in this dropdown list.

Always Open Schedule Book in | Select to cause the program to open a new browser tab for the schedule

a New Tab book automatically when you open it.
Rows to Display Select how many rows to display on the worklist.
Themes Select a default theme of Bright (default) or Dark.

500-000594A 13
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Culture Select the language/culture of the user interface.
Pin Burger Menu Select to keep the burger menu open in the left pane of the screen.
Hide Worklist Icons Hides the lower toolbar and study row buttons on the worklist. Hidden

functions remain available in shortcut menus and other controls.

Hide Order Menu Hides the navigation menu within the Edit Study screen.

Bandwidth Select the expected speed of the network on which your client installation
runs. This helps to optimize performance in your networking
environment.

Session Interval Type the number of minutes to elapse before the program times out and
returns to the sign-in screen.

Default Scheduling/Radiology | [Unused]

4, Select SAVE.

View version information
You can view version information about the application, host system, services, and external tools.

Procedure

1. Select the burgerE button.

2. At the bottom of the burger menu, select the white Konica Minolta globe.

-

IEONICA MINOLTA

Result: The About screen appears.

500-000594A 14
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App/DB/Misc Services
Exa: 1.4.32-p3-135 C-Move Service: 1.4.32.50
Mode; v16,16.0 DICOM Service: 1.4.32 50
PostgreSQL: 14.4 Fax Service: 1.4.32.50
WGINX: 1.23.1 fimpeg: Mot Found
Redis: Mat Found imageserver_http:> 1.4.32.50
TxTransportation: Mot Found Image Service: Mot Found

MWL Service: 1.4.32 50
Sy‘stem Opal Listener Service: 1.4.32.50

Opal Sender Service: 1.4.32.50
Dicom Print Service: 1.4.32.50
Storage Commitment Service; Not Found

05 Type: Windows_NT
05 Platferm: win3z
0% Architecture: x64

Total System M 1200 GB
o ystem Memory Tools

Opal Tools Setup: Mot Found
Opal Viewer Setup; Mot Found
EXA Trans: Mot Found

EXA Doc Scan; 1.0.11.0

Create a shortcut for Exa PACS/RIS

You can create a shortcut for the local Windows user to Exa PACS/RIS and place
it on the desktop.

Procedure

1. In Chrome, go to the Exa PACS/RIS sign-in page.

2. Inthe address bar, drag the lock ® icon onto the desktop.
The Exa Login shortcut appears.
3. Optional. To change the shortcut icon:

e Right-click the shortcut and then select Properties.
e Select Change Icon, and then browse for and select an icon.
e Select OK.

Calibrate monitors

Especially after a new installation or upgrade, you can use Exa PACS/RIS to calibrate your monitors to
ensure accuracy of length and other measurements. If all images you work with contain pixel spacing
information, you can skip this procedure.

Prerequisite: Enter Calibration Width and Calibration Height settings for your monitors.

Procedure

500-000594A 15
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1. Open animage in the viewer.

2. Optional: For higher accuracy, on the image shortcut menu, select View > Actual Image Size.
3. Hover over the upper-right corner of a frame, right-click E, and then select Recalibrate.

4. Select two points on the image.

5. In the Dialog dialog, type the length between the points and then select OK.

Note: If prompted to apply calibration to the series, select OK.
Results
e The calipers are modified.
e Previously annotated measurements are redrawn.
e Future measurements will appear according to the new calibration values.

See also:

Set up connected displays

500-000594A 16
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Configure Exa PACS/RIS

This section describes core settings that you should review or configure prior to using Exa PACS/RIS. For
other settings, see the following topics.

See also:

Worklist settings
User settings

Viewer settings
Configure the viewer

Set up the office: Companies

Company here means the parent hospital, clinic, or other institution where Exa PACS/RIS is installed.
After configuring your company you can configure its child facilities (see Add a facility) and other locations
as needed. In configuring your company you enter basic settings such as its name and address, but also
—depending on product and configuration—you can customize Exa PACS/RIS for your company's needs
by adding preset options for such things as: sex, body parts, and ethnicity; patient alerts, critical findings,
cancellation reasons; MRN and accession number formatting; passwords; and billing modifiers.

Configure your company
To add your company to Exa PACS/RIS:
Procedure

1. Go to SETUP > Office > COMPANY.

LHE

e * Waswe * by Canripuding Timstws * LS Eastain w [ moatbs upaP [ Pasble RComa Seice [ Bradiie Paymient Gotgwsy

[ Taggm Reutng an Sudy Flag Changad m

2. Enter the following settings.

Code Type your internal code for your institution.

Name Type the name of your institution.

Timezone Select the time zone used by your institution.

Enable LDAP If your institution uses an LDAP or Active Directory server, select this
option to display the LDAP CONFIG sub-tab, and then see Configure all
LDAP settings.

500-000594A 17
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Enable RCopia Service Select to turn on the RCopia service, if available, and display the RCOPIA
CONFIG sub-tab. Enter settings in the sub-tab, and then select SAVE.

Enable Payment Gateway Select to turn on the Payment Gateway service, if available, and display the
PAYMENT GATEWAY sub-tab. Enter settings in the sub-tab, and then select
SAVE.

Trigger Routing on Study Flag | Select to reprocess routing (DICOM transactions) automatically when a user
Changed changes a study flag.

3. Select SAVE.
4. Enter additional information as needed by following the steps in later subsections.

Note: When finished, select SAVE again at the top of the screen on the right side of the Trigger
Routing on Study Flag Changed checkbox.

General settings

Enter the main contact information for your company and other basic settings relating to scheduling,
billing, documents, security, image viewing, and peer review.

Procedure

1. Go to SETUP > Office > COMPANY > GENERAL.

[me Lt

— S
Arddiess Line 1 3317 hwes TOE Ftie Snpee Scurtreed Dotz -
Ao Lire 2 Besinity
Eiraaieaf CARMER MO v 27520

bocount lochout w
Phane hin

nemhzls

[

Viwrwer
Wabsdts
Sehvedhiineg Waser Trichar Test 1 Pt e Maives 0 Accenmizn Myrnha

2. Enter the following settings.

Contact Information | Enter the company address and contact information.

Scheduling Highlight new Patient exams on Select to highlight new patient appointments on
ScheduleBook the schedule book for easier identification.

500-000594A 18
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Highlight Color

Select the color to use to highlight new exams on
the schedule book.

Default Distance from ZIP Code

Select the default distance for finding facilities near
patients.

Enable schedule rule reason

Select to require users to select a schedule reason
when creating a schedule block.

Enable reschedule reason

Select to prompt for a reason when rescheduling
an appointment.

Enable pause reason

Select to prompt for a reason when a technologist
pauses an exam.

Billing Information

Corporate Office Type

Select Person for an individual practice. Otherwise,
select Non-Person Entity.

NPI No.

Type your national provider identifier.

Taxonomy Code

Type your NPI taxonomy code.

Tax ID

Type your national tax ID.

EDI Submitter ID

If using an EDI service, type your submitter ID.

EDI Receiver ID

If using an EDI service, type your receiver ID.

Modifiers in Order

Forces the user to enter modifiers before creating
an order.

ICD9 to ICD10

Select to automatically convert diagnostic codes
from the ICD9 to ICD10 standard.

Type the tax

Documents File Store Select a file store for scanned documents at your
company. This is separate from the file store used
by AEs to store images.

Security Account Lockout Threshold Set the maximum number of sign-in attempts.

Viewer Viewer Titlebar Text Select to display the patient name or the accession

number on the title bar when opening a study in
the viewer.

Peer Review

Schedule (how often studies are
assigned to be peer-reviewed)

Select the frequency of assignment.

To customize, select Custom settings, and then
type the following in the boxes: seconds, minutes,
hours, day of the month, month, and day of the
week.

Cron custom settings

Available when you select Custom settings in the
Schedule dropdown list. Type a custom frequency
for assigning peer reviews.

Peer Review Percentage of yearly
approvals

Type the percentage of studies to be assigned
annually for peer review.

500-000594A
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Studies per draw amount

Type how many studies to assign for each
reviewer, for each draw.

Cutoff period

The number of days in the past from which Peer
Review will draw studies.

Interval

Type how often to run the peer review background
service.

Email Information Server Address

Type the address of your outgoing SMTP/mail
server.

Port

Type the mail server port number, provided by
your ISP.

User Name

Type the account administrator user name or
email address.

Password

Type the email account password.

Sender Address

Type the default sender address (the
administrator's email address).

Email Subject

Type a default email subject to use if no subject is
configured on the notification template.

4. Select SAVE ALL INFO.

Settings

Settings here means presets that appear as options in other parts of the program, mostly related to

people (such as staff and patients).

Procedure

1. Go to SETUP > Office > COMPANY > SETTINGS.

500-000594A
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2. On the left pane, select a category.

3. At the bottom of the screen, in the Description box, type a setting.

User Titles

User prefixes, such as Mr., Mrs., and Dr.

Marital Status

Patient marital statuses, such as Single, Married, and Divorced.

Sex

Patient sexes.

Body Parts

Patient body parts under examination.

Employee Status

Statuses of employees at your institution.

Credentials

Physician credentials, such as Ph.D. and M.D.

Racial Identity

Patients’ self-identified races.

Ethnicity Patients’ self-identified ethnicities.

Relationship Relationships of people to patients (including self).

Priorities Priorities that can be assigned to studies in the worklist. These are separate
from STAT levels.

Sources Sources of patient arrivals, such as clinic referral, attorney office, hospital
transfer, or emergency room.

Orientation Lateralities as they pertain to the study.

500-000594A
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Languages Patients’ preferred languages.

Specialties Healthcare worker specialties such as oncology or sports medicine.

Communication Preferences Patients’ preferred methods of communication, such as cell phone or

email.
Administration Site Immunization modes.
Regions Geographical regions, such as for grouping markets.
Units of Measure Units of measure, such as for doses of medication or contrast material.
Needle Gauge Available needle gauges.

4. Select SAVE.

App settings

App settings here means presets that appear as options in other parts of the program.

Regarding STAT levels

Because different PACS systems use different STAT levels, you need to translate the STAT level of
inbound studies to the STAT levels you configure in Exa PACS/RIS, and conversely, you need to
translate the STAT levels of studies you send to other systems to their STAT levels. To do this, as
described in the following table, select the value of the (0040,1003) Requested Procedure Priority tag
to translate "from" in inbound DICOMs, and to translate "to" in outbound DICOMs.

Procedure

1. Go to SETUP > Office > COMPANY > APP SETTINGS.

500-000594A 22
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2. Inthe list on the left side of the screen, select a setting.
3. For each option in the following table, enter settings.

States Description | Type states, provinces, prefectures, or other regions used in various parts of
the program.

Scan Document Description | Type descriptions to assign to documents to be scanned, such as “Photo ID”

Types or “Explanation of Benefits.”
Requires Select to require review of the document before moving to the next status in
Review the current workflow. See Require document review.

Stat Level Description | Type descriptions for each of the STAT levels (0-5).
Color Click in the text box, and then use the color picker to select a background

color for studies on the worklist having the STAT level.

Text Color Select a text color for studies on the worklist having the STAT level.

Inbound Select the requested procedure priority of inbound studies to assign to the
DICOM STAT level you are configuring.
Outbound Select the requested procedure priority to assign to outbound studies that are
DICOM in the STAT level you are configuring.

TAT Description/ | Select the edit ¢ icon of a TAT to modify its description, text color, and
Colors background color. You can set the max TAT for a facility under Setup > [all

uppercase menu] > Office > Facility.

Patient Arrival Waifl Use the following settings to configure color-coded descriptions corresponding to lengths of]
Times time that a patient waits upon arrival. These bands of time appear in the wait time monitor
at the top of the Patient Arrival Worklist.

Description | Type a description for the band such as "Short Wait" or "Long Wait."
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Color Background color for arrivals at the current wait time.

Text Color Text color for arrivals at the current wait time.

Minutes Type the maximum number of minutes that a patient waits to remain in the
band.

Access Reasons Reasons for accessing confidential patient records when using the Break the Glass function.

Code Type an internal code for the reason.

Description | Type a name or description of the reason such as, "Direct patient care."

Ordering Facility Description | Type a description such as "Assisted Living" or "Prison."
Types

4. Select SAVE.

Reason codes

Reason codes are text strings that identify reasons for taking various actions such as cancellations, follow-
ups, and rescheduling. You can preconfigure them for use in various parts of the program.

Procedure

1. Go to SETUP > Office > COMPANY > REASON CODES.

Coedus * Hume * &y Company Tlvepars * LS Eindem
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[15 21
Felorw-Up Reasns

Fhyaics Limlilion
HE Cosparis

i : Frachwisie
Padiem; Alerin

Seheculing Confict
Resson far Desth

0 0O O @ O O

Teatapormalise
Tearagroription Reasong

E Hate Inacires

2. On the left pane, select a category.

3. On the right pane at the bottom, type a reason.
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4. Optional: To make the reason temporarily unavailable, select Hide Inactive.

Cancel Reasons Description Type reasons for such canceling such things as appointments or
exams in progress.

Abort Reasons Description Type reasons for aborting exams in progress.
Call Categories Description Type reasons phone calls, such as to patients for scheduling.
Critical Findings Description Type critical findings you can assign to studies, such as "Acute
Positive."
Follow-Up Reasons Description Type_ reasons to follow up on a study, such as "Benign but
suspicious."
Code Type your internal code for the finding.
Follow Up Type and select the length of time until the follow-up.
HIE Consents Description Type indicators as to whether a patient has consented to release of

demographics and medical data through a Health Information
Exchange for treatment, payment, and health care operations

purposes.
Patient Alerts Description Type alerts to assign to patients, such as "Patient is claustrophobic."
Pause Reasons Description Type reasons that your company deems acceptable for pausing an

exam, such as "Patient Movement."

Reason for Death Description Type reasons for death.
Reschedule Reasons Description Type reasons for rescheduling an exam.
Schedule Rule Reasons | Description Type reasons to use when writing schedule rules to make a timeslot

unavailable, such as "Machine maintenance."

Color Assign unique colors to each schedule rule reason for easy
identification on the schedule book.

Transportation Reasons | Description Type modes of transportation such as "Medical Transport" or
"Personal Vehicle."

5. Select SAVE.

MRN information

MRN information here means your internal format for MRNs at your company. To Exa PACS/RIS can
assign MRNs automatically according to the following settings.

Procedure

1. Go to SETUP > Office > COMPANY > MRN INFORMATION.
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COMPANY

Casdn * HNamv *| My Corroany TiwkEorw *  ISEastesm

O Taigyer Rocting on Stady Flag Changed m

MAM Inlarmaticn

MRH Typs * Coef st "

Prefix B canEn

Suffix O Mlow Tushcass
FrafiasSuffe Max O Ficed Length

Length

LLLFFY

2. Enter the following settings.

MRN Type Select Default to use the default formatting included with Exa PACS/RIS, or
Custom to define your own formatting.

Fraview

Prefix Type a prefix to prepend to the MRN. To be able to modify the prefix,
select Can Edit.

Suffix Type a suffix to append to the MRN.

Allow Duplicates Select to allow duplicate MRNs.

Prefix/Suffix Max. Select Fixed Length (above), and then type or select the maximum length

of the MRN prefix and suffix.

Fixed Length Select to enter a maximum length of the MRN.

3. Select SAVE.

Accession information

Accession information here means global modifications you want Exa PACS/RIS to make to accession
numbers.

Procedure

1. Go to SETUP > Office > COMPANY > ACCESSION INFORMATION.
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2. Enter the following settings.

Prefix Type a prefix to prepend to the accession number.

Suffix Type a suffix to append to the accession number.

3. Select SAVE.

AE filter

This sub-tab is currently unused.

Payment gateway
If you selected Enable Payment Gateway previously (see Configure your company):

Procedure

1. Go to SETUP > Office > COMPANY > PAYMENT GATEWAY.
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COMPANY

Coda * | L Nama * | by Company Tiengzana * US/Eastern

B Enabile Roopsa Sesvice Bl Enstile Payment Gateway Trigger Routing on Study Flag Changed ﬂ

n

sEMERAL GETT =5

PAYRENT QATEWSY I aPA HF Hl ASSWDRD MGT

Gateway Information

Gateway * w
blgcs -
Cheng il =

Client Secrey =

Static URL *

2. Enter settings to make a payment gateway available, such as PayPal.

3. Select SAVE.

LDAP configuration
See Configure all LDAP settings.

RCopia configuration
If you selected Enable RCopia Service previously (see Configure your company):
Procedure

1. Go to SETUP > Office > COMPANY > RCOPIA CONFIG.
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DOMPANY
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B Save Responss Files

2. Enter RCopia service details.

3. Select SAVE.

HL7

This sub-tab is currently unused.

Password management

You can customize requirements for passwords that users create to sign in to Exa PACS/RIS and other
related client apps.

Procedure

1. Go to SETUP > Office > COMPANY > PASSWORD MGT.
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COMPANY

Ceda = W Hame *  hy Compary Timazene *  US/Eastern w [ Enatls LOAP

Enabfe RCopia Service Enable Payment Gateway B8 Trigger Routing on Study Flag Changed m
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O - Passwards Must Comain Lowercase Lotters [ Apply Password Requirementa ta Patient Partal
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2. Enter the following settings.

Password Must Be between-:- Type a minimum and maximum number of characters that passwords can
contain.
Passwords Must Contain - Uppercase Letters Exa PACS/RIS validates passwords

based on these selections.

Lowercase Letters

Numbers

Symbols or Special Characters

‘User Must Change Password Select or clear to assign the default state of the setting.
Next Login’ Is Checked by
Default

Force Users to Reset Their Select to require password resets of a specified interval.
Password on a Set Schedule

Apply Password Requirements | Select to use the same password requirements for Patient Portal accounts.
to Patient Portal

3. Select SAVE.

Modifiers
Modifiers are codes that provide additional detail to billing transactions.

Procedure
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1. Go to SETUP > Office > COMPANY > MODIFIERS.

COMPANY

Code * Hams * by Company Timezoes * LS Eastem
B Enable ACopia Servce Ennbe Payment Gabeway B Triggsr Routing on Study Flag Shangsd m

Modifiens
KT HIGHT
LT LEFT
=0 BILATERAL
B =3 ETINCT FROCEDURESBERVICE
B E2 RELUCED SERVICES
Fra 28 FROFESEIONAL COMPORENT
w TECHMNICAL COMPORENT

O imgtici

2. Move to the bottom of the screen, enter the following settings.

Code Type the CPT modifier, or other modifier code.

Implicit Select to visually exclude the modifier from submitted claims.
Description Type the description for the code.

Fee Level Select the fee level in the dropdown list.

Fee Override Type the fee override code which takes precedence over any modifier

created previously. To configure an override amount: In the first
dropdown list select an operator (+ or -), in the box type an amount, and
then in the last dropdown list select Value or %.

M1-M4 Select the modifier number to which to assign the code.

Display on Schedule Book and | Select or clear to control visibility of modifiers.
Print Order

3. Select SAVE.
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Link encryption

You can define how Exa PACS/RIS responds when a user clicks a link to a study using an encrypted URL.
Settings here must match those agreed upon by the entity creating the encrypted links. You cannot edit
link encryption settings, only add and delete them.

Procedure

1. Go to SETUP > Office > COMPANY > LINK ENCRYPTION.

O KGT MODIFIERS LMK ENCRYPTIGN
g
KEY¥ CDDE LINK.ENCRYPTION = INTEORATION MAME LINKEXNPIRY: KEY TYFE KEY EXPIRY KEY EXPIRY DA

Mo recosds fc:-ur:n

2. Select ADD.
Link Encryption Type * | Simnpla Viewsr w
Integration Mame * Test
Link Expiry Haurfs] ~ 1
Fey Type * AES-192
Key Expiry B | oasveos i
e | "o

3. Enter the following settings.

Link Encryption Type Select the screen in which to open the study.

Integration Name Type the friendly name of the integration (matching the one included in
the URL, which identifies the decrypting preshared key and action to take
on the decrypted URL).

Link Expiry Select the checkbox to apply an expiration to the URL, and then use the
dropdown list and text box to configure a length of time before expiration.

Key Type Select a type of encryption for the key.

Key Expiry Select the checkbox to apply an expiration to the key, and then use the

date picker to select an expiration date.

4. Select GENERATE.
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5. In the dialog, copy the passphrase and initialization text to a safe location, and then close the
dialog.

CAUTION: Do not close the dialog until you copy the information; Exa PACS/RIS will never
display it again. If you lose the key, you must create a new one.

6. Send the passphrase and initialization text to the EMR company or other entity creating encrypted
links.
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Set up the office: Other assets

Add a market

You can add regional markets for use in other parts of the program, such as for assigning facilities.

Procedure

1. Go to SETUP > Office > MARKET.

MARKET

Hide Inactive

CODE

2. Select ADD.

Cade *
Hame *

Reqien

MAME FEGIN
all Le

Karketl

123 O mactive
Teat Markel

Ragion 1w

3. Enter the following settings.

Code Type your internal code for the market.
Name Type the name of the market.
Region Select the geographical region in which the market is located.

4, Select SAVE.
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Add a facility

Facilities are typically where healthcare services are rendered. You must add at least one facility to your
company by following the procedure below.

Common tasks after adding a facility

After adding your facilities by using the procedure below, see the following topics on other tasks you
may need to complete.

e Configure study statuses

e Configure application entities
e Configure a file store

e Configure routing rules
Configure AE scripts
Understanding receiver rules
Configure a receiver rule
Configure study flow

Add modalities

Add modality rooms

e Add a report template

e Configure a schedule template and schedule rules

e Configure appointment types
e Create a user

Procedure

1. Go to SETUP > Office > FACILITY.

FAGILITY

Hide Inactive

CODE= NAME MARKET
All g
S H aD srindka Facility 1
S angt Angie Facility
SEE123 Meera Faciity

2. Select ADD, and then enter the following settings for the facility.

Code Type your internal code for the facility (up to eight characters).
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Name Type the name of your facility.

Market Select the market that the facility serves.

Contact No. Type the phone number of the primary contact person at the facility.

Fax No. Type the fax number for receiving approved reports.

Send Reports to Fax No. Select to automatically send reports to the fax number you entered
previously.

Email Type the email address of the primary contact at the facility.

Email Report Link Select to automatically send an email when a report is created to the email

address entered earlier that contains a link to view the reports on the
ReportLink service.

Report Password Type the password needed to view reports on ReportLink.

Email Attachment Select to receive reports by attachment.

Timezone Select the time zone used by your facility.

Mammo License ID Type the facility’s mammography license ID.

Max TAT Type the maximum allowed turnaround time, in minutes, before a breach of

contract occurs.

Enable Alt. Acc. No. Select to use of more than one account number for a patient.

Required SSN Select to require a social security number to provide treatment.

Require Primary Phys. Select to require a primary physician’s information to provide treatment.
PokitDok Response [Unused]

Upload Logo Select Choose File, browse for and select a logo file for the facility, and then

select Open. Logos can be in JPEG or PNG format.

Remove Logo To remove the current logo, select REMOVE LOGO.

[Address] Type the address of the facility.

File Store Select the default file store to use at the facility.

Show Patient Alerts Select to show a patient alert window when scheduling in the schedule
book.

Show Recent Schedules Select to display the recent schedules dialog when: 1) scheduling a

preorder; and 2) double-clicking a patient in the Patient tab of the New
Appointment screen.

Days: Type the number of days in the past and future to control which
exams appear in the recent schedule screen.

Enable Veterinary Registration | Select to be able to register veterinarians as physicians.

Mobile Rad Dispatching Address| Type the address of the office that dispatches mobile radiology.
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Do Not Allow Overlapping Select to prevent users from scheduling more than one procedure in the
Procedures to Be Scheduled same timeslot in the schedule book.

Import Documents into Study | Select to automatically convert documents to DICOM images before

as DICOMs importing. If not selected, the user can select whether to convert at the time
of import.
Global Auto-Print Select to automatically send radiology reports to printer that is configured

on the Exa server.

Abbreviated Receipt Select to use an abbreviated formatting for payment receipts.

Custom Receipt Select to use a custom receipt for payments, such as co-pays.

Exclude from all Portals (All Select to exclude all studies associated with the facility from all portals,
Portals & Break the Glass) including when "breaking the glass."

Required Fields at Scheduling Select options to require when scheduling an exam.

Required Fields for Creating a | Select options to require when creating a preorder.
Preorder

Study Status When Patient Select the status to assign to the study when the patient arrives at check-in.
Arrives

Study Status When Patient in Select the status to assign to the study when the patient arrives in the exam
Room room.

Report Delay to Patient Portal | Type the number of days to wait before making reports available on the
patient portal.

Formal Name Type the formal name of the facility, if different from the commonly used
name.

Facility Notes Type additional notes for the facility if needed.

MRN Information: Inherit Select to copy the MRN from your company settings or EMR of origin. Clear

to define a dedicated format for the facility.

Other MRN settings See MRN information.

The following settings become available after you save.

NPI No. Type the national provider identifier of the facility.

Enable Insurance Eligibility [Unused]

Federal Tax ID Type the tax ID of the facility.

Enable Insurance Claims [Unused]

ImagineSoft Provider ID Type the "facility ID" used by ImagineSoftware.

Default Billing Provider If using Exa Billing, select the default billing provider (the provider issuing

invoices for treatment).

Service Facility The facility providing treatment.

POS Type Select the place of service code for the facility.
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To use this value as the default for all facilities, select the Always set POS to
This Value checkbox.

Fee Schedule Select the fee schedule for the facility.

Rendering Provider The primary radiologist at the facility.

3. Select SAVE & CLOSE.

See also:

Configure an ordering facility

Add modalities

You must set up each modality available to your facility or institution in Exa PACS/RIS. In particular, you
must add modalities before entering DICOM settings.

A Do not add non-DICOM modalities, as this could result in problems sending studies to external
PACS.

Procedure

1. Go to SETUP > Office > MODALITY.

MODALITY

u Hide Inactive

ND. | CODE MNAME
Sl @ BD Bone Densliometry
A2 ER BR Modality
R cT Computed Tomaaraghy
2. Select ADD.
}?ude » B8R O mactive
Fuarme * 2R Modaliy O Hicden an Physician Pertal

3. Enter the following settings.
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Code Type the standard DICOM modality code. For example, for ultrasound, type
us.

Name Type a unique name for the modality.

Hidden on Physician Portal Select to hide the modality name on the physician portal to prevent
unwanted scheduling. Useful for hiding non-scheduled modalities such as
SR.

4. Select SAVE.

5. In the list of modalities, select the ® @ buttons to order the new modality.

Note: During modality-related tasks, Exa PACS/RIS matches modalities by the order in the list.
Therefore, for example, you should list MG before SR.

Add modality rooms

Modality rooms are named locations where modalities are used for exams, and must be configured for
use in scheduling exams. Add a modality room for for each modality at your facility.

Avoid common mistakes

e Give your modality rooms intuitive names that are easy to find when creating schedule
templates

e Set the From date to a date in the past to view past scheduled appointments

e Set the To date to a date in the future (such as 1/1/2099) unless you plant to permanently
close the room.

Prerequisites: Add modalities, Add a facility, and DICOM modality worklist (see Configure application
entities).

Procedure

1. Go to SETUP > Office > MODALITY ROOM.
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MODALITY ROOM
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|
| Click here to view/edit Schedufe Templates applied to this room

3. Enter the following settings.

Code Type your unique internal code or name for the modality room.

Facility Select the facility where the modality room is located.

Name Type a name for the modality room.

From Date/To Date Select the long-term date range in which you plan to keep using the
room.

Color Code Select in the box, and then select a color from the picker to assign to the

modality room. The color appears in a bar below the name of the modality|
room in the schedule book.

Display Order Type a number to determine in which column the modality room appears
in the schedule book. Lower numbers appear on the left side of higher
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numbers.

Modalities Select all modalities that are in use in the modality room. All appointment
types with the modalities you select become available to schedule in the
room (unless excluded by schedule rules).

DMWL Select the AEs in the room to which to serve the worklist. Only the selected
AEs will receive orders for that room.

4. On the MODALITYTIMES sub-tab, select the here link, and then add a schedule template to the
room.

5. Optional: On the LINKED RESOURCES sub-tab, select which treatment resource is associated
with the modality room (technologist or Mobile RAD vehicle), and then type or select the name of
the resource.

6. Select SAVE.

Add a group chat room

In a screen outside Exa Chat, you can create group chat rooms, manage members of the rooms, and
make the room available to selected users to join.

Procedure

1. Go to SETUP > Office > GROUP CHAT ROOMS.

GROUP CHAT RDOMS

CHAT RO NAKE CHAT RO MEMEBERS LISERS WiTH CHAT ROON WISIELITY

ha

£ TestChetRoom

2. Select ADD.
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GROLP CHAT ROCHS

Raam Mamea = TaziRoom

Usars Sefact Membe " fuailable to Seiact Membe h

3. Enter the following settings.

Room Name Type a name for the room.
Room Users Select the members of the group chat room.
Available to Select users that can find the group chat room when searching for a room to join.

4. Select SAVE.

Add a notification

You can pre-configure notifications to appear on the dashboard and/or portal sign-in pages under

"Organizational News." These notifications are fixed messages, and not related to email or fax
notifications.

Prerequisite: Add at least one facility.
Procedure

1. Go to SETUP > Office > NOTIFICATION.

MOTIFPCATION

m

MNew Hires
Welcome cur nisw prowideral

2. Select ADD.
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WNOTIFICATION
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3. and then enter the following settings.

Title Type a title for the notification.

Show on Provider Portal Login | Select to display the notification on the sign-in page of the physician
portal.

Show on Attorney Portal Login | Select to display the notification on the sign-in page of the attorney portal.

Description Type the body of the notification.

Office Location Select one or more facilities to which to send the notification.

4. Select SAVE.

Add tasks

Administrators can add tasks for marketing representatives, such as “Tell referring physician offices that
we will start offering 3D mammography in January.”

Procedure

1. Go to SETUP > Office > TASKS.
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TITLE DESCRIFTIIM COMPLETE DUE DATE
all L
Offering marmmagraphy in April

ill Raf Phys Reminders X Q3 E12023
- Mew imtake farms

o

2. Select ADD.

TASKS

Title + Ref Phys Reminders O completed

Description * - Offering mammaography in April
- Maw intake forms

Due Date 033172022 | [H

3. Enter the following settings.

Title Type a title for the task.
Description Type a description of the task.
Due Date Select a due date for the task.
Completed Select when the task is completed.

4. Select SAVE.

What are authorization, verification, and estimation?
Insurance companies and other providers may require authorization and verification of eligibility.

e Authorization involves contacting the insurance company about a procedure, providing proof of
medical necessity, and obtaining permission for the procedure in the form of an authorization
number.
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e Verification (of eligibility) means to check whether a patient’s insurance policies cover medical
products or services.

e Estimation refers to estimating coverage in the form of amounts payable by insurance companies,
patients, and other parties.

Eligibility verification and insurance coverage estimation is performed electronically with a clearinghouse
through PokitDok, ImagineSoftware, or other service. If the verification service is not able to determine
eligibility, it can be determined manually by clinical staff.

Add authorization rules

Authorization rules prevent you from scheduling an exam on a date sooner than the amount of time
required to obtain insurance authorization. Exa PACS/RIS automatically adds a warning (red star) to
studies on the worklist that match the criteria in your rules (such as facility, modality, and procedure
codes) that are awaiting authorization.

Prerequisite: Configure at least one procedure code and insurance provider.
Procedure

1. Go to SETUP > Office > EXAM AUTHORIZATION.

EXAM AUFTHORIZATION

FACILITIES MODALTIES DAY ALLOWE SCHEDULIMNG FROCEDURE CODES INEURANCE FROVIDERS
v | Al w all W
B Andgie Facility BOCTEBRMG MA KMIZ o 3 Selacted 3 Seacied
£ B Mirmilla Test Facility XA 2 o 2 Salpcted 2 Selectod
£ T srnika Facilty 1 CTLS A - o 3 Bolecied 1 Selected
2. Select ADD.
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Facility * (O Select all current and future facilities ® Choose facilities
Days * 2
Allow Scheduling
Procedure Codes 3 CODES SELECTED
Insurance Providers 3 PROVIDERS SELECTED

3. Under Facility, to make different authorization rules for different facilities, Choose facilities.

4. Configure the following settings.

Description

Facility Select one or more facilities in the dropdown list that will use the authorization
rule.

Modality Select one or more modalities to which the authorization rule will apply.

Days Type the minimum number of days required for authorization (the exam cannot
be scheduled during the number of days you enter).

Allow Scheduling Select to allow users to schedule exams that are currently unauthorized, but that
can be authorized in the future. Gives the user the option to schedule the exam,
create a preorder instead, or cancel.

Procedure Codes Select one or more procedure codes. The authorization rule only applies to the
procedures you select.

Insurance Providers Select one or more insurance providers. The authorization rule only applies to the
providers you select.

5. Select SAVE.
See also:

Authorize an exam
What are authorization, verification, and estimation?

Create a study flag

You can create a study flag that users can apply to studies and orders on the worklist. Sorting the worklist
by flags is one way for users to easily find groups of studies or orders to work on. You can also use them
to trigger routing rules. When you create a study flag, you can restrict its availability by institution, facility,
modality, and other parameters.

Procedure

1. Go to SETUP > Office > STUDY FLAG.
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STUDY FLAG

DESCRIFTION 3 INSTITUTIONS FACILITIES MODALITIES COLOR CODE

& I Flagn
& W Flagz
ZH Flaga

2. Select ADD.

STLRNY FLAG

Description * Flagl O wmactve [ Availsblein Pargl OO wicw Study Flag Calor Code
an Schedule Book
Institutians Facilities Madalitios
OO a8 mmstnutions O aliFacilitizs I &l Madslities

' - - : O oo

O

ER

T

I

L]

O

W

3. In the Description box, type a name for the flag.
4. Enter the following settings.

Available in Portal Select to make the flag available in the physicians’ portal. If selected, all
other settings become unavailable.

View Study Flag on Select to show any study flags added to a study on the appointment
Schedule Book card in the schedule book.
Color Code Select a color in the picker. This color appears in the Study Flag

column in the workilist.

Institutions Select the institutions for which the study flag is available.
Facilities Select the facilities for which the study flag is available.
Modalities Select the modalities for which the study flag is available.

5. Select SAVE.
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Set monthly goals
You can set monthly goals for the number of studies to perform, for example.
Procedure

1. Go to SETUP > Office > STUDY FLAG.

MONTHLY GDALS

MODALITY GOAL PERMOD (MONTHS RMEHTHLY (DAL WORKIMG DavE PER MONTH Erily {5l
i v
2 & WG Fohruary 2023 51] Fal El
2. Select ADD.
Modality * MG »
Goal Period (Month/Year) * March 2023
bdonthly Goal * 100
'n‘n'l;:-:hirl-:] [:I:;l:,'s par Maonth * 1

3. Enter the following settings.

Modality Select the modality for which to set a goal.

Goal Period Select the month for the goal.

Monthly Goal Type the target number of studies to perform with the selected
modality.

Working Days per Type the number of days in the selected month.

Month

4. Select SAVE.

Configure macro notes

Macro notes are pre-configured blocks of text and metadata that you can add as notes to items in various
parts of the program such as studies, schedules, and claims. Configuring macro notes ahead of time
saves you from having to re-enter the same notes on multiple occasions.
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Procedure

1. Go to SETUP > Office > MACRO NOTES.

MACRD NOTES

DESCRIPTION & TYPE FACHITIES RODALITIES
* [ S sludy nates Sty My CompanyMrmilla Test Facility srinikca Fa a4
2. Select ADD.

BAVE RESET BACK
Descriptian * S iy nones

Ml aezre Tioed # Procaduras

Testing - notes scenarios EDIT APPOINTMENT TYPEE
All-appodbmant typas:

3. Enter the following settings.

Description Type a short description for the macro note to appear as the selectable
option when adding notes in other parts of the program.

Macro Types Select the context in which the macro note is available.
Facilities Select the facilities where the macro note is available.
Modalities Select the modality with which the macro note is available.

Edit Appointment Typeqd Select to add or remove the appointment types for which the macro
note is available.

Macro Text Type the text of the macro note.

4. Select SAVE.

Configure portal links

You can add up to two custom links (URLS) to the patient, provider, or attorney portal. For example, you
could add a link to the patient portal that sends your patients to your company’s payment website.

Procedure

500-000594A 49



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

1. Go to SETUP > Office > PORTALS.

PORTALS

PATIENT PORTAL PROVIDER PORTAL ATTORNEY PORTAL
s
Label Qur Patiant Portal i
Link ittt testpporial.no

2. Select a portal sub-tab, and then enter the following settings.

Label Type the link text that appears to the user. For example, Pay Now.

Link Type the URL. For example:

htt ps: \ ww. our conpnane. com cust oner _paynment _site

3. Select SAVE.

Manage life cycles

To automatically purge aging images from the database (such as for legal or efficiency purposes), you
can create life cycle management (LCM) rules.

Procedure

1. Go to SETUP > Office > LIFE CYCLE MANAGEMENT.

LIFE CWCLE MANACEMENT

MAMSE T FRCRITY ROEALITY AGE OF STUl Pundl ATV

v |k w

Prarge Times GohitaTesiFaciily HOBRCHC TDG NS MR NI 0T 3 menths o

2. Select ADD.
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LIFE GYGLE MANAGEMENT

LCK Ruls M * FurgeTime 0 tnactive
Select Facility and Modality Fadect Datn 1o Purge Select When ic Purge
B images Ageof Study *  Maontka ~ | 3 %
O Resars [ Sudy Date [ Study Received Dats
O Decumsnts [ Age of Patient

O =tidy bastanca O Werity image sretances belors ramaving
O =Study bactans

3. Inthe LCM Rule Name box, type a name for the rule.

4. Enter the following settings.

Facility/Modality Select the facilities and modalities whose data is subject to purging by
the rule.

Data to Purge Select one or more types of data to purge.

When to Purge Age of Study: Select the checkbox, and then enter the number and

category of days.

Age of Patient: Select the checkbox, and then enter the age of the
patient.

Verify image instance before removing: Select the checkbox, and then
select the databases from which to purge the images.

5. Select SAVE.
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Configure all LDAP settings
Exa PACS/RIS supports the LDAP and LDAPS (LDAP Secure) protocols.

Make LDAP available

You can set up a connection to an Active Directory/LDAP server and synchronize users between the Exa
PACS/RIS database and the LDAP server.

Procedure

1. Onthe burgerE menu, select SETUP.

2. On the OFFICE menu, select Office.

3. On the COMPANY tab, select Enable LDAP.
4

On the LDAP CONFIG. sub-tab, under Active Directory Server, type the server address and
other settings.

o

Under Credentials, type user credentials to sign in to the LDAP server.

6. Under User Synchronization, enter whether and how often to synchronize the Exa PACS/RIS
database with the LDAP server.

7. Optional: To confirm your connection settings, select CHECK CONNECTION.
8. Optional: To synchronize servers manually, select SYNCHRONIZE.
9. Select SAVE LDAP CONFIGURATION.

About AD synchronization

Synchronize AD users and groups to ensure that the Exa PACS/RIS server has the same AD users and
groups as the LDAP server. With regard to groups, a user can only be a member of one Exa PACS/RIS-
related AD group at a time. The following examples illustrate how group synchronization works.

Example 1
Before synchronization Change After synchronization
User 1 in LDAP group A Add user 1 to LDAP group B User now in LDAP group B

User 1 not in LDAP group B

User 1 in Exa PACS/RIS group A Exa -none- No change
PACS/RIS has no group B

Example 2

Before synchronization Change After synchronization
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User 1 in LDAP group A Move user 1 from LDAP group A to User now in LDAP group B
LDAP group B
User 1 not in LDAP group B

User 1 in Exa PACS/RIS group A Exa -none- User is removed from group
PACS/RIS has no group B Exa PACS/RIS group A, but can
be added back.

Synchronize AD groups
To synchronize AD groups with the LDAP server:

Procedure

1. Onthe burgerE menu, select SETUP.

2. On the OFFICE menu, select User Management.

3. On the AD GROUPS tab, select SYNC. AD GROUPS.

4. Inthe left pane, select the groups that you want to synchronize (add to the server).
5

Select CREATE SELECTED GROUPS.

Synchronize AD users
To synchronize AD users with the LDAP server:

Procedure

1. Onthe burgerE menu, select SETUP.

2. On the OFFICE menu, select User Management.

3. On the AD USERS tab, select SYNC. AD USERS.

4. In the left pane, select the users that you want to synchronize (add to the server).
5

Select CREATE SELECTED USERS.

Optimize LDAP for large numbers of query results

By default, windows returns a maximum of 1000 objects in response to an LDAP query, but you can
increase this number. This can be useful when importing bulk accounts or other objects from Active
Directory by using Adobe Connect or other means.

Find the fully qualified domain name (FQDN)

1. On the LDAP server, in Control Panel, select System and Security > Administrative Tools >
Active Directory Domains and Trusts.
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2. Inthe left pane of the Active Directory Domains and Trusts dialog, under Active Directory
Domains and Trusts, find the FQDN for the computer or computers.

3. Keep this information for use in the next procedure.

Set parameters

1. On your LDAP domain controller, at the command prompt, sign in as the domain administrator.
2. Type NTDSUTI L, and then select ENTER.

3. Atthentdsutil : prompt, type |l dap policies.

4. Atthel dap policy: prompt, type connecti ons.

5. Atthe server connections: prompt, type connect to server <FQDN of dommin

controll er>.
6. When the connection is open, type q.
7. Atthel dap policy: prompt, type show values to view the current MaxPageSize value.
8. To change the value, type: set MaxPageSi ze to 30000.
9. Optional. To confirm your in-progress change, type: Show Changes.

10. To commit the change, type: conmi t changes.
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Configure providers and resources
You can set up individual healthcare providers, their groups and facilities, and provider pay schedules.

Configure an ordering facility

You can configure an ordering facility at your institution to be able to submit electronic orders for exams.
The orders submitted appear on the PRE ORDERS tab of the worklist for scheduling.

Procedure

1. Go to SETUP > Office > Providers & Resources > ORDERING FACILITY.

OARDERING FACILITY

Hide inactres

COCE MARAE ADORESS PHOME MO Fax b ERAIL Ll
Al o
E MyoF ity Ordering Eaciy 2217 1% Highways 70 East
el El] OFI0 addr
g 2] L address

2. Select ADD, and then enter the following information.

Code Type your internal facility code.

Name Type the name of the facility.

Market Select the market served by the facility.

[Address] Type or select the address and country or region of the facility.

Default POS Map

Select a map to the place of service, such as Google Maps.

Medicare Provider No.

Type the Medicare provider number of the facility.

CLIA No. Type the clinical laboratory improvement amendments number of the
facility.

Notes For mobile billing, type notes to the ordering facility, and apply
formatting by using the word processing tools provided.

NPI No. Type the national provider identifier of the facility.

Provider Agreement
Code

Select the Medicare provider agreement code of the facility.

Entity Identifier Code

Select the entity identifier code of the facility (refer to the USHIK).

500-000594A

55



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

EIN Type the employer identification number of the facility.
State License No. Type the state medical license number of the facility.
ETIN Type the ETIN to be able to use electronic transfers.
Federal Tax ID Type the federal tax ID of the facility.

Medicaid Provider No. | Type the Medicaid provider number.

Taxonomy Code The Medicare/Medicaid taxonomy code (refer to CMS.gov).

Medicare UPIN If there is only one healthcare provider at the facility, and the provider
has no NPI, type the unique physician identification number of the
provider.

SSN If there is only one healthcare provider at the facility, type the social

security number of the provider, if available.

Contract Start Date The start date of any mobile billing contract made with the ordering
facility.
Fee Schedule Select a fee schedule from the dropdown list. To add fee schedules, see

Configure a fee schedule.

Locations/Contacts Select a irovider associated with the ordering facility, and then select

the plus button.

3. Select SAVE.

4. Enter the following settings on the sub-tabs that appear.

Locations/Contacts

See Add a location or contact to an ordering facility.

Providers

To view the providers at the ordering facility, select the PROVIDERS sub-tab.

[None] Lists providers added to the ordering facility.

Summary

To generate summaries of patients and studies at the ordering facility, select the SUMMARY sub-tab.

Patients/Study Select whether display patients or studies in the ordering
facility summary report.

From Date/To Date Enter a date range for the summary report.
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e Select GO to view the summary report.

Marketing Rep

To configure a marketing rep. for the ordering facility, select the MARKETING REP. sub-tab.

Marketing Rep. Select the marketing representative for the facility.

Inherited From If inherited, enter the contact information of the origin.

1. Select SAVE.

2. Inthe Notes, Follow-Ups/Tasks, and Contracts areas, select ADD to add the corresponding
items to the marketing rep.

3. In the Patient Documents area, select UPLOAD to upload documents.

Login Details
You can link users who can sign in to the ordering facility portal, and assign sign-in credentials.
1. Select a user and then select LINK USER.

2. Optional. To add a new user, enter credentials and select CREATE USER.

Credentialed Technologists

You can link technologists to ordering facilities for which they are credentialed. This ensures that
mobile sites do not assign non-credentialed technologists. If no technologists are linked, all
technologists are available to assign.

e On the CREDENTIALED TECHNOLOGISTS sub-tab, select one or more technologists in the
dropdown list.

Credentialed Radiologists

You can link radiologists to ordering facilities for which they are credentialed. Only linked radiologists
can read studies of the ordering facility. If no radiologists are linked, all radiologists can read studies of
the ordering facility.

e On the CREDENTIALED RADIOLOGISTS sub-tab, select one or more radiologists in the
dropdown list.
Linked Resources

To link technologist or vehicle resources to the ordering facility, select the LINKED RESOURCES sub-
tab.
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Technologist Select a technologist to link.
Vehicle Select a vehicle to link.
Billing Rules

See Add billing rules (see also About billing rules).

Import an ordering facility
If you obtain exported facility information you can import those facilities.
Procedure

1. Go to SETUP > Office > Providers & Resources > ORDERING FACILITY.

CADERING FACILITY

Hide inactiee

COLE MARIE AIORESS PHOME B Fax b EMAIL MAHKET
All w
& mvoE Mty Orderiong Eacity 221715 Highways 70 East
&48 o aFin Addr
GEM 3 adilregs

2. On the ORDERING FACILITY tab, select IMPORT.

ADD RELOAD IMPORT HELP

Choose Flie [RR=EephEE]

2 | . Update Existing

3. Select Choose File, browse for and select the file to import, and then select Open.
4. Optional. To replace existing facilities, select the Update Existing checkbox.

5. Select IMPORT.
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What is a billing type?

The billing type is a setting for ordering facility locations that determines how their claims are handled.
Since some insurance policies do not cover certain mobile billing charges, the Split billing type can be
used to split charges between the ordering facility and the insurance carrier. Often the responsible payer
for a mobile exam is unknown when the invoice is initially drafted, and you can use the Census billing
type to place such orders in a queue until the payer is determined. If both of the previous cases apply,
you can use the Global billing type. Finally, you can use the Facility billing type to invoice the ordering
facility for all charges.

The following provides more details about each billing type.

Type Claims |Charges |Respons. Modifier Description
Payer (or Result When Census Updated)

Global 1 Global fees | Primary None Ordering| Studies change to Billed status and are removed
insurance facility from the Census screen.
location
Split 2 Technical Ordering TC saved | None e Box 20 is checked "Yes," total claim amount
charges facility in M1 or filled into the charges box to the right of box
next 20
available.

e Box 32 filled in with rendering provider's name,
address, and NPI number.

e Claims change to Billed status and are removed
from the Census screen.

Note:
e When there are no technical charges, the claim
Professional | Primary 26 saved is created but has zero bill fees for those
charges insurance in M1 or charges
next
available. ¢ When there are no professional charges, the
claim is created but has zero bill fees for those
charges

¢ When there are only global charges, the claims
is created but has zero bill fees for those

charges
Facility | Any Global fees | Ordering None Ordering| Studies do not appear in the Census screen.
facility facility
location
Census Studies appear in the Census screen for delayed

claim creation. Use this billing type for skilled
nursing facilities and other locations that need to
wait to determine the claim payer type.

500-000594A 59



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

Add a location or contact to an ordering facility

Ordering facilities can have multiple locations. For example, skilled nursing facilities (SNFs) can have
different halls, each with different nurse stations or fax lines. To address this, you can add locations or
contacts to an ordering facility.

Procedure

1. Go to SETUP > Office > Providers & Resources > ORDERING FACILITY.

CADERING FACILITY

Hide inacties

COLE MARIE AIORESS PHOME KO Fax EMAIL MAHKET
All w
& mvoE Mty Orderiong Eacity 221715 Highways 70 East
SE oo QFI0 Adddr.
E 03 0Fl Adiss

2. On the ORDERING FACILITY tab, open an ordering facility to edit, and then select the
LOCATIONS/CONTACTS sub-tab.

LOCATIONS/CONTACTS PROVIDERS SUMMARY
CREDENTIALED RADICLOGISTS LIMKED RESOURCES
LOCATION MAME PHOME MUMBER FAL MO

& Wy Ordering Facifty

3. Select NEW CONTACT, and then enter the following settings.

Location Name Type the name of the location.
Phone/Fax/Email Type the contact information for the facility.
Send Fax/Email Select the checkboxes to indicate how to receive approved reports.
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Report Password Type the password that the ordering facility must use to view
reports generated from exams that they ordered.

Ordering Facility Type Select the type of ordering facility for the location.

POS Type Select the place of service code for the location.

Primary Contact Select if this location is the primary contact for the ordering facility.

Billing Type Select the billing type of the location. What is a billing type?

5. Select SAVE CONTACT.
6. Select SAVE & CLOSE.

About billing rules

Billing rules apply to mobile billing claims for ordering facilities of type Split. Billing rules define automatic
modifications to default charges and fees on ordering facility location claims. For example, if your ordering
facility location frequently adds extra charges for X-rays performed after hours, you can create a billing
rule that automatically adds the extra charge for you. The following table describes the types of billing
rule that are available to configure. For instructions on how to configure a billing rule for an ordering

facility, see Add billing rules.

After Hours Selected CPTs when performed after hours.

Exam Override Selected procedures.

Exam Type Override Selected modalities.

Setup Setup for selected CPTs.

Stat Selected CPTs performed STAT.

Stat Exam Type Selected modalities performed STAT.

Transport - Multi-patient Transport to multiple patients with selected modalities. When
serving multiple patients in a single dispatch, the transport fees
are divided evenly between patients.

Transport - Single Transport to the patient with selected modalities.

Add a billing rule
To add a billing rule for an ordering facility location:

Procedure
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1. Follow the steps in Configure an ordering facility.
2. On the BILLING RULES sub-tab, enter the following settings.

Note: Available settings change depending on which billing rule type you select.

3. Select SAVE.

Billing Rule Select the billing rule type.

Ordering Facility Locations Select the OF locations whose claims you want to modify by the
rule.

Modalities Select the modalities whose fee you want to modify.

Fee Code Select the CPTs whose fee you want to modify.

Fee Basis Percentage: Select to increase the fee by a percentage, and then|

type the percentage in the box. The percentage is applied to the
billable fee schedule of the ordering facility if one was assigned,
or otherwise the default fee schedule.

Value: Select to increase the fee by a fixed amount, and then
type the amount in the box.

Billable Limit If limits apply (for example by insurance companies), type the
maximum amount for each patient for each dispatch that can be
added to the fee.

See also:

A t billing rules

Add a provider organization
A provider organization is a parent entity for provider groups and locations.
Procedure

1. Go to SETUP > Office > Providers & Resources > PROVIDER ORGANIZATION.

PROATDER ORGANIZATION

CODE PROVIDER OROANIZATION = FROVIDER GROUPE

Em Picwider Qegararaten Tes] By Provadas Group ), AgieTasl

2. Select Add, and then enter the following settings.
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Code Type your internal code for the organization.

Description Type a description.

3. Select SAVE & CLOSE.

Add a provider group or location
If your institution works with a provider group, add it to the system.
Procedure

1. Go to SETUP > Office > Providers & Resources > PROVIDER GROUP/LOCATION.

PROVIDER GROUPLOCATION

cope MAME = AGORESS PHONE KO FA3 M EMaIL
il arg AgieTeslProGioip 654 wusl 5t
0 e My Prowider Group T 2217 US Highway 70 East

2. Select Add.
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PROVIDER: GROUP/LDCATION

Code *
Hame *
Pravider Orgenizadion

Address Line 1 #

Acdress Lime 2

City/Stated TiP

Phons Ma

Fam Mo

WVPRG

Ky Provider Graup T

Pravider Organization Test ® | =

2217 US Highway 71 East

Selec) w

D Sard Fax

Ermaall

Reepart Paszward

HCP1OPR

RAD

Radiodogist, Aichard

Test, Aadiokegis

NP R MAAKETIMNG REF A0

B

le1]

3. Enter the following settings.

Code

Type your internal code for the group.

Name

Type the name of the group.

Provider Organization

Select the provider organization to which the provider group or
location belongs.

[Address]

Type and select the address and country or region of the group.

Phone/Fax No.

Type the primary contact information for the group.

Email

Type the email address of the primary contact at the group.

Report Password

Type the password that the provider group must use to view reports
generated from exams that they ordered.

4. Select SAVE.

5. Use the PROVIDERS sub-tab to view or edit the list of configured providers.
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6. Use the SUMMARY tab to display a list of patients or studies associated with the current provider
group.

7. Use the MARKETING REP sub-tab to add a marketing rep to the provider group.

Add a resource

A resource is an attorney, nurse, provider, laboratory, radiologist, technologist, or referring provider. You
can add individual resources and add them to one or more provider groups.

Procedure

1. Go to SETUP > Office > Providers & Resources > RESOURCE.

RESOURCE
RELOWAD EXPORT
CODE2  MWAME NPl MARKETIMG REF AODRESS FHOME® FAK S EFECIALIT AESOURCE MARKET ACT SYE
&l L | Al g | g | e
* Ao Tast, Attarmey 2217 U2 Highwsat CIZANTIZ-T Astoemiey £
+ iz Adtariey, GolikaTest AuboTestiddress Aaleireey W
* Flang2 Amgin, Ang BS54 woot ot Aofoming P w
2. Select Add.

Note: The settings available differ depending on your selection in the Type dropdown list.
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RESOURCE

PREV ~ NEXT

Maimg = Referring
I
Frovider
Titla
MNP Me
Licensa Mo

Tamonomy Code
Medicare Provider Ko 100

O Office Mame
Medicaid Provider No

55N
Prow. Agreement Code w7
Fadiaral Tax i
POE Typa Salapt W
EIM ha
Fee Schedule Salect w
ETIN Mo,
Max TAT i {in min)
Madicans LFIN
LOCATIONS/CONTACTS LOGIM DETAILS ALT. MAME MOBILE SCHEMILE TEMPLATES SIGMNATURE SUMMARY
CODE CONTACT MAME GROUP ORDERING FACILITY  ADDRESS | PHONE® MARKET
& HEP12RF12 Lir Sareat

3. Enter the following settings.

2b/Subtab

RESOURCE Type Select an Exa PACS/RIS provider type.
Code Type your internal code for the provider.
Name Type the name of the provider.
Modality Select the technologist’s allowed modalities.
Title Type the academic credentials of the provider (e.g. MD)
NPI No. Type the national provider identifier of the facility.
Taxonomy Code The Medicare/Medicaid taxonomy code (refer to CMS.gov).
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ab/Sub-tab

Dr. Office Name

eXQ-PLATFORM

Type the business name of the provider’s office.

SSN

Type the social security number of the provider.

Federal Tax ID

Type the federal tax ID of the provider.

EIN No.

Type the employer identification number of the provider.

ETIN No.

Type the ETIN to be able to use electronic transfers.

Medicare UPIN

If the provider has no NPI, type the unique physician
identification number of the provider.

Market Select the market that the resource serves. All facilities in
the Facilities dropdown list that are associated with the
selected market become selected.

Facilities Select all facilities with which the provider is associated.

Specialty Select the specialties of the provider.

License No. Type the state medical license number of the provider.

Medicare Provider No.

Type the Medicare provider number of the provider.

Medicaid Provider No.

Type the Medicaid provider number of the provider.

Prov. Agreement Code

Type the code for the legal provider agreement code.

POS Type

Displayed when Referring Provider is selected as the
provider type. Select the place of service type for the
referring provider's location.

Fee Schedule

Displayed when Referring Provider is selected as the
provider type.

Max TAT Assign a maximum turnaround time for the provider, in
minutes. Exa PACS/RIS divides this time into 4 segments on
the TAT monitor on the worklist.

Locations / Code Type your internal code for the provider.
Contacts

Organization

Select the provider organization of the provider.

Group

Select the provider group to which the provider belongs.

Email

Type the email address of the provider. This is required to
receive email reports, notifications, or attachments.

Contact Name

Type a contact name, such as the name of the
administrative assistant of the provider.

[Address]

Type or select the country or region and address of the
provider.

Provider Alerts

Type any alerts for the provider, such as “only takes
referrals.”
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Office Phone/Fax

eXQ-PLATFORM

Type the contact information for the provider’s office.

Mobile/Pager No.

Type the mobile and/or pager number of the provider.

Phone No.

Type the personal phone number of the provider.

Fax No.

Type the personal fax number of the provider.

Primary Contact

Select to send reports to the referring provider only.

Reports to
Me/Contact
Information

Email Report Link
Email Attachment
Postal Mail

Fax

Office Fax

HL7

Select to send reports to the individual provider
location/contact, and select which methods to use.

Note: If you select Email Report Link and/or Email
Attachment, you must enter the recipient email address in
the Contact Information area.

Reports to Group

Email Report Link
Email Attachment

Select to send reports to all members of the provider
location/contact's provider group, and select which

Receive When Added as
CC Provider

Postal Mail methods to use.
Fax
Office Fax
HL7
Report Password | -- If you selected Email Report Link previously, type the
password that the provider must use to view reports
generated from exams that they ordered.
Reports to Patient | Delay Type the number of days to wait before posting reports on
Portal the patient portal.
Image Delivery CcD Select which media to use to deliver images.
Options Film
Paper
Notification Email/Fax Select to receive notifications by email and/or fax.
Settings

Select to have the provider receive notifications by email if
they are added as a CC (carbon copy) provider.

4. Select SAVE CONTACT and then SAVE & CLOSE.

See also:

Configure a technologist

Deliver reports

Configure a notification template
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Convert or merge a system provider resource

When Exa PACS/RIS receives a study with providers that it does not recognize, it automatically creates a
system provider resource and associates the study with that system provider. System providers are not

available in other parts of the program, but you can convert them to a usable provider or merge them
with an existing one.

Procedure

1. Go to SETUP > Office > Providers & Resources > RESOURCE.

RESOURCE
SEARCH FOR PROVIDER ON WEB P
CODES  MAME LS MARKETIMG REl ADDRERS FHOMNEZ FAX = EPECIALIT AESOURCE MARKET Merars
C e | il
+ Sl Tost, Mtomay 2317 US Highws: (322227 e ’
+ ¢“lloz by, GaolikaTesl AutoTestdddress: ki ad
. i e G54 oot st Rodfpring P b

2. On the SYSTEM PROVIDER column, select Yes.

COMVERT SELECTED SEARCH FOR PROVIDER ON WEB
CODE = MNAKME MPME MARKETING ADDRESS SPECIALITY RESOURCE ACTIVE SYSTEM PROVIDER
np all w |l v Yes vl Yes -
* HCP2ZIRF  NB KRISTY-5U fEYSTEM PROVIDE FeferingFr o o

1. Select a system provider in the list, and then select CONVERT SELECTED.
2. To create a new provider, select CONVERT DIRECTLY.

3. To merge with an existing provider, select USE EXISTING, and then select a provider in the list.

System provider management

How would you like to convert the selected
system providers?

CAHCH.

4. Select SAVE.

500-000594A 69



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

Configure a technologist

Technologists have access to special features in Exa PACS/RIS, and therefore require a slightly more
detailed configuration. For example, you can select which appointment types the technologist is allowed
to perform, and assign schedule rules to the technologist, which prevents scheduling them for an
appointment that they are not allowed to perform. To configure a technologist:

Add a technologist resource

1. Follow the steps in Add a resource to add a resource of type Technologist, but do not select
SAVE & CLOSE.

2. Onthe ALLOWED APPOINTMENTS sub-tab, select ADD.

3. Inthe Edit Appointment Types dialog, select the checkboxes for all appointments that the
technologist is allowed to perform, and then select SAVE.

4. Optional. On the SCHEDULE RULES sub-tab, select an edit button to modify a schedule rule.

5. Select SAVE & CLOSE.

Create a technologist user role

1. Onthe burgerE menu, select Setup.
2. On the OFFICE menu, select User Management.

3. On the USER ROLES tab, select ADD, type a name and description of the role (such as
"Technologist"), and the select SAVE.

4. In the User Role Permission area, select the Technologist user right, plus any other rights you
want to grant all technologists.

5. Select SAVE & CLOSE.

Create a technologist user group
1. On the USER GROUPS tab, select ADD.

2. Inthe Roles dropdown list, select Technologist (or the name of the technologist user role you
created earlier).

3. Enter other settings for the group (see Create a user group), and then select SAVE.

Create a technologist user
Configure an individual technologist as a technologist user.
1. On the USERS tab, select ADD.

2. Inthe Linked Provider User Type dropdown list, select Technologist.
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3. Inthe Technologist dropdown list, select the technologist resource you created earlier.
4. Enter all other settings for the user (see Create a user).
5. Select SAVE.

Configure a provider pay schedule

To help with billing, you can configure a pay schedule for each organization that provides radiology
reading services. The schedule defines the charges by procedure, modality, and radiologist.

Procedure

1. Go to SETUP > Office > Providers & Resources > PROVIDER PAY SCHEDULE.

PRIVADER PAY SCHEDULE

HahtE = START OATE =D OATE
I Tesi 1201150y 12317202
2. Select ADD.
Pay Schedule Mame *  Tagt 0O nactive

Start Date/End Date *  pMVDDAYYYY & | mnioDsyyyy | B

Provider * Test, Radiologist x |= -

Selected Providers
Test, Radiologist >
Modalitiss |:| Al Badalities Modality Fee 00,30
L7 BH =
B cr
B o
B v =
Surmimary
hppointment Types 30 RMNDRIRR CTMRI US/OTH REQ POSTPCY | * Appointment Type Fee 100

Zelected Appointment Types

3. Enter the following settings.
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Pay Schedule Name Type a name for the pay schedule. Typically, this is the name or
organization of the radiologist.

Start/End Date Select a date range during which the pay schedule is valid.
Provider Select a radiolohist to assign to the providing organization, and then
select the plus button. You can add multiple radiologists.

Modalities/Fee Select one or more modalities to which to assign a fee.

Type the fee to charge when usiﬁthe selected modality during an

exam, and then select the plus button. Add all modality/fee
combinations that the provider offers.

Appointment Types/Fee| Select one or more appointment (exam) types to which to aﬁn a fee.

Type the fee for the selected exam, and then select the plus button,|
Add all appointment type/fee combinations that the provider offers.

4. Select SAVE.
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Configure scheduling and codes

You can set up information related to scheduling exams, including fees, body parts, appointment types,

diagnostic and procedure codes, and various kinds of templates.

About fee schedules

Fee schedules define what your healthcare institution charges for procedures. There are three types of

fee schedule.

o Billing fee schedule: The primary type of fee schedule. Lists the global fees before any other

considerations.

e Allowed fee schedule: The contract rate agreed upon with insurance companies. Used for

reference purposes.

e Self-pay schedule: Reflects discounts for cash payments made by individual patients.

To create fee schedules, see Configure a fee schedule.
To assign your fee schedules, see the following topics:
Add an insurance provider

Configure an ordering facility

Add a facility

Configure a fee schedule

You can configure fee schedules by following these steps:
Prerequisites: Configure procedure codes.

Procedure

1. Go to SETUP > Office > Scheduling & Codes > FEE SCHEDULE.

FEE BCHEDALE FACILTT

HUEKIE = TYFE FROKA DATE

£ Defmit Biling Fee Schecule (I ko i
7 Bpw cafault Daalaul Fee Schwdile el B e
£ Nl bl dee Schad Esfing Fad Schadude nassesre

2. Select ADD, and then enter the following settings.

O HI0F0

030173023

12/30/2023

500-000594A

73



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

Fee Schedule Name Type a name for the fee schedule.

From Date/To Date Select a date range during which the fee schedule is valid. The From
date must be the current day or earlier.

Type Select a type from the dropdown.

3. Select SAVE.

4. On the FEE SCHEDULE tab, find the schedule you just added, and then double-click to open it.

Foe Schaduie Name * e Bl Tes achaqd
[ wnactive

Froen DatefTo Data L pirtat el (10 R0 5 120302023

| Type Biling Foe Schedule. w
CooE DESCRIFTION SERVICE TYFE SODELITY FACILITY GLOE
w' Al w Al -

[ & vooE HRT FAILURE ASSESSED witrvka Faciny 1 dingle Facrhe 000

* I DooEA, MM ADMMN SARSCONT J0MCLEM. SV DIL FECDN afviukn Fasiity 1 Angs Fasbe 0.00
il T 1A ADMN SARECOWE A0MCENT. 3L DIL FECTS S arinfkes Feastty 1, Angi Faciie .00

5. Select ADD PROCEDURE, select one or more procedures in the list, and then select SAVE.

To find procedures to add, enter one or more of the following search criteria, and then select

SEARCH.
Add To Shows the name of the current fee schedule.
Facilities Select the facilities that provide the procedure.
Code Type the code for the procedure.
Short Description Type one or more characters in the description of the procedure.
Modalities Select the modalities used in the procedure.
Ref. Code Type the reference code for the procedure. In most cases this can be
the CPT or LOINC code.
NDC Code Type the national drug code associated with the procedure.
Service Type Select a service type in the dropdown list.

6. On the FEE SCHEDULE tab, select SAVE.

Result: The Fee Schedule tab reappears with the procedures you added in the list.
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7. Open one of the procedures, and in the Fee Details dialog, enter the following fees:

Fee Details:

Code

T

Short Description

Description
RT FAILURE ASSESSED
Global Fes
0.00
Professional Fee
000
Technical Feas
0.00

8. Add fees to all of the procedures in the fee schedule, and then select SAVE.

See also:

About fee schedules

Import or export a fee schedule

You can import a fee schedule from another Exa PACS/RIS installation, or export a fee schedule from

your current installation.
Procedure

1. Go to SETUP > Office > Scheduling & Codes > FEE SCHEDULE.

FEE SCHEDLLE

NAME = TYFE FHOM DATE 10 LATE
L £l
22 Defmit Filing Faw Scheduls I s o 01302050
7 W it Tt Frse Schadils 03/282023 03/01/2023
£ e il fee scivmdd Eifing Fae Schecide 020382023 12/3072023
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2. Double-click an existing fee schedule to open it.
3. To import a fee schedule:
a. Select IMPORT FEE SCHEDULE.
b. Select Choose File, browse for and select a file to import, and then select Open.

c. Select IMPORT.

FEE SCHEDLLE

Fea Schedule Mame * teal bill fee sched
D Inactive
FromDate/ToDate *  o2a2g/2022 | B wzaosmzz  H
Type Billing Fee Schedula
CODE CESCRIPTHIN SERYICE TYPE MCDALITY FACILET
B Al W Al
3 000iF HET FAILURE ASSESSED srenika |
< § 0601A PhalA ADMAN SARSCOVZ SOMOGD, 3L DIL RECON | srnika |

5. To export the current fee schedule to your Windows Downloads folder, select EXPORT FEE
SCHEDULE.

Configure a facility fee schedule

It can be useful to configure individual facility fee schedules: if your fees differ by facility; for
teleradiology; of if you generate the Fees by Facility or Fees by Modality report.

Procedure

1. Go to SETUP > Office > Scheduling & Codes > FACILITY FEE SCHEDULE.

FACILIT'Y FEE SCHEDULE

MbME = START DATE ENG DATE
I Herrvilis Tes Fsedry (k) e D750 200
2. Select ADD.
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Fee Hame * Hirmilla Test Facility O inacuve

Starl Date/End Date *  07/01/200% = 01/31/2050 &
Facliites * O all Facilities
Mirmilla Test Facility
hadalities O adl rsadalities Madality Fee 0000
O eo
O er
O er
Sumirnary
CR: £50.00
Us: 510000
KA 550,00

3. Enter the following settings.

Fee Name Type a name for the facility fee schedule.

Start Date/End Date Select a date range during which the schedule is valid.

can add multiple modality/fee combinations.

Facilities Select one or more facilities to which the schedule applies.
Modalities Select one or more modalities to which the fee applies.
Modality Fee Type the fee for the modality, and then select the plus button. You

4. Select SAVE.

Configure body parts

You can define body parts for use in other parts of the program.
Procedure

1. Go to SETUP > Office > Scheduling & Codes > BODY PARTS.
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BO0OY PARTE

NAKE =

2. Select ADD.

ALT RRME

Bbgdormn

Arile

3. Type the name and alternative name for the body part, and then select SAVE.

Configure diagnostic codes

You can enter SNOMED, ICD, or LOINC codes for use in other parts of the program.

Procedure

1. Go to SETUP > Office > Scheduling & Codes > DIAGNOSTIC CODES.

£l R00

ek ]

2. Select ADD.

Code *
Description *

Code Type

MHAGHOETIC CODES

CEECRFTIN TYFE
wl
Chalera doe §a Yiboo chalerae 00, bk chaferae s ko]
Chalera S 80 Vibrio cholerae 07, hiovar sile wohan
Cholera, unapecified Kb
ADC.O O Inactive

Cholera due to Vibrio chol

3. Enter the following settings.

Code - Type the code to enter.

Description - Type the code’s diagnosis description.

Code Type - Select the code standard to which the code belongs.
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4, Select SAVE.

Import diagnostic codes
If you obtain exported diagnostic codes, such as from the CMS or AMA, you can import them.
Procedure

1. Go to SETUP > Office > Scheduling & Codes > DIAGNOSTIC CODES.

DIAGNOSTIC CODES

T 000 Chikera doe 15 Yibno Shoeleae 07, bive ehaleise e ik} w
Pl L v Chabera dhos 50 Wibvio chederae 07, hiovar sifoe W00 [

g a0g Cholera, unapecifed b 1/
Select IMPORT.
Select Choose File, browse for and select the file to import, and select Open.

Optional. To replace existing facilities, select the Update Existing checkbox.

i A N

Select IMPORT.

About procedure codes, appointment types, and appointment type procedures

Procedure code

A procedure code (or CPT code) is an internal code that identifies a medical procedure. You enter
procedure codes in Exa PACS/RIS primarily for purposes of billing.

Appointment types and appointment type procedures

An appointment type defines a set of related procedures to perform during an exam for purposes of
scheduling and medical examinations (by the front desk, radiologists, and technologists).

An appointment type includes one or more appointment type procedures (which are the same as
"procedures") to perform during a single appointment. A common example would be an appointment
type that includes an imaging study (one procedure) with contrast (another procedure).

Where do I use these?

Exa PACS/RIS prompts you for either a procedure or appointment type (or both) depending on which
part of the program you are using. For example, when scheduling the exam, the scheduler enters
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appointment types. When reading the exam, the radiologist also enters appointment types. When billing
the exam, the biller enters procedure codes.

Grouped appointments

For even more flexibility when scheduling, you can create grouped appointments that contain one or
more appointment types. As an example, a grouped appointment could have the following hierarchy.

Grouped appointment Appointment type A Appointment type procedure A

Appointment type B Appointment type procedure A

Appointment type procedure B

Appointment type procedure C

What's the difference?

e Appointment types are intended to contain multiple similar or related procedures.

e Appointment types can be scheduled from the schedule book or by using the Find Slots
feature.

e Grouped appointments are intended to contain different exam types, such as an ultrasound
and a mammogram--studies that take place in different modality rooms.

e Grouped appointment can only be scheduled by using the Find Slots feature.

Procedure code charge types

You can select a charge type for individual procedure codes that determines whether the procedures are
billed to an ordering facility or insurance carrier, regardless of the claim's responsible payer. When you
create a claim, Exa PACS/RIS automatically creates separate invoices for all procedure codes of each
charge type—one invoice for the insurance carrier, and one for the ordering facility. Specifying charge
types is especially useful when working with ordering facility billing rules that automatically add special
charges to ordering facility invoices.

See also:

Configure procedure codes
Configure appointment types
Configure grouped appointments

Configure procedure codes

A procedure code is an internal code that identifies a medical procedure. Additionally, procedure code
entries serve as detailed sets of information about procedures that Exa PACS/RIS uses for billing,
ordering, and other functions.
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When you configure a procedure code, you can add NDCs that technologists can select when performing
the exam. This makes the process of searching for and adding the appropriate contrast material and
other medications more efficient and accurate.

Prerequisites: For adding NDCs to a procedure code, complete the steps in Configure NDCs.

Procedure

1. Go to SETUP > Office > Scheduling & Codes > PROCEDURE CODES.

PROCEDURE CODES

RELBAD IMFORT CPT
B Hide nactie
CopE = DESCRFTION EXAM PREP INSTRUCT GLOEAL FE DURATICH FACILITY MOOALITY RIOCAFIERS SERVICE TYFE Rl
WA w0 A a
L DomiA MK ADKN EARSCOVD [ 1% srisika Faclity 1 Angas Fac usdelesd -
& OD0F HRT FAILURE ASEESEE [ 15 arinika Facdity 1 Angee Fao
2 000Ta PR DK ARSI i 15 wiinika Facddy 1Ange Fag urdefimad
2. Select ADD.
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Facilities all Facilities Service Typa Select
Ref. Code OO00TA
NG Code

MNOEC hsasure

Colat Code
Code * o001 4 O inactive SOE Study O
Short Descripton * MM ADBAN SARSCOVZ 2
Descriplion * IMBA A0RAN SARSCONE 3
NERAL f XAk F & & f LATE I
Body Part Salect w Duration * 15
] manTranscbable ] Require Gopay Default Units !
O Require Fhysician O Redquire Waiting Time R
Notes Ll Select W
Muodalities * O ao
[ er
Charge Type Salect w O et
[

3. Enter the following settings.

Single/Empty Code [unused]

Facilities Select one or more facilities that perform the procedure.

Code Type your code for the procedure.

Short Description Type a short description for the procedure.

Description Type a full description of the procedure.

Service Type Select the service type to which the procedure belongs.

Ref. Code Type the reference code of the procedure. In most cases this can be theg

CPT or LOINC code.

NDC Code Type the national drug code associated with the procedure, if any. For
a more advanced NDC function, see later steps in this topic.

NDC Measure Type the unit of measure for contrast and/or liquid medications. The
value for this is usually UN.
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Color Code Select in the box, and then select a color in the picker to assign to the
procedure.

SDE Study Select the checkbox if the procedure is associated with echo
ultrasound.

4. Select SAVE.

5. Optional. On the GENERAL sub-tab, enter the following settings, and then select SAVE.

Body Part Select the body part associated with the procedure.
Non-Transcribable Select if the procedure cannot be transcribed.

Require Copay Select if the procedure requires a copayment.

Require Physician Select if the procedure must be performed by a physician.

Require Waiting Time | Select if the procedure requires a waiting time before beginning (such
as drinking Barium some number of hours before a procedure).

Notes Type notes for the procedure as needed.

Charge Type Select on which invoice to add the charge.
Ordering Facility Invoice

No Split - Insurance

Duration Type the expected duration of the procedure.
Default Units Type the number of procedure units.
RVU Type or select the relative value units of the procedure for Medicare

reimbursement.

Level The provider level code that determines the pay rate to the radiologist.

Modalities Select one or more modalities used in the procedure.

6. Optional. To add NDCs to the procedure code, do the following.
a. Onthe NDC sub-tab, select Add.
b. Search for a code by entering criteria in the search boxes at the top and selecting Enter.
c. Select the checkboxes of the NDCs to add, and then select SAVE.

7. Optional. For EXAM PREP. INSTRUCTIONS, see Configure exam prep instructions.

8. Optional. To add diagnostic codes (other than standard ones already on your system), on the
DIAGNOSTIC CODES sub-tab, select codes from the dropdown list.

9. Optional. To associate a diagnostic code with the procedure code, on the DIAGNOSTIC CODES
sub-tab, select a code.
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10. Optional. To select a report template to be used for the procedure, on the DEFAULT REPORT

TEMPLATE sub-tab, do one of the following.

¢ Inthe Template List, select an existing template.

e Select NEW TEMPLATE, type a template name, create a template in the word processing

area, and then select SAVE TEMPLATE.

11. Select SAVE & CLOSE.

See also:

About procedure codes, appointment types, and appointment type procedures

Import specimen catalogs

If you obtain specimen catalogs in CSV format, you can import them.

Procedure

1. Go to SETUP > Office > Scheduling & Codes > PROCEDURE CODES.

Select SPECIMEN CATALOG.

i A N

Select IMPORT.

Import procedure codes

FROCEDURE CODES

RELOAD IMPORTCPT
B Hide nactne
CODE = DESCRIFTION EXAM PREP INSTRUCT GLOEAL FE DURATICN FACILITY MDOALITY
£ DooiA MM ADWIN SARSCOVD o 15 srisika Faciity 1 Angas Fac usdelesd
I 00O HET FAILURE ASEECEE i 1% arindka Facdity 1,Angee Fao
2 000ta Pdbd DK SARSCTY i 15 wiindka Facdry 1Ange Fag uordefimed

RIOCAFIERS SERVICE TYFE Rl

Select Choose File, browse for and select the file to import, and select Open.

Optional. To replace existing facilities, select the Update Existing checkbox.

If you obtain exported procedure (CPT) codes, such as from the AMA or third-party billing companies,

you can import them.

Procedure

1. Go to SETUP > Office > Scheduling & Codes > PROCEDURE CODES.
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PROCEDURE CODES

RELOAD IMPORT CPT
B Hide nactive
CODE = DEECRFTION EXAM PREP INSTRUCT GLOEAL FE IURATICN FACILITY MODALITY BAOCAFIERS SERVICE TYFE Rt
il # | A SRR | W M a
& Domia MK ADKAK EARECOND [ 1% sritihs Faclity 1 Ange Fac sl d -
& F HRT FAILURE ASEESEE i 1% arinfka Faciity 1,Angee Fao
S B 0L i DN ARSI [ 15 stirika Facifty 1 Angie Fac urciefired
Select IMPORT CPT.

Select Choose File, browse for and select the file to import, and select Open.

Optional. To replace existing facilities, select the Update Existing checkbox.

v A N

Select IMPORT.

Configure NDCs

You add an NDC (national drug code) for use elsewhere in the program. You add NDCs either manually
or by importing them.

Add an NDC manually

1. Go to SETUP > Office > Scheduling & Codes > NDC CODES.

NDC COOES
INIFOET EXPOHAT
PROFRETARY MAM= = NONPROPRIETARY HAM HOC PACEAGE CODE FECHALE DESCRIFTION LAEELER NAME FROCUCT KEC ROUTE
|} W
Esedrin Pen Tripie Action Sostaminophen, &spein [rH7 205 10 P0G i 1 B0 « 1 Pelancamtnkine Gorsure Tablet, Coated Hazal

2. Select ADD.
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Propristary Mame *
Mo Progrstany N *
MDOE Package Codo *
Fackage Destription *

Strergth

Excediin P Triphs Action Capiets? Labaler Narre * Glaxagmithkine Consumer Heafhese Hild

Acataminoghen, Aspinn {rs=ed) And Dyphent Procuct NDC = Tatles, Coated

Rouie Plagal

N POUCHM T BOX > 7 PATCH m 7 POUCH »

Ukt | g W

3. Enter the following settings.

Proprietary Name

Type the trade name, or the name of the drug chosen by the
labeler.

Non Proprietary Name

Type the generic name or the active ingredient in the drug

NDC Package Code

Type the code from the manufacturer.

Package Description

Type the description of the package from the manufacturer.

Strength

Type the strength of the active ingredient, then select the units of
strength in the UOM dropdown list.

Labeler Name

Type the name of company corresponding to the labeler code
segment in the Product NDC.

Product NDC

Type the labeler code and product code segments of the NDC
number, separated by a hyphen.

Route

Select the administration method for the drug.

4. Select SAVE.

Import NDCs

Hint: Select the Help button to view a list of the column names and their order.

=

i A N

checkbox.

6. Select IMPORT.

Obtain a CSV file of NDCs that include the same options in the previous table.
On the OFFICE menu, select Scheduling & Codes.
On the NDC CODES tab, select IMPORT.

Select Choose File, browse for and select the CSV file, and then select Open.

Optional: To append (and not replace) the CSV file to existing NDCs, select the Update Existing
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See also:

Configure procedure codes
Add charges and NDCs in the exam screen for technologists
Use the exam screen for technologists

About schedule blocks

You can reserve blocks of time on the schedule book for modality rooms at selected facilities, and you can
select whether to be able to schedule exams during the block. Each block is given a reason (such as a
specific patient’s name), so that if scheduling is allowed, the scheduler knows what exams they can order
during the block (such as ones needed by that specific patient). There are three types of schedule block:

Hard block: Cannot overlap with other blocks
Soft block: Can overlap with other blocks
Quick block: A schedule blocks that you can create "on the fly" directly from the schedule book

To create a schedule block, you create a schedule rule within a schedule template and select the "Display
as a block on schedule book" option. See Configure a schedule template and schedule rules.

See also:

About schedule templates and schedule rules
Create a quick block

About schedule templates and schedule rules

A schedule rule determines when appointment types and modality rooms can be scheduled. Think of
schedule rules as the "office hours" for exams. When working in the schedule book, Exa PACS/RIS
prevents you from scheduling an exam that breaks any rule you configure, such as by hiding modality
rooms on specified days, or by warning you with a message.

Inclusion and exclusion rules

e An inclusion rule defines when something is available
e An exclusion rule defines when something is unavailable

A schedule template is a container for a set of schedule rules. It also links to one or more appointment
types and one or more modality rooms.

Schedule rules and the Find Slots feature

Find Slots uses schedule rules to determine the availability of timeslots in the following manner:

1. If no rule applies to a slot, the slot is always available.

2. If an exclusion rule applies to a slot, the slot is not available.

3. If an inclusion rule applies to a slot, regardless of time:
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e All other slots are unavailable.
e A priority is set for the inclusion rules in the following order: Specific date, yearly, monthly,
weekly, daily.

For example:

e If a specific date and a daily inclusion rule apply, the specific date rule is applied and the daily
rule is ignored.

e Iftwo equal priority rules exist (such as two daily rules), they both apply (they "stack").

e Inclusion and exclusion rules can apply together, such as a weekly inclusion rule and a daily
exclusion rule.

See also:

Configure a schedule template and schedule rules
Use the Find Slots feature

Configure a schedule template and schedule rules
To configure a schedule template:
Procedure

1. Go to SETUP > Office > Scheduling & Codes > SCHEDULE TEMPLATE.

SCHEIILE TEMPLATER

Teenplabe Mamo  Soecr schedule 1ar =52 - : Sy Inactive

Schedule Rules

RULE FRAME RALILITY RAOCALE MODALITY ROOK STAST DATE - END OATE RESOURCE APPOINTIAENT TYPES AvAl A ACTIVE
&2 Inciumon Sarmita Tess Facibty [} 5T ] o
Select ADD TEMPLATE.

Type a name and description for the template and then select SAVE.

Under Schedule Rules, select ADD.

LA

In the schedule rule screen, enter the following settings.

Template Name Select the template to which to add the schedule rule.

Rule Name Select Predefined or Free Text, and then type or select a name for the
schedule rule.
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Modality Rooms Select a combination of these items along with dates and times to define
the rule. For example, your rule could state that:

Appointment Types
“Resource A can perform appointment type B in modality room C."

Resource
Important: If you do not select a modality room, the room applies to all
facilities.

Type Select Repeating if you want the schedule rule to recur, or Date/Time if
not.

Not Available Select Not Available to create an exclusion rule. Clear the checkbox to

create an inclusion rule.

Display as a block on schedule | Select if this rule defines a schedule block on the schedule book. Select the
book hexadecimal color code box, and then use the color picker to assign a
color to the block.

Ignore rule in scheduling This setting becomes available when you select Display as a block on

engine (use only for displaying [ schedule book. Select this Ignore rule... checkbox to display the block on

text/color label) the schedule book, without the program taking it into account when
finding slots.

Autoblocking If you select a technologist resource for the rule, and the technologist is

available to work in two modality rooms at the same time, select
Autoblocking to prevent double-booking that technologist.

6. Do one of the following

e To save the current rule and add another rule, select SAVE.
e Select SAVE & CLOSE.
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Example of a schedule rule: Technologist lunch break

O nactive
Tempigte Name * enns Templaie "
Fule Mame * O Predefined ® Fres Toxt

Lurch 12-1pm

Modality Rooms EDIT MODALITY ROOMS n n Appomiment Types SR et S TGS =
BO-H (BD-H) CTH (CTH)

KRAY-H (XRAY-H)

Type ® Repeanng W Start Date 104032022 [z
B ot Availabie

B Dispiay as a biock on schedule book

[ Ignore rute in schaduling engine (use
ondy for displaying text/colos label]

Repeats Daily W Every 1 w days

From | 12:00 P L] To 1:00PM L]

Summary
Mot Available Every day from 12:00 PM 12 1:.00 PM beginning 10/03/2022

See also:

About schedule templates and schedule rules
About sch le block

Create a quick block

Configure a schedule filter

You can create a filter that controls what appears in the schedule book. For example, you could create a
filter that only shows two modalities during a four-day period.

Procedure

1. Go to SETUP > Office > Scheduling & Codes > SCHEDULE FILTER.
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ECHEDULE FILTER

2. Select ADD.
Fibisf Blame Tek
o o Diayd = 4 =
Locations LAy Compsy o ¥
Masdalsy Rooms Cormputer Tame 5

biE ]

Mt Hold Cirl o Shift 1o select muiple modality rooms,

3. Enter the following settings.

Filter Name Type a name for the filter.

No. of Days Type the number of days to display on a single page of the schedule
book. If the content of the page exceeds the available display width, a
scroll bar appears.

Locations Select a facility in the dropdown list. The modality rooms at the

selected facility appear in the Modality Rooms list.

Modality Rooms

Select one or more modalities in the list, and then select the right

arrow button to add them to the Selected Rooms list. These are
the only modality rooms that will appear in the schedule book when
you apply the filter.

4, Select SAVE.

Configure study statuses

Workflows in Exa PACS/RIS are status-driven. To create or tailor workflows, you can create a set of study
statuses, and then You You can configure how studies move from status to status (see Configure study

flow). To add statuses:

Procedure

1. Go to SETUP > Office > Scheduling & Codes > STUDY STATUS > STUDY STATUS.
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STUDY STATUS

STUDY STATUS STUDY FLOW

Facility *

My Company * | Seanc!
B oRrp/Ordered | oner

PR/Precheckin | omer|

SCH/Scheduled [ order

B conjConfirned | omer

CHI/Check-In  ome

B 1= Tech Start

I TE/Tech End
2. In the Facility dropdown list, select a facility, and then select ADD.

STUDY STATUS STUDY FLOW

3 : o el
Ganeral Information Things to Validata O alveays shaw Validation Window

Hatus Code * [ Pattent Addrezs O cPToods
s . {Address, City, Stabe, ZIF)

L s 30 Stady Shartou! Mersa on Worklist u Cagcsis Code
[ Patient &3

Fatus Descrption © [ miobileRad Retated [ Fetient atets

N o O Patient Contact

G S O Crder Retated Pumiber (Home of O Aeason bar Stdy
Mobila)

Kax Walt Time min (=5 E: Cracumiend Reviewy

[l Rofomirg Physician

mm D Primaty Insurance

Naotfication Settings

Email Temnplate iz

3. Enter the following settings.

General Status Code Type your internal code for the status.

Information
Add to Study Shortcut Select to add the status to the study row shortcut menu
Menu on Worklist on the worklist.
Status Description Type the name of the status.
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MobileRad Related

eXQ-PLATFORM

Select if the status is for Mobile RAD. For use with the
Mobile RAD app.

Color Code

Select in the box, and then select a color from the picker
to color code the status.

Order Related

Select if the status is related to orders only.

Max Wait Time

Type the number of minutes to complete check-in. If the
time is exceeded, the “Exceeds maximum time limit”
count at the bottom of the worklist increments.

Things to Validate

Always Show Validation
Window

Reserved for encounters.

[Other checkboxes]

Select the items that Exa PACS/RIS validates (checks for
inclusion) before moving the study to the next status.

Document Review

Select to require document review to advance to the next
status in the study flow. Select the documents for which
to require review in the button list.

Notification
Settings

Email/Fax Template

Select templates that determine whether and to whom
notification is made when a study arrives at the status.

4, Select SAVE.

See also:

Reqguire document review

Configure study flow

Exa PACS/RIS provides a graphical representation of the flow of studies from status to status at each

facility. You can define these flows, and also apply routing rules to control whether data can move to the

next status in the flow. The easiest way to define a new flow is to copy an existing one from another

facility, if available.

Note: You do not need to apply routing rules for manual DICOM send operations.

CAUTION: Changing the study flow incorrectly can “orphan” studies, leaving them unable to move to the
next status in the workflow.

Procedure

1. Go to SETUP > Office > Scheduling & Codes > STUDY STATUS > STUDY FLOW.

2. In the Facility dropdown list, select a facility.
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STUDY STATUS STUDY FLOW

|: Argie Facdity m
!: GabikaTestFacility
D Mueera Facdity
M mv Cnmnany -
) Echoduled a i. ol e e |
o B £ 155 =
Eracheckin
A s
L. Gebediiag
i -~
Chiidn " :: Tach Suat | [ _
LOfTETras
R -'i‘l i
&£ o 3
hegkdn
Chaek-0ul 3 Tech End :
o, l Tmch S5me

3. To modify the flow:

e Copy an existing flow to your new facility by select the source and destination facilities in the
lists (see figure).

e Drag the orange barin a status node to another status, and drag arrows.

e Add a routing rule between statuses by selecting the triangle on an arrow them, select a
routing rule, and then select OK.

4. Select SAVE.

See also:

Configure study statuses

Add a transcription template

You can add a template for use during transcription. A transcription template is for formatting a
transcription, whereas a report template is for final formatting of approved reports. To create a
transcription template:

Procedure

1. Go to SETUP > Office > Scheduling & Codes > TRANSCRIPTION TEMPLATE.

500-000594A 94



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

T RAMSCHIF TION TEMPLATE

TEMPLATE WAME =

L Terglete Hew

I

Test two

HRAY FARD

2. Select ADD.

SAWE HAVE R CLOEE

Tempiate-Hame ® m MOME: MSERT CPAGE LSTTIUT  REPGRTING  WUEW  PRODFMD  FPERMESONS Skon Ribbon
CHAY HAND = s TP TR (T i Tentpiate Mo
Arimi e - A = ¥ k= = o= W ors
I:I Inacove E 3fpkal .I-IEL — )
e Dcteand it Uy x| AT = helf = "
Mncsn Keywoed 3 ::
=t Fa= Faragracs
L ! a- Lt [} | L 1 i & . & b
User
-
i
Exam: RADIOGRAPH OF THE _ HAND
Technique: PA cbbkoue and lateral views of the _ hand are submitied
Appemament Types Clinical Data: Pan

Prior Shadies:

Findings: There is regional ostecpena  Scatered moderate degenerative changes with
joirt Space narowing scetosis and spuring present. Early arcsave changes PIP and DR
joink levels, and first carpal-metacarpal joint. Comrelate with erosme ostecarthngis

Oesmifiedicakofied density along he base of the s malacopal may reect Sofl lissue
changes associated with previous rauma. Sofl issues are unremarkabie. Mo disinct
aouie frachre o other acute osseous abnonmmalkty

Fieques Al Match .
L Beques il Marck i Impressian:

Fasilities

g Recommendation:

Madality * 163215

-

3. On the left pane, enter the following settings.

Template Name Type a name for the template.

Global Select to make the template available to all users.
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Macro Keyword

Type a macro keywords that can be voice-recognized to open a template.

User

You can restrict availability of the template by assigning users to it. Select a

user in the list and then select the plus +
template to multiple users.

button. You can assign the

Appointment Types

Restricts availability of the template to studies of the selected CPT code.

Require All Match

Restricts availability of the template to users and studies who match all
criteria entered in these settings.

Facilities Select one or more facilities to which to assign the template.
Modality Restricts availability of the template for use with one or more modalities.
Body Part Restricts availability to the template for use with one or more body parts.

Study Description

Restricts availability of the template to studies with the entered study
description.

Institution

Select one or more institution to which to assign the template.

4. Select SAVE.

eXQ-PLATFORM

5. In the template editor, type text and apply formatting for the template, and then select SAVE.

6. Optional. To paste items onto the template that you copied from outside Exa PACS/RIS, on the
HOME tab, select Paste, and then in the button shortcut menu, select Paste.

7. To add merge fields, select REPORTING (1) > Insert Merge Field (2), and then select a merge

field (3).
5 1
m ? LI] ":- ; I !:DI :q\ g R Infzne Cilohal

kAT datslt Sppont T Dpate st

[ETEENE ]

8. For formatting options (4), right-click in the body of the template.
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9. When finished with your template, select SAVE & CLOSE.

Add areport template

A report template is for final formatting of approved reports, whereas a transcription template is for
preparing transcriptions. You can create report templates and enhance them with logos, tables, and
merge fields. When you prepare a report based on your template, Exa PACS/RIS substitutes merge fields
with study and patient information.

Add a report template

Add a report template with the following steps, and then continue to the next procedure to edit the
header or footer.

1. Go to SETUP > Office > Scheduling & Codes > REPORT TEMPLATE.

REPCHT TEMFLATE

TEMPLATE HAME = ELMARY FACILITY MAHEET
A w
¢ 2 Bl KT Samiple Sarmgle naging ol modaitis Anger Facdity My Cormpany Nirmila Teet
& E T Tl Ange Facdity GokdkaTestFac iy Meers [kt

2. Do one of the following.

e To base the new template on an existing one, select the copy a button of the existing
template.

e To edit an existing template, select its edit & button.
e To start a new template from scratch, select ADD.

Template Hame * KaikE Sample Study Descripticn
i |+
O mactive o1
i 5 o :
- B &
B
Facifties 4 88 ECTED - B o
Ingtitution B e
B
%
B =
B ch
B oo
B ex
& er
B rr 5
=1

3
i

Sarngle maging all madalties
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3. Enter the following settings.

eXQ-PLATFORM

Template Name Type a name for the template.

Market Optional. Select the market to associate with the template. All facilities in
the selected market become selected in the Facilities dropdown list.

Facilities Select all facilities that use the template.

Institution Select institutions that use the template.

Modality Select all modalities to which the template can apply.

Summary Type explanatory information about the template.

Study Description Type study descriptions for the templates to be applied. For example, US
Abdomen could have a different template than MRI Abdomen.

4. Select SAVE.

5. Perform the steps in the following subsections as needed.

Add a header and footer

You can configure the header and footer of a report template, or edit existing ones.

1. At the bottom of the page, select the PAGE HEADER/FOOTER sub-tab.
Result: The word processor appears (it may take a few moments).

2. On the INSERT tab, select Header or Footer, and then in the button shortcut menu, select Edit
Header or Edit Footer.

HEADER/ OO

HOME INSERT PAGE LAYOUT REPORTS VIEWY TABLE LAYOQUT
—' iy t Q
F‘, = B La Ta 2 R 4] | &5

Fage Tout Fia Syimibol
{umber » Frame » ¥

|--E|l:|l: Table Image Shapes LChart Hyperink Sookmark
Break L L L

abers Text

Headers & Fo

Pages Tabil=s s iraboins Links Symbols

3. Type information for the header or footer.

4. Select SAVE.

Add a table
While not required, it can be helpful to organize information on your header with a table.
1. On the INSERT tab, select Table, and then in the button menu:

e Select a cell layout, or
e Select Insert Table dialog, enter table settings and then select OK.
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2. Type textin cells, and select Save.
3. See below to add logos and merge fields to the table.
Add a logo
1. Prepare a bitmap image and save it in the following:
[drive]:/EXA/WebImages
2. Place the cursor in the header or footer where you want to place the logo.
Note: It may be helpful to add carriage returns to make room for the logo.
On the INSERT tab, select Image, and then in the button shortcut menu, select Image.
In the Open File dialog, type the name of the bitmap image and then select Open.
In the image shortcut menu, select Format.
In the Image Attributes dialog, under Wrapping Style, select In Line, and then select OK.

Optional. On the HOME tab, select the text alignment tools, or drag the image to position it.

o N o U kW

Select Save.

Add merge fields
1. Place the cursor in the header or footer where you want to add the merge field.

2. On the REPORTING tab, select Insert Merge Field.
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PAGE HEADER/FOCTER REPORT SIGNATURE
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3. On the Merge Field button shortcut menu, select a merge field, or choose a field from one of the

sub-menus.

4, Select Save.

Add a report signature line

1. Select the REPORT SIGNATURE sub-tab.

2. Type text and add merge fields as described earlier.

REPORT SHIHATLRE

HOME NEERT PRGE LAy DUT TEWY
Teiad T
=] Rl W Iy | [o] dof| | (@] |
bdsrge s Specis Blgige Toalags e Fisin | Bbr Frpamn Fomi &
Pl v Faded Beck ¢ BRcts Cades Pl Tl Vi Pty Vaige
e Pk Bhaags [k Wee | PieiEw Frah
L =TT -I i ! - o R o ¢ Pais '.n‘ -z 5

Eletronically Signed By

Al okt Eullames
aETowder Signalue
aZ{gnabure] Exls

<-Merge fields

3. Select the SAVE buttons on the top and bottom of the screen.
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Configure functional and cognitive statuses

Functional and cognitive statuses are preset descriptions of a patient’s level of physical and mental
functioning that can be used in other parts of the program.

Procedure
1. Go to SETUP > Office > Scheduling & Codes.

2. On the FUNCTIONAL STATUS tab, in the Description box, type a functional status and then
select SAVE.

FUNCTIOMAL STATUS

DESCRIPTION
m Arnbadatary

" ;
o i Cane/walker

Dscrepticen *

=3l

3. On the COGNITIVE STATUS tab, in the Description box, type a cognitive status and then select
SAVE.

500-000594A 101



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

COGNITIVE STATUS

DESCRIPTION
& i Mitd aphasia
& il femory impairment

Description *

s

What are lead time and expected arrival time?

The lead time is the number of minutes prior to the appointment time that the scheduler wants the
patient to arrive. The program calculates an expected patient arrival date and time (the expected arrival
time) by subtracting the lead time from the appointment time. The scheduler may find it convenient to
inform the patient of this expected arrival time rather than the formal start time of the appointment.

If an appointment contains multiple exams, the program calculates the expected arrival time based on
the lead time of the first exam. If the first exam has no lead time, it uses that of the second exam, and so
on. If no exams have lead times, the expected arrival time is simply the time of the first exam.

Configure appointment types

An appointment type defines a set of procedures to perform during an exam. You can configure
appointment types for use in scheduling and other parts of the program.

Procedure

1. Go to SETUP > Office > Scheduling & Codes > APPOINTMENT TYPES.

500-000594A 102



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

APPOINTMENT TYPES

IMPOAT EXPORT HELF
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2. Select ADD.

Code CAPFA [ mactne Faciktea ALL SELECTED {&) =

Fef. Codo CEPP Idadaliy =
Mame * CombedpptTypel Miadality Reom HONE SELECTED -
Description £ Hamrwroads
Duratian * 15

Additional Tima
l.eai Timg
Exaim S 1

[ arouped Appotriment

AFPOATMENT T¥PE PROCEDURES ERAN PREFIFOOM LEVEL Ot
cone LESCRIPTION
7a17 7 ASD & PELYES WD CONTRAST
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3. Enter the following settings.

Code Type your internal code for the appointment type.

Ref. Code Type the reference code.

Name Type a name for the appointment type.

Description Type a description for the appointment type.

Duration Type the expected duration of the appointment type.

Additional Time Type the number of additional time needed beyond the default duration.
Lead Time Type the number of minutes to arrive before the exam begins.

Exam Count Type the number of exams to be included.
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Grouped Appointment Select for grouped appointments (see Configure grouped appointments).

Facilities Select one or more facilities where the appointment type is available.

Modality Select one or more modalities to use for the appointment type.

Modality Room Select one or more modality rooms where the appointment type can be
scheduled.

Keywords To make the appointment type easier to find during scheduling, type a
keyword and select the plus button. Add as many keywords as needed.

4. Onthe APPOINTMENT TYPE PROCEDURES sub-tab, select ADD.

5. Inthe Appointment Procedure dialog, select a procedure and any applicable modifiers, and
then select SAVE.

6. On the EXAM PREP/ROOM LEVEL CONFIG sub-tab, add or edit exam prep instructions as
needed.

7. Select SAVE.

See also:

Configure exam prep instructions
About procedure codes, appointment types, and appointment type procedures

Configure exam prep instructions

For each appointment type you can assigh exam and room preparation instructions. The instructions are
linked to modality rooms so that if an exam is rescheduled to a different room, the instructions change
accordingly. To configure exam prep instructions, start by following the procedure in Configure

appointment types and then:

Procedure

1. On the EXAM PREP/ROOM LEVEL CONFIG sub-tab, select ADD.
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Exam Prep/Room Level Config

Modality Reamis) * [] Select All Modality Booms

Duration
additional Time
Lead Time

Prep Instructions

2. and then enter the following settings.

Modality Room Select the modality room to which to apply the prep instructions.
Duration Type the estimated duration of the exam.

Additional Time Type the number of additional time needed beyond the default duration.
Lead Time Type the number of minutes to arrive before the exam begins.

Prep Instructions Type the exam and room preparation instructions.

3. Select SAVE.

Configure grouped appointments

A grouped appointment is an appointment type that contains more than one billable procedure. Grouped
appointments make it easy to schedule more than one procedure or exam during a single patient
appointment. To configure a grouped appointment:

Procedure

1. Go to SETUP > Office > Scheduling & Codes > APPOINTMENT TYPES.
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2. Select ADD.

APPOINTMENT TYPES

IMPORT  EXFORT  HELF

RESCRIFTION =

T w
SnERNM w
SOER KM w

3. Select the Grouped Appointments checkbox.

Code * GR1
Ref. Code GEMN-OOSOW MK
Marme * GroupExample
Description

Lead Time

Exam Count 2

|:i Inactive

0 minutes {pulled from one of the appointment types below)

Facilities *

Heywords

Grouped Appoindment I

4. Enter the following settings.

Code Type a unique code for the grouped appointment. The code does not need
to match an existing procedure code.

Ref. Code Type the reference code, if any.

Name Type a name for the grouped appointment type.

Description Type a description for the appointment type (it can be the same as the
name).

Lead Time (Will be determined automatically)

Exam Count Type the number of procedures to be included.

Grouped Appointment

(Already selected).

Facilities

Select one or more facilities where the appointment type is available.

Keywords

To make the appointment type easier to find during scheduling, type a
keyword and then select the plus button. Add as many keywords as
needed.

5. Select SAVE, and then in the message box, select YES.
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6. Inthe Appointment Types dialog, select an appointment type to add to the grouped
appointment.

Appointment Types

Appointment Type * | Select an appointment type r
Code *

Minutes to wait

after exam

7. Optional. In the Minutes to wait after exam box, type the expected minutes the patient must
wait between appointment types.

8. Select SAVE, and then in the message box, select YES.
9. Repeat steps above until all appointment types are added to the grouped appointment.

IMPORTANT: Add the appointment types in the order that they are performed, or in the correct
scheduling priority.

10. On the APPOINTMENT TYPES tab, select SAVE.

View locked slots

Exa PACS/RIS "locks" timeslots as soon as a scheduler selects them. The prevents other schedulers from
simultaneously double-booking in the same slot. You can view which slots are currently locked with the
following steps.

Procedure

1. Go to SETUP > Office > Scheduling & Codes > LOCKED SLOTS.
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Configure DICOM settings

You can configure DICOM settings such as by configuring AEs, setting up file stores, and defining receiver
and routing rules.

Note: The default AE title for Exa PACS/RIS is EXA_SCP, or EXA_MWL when acting as a worklist source.
These titles are configured elsewhere in the program by a Konica Minolta installation engineer.

Configure application entities

In Exa PACS/RIS an application entity (AE) title is a named configuration for a DICOM application that
includes information such as its type, host computer, and port number. You must set up AE titles for
Modality Worklist, send, receive/store, print, query/retrieve, and other functions to make them available
on Exa PACS/RIS. To configure an AE, use the following procedure.

AN

Failure to correctly configure application entities can cause general failure of DICOM communication
between Exa PACS/RIS and those entities.

Procedure

1. Go to SETUP > Office > DICOM > AE TITLE.

AE TITLE

B Hide lnactiee
nE:S HGST PORE DEICAIPTION FiLE STORE &E TIFE
T ExXayIzal W0 FIT 2676 el ] Eap-y iz Erg Serenl insgey SEMDRECEIVEQUERY/RETR
@l DLD_ARCHIVE QL0 ARCHNVE EIEFARILT STORAE FECENE
1 OPAL32.33 10997 26100 33336 OFAL_37. 33 Exa Saréar Images SENDRECEIVE QUERY/RETRI

2. Select ADD.
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3. Enter the following settings, and then select SAVE.

Note: Depending on the AE type, not all of the following settings are available.

AE Type

Select one or more transactions that Exa PACS/RIS makes with the AE.

AE Title (Remote)

Type the title of the AE. If an AE title is pre-configured on the device
hosting the AE, use the same title.

Ignore Scan Docs (Send)

Select to prevent sending of scanned documents to the AE (only DICOM
studies are sent).

My AE Title Type a title to set the identity of Exa PACS/RIS individually for each DICOM
node. In most cases, leave blank to use the default (EXA_SCP for PACS/RIS
functions, and EXA_MWL for modality worklist functions).

Host Name Type the host name or IP address of the AE.

Description Type a description for easy identification of the AE.

Disable QC2LIVE

Select to disable the automatic transfer of studies from QC to live.
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Retries Type the number of times the system attempts to reconnect with the AE
after a communication failure.

Send Single Instance per Study| Select to send one image per study.

Max Concurrent Type the maximum number of concurrent threads that the system can use
for the transaction.

Facility Select the facility to associate with the AE.

Ignore Inbound Stat Value Select to keep the Stat level of the study from Exa PACS/RIS.

Clear to use the Stat level of the study as received.

Send Annotations as Select how to process annotations for sending.
Burned in: “Flattens” the image and overlay into a single image.

DICOM Overlay: Converts the annotations to a DICOM overlay and sends
along with the study.

GSPS/PR Object: Converts the annotations to a presentation state and
sends along with the study.

Send Unique Image UID from | Select to generate a new UID for each image (rather than just for the

Viewer series or study).

DMWL Modalities Select to which modalities to serve a modality worklist.

DMWL Facilities Select to which facility to serve a modality worklist.

Issuer Type Select the type of issuer of PID:
None - DICOM receive and query/retrieve takes place as if no issuer was
configured.
Issuer list.

Dynamic - Automatically define the issuer based on retrieved results, and
allow multiple issuer/alternate ID combinations.

Issuer When you select an issuer type of Static, select the entity that issues the
patient’s PID, MRN, or account number. This makes available tracking and
correct assignment of account numbers for sending and receiving studies
when more than one are available.

AE Flag Select one of the following services to use to send studies.
DICOM: C-MOVE

DICOM SSL: C-MOVE, secured

HL7: Standard HL7 protocols.

OPAL: The Opal Transfer service.

Institution Type the name of the institution for easier identification.
File Store Select a file store for storing received data.
Port Type the port number through which the AE can connect to Exa PACS/RIS

(the Exa PACS/RIS listening port).
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Require SSL Select this checkbox if: 1) you selected the DICOM SSL AE flag; and 2) the
port number requires an SSL certificate.

Transfer Syntax (Send) Select the transfer syntax for sending.

Transfer Syntax (Receive) Select the transfer syntax for storing and receiving.

Vehicle Select vehicles to which to assign received studies.

SDE Modality Select if the AE is a dedicated echo ultrasound.

Include Approved Reports Select to include approved reports when sending as DICOM. Note: When

DICOM-sending, the report status (such as Approved or Transcribed) is not
included. To include the status, send via Opal.

See also:

Configure a DICOM printer

Configure a DICOM printer
Configure and save AE with AE type of “Print,” and then perform the following procedure.
Procedure

1. Go to SETUP > Office > DICOM > AE TITLE.

2. Configure a print AE, and then under Extra Printer Options, enter the following settings.

Extra Printer Options

ARTIM Timeow Max PO Length
Read Timecan B Margire 2
Write Tomeout Trua Slzo

Printer Configurations

v Madium Filen Size Bordar Duniily daulination ar|aritatks Magnification Ernply Demsity Mumasy Aflocatlen
FE P PAPER BIMX T0IN BLACK MAGAZIME PORTRAIT REPLICATE BLACK LT
ARTIM Timeout Type the number of minutes to wait for an acceptance or rejection

response to an association request before timing out.

Read Timeout Type the number of minutes the printer waits to receive data before
timing out.

Write Timeout Type the number of minutes the printer waits to send data before timing
out.
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Max PDU Length

Type the maximum number of bytes of a protocol data unit that the
printer can receive.

Border Margins

[Unused]

True Size

[Unused]

3. Select ADD CONFIGURATION.

Configuration

Mamme

Medium

PAPER w
Fillm: Sizee

EINX TN g
Border Density BLACK

Memaory Alocation (KB}

4. Enter the following settings.

Fim Destination MAGAZINE w
Fim Origflation PORTRAIT W
Magnification REPLICATE
Empty Density BLACK =~

Name Type a name for the printer.
Medium Select the printer medium.
Film Size Select the film size for the printer.

Border Density

Select a border density of Black or White.

Memory Allocation (KB)

For most printers, accept the default of Auto. Otherwise, type the
amount of memory in kilobytes to allocate for a print session.

Film Destination

Select the destination for exposed film.

Film Orientation

Select the orientation of the film.

Magnification

Select a magnification factor for printing images.

Empty Density

Select the density of the image box area on the film that contains no
image.

5. Select SAVE.
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Configure a file store

File stores are directories on servers that Exa PACS/RIS uses to store files received in a DICOM
transaction, such as images from a modality.

CAUTION: Changing an existing file store can prevent the study from opening.
Procedure

1. Go to SETUP > Office > DICOM > FILE STORE.

FILE STOAE

HAME = MOTES REHOT DIRECTORY
DEFALILT STORS Linprocessed DICOM stodies FAEL AN ICORAS
& B Exmervee kmages Fronassed DM stodiEs FAEdanmaes
¥l Beannad Docs Scanned Docirmisls 1o Patient Gags FaExaScanned bnajes
2. Select ADD.

3. Type the server name, root directory, and notes, and then select SAVE.

Configure routing rules

With routing rules, you can define how certain types of data flow between Exa PACS/RIS and other AEs.
For example, you could create a routing rule that tells Exa PACS/RIS to automatically send all data that it
receives from ultrasound modalities to another PACS. You can also add criteria to your rule for more
precise control. For example, your rule could limit sending of ultrasound data from only a specific facility.

Use the following procedure to configure a routing rule, and then apply the rule by following the steps in
“Configure study flow.” It is not necessary to apply routing rules for manual DICOM send operations.

Procedure

1. Go to SETUP > Office > DICOM > ROUTING RULES.

ROUTING RULES

HULE NAME = AETITLE FRIOHTY

= B Ruke EX&-AATAED 2

2. Select ADD.
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Priarity *

Attempts *

[ =]

3. Enter the following settings. The available settings change depending on the AE type that you
select in the Type dropdown list.

Rule Name All Type a name for the rule.
Type All Select the transaction to perform with the AE (for example, SEND).
Interface/Trigger] HL7 Send Select an interface and/or trigger for HL7 send actions.
Name
AE Title SEND Select the AE with which to perform the transaction (for example, select
Remote_Hospital to send to that AE).
PRINT
QUERY/RETRIEVE
Send Report (Opal)
LOCAL_CACHE
Priority SEND Type a number to indicate which rules to evaluate first. Lower numbers
take higher priority. Refer to your current list of rules on the ROUTING
PRINT RULES tab to determine the priority to use for the rule you are adding.
QUERY/RETRIEVE
Send Report (Opal)
HL7 Send
LOCAL_CACHE
Attempts SEND Type the number of attempts the program should make to apply the
PRINT rule.
QUERY/RETRIEVE
Send Report (Opal)
HL7 Send
LOCAL_CACHE
Priors QUERY/RETRIEVE Type the number of priors to retrieve. Type 0 (zero) for all priors.
Modality QUERY/RETRIEVE Select an option to filter which priors to retrieve.
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Number of SEND Type the number of priors to send along with the study.
Priors to Send
LOCAL_CACHE
Auto Send Priors| SEND Select to send any priors found in the system along with the current
study.
LOCAL_CACHE

e The system sends as many priors as it can find, up to the Number of
Priors to Send.

e The system sends the most recent priors first.

Relevant Priors | SEND Select to send relevant priors when auto-sending, along with any non-
relevant priors that the system found. Enter criteria to define what is
LOCAL_CACHE relevant.

e If you do not define relevant priors (see "Define relevant priors" later
in this topic), the system considers relevant priors to be studies of the
same modality and/or body part.

e The system sends as many relevant priors as it can find, up to the
Numbers of Priors to Send.

o If the system finds fewer relevant priors than the Number of Priors
to Send, it adds non-relevant priors up to the number.

Force Relevant | SEND Select to send only relevant priors.
Only
LOCAL_CACHE o If the system finds fewer relevant priors than the Number of Priors
to Send, it does not send any additional priors.
[Define relevant | SEND Available when you select Relevant Priors. See "Define relevant priors"
priors] later in this topic.
LOCAL_CACHE

4. Optional. Configure a criterion for the rule:
a. Inthe Field dropdown list, select an argument and a logical operator.
For example, Modality and Is
b. Select a matching value for the argument.

For example, in the Modality list, select MG.

Rule Mame = O tnactive
Fulel Priorety * 2

Type * Atternpts * 2
SEMD »

AE Title # EXANII-VIZ
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c. Select ADD TO RULES.

Result: In this example, when Exa PACS/RIS receives an MG study, it automatically sends it
to the AE named Remote_Hospital.

6. Optional. Add more criteria.

7. Select SAVE.

Define relevant priors

Defining relevant priors allows you to send only priors that are relevant to the current study based on
study description, modality, or body part. To write definitions for which priors are relevant you use a
syntax called relevant prior logic:

STRING or (STRING STRING ...){.*(STRING STRING ...)}

"A single string, or multiple strings delimited with a bar, optionally followed by ".*" plus multiple
strings delimited with a bar."

Enter your relevant prior logic in a table, such as in this example:

Prior settings on the left... ...main study settings on the right
Main
Prior Study Main Study Body
Madality Priar Body Part Priar Deseription Madality  Part Main Study Description
o1 wAR # 7]
(KNEEJPATELLA) KMNEE LA |
(HEEL|CALE L *{LEFTILTISI) \HEELICALC).*(LEFTILT|BI) L |

Row 1: Does not require relevant prior logic. When the main study is an MR, relevant priors are
CTs.
Row 2: When the main study is of the knee, relevant priors are either of the knee or patella.

Row 3: When the main study description contains "HEEL" or "CALC" followed by "LEFT," or "LT,"
or "BI," relevant priors are those whose descriptions also contain "HEEL" or "CALC" followed by
"LEFT," or "LT," or "BI."

Note: You can also define relevant priors that you want to auto-open in the viewer (see Configure

modality-specific viewing options).
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Configure AE scripts

You can write scripts that modify DICOM tags when carrying out a DICOM-related transaction such as
sending, printing, or receiving.

Procedure

1. Go to SETUP > Office > DICOM > AE SCRIPTS.

AE SCRIPTS

PRICHIT-AE TYFE AE TITLE DESCRIFTION
&l w ] -

& 1 SEHD Exa-wazwa2 Senpls

2. Select ADD.

AE Type * Select v [ Inactive

n‘!\ETlﬂl’:‘ * Salast D Al

Seript Description

O Asynchronous

Script * 'd

3. Enter the following settings.

AE Type Select a transaction and node. The script runs when Exa makes the
selected transaction with the selected node.

AE Title

All Select all AEs of the selected AE Type.

Script Description Type a description of the script.

Asynchronous Select to run the script asynchronously.

4. In the Script area, type the script to run when the previous conditions are true.

Note: For syntax, select the help ? button.

5. Select COMPILE, and correct any errors that occur.
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6. When the script is free of errors, select SAVE.

Understanding receiver rules

A receiver rule is a detailed set of criteria and instructions that tells Exa PACS/RIS where to place studies
that it receives, and what status to assign them. For example, you can configure a receiver rule such that
studies with unrecognized account numbers are placed on the QC tab to await reconciliation by the user
before going live.

Note: Receiver rules also have an important role in accelerating the processing of incoming data.
Exa PACS/RIS processes each receiver rule in order on a particular computer. Therefore, to
improve speed, you can apply different rules on different computers.

To understand how receiver rules are evaluated and applied, it is helpful to imagine a 4-step process that
Exa PACS/RIS performs for each incoming study.

e Find a receiver rule that matches the study.

e Validate the study against existing PACS studies and/or match it to existing RIS orders.
e Process the successes (studies that passed validation and/or matched orders).

e Process the failures (studies that failed validation or did not match an order).

A detailed explanation of each of these steps follows.

Step 1 — Find a matching receiver rule

When Exa PACS/RIS receives a DICOM study, it evaluates the study against each receiver rule on the
RECEIVER RULES tab in order of “Priority” (starting from the top) until it finds one that matches.

PRIORITY =  RULENAME

2. + ¥ 12 Kforwarder7
m 4+ ¥ 13 Kforwarderd

7 W L PMT2

2 0 4 14 MMD Live
g W 4+ ¥ 2 PMT

.". |5 —
b o+ ¥ 3 File Import
From top... ...to bottom

If no user-defined rule matches, Exa PACS/RIS uses a “default” rule that has a minimum number of
criteria to ensure that all legitimate studies match at least one rule. (If a study did not match any
rule, Exa PACS/RIS would not receive it.)

To evaluate whether a study matches a rule, Exa PACS/RIS compares the settings you enter under
Rule Info and Filter (in the green box in the following figure) to the information in the study. If all
relevant criteria match, the rule becomes active, and the process continues to step 2.
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Rule info and Filter

Rule Name * [ Inactive
AE Title All ¥

Facility All b
Modality Al v

Institution

Status Unread v

Interval (Sec) * 120

Trigger RoutingRules O

Step 2 — Validate and match against PACS and/or RIS

A “rule” is actually not a single rule, but rather a combination of the previous “Rule Info and Filter,”
plus one of four possible preset “Applied Rules,” such as in the following figure.

Applied Rules

Reconciliation Mode: Pacs only site
Emit Live Update

Precache Study

Precache Priors

No. of. priors: 3

Pick study description from DICOM
Patient

= Account #/Dicom Patient ID

e Last name

= Date of Birth

« Move Anyway (Even in exception)
* Move to live when there is no-match
= Study

e Study UID
= Move to live when there is no-match

- L] - - L] - L]

Figure: Applied rules in the PACS ONLY preset.

Exa PACS/RIS compares the items in the green boxes from the incoming study against PACS, RIS, or
both, depending on the reconciliation mode (the first bullet item in the figure). The items under
Patient (such as “Last name” in the figure) and Study (“Study UID”) must match a patient in PACS
and/or a RIS order. Exa PACS/RIS stores the result of the match (success or failure) in this step, and
then evaluation continues to step 3 or 4.
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Step 3 — Process successes

If matching succeeded, Exa PACS/RIS waits the number of seconds specified in the Interval setting
from step 1, moves the study from the QC tab to the ALL STUDIES tab (the study “goes live”), and
assigns to the study the status selected in the Status dropdown list from step 1. At the same time, it
performs the actions and applies the options in the blue box in the following figure.

Applied Rules

Reconciliation Mode: Pacs only site
Emit Live Update

Precache Study

Precache Priors

No. of. priors: 3

Pick study description from DICOM

Patient

* Account #/Dicom Patient ID

e Last name

¢ Date of Birth

s Move Anyway (Even in exception)

e Move to live when there is no-match
Study

= Study UID

* Move to live when there is no-match

Step 4 — Process failures

If matching failed, the study initially remains on the QC tab with a status of Confiicts to await
reconciliation by the user. However, there is one more set of evaluations left to make, based on the

items in the orange boxes in the following figure.
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Applied Rules

+ Reconciliation Mode: Pacs only site
¢ Emit Live Update
* Precache Study
* Precache Priors
e No. of. priors: 3
¢ Pick study description from DICOM
* Patient
e Account #/Dicom Patient ID
e Last name
* Date of Birth
* Move '};—"\nyway (f—f\fenﬂi:n exception}
| * Move to live when there is no-match |
B Study -
« Study UID
« Move to live when there is no-match |

If any of these items are present, the study status is set to Completed in the QC tab. Additionally,
each item results in the following.

Move Anyway (Even in exception)

If duplicate matching demographics are found, or if at least one matching criterion fails, the study
also appears on the ALL STUDIES tab with a status of “FIX_.”

Patient: Move to live when there is no-match

The study moves to the ALL STUDIES tab even if patient demographic validation fails. Generally,
this is used only when no modality worklist is available.

Study: Move to live when there is no-match
The study moves to the ALL STUDIES tab, even if no matching order is found.

Note: If “Move to live when there is no-match” is present both under Patient and Study, Exa
PACS/RIS processes the study as a success.

See also:

Configure a receiver rule

Configure a receiver rule

You can configure receiver rules to tell Exa PACS/RIS where to place studies that it receives, and what
status to assign to them. For more information, see Understanding receiver rules.

Procedure
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1. Go to SETUP > Office > DICOM > RECEIVER RULES.

RECEIVER RULES

FRIODRETY RULE MARE AE TITLE FACILITY MODALITY HSTITUTICH STATLS
All wll At w Al w &l ]

s ] 1 IMFORT OFALIMPORT All Al Unread

s ] _.ﬁll All 1) Linnead

2. Select ADD.

Rule Information and Filter Applied Rules

Rule Harme * Falad 0] mnsctive = Reconciliation Mode: PACS Only Site
= Emit Live Update

AE Title All -

= Precache Study
Facility + Precache Priors
todality Al - s Mo, of Priors: 3

o Select Study description from DICOM
ki + Patient
Btatug Uniread W = Account Mo /DICOM Patient 1D
Inderval (Sec) = 120 + Last Mame

= Date of Birth
= Move Anyway (Even in Exception)
asuer Of Ahtemnane O + Move to Live on No-Match
Accaunt Numbear
= Study
Recemwver Bule . Stud}" UlD

Example showing the PACS ONLY rules
3. Onthe RULES tab, select ADD.

Trigger Routimg Rules |:|

4. Under Rule Information and Filter, enter the following settings as needed.

Rule Name Type a name for the rule.

AE Title Use these settings as filtering criteria. For example, to evaluate the rule
only against mammography studies, on the Modality dropdown list,

Facility select MG. To evaluate the rule only if the study comes from a specific
AE, select one under AE Title.

Modality

Institution

Status Select the status to assign the study if it matches the rule.
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Interval Select a number of seconds to wait before moving the study from the
QC tab to the ALL STUDIES tab (go live).

Trigger Routing Rules Select to force evaluation of matching studies against routing rules.
Issuer of Alternate Account Select to make alternate account numbers available. See Use alternate
Number account numbers.

5. Select one of the following preset buttons to assign a reconciliation mode and to add “applied
rules” (matching criteria and actions to perform) to your receiver rule.

PACS ONLY PACS Validate patient and study items against existing
PACS records.

PACS/RIS PACS + RIS Validate patient and study items against existing
PACS records and/or RIS orders.

PACS/DMWL PACS + RIS --same--

MIGRATION PACS Use when migrating data from another PACS. Allows

everything to be received.

6. Select SAVE.

See also:

Understanding receiver rules

Configure matching rules

See Work with Display Management.

Configure hanging protocols

See Work with Display Management.

Manage jobs in the transfer and SR queues

DICOM studies that you send appear as jobs in the transfer queue. You can view and change job status
and priority, cancel jobs, and requeue failed jobs.

Procedure

1. Go to SETUP > Office > DICOM > TRANSFER QUEUE or SR QUEUE.
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THANSFER QUELIE

CURRENT STATLS CIFRIED DATE AET UPDATED DATE STURY DATT ADCRERIIN R PATIERT HAMI

A e IR0 - 03 13023
2. Perform any of the following tasks.

View job status

In the list of jobs, the status is listed in the CURRENT STATUS column. The available statuses are as

follows.

Queued Processing not yet started.

In-progress Sending of data has started but not finished.

Completed Sending of all data is finished.

Canceled Sending of data canceled by the user. You can only cancel a job with a status of
Queued.

Error Sending was aborted due to failed association or the request was rejected by the
destination.

View demographics

To view the demographics of a study in the transfer queue, select the expand *+ button.
Change the job priority
To change the priority of a job, select the 7 edit button, select a new priority, and then select SAVE.

View job details

To view demographics and other queue details, select the view ol button.

Cancel a job

To cancel a job, select the cancel @ button.

Requeue a job

To requeue a job means to repeat or retry sending. If the status of a job is Queued, Error, Completed,

or Cancelled, you can requeue the job by selecting the requeue k button. Requeued jobs remain
in the transfer queue for 15 minutes before reprocessing begins.
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Reprocess non-failed jobs

Rather than requeuing jobs one at a time, you can select multiple jobs for reprocessing, and then
select REPROCESS SELECTED.

Reprocess failed jobs

Failed jobs are ones with a status of “Error.” You can select a range of failed jobs (such as by filtering
the worklist) and reprocess them all at once.

1. On the transfer queue, select REPROCESS FAILED.
2. Inthe date boxes, enter a date range of jobs to reprocess.
Note: To select all dates, leave the boxes blank.
3. Inthe AE Title dropdown list, select the AE whose jobs you want to reprocess.

4. Select REPROCESS.

Reprint DICOM Print jobs
1. On the transfer queue, find a job with type PRINT and status Completed.

2. Right-click the job, and select REPRINT.

Cancel a DICOM Print job
1. On the transfer queue, find a job with type PRINT and status Queued.

2. Right-click the job, and select Cancel.

Configure an issuer of a PID
See Use alternate account numbers.

Automatically retrieve priors from an external PACS

When a patient is referred from another facility, it can be efficient to automatically retrieve priors from the
referrer's PACS that are not already present in Exa PACS/RIS, and to control the timing of that retrieval.
That is, you can configure Exa PACS/RIS to retrieve priors when it becomes likely that the exam will take
place (such as when confirmed by the patient), but not so close to exam time (such as upon check-in)
that waiting to fetch priors could delay reading. To set up automatic retrieval, follow this example in
which we configure Exa PACS/RIS to retrieve priors when the study changes from Scheduled to
Confirmed status.

Procedure
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1. Go to SETUP > Office > DICOM > AE TITLE.

AE TITLE

B Hide Inactree

TLE X HET PORE CEALAIPTION FILE STORE SE TYFE
7 0 Enayvizean 10317 26 Th ek Xy 322 Exa Serenf hages SEMDRECEIVEQUERYRETR
il DLD_ARCHIVE LD ARCHIVE BEFANILT ETORE FECENE

& OPAL32. 33 0237 26100 33336 OFAL_32_33 Exa Saréar Images SENDRECEIVE QUERN/RETHI

2. Select ADD, and configure a query/retrieve AE.
3. Go to SETUP > Office > DICOM > ROUTING RULES.

4. Configure a routing rule with the following settings.

Rule Name Q/R Old PACS

Type QUERY/RETRIEVE

AE Title Select the query/retrieve AE you configured earlier.
Priority 1

Attempts 10

Priors 10

Modality Modality of Current Study

Summary - Field

Patient Identifier

Account Number

Select to query the external PACS by the patient's account number, alternate
account number, or alternate account number via issuer.

Issuer Select the issuer
Name Select Yes to include the patient's name in the query.
DOB Select Yes to include the patient's date of birth in the query (in YYYY-MM-DD

formatting).

5. Configure a study flow from Scheduled to Confirmed status using the previous routing rule.

See also:

Configure application entities
Configure routing rules
Configure study flow
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Configure billing

Exa Billing uses patient and insurance information that you entered in other Exa PACS/RIS modules, but
you must also enter other information directly into Exa Billing such as codes, statuses, templates,
providers, and validation rules.

Configure columns on the Studies and Claims screens

You can show, hide, and reorder columns on the Studies and Claims screens. You can also configure how
the studies and claims lists are sorted by selecting default columns and their default sort orders.

Procedure

1. Go to BILLING > settings -

User Settings

Column Order Settings
Study Date = Default Column W
Patient Name Default Sart ~
i Account No. Order
" Date Of Birth Printer Templates
85N Paper Claim Select A
[ Place Of Service (B&W)
| Referring Providers Paper Claim Select R
_ Rendering WRED)
~ Providers
Direct Invoice Selet U'
| Billing Fee
Patient Invoice Select w
Payer Type

Clearing House Special Form Seolect w

_ Balance

PR o -
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2. Under Column Order, do one or more of the following.

e To show or hide a column, select or clear its checkbox.
e To reorder a column, drag it to a new position in the list.

1. Under Settings, select a default column and its default sort order.

2. Select SAVE.

Add codes and other basic data

Use this procedure to add or edit: adjustment codes, billing codes, billing classes, claim statuses, billing
providers, provider ID code qualifiers, billing messages, payment reasons, CAS group codes, CAS reason
codes, and status color codes.

Procedure
1. Go to BILLING > Setup > Adjustment Codes.
2. Inthe left pane, select the type of data that you want to add.

3. In the upper-right side of the page, select ADD.

SETUP

— = Code = [ Inactive
ADJUSTMENT CODES
Dresoriplion *
LIS IS0
Entry . salect ¥
|LLING CLASSE
Type

COLLECTIONS

NFl &Y RFASTIMS

4. Enter the information in the dialog, and then select SAVE.
See also:

Configure claim validation

Create or edit an EDI or ERA template
Configure an EDI clearinghouse
Insurance mapping

Create a printer template
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Configure the billing collections process

You can configure Exa PACS/RIS to automatically assign collection review status to claims meeting
criteria that you enter. You can also automatically write off the balances of claims in collections.

Procedure

1. Go to BILLING > Setup > Collections Process.

ADJUSTMENT CODES
BILLING CODES

BILLING CLASSES

CLAIM BTATUS

Process Collections Automatically

Menimuem Account Bafance

Collections Review Criteria

Multi select a1 least one aption

COLLECTIONS

PROCESS

DELAY REASONS
BILLING PROVIDERS

PROVIDER 1D CODE

QUALIFIERS
BILLING MESSAGES
PAYMEMNT REASONS

CAS GROUP CODES

CAS REASON CODES

2. Enter the following settings.

[C] Change clalm status to Collections Review if no payment is applied to the
patients account days after statements are sent

(] Change claim status to Collections Review if no payment is applled to the
patient account within days of the last patient payment

Claim Balance

When not selected claim balances will remain

[”] Write off the balance when there is a claim status in Claim In Collections

Process Collections Automatically

Select to turn on automatic collections processing.

Minimum Account Balance

Type a dollar amount. If the claim balance is lower than the amount you
type, it will not be processed for collections.

Collections Review Criteria

Select one or more criteria, and then type the values in the boxes.

claim status in Claim in Collections

Write off the balance when there is a | Select to automatically write off the balance of claims that are in the

Claim in Collections status.

Debit/Credit adjustment Code

When writing off balances, select a debit or credit adjustment code to
use for the write-off.

3. Select SAVE.
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Configure claim validation

Exa Billing validates claims by confirming that the information satisfies the requirements of various public
and private health agencies (if applicable), and by checking whether you entered information in required

options. You can select which options are required.
Procedure

1. Go to BILLING > Setup > Billing Validations.

2. On the top of the billing validations page, select a billing method of Electronic, Invoice, or

Patient.

ADJUSTMENT CODES | - Wi Fatienl

BILLING CODES Billing Provider

BILLING CLASSES Billing Provider-Address Line 1
CLAIM STATUS Billing Provider-City
COLLECTIONS Billing Provider-Name
PROCESS

) Billing Provider-NP|
CELAY REASONS

7 ider-
BILLING PROVIDERS & Billing Provider-State

PROVIDER 1D GO0 Billing Provider-ZIP

QUALIFIERS
Claim
BILLING MESSAGES
Claim-CD Code 1
PAYMENT REASONS
Claim-Place of Service Code
CAS GROUP CODES
Clairm-Tetal Charge
CAS REASON CODES
_ Primary Insurance
STATUS COLOR
CODES

i -
IHELING YAURATIONS Insurance Provider-City

EDI/ERA TEMPLATES

Insurance Pravider-Company Name

3. In the list of options, select the ones that you want to be required.

4. Select SAVE.

Insurance Provider-Address Line 1
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Configure a billing provider

A billing provider is the provider who issues invoices for an exam. In order to create claims, you must
configure at least one billing provider.

Procedure

1. Go to BILLING > Setup > Billing Providers, and then select ADD.

Mamae * | Inactivi NP1 Mo, *
ADJUSTMENT CODES
IR e Code * Taxonomy *
BILLING CODES Code
BILLING CLASSES Short :
smebnbl s Description
CLAIM STATUS
SEAIMEPATLS Eaderal
COLLECTIONS Tax 1D
PROCESS
Address Info Pay To Address
DELAY REASONS
BILLING PROVIDERS Contact * Addresal
Mame
PROVIDER 1D CODE Address
QUALIFIERS Address] *
Chiy/State/ZIP * &,
BHLLING MESSAGES Address?
PAYMENT REASDMNS City/ State/ZIP * [
I R Fhona
CASGROUP CODES
Fax
CAS REASON CODES
o : Phone *
STATUS COLOR - Eronl
CODES e
BILLING VALIDATIONS Email
Web LURL

EDI/ERA TEMPLATES

EDM

2. Enter information as needed, and then select SAVE.

Create or edit an EDI or ERA template

You can create or edit an EDI template to format electronic claims submissions. You can also edit the ERA
template.

Procedure
1. Go to BILLING > Setup > EDI/ERA Templates.

2. On the top of the page, select EDI Template, and then select ADD.
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3. In the Template Creation dialog, type a name for the template and then select SAVE
TEMPLATE.

default_edi ].billingPre
WEE_CBEE

I.".-‘UE_':-EFU ingPravider, lastName) ™,

d=r. spplicationSenderfode]”

Template Creation

Temglate

4. Below the EDI Template button, in the template button menu, select your template.
5. In the template editing area, edit the template.

6. To edit the ERA template, select the ERA Template button and then edit the template as
needed.

7. Select SAVE.

Configure an EDI clearinghouse

To process transactions through a clearinghouse, you must configure one as follows. If you transact with
the Alberta, Canada healthcare system, add the Alberta WCB as a clearinghouse.

Prerequisite: Obtain credentials and other connection information from the clearinghouse.
Procedure

1. Go to BILLING > Setup > EDI CLEARINGHOUSES > ADD.
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Description * [ Inmctive Recemer
I S
ADJUSTMENT CODES Mame
BILLING CODES R i *
[ Enable FTR it

BELLING CLASSES

Clearing House Control Header

COLLECTIONS Auh. Infg * Repatiticn
LT UGS
A Segyaraton{ 5070}
e ESE
R Sacurity. Info *
DELAY REASQOMNS Element/Sub-
Sarder 1D * Elemment
HELLIMNG FROVIDERS Dralirnitar
Racalver [ *
PROVIDER ID CODE ; Segenent Ackaowledgement
GUALIFIERS Inter o Stand 10 Terminator Requested?
BILLING MESSAGES i L Lbzage * O Proguction O Testing
Murngar
PAYMERT REASONS EDH Fée
Extenzion
CAS GRAUP COOES
e i ERA Fifla
CAS REASOM CODES Extanion
STATUSCOLOR
il Functional Control Header
L LING VALIDATIONS
BILLING WL D § Apploation < apglicatian
EDVERS TEMPLATES Sender Code Receiver Code
CLURTES CHIFLAIED
EOE Rasponsible  # War Ral ind 10
CLEARINGHOUSES Aigarcy Code Cods
INSLIRANEE MAPPING Transaction Set Header Clearing House info

2. Enter all relevant information for the clearinghouse and select SAVE.

Add billing messages

You can associate customized messages with accounts receivable codes. Billing messages print on the
patient statement based on the age of the oldest claim included in the activity.

Procedure
1. Go to BILLING > Setup > Billing Messages.

2. To find a code, enter a criterion in the CODE box and then select Enter.
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ADJLISTMENT CODES eope

BILLING CODES

BILLING CLASSES & eolleclisns
CLAIM STATUS & 120
COLLECTIONS £ o120
PROCESS

F 5 B
DELAY REASONS

3160

BILLING PROVIDERS

& 040

PROVIDER 1D CODE

QUALIFIERS

BILLING MESSAGES

PAYRENT REASONS
3. Inthe list of codes, double-click a row.

Code * -1

Drascription * A long time to wait for
paymant]

4. Enter a description, and then select SAVE.

Add an insurance provider

Before you can bill an insurance provider, you must set the provider up in Exa PACS/RIS. Note that
insurance provider in this context means any institution that can act as a payer, including insurance
companies, financial firms, and attorneys.

Procedure

1. Go to SETUP > Office > Billing > INSURANCE PROVIDER.

INSURANCE PROVIDER

CODE & HAKIE PAYER D PROVIDER TYPE CONTACT IMFORLMATION FACILITY M ARKET A

Al W

SEN00E AETMAHEALTH PLAM Aslria 100 PO BOE 25579 2alle 102 RICHAAGHD sinia Facilly 1.Angks FaciftybMarkstl o
Filiza AARF HEALTH ADVANTAGE BTT I8 PO BOX 7402719, 5ui%e 101 ATLANTA srinfka Faciity 1.Argie FaciinyMarkst o
SELGA AFFINITY MEDHCARE ADWA! 15535 PO BOX A0TRSCRANTON sfinie Fagiiy 1.angie FacilybMarket E
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2. Select ADD.

I:] Inaichie
Facillitios = ALL SELECTED (&) =
Insurance Name * SETHA HEALTH PLAN
O Require AUC Pravider Type Selact
Payer 1D * Aeina |09 F'-r‘l:.-er Salact
Address Line T * B0y BOX 03000 Fee Schedule Salact w
Address Line 2 Suite 000 Allowed Fae Schedule Salact w
iy A
Ch sl i AICHMOND VA Trading Partner ID 60054
23260
Webazita
Fhone Mo (EOD)Z22-1111|

Insurance Provider Alarts

Fax ho.
Additicaal Phone Numbars

Ralerence Mote Phone Mo

3. Enter the following information for the provider. Depending on customer options, some fields are

not available.

Code Type the insurance provider's plan ID.

Inactive Select this checkbox to:

1. Make the insurance provider unavailable in other parts of the
program.

2. Make all associated patient insurance profiles unavailable in other partg
of the program.

3. Set the insurance profile Valid To date to yesterday’s date.

Insurance Name Type the name of the provider.

Require AUC Select if the provider requires the physician to satisfy AUC before
submitting orders for Medicare. Selecting this checkbox will
automatically open the CDSM application when creating the order in the
physician's portal.

Payer ID Type the insurance provider's ID (or ID based on information from your
clearinghouse).

[Address] Type the address of the provider.

Phone/Fax No. Type the primary phone and fax numbers of the provider.
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Type additional phone numbers, if available.

eXQ-PLATFORM

Market Select the market that the insurance provider serves. All facilities
associated with the selected market become selected in the Facilities
dropdown list.

Facilities Select the facilities where you see patients with this insurance provider.

Provider Type

Select a provider type.

SOP Payer

Select a source of payment code for the provider.

Fee Schedule

Select the default billing fee schedule used for the provider.

Allowed Fee Schedule

Select the allowed fee schedule for the provider.

Trading Partner ID

Type the PokitDok or ImagineSoftware trading partner ID. For PokitDok,
you can find the trading partner ID at:
https://dashboard.pokitdok.com/#/trading-partners?

code=270&name=Eligibility

Website

Type the URL to the provider’s website, if available.

Insurance Provider Alerts

Type alerts as needed.

4, Select SAVE.

See also:

Configure a fee schedule
About CDSM and AUC

Add an insurance provider payer type
Verify eligibility of preorders and studies with PokitDok

Verify eligibility and estimate coverage with ImagineSoftware

About active and inactive insurance

Insurance providers can be inactivated, but individual patient insurance policies from those providers can
also be inactivated from the patient chart. When adding insurance to an order, the following describes
the relationship between the two.

Insurance Order Status

Policy Valid To Date

Policy Status

Provider

Active Unscheduled < Current date Inactive and unavailable.

> Current date Active and available.

None Active and available

Scheduled < Scheduled date Inactive and unavailable.

> Scheduled date Active and available.
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Insurance Order Status Policy Valid To Date Policy Status
Provider

None Active and available

Inactive Scheduled or Any Inactive and unavailable.
Unscheduled

* Unavailable means that it cannot be added to the order, or selected anywhere in Exa PACS/RIS. If the
policy was previously added to a patient chart, it is still be viewable but cannot be edited or used for
billing or other purposes.

See also:

Add an insurance provider

Import an insurance provider
If you obtain exported insurance provider files, you can import them.
Procedure

1. Go to SETUP > Office > Billing > INSURANCE PROVIDER.

INSURANCE PROVIDER

CODE & HAKIE PAYER D PROVIDER TYPE CONTACT IMFORLMATION FACILITY M ARKET A

Al [ B

SO0 AETHA HEALTH PLAN &elrin 100 PO BOE 25579 2alle 102 RICHAAGHD sinia Facilly 1.Angks FaciftybMarkstl «
Filiza AARF HEALTH ADVANTAGE BTT I8 PO BOX 7402719, 5ui%e 101 ATLANTA srinfka Faciity 1.Argie FaciinyMarkst o
B4 AFFINITY MEDHCARE ADWA! 15535 PO BOX A0TRSCRANTON sfinie Fagiiy 1.angie FacilybMarket L

2. Select IMPORT.

ADD RELOAD IMPORT HELP

INF}
Choose Fiba [§i 00t v

_| Update Existing

3. Select Choose File, browse for and select the file to import, and select Open.

8o

4. Optional. To replace existing facilities, select the Update Existing checkbox.
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Add an insurance provider payer type
You can create insurance provider payer types.

Procedure

1. Go to SETUP > Office > Billing > INSURANCE PROVIDER PAYER TYPES.

INSLURANCE PROVIDER PAYER TYPES

CODE= DESCARIPTEON
% B AP auba suranes Folicy
s i 1 Coimmiercial
i CP Weedicare Conditionally Primary
2. Select ADD.

3. Enter your internal code and description, and then select SAVE.

Add a provider level code
You can create provider level codes to associate with Procedure Codes.

Procedure

1. Go to SETUP > Office > Billing > PROVIDER LEVEL CODE.

PROVIDER LEVEL CODE

CODES DESCRIFTION

2. Select ADD.

3. Enter yourinternal code, description, and level, and then select SAVE.
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Add a POS map

With a POS (place of service) map, you can select default locations to which to dispatch mobile radiology
orders from providing entities. For example, an ordering facility might typically dispatch its orders to the
patient's residence rather than its own location, and you can pre-configure this arrangement by using a

POS map.

Procedure

1. Go to SETUP > Office > Billing > POS MAP.

POS MAP

COBE2 HAME =08 CODE PS5 ADDRESS MOBILE RAD DIEPATCHING ADDF
Al W Al
e ] PrisenCanectional Facifity 09 Faciity Facility
Fell R B office 11 Ordating Facil ity - Sty
7 B 1z Hiome 12 Fatients Recsidenca

2. Select ADD.

iCode *

Mame *
P05 Code
POS Address

Mobile Rad Dispatching Address =

0g

Prisan/Correctional Facili

oo | PrisonfCorectional Facill
Facility -
Facility w

3. Enter yourinternal code, name, POS code, POS address.

4. In the Mobile Rad Dispatching Address dropdown list, select one of the following.

Facility

Dispatch to the address of the Facility.

Ordering Facility - Study

Dispatch to the OF address selected for the study.

Ordering Facility - Patient

Dispatch to the OF address selected in the patient chart.
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Ordering Physician Dispatch to the address of the ordering physician.

Patient Residence Dispatch to the address of the patient.

5. Select SAVE.

Insurance mapping

Insurance mapping means to assign a billing method (such as direct, paper, or electronic) and a
clearinghouse (for electronic billing) to an insurance provider or other payer.

Prerequisite: Add an insurance provider

Procedure
1. Go to BILLING > Setup > Insurance Mapping.

2. Double-click an insurance provider in the list.

Insurance * AETHA SENIOR SUPPLEMENTAL

CAS GROUP CODES
MName

CAS REASON CODES

Insurance " ATSENIOR
STATUS COLOR e

CODES

Billing Method * Direct Billing ~

BILLING VALIDATIONS

EDI Code ol

EDI/ERA TEMPLATES

Claim File
EDH indicator Code

CLEARINGHOUSES

Print Name In Claim Form

INSURANCE MAPPING Print Signature On File for Paper Claim Farm
Print Billing Provider Address

QUALIFIERS
3. Inthe Billing Method dropdown list, select an item, and then enter information as needed in the
other options.

4. Select SAVE.

Create a printer template
Exa Billing comes with templates for standard billing forms, but you can also create custom templates.
Procedure

1. Go to BILLING > Setup > Printer Templates.

2. At the upper-right, select ADD.
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RELQAD (ETAULT TEMPLATE RANT
Mama Foed T Inaciet L Detsuk
MERT COOE

Magn 7.0 Meegn 340 Temple * Papes Chim Diiganad R

i Len Top Troe

IG CLAREES Magn e Musn ot
R Bamen
LLEL - Eage 782 Page - (351
Hisght e
BEAY S P

1ber{ 0 |, clafaf 11ingl
iy b [, £ 1ad w1 L

‘|
3. Optional: To base your template on the default, select RELOAD DEFAULT TEMPLATE.
4. Enter the name, template type, and margins.
5. In the Template Definition area, type the JSON code for the template.

A preview of your template appears in the right pane.

6. Select SAVE.

Select default printer templates

You can select which templates to use by default for printing out standardized forms and customized
invoices. Exa Billing comes with several templates, and you can also create your own.

Procedure

1. Go to BILLING > settings -
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User Settings

Column Order Settings
Study Date = Default Column W
Patient Name Default Sort ~
71 Account No. Crder
" Date Of Birth Printer Templates
1 SSN Paper Claim Select ¥
[ Place Of Service (B&W)
| Referring Providers Paper Claim Select -
_ Rendering (RED)
~ Providers
Direct Invoice Select -
| Billing Fee
Patient Invoice Select bl
Payer Type
Special Form Select w

Clearing House

_ Balance

[, . T - -

2. Under Printer Templates, make the following selections.

Paper Claim (B&W) - The standard “black and white” claims form.

Paper Claim (RED) - The standard “red” claim form.

Direct Invoice - Select a template for billing insurance companies.

Patient Invoice - Select a template for billing patients.

Special Form - Select to use special-case forms, such as for claims in New Jersey.
3. Select SAVE.

See also:

Create a printer template

500-000594A 143



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

Man age users
Administrators can configure individual users, user groups, Active Directory, and assign roles (rights) to

users. In Exa PACS/RIS, you assign user roles to user groups, and then you assign user groups to
individual users.

AN

Incorrect user configuration can lead to security risks such as leaked patient information.

Create a user role

A user role is a named collection of user rights that you can assign to user groups. To create a user role,
complete the following steps.

Procedure

1. Go to SETUP > Office > User Management > USER ROLES.

USER BOLES

ROLE NAME = ROLE DEECRPTICH
&8 pdleg Biling
o B Faoility Admin Faciity Admin
& 8 Fromtdesk Feani-desk

2. Select ADD, type a name and description of the role, and the select SAVE.

For example, type BI LLI NG, and then select SAVE.

3. Inthe User Role Permission area, select all of the user rights that you want to assign to the user
role.
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Role Name *

Role Description *

Billing

Billing

User Role Permission

[ Inactive

O eilling/Setup

Billing Codes
Billing Class
Claim Status
CAS Group Code

Provider ID Code Qualifier

4, Select SAVE & CLOSE.

See also:

User rights

Create a user group

Create a user

Create a user group

Order ICD

Order Referring Provider
Order Studies

Qc Delete

QC Edit

O000O0O0

QC Maove 1o Studies

A user group is a named collection of individual users to which you can assign roles and access to certain
document types and areas of the program.

Prerequisite: Create a user role.

Procedure

1. Go to SETUP > Office > User Management > USER GROUPS.

USER GROUPS

O shaw Inactive

GROLETCODE

i AL

FAD

FROE

GROUP MAME

BILLING

Faciity Acmin

Froes-desk

EROUP OESCRIFTAON 2

BILLING

Facility Administrator

Feioas desik parsannel
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2. Select ADD.

Group Code * BiL
Group Mame * BELLING

Group Description ™ BILLING

Roles

Billing

L) Facility Admin
L Front-desk
L] Portal

O rap

1 REF

1 TecH

| TRAMNS

3. Enter the following settings.

D |mgptive E All Bocurments
Decument Types *

fPE2 7 IR Card
B Insurance Card

[ ] HEFI-F!I'IE

Mavigation

1 Dashboard

o

Wiorklist

Patient Arrival Worllist

B O

Patient

(<]

Fax Manager

(<

Schedule

B

Billing

B

Payments

Group Code

Type your internal code for the group. For example, RAD.

Group Name

Type your internal name for the group. For example, Radiologist.

Group Description

Type a description for the group.

Document Types

Select the document types that group members can access. For example,
select All Documents.

Roles

Select all user roles that you want the group members to have.

Navigation

Select the areas of the program that group members can access (items
available on the burger menu).

4, Select SAVE.
See also:

Create a user
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Create a user

A useris a member of a user group for whom you can configure custom rights and limitations in addition

to those defined in user roles.
Prerequisite: Create a user group.
Procedure

1.

Go to SETUP > Office > User Management > USERS.

O Sterw Inastive

USER MARIE = HEME QR NabbE
Zlladesk Ak, Angia Froet-dask
S Arneer e Anna Faciity Admin
£Earagin Tagin, Argie Facdity admin
2. Select ADD.
SAVE SAVE & CLOSE

Grgup Hams

Accens Expires Afies

ﬂ Hide AD Greaps

Mameg * 1 Mure

Maokile Phana Mobile Phony

E-tall = il

Usar Marms * np b

Pasgword *

Confirn Passwoed *

Sesamn Inberval

O wnactive

Mlaraat
Facilities *

Linked Prowicer Wser Type

O asawe Thargengy Aooess

3. Enter the following settings.

HEERTYTE MARKET
i | Al w
Oifwers
Others Barket]
OfFefa
UNLOCE ACCOUNT CLEAR BACK
days s

L_.,| Ome-Time Acoens
B User st Charge Password Next Login

[ Assign Claims 1o Follew-Up Cusue for Anather
Usar

O Uses can charge acsounting dales

|:| Bragan 360

NOME SELECTED ~

Selact w

O Hide arder Meru

Not all settings may be available depending on your product and configuration.

Group Name

Select the user group to which the user belongs.
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Name

Type the user’s name.

Mobile Phone/
E-Mail

Type the user’s mobile phone number and/or email address. The email
address must be unique, and is required for two-factor authentication.

User Name

Type a sign-in user name for the user.

Login with Google

When selected, the user can sign in through their Google account.

Netcare access

Select to grant permission to access Alberta Netcare (Alberta only).

Password

Type a sign in password for the user. This option is only available the first
time you configure the user.

Session Interval

Type or select the number of minutes before the user’s session times out.

Allow Emergency Access

Select to assign “super user” rights to the user regardless of roles or
groups.

Linked Ordering Facility

This dropdown list becomes available when you select Ordering Facility in
the Linked Provider User Type dropdown list. Select ordering facilities to
appear on orders the user creates in the Ordering Facility portal.

Access Expires After

Type and select a duration after which the user’s account expires. Leave
blank to keep the account open indefinitely.

One-Time Access

When selected, the user can sign in only one time.

User Must Change Password
Next Login

Select to force the user to create their own unique password after logging
on the first time.

Assign Claims to Follow-Up
Queue for Another User

Select to give the user the ability to add claims to another user's follow-up
queue.

User Can Change Accounting
Dates

When selected, the user can edit accounting dates under Billing >
Payments.

Dragon 360 [reserved, do not select]

Market Select the market that the user serves. This setting narrows search results
in other parts of the program. For example, when the user searches for a
patient chart, Exa PACS/RIS only returns charts of patients in the same
market as the user.

Facilities Select the facilities that the user can view and modify.

Linked Provider User Type

Select the user type if linking to one. If you select Ordering Facility, the
previous Linked Ordering Facility and Ordering Facility dropdown lists
appear.

Ordering Facility

Appears when you select Ordering Facility in the Linked Provider User Type
dropdown list. Select the ordering facility into whose portal the user can
sign in.

Search Type

(Available when Provider or Ordering Facility is selected.)

Select the range of patient and other data that the user may search: full
patient database, or only the associated patients in the portal.
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Scheduled By (Available when Ordering Facility is selected.)

Select an option to control the dates available to the user when requesting
an appointment in the ordering facility portal.

4. Select SAVE.

5. Optional.
e To limit what the user can view on the worklist, see Configure an administered worklist filter.
e To view a user’s devices, select the ATTACHED DEVICES sub-tab.

e To restrict the user’s access to specific ordering facilities, select the USER PERMISSIONS
sub-tab.

See also:

Create a user role

Reset a user’s password as an administrator

If a user forgets their password, an administrator can reset it or prompt the user to reset it the next time
they log in.

Procedure

1. Go to SETUP > Office > User Management > USERS.

: Shovey i

PEER MAME * HAME QRGP NAME LISER TYIE BARKET
Al w
Flladesk ADask, Angi Froet-diesh Oitfrars
S brneler =t Anna Facility admm Others Barketi
£ B aragin T, e Facdity admin OiFees

2. Double-click the user in the list and do one of the following.

e Select RESET PASSWORD, and then choose a new password for the user.
e Select the User Must Change Password Next Login checkbox.
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RESET PASSWORD UNLOCK ACCOUNT BACK

L After days hd

[0 One-Time Access

[J User Must Change Password Next Login

[0 Assign Claims to Follow-Up Queue for Another
Llser

O usercan change accounting dates
O Dragon 360
3. Select SAVE.

4. Inform the user to sign out and then sign in again with the new password, or follow the on-screen
instructions to reset their password.

Configure an administered worklist filter

In addition to user roles, administrators can use the following steps to configure worklist filters that
control which studies, patients, and other information are available to individual users and user groups.
Users can configure their own worklist filters but cannot edit filters that administrators configured for
them.

Procedure

1. Go to SETUP > Office > User Management > USERS.

O Stoerw Inastive

UBER MAME = HAME GIRGUE NaME USER TYTE BARMET
i L 1) w
S lladesk fibiesk, Angia Froei-dask Othwrs
S brneier e Anna Facility Admin s Marketl
£ Earagin T, g Focdiny admin OiFess

2. Double-click a user row to open a user, and select the WORKLIST FILTER sub-tab.
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WORKLIST FILTER ATTACHED DEVICES LUSER PERMISSIDNS

[J show Encounters Galy [ Disable Right-Click on Worklisl STAT Studies Override Current Sub-Filter

[ show DICOM Studies Only  [] Show RIS Orders Only [ shew Ascigned Studies Only

Deleted Al o
Date Operations By ) Study Date o Study Received Date ) schedulsd Date 2 Last call made
G Created Dats
O Prefernatted
:__:! Last
From ] To o
O Rewt
) Date Frem ] Data To f @

3. Perform one or more of the following procedures.

Configure general user worklist filter settings
You can finely control the information on the worklist to which the user has access.
1. Inthe left pane, select GENERAL.

2. Enter the following settings, and then select SAVE.

Show Encounters Only Select to show only studies involving interaction between a patient and
provider.

Show DICOM Studies Only Select to show only DICOM (imaging) studies.

Disable Right-click on Worklist Select to prevent the user from opening the worklist shortcut menu.

Show RIS Orders Only Select to show only orders from RIS.

STAT Studies Override Current Select to always show studies with assigned STAT levels, regardless of any

Sub-Filter other filtering criteria.

Show Assigned Studies Only Select to show only studies to which a user is assigned.

Deleted Select whether to show all, only, or no (None) deleted studies.

Configure the following settings together to compose a single filtering condition.

Date Operations By Select a study property against which to apply criteria.
Study Date

Study Received Date

Scheduled Date

Last Call Made
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Created Date

Preformatted Select from a list of preformatted date ranges, rather than manually
entering one by using the settings described later.

Example:
Date Operations = Study Date
Preformatted = Last 7 Days

“If the study date falls within the last 7 days, display the study on the
user’s worklist”

Last/Next Select a time range for the selected property.
Example:

Date Operations = Study Received Date
Select Last, type 8, select Week(s)

“If the study was received some time during the last 8 weeks, display the
study on the user’s worklist.”

Date From / Date To Select and enter a date range for the selected property.

From / To Select and enter a time range for the selected property.

Limit access to patient information
You can limit the worklist to only display studies for patients who satisfy certain criteria.
1. Inthe left pane, select PATIENT INFORMATION.

2. Under Patient Name, select a logic option, type the exact portion of the patient name that

corresponds to the selected logic option, and then select the plus button to add the criterion.
3. Under Account No., perform the previous step as appropriate for the account number.

4, Select SAVE.

Limit access to study information
You can limit the worklist to only display studies that satisfy certain criteria.
1. Inthe left pane, select STUDY INFORMATION.
2. For each criterion, select a logic option, and then type or select a value.
3. For example, to display only abdominal studies, under Body Part:

e Select the Is option

¢ Inthe list of body parts, select Abdomen
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4. Select SAVE.

Limit access to information related to specific resources
You can limit the worklist to only display studies whose resources satisfy certain criteria.
1. Inthe left pane, select RESOURCE.
2. For each criterion, select a logic option, and then type or select a value.
For example, to display only studies whose referring physician is Jane Doe, under Ref. Phys.:

e Select the Is option

e In the box, type JANE DOE, and then select the plus button.
3. Select SAVE.

Limit access to information from specific insurance providers
You can limit the worklist to only display studies for patients who satisfy certain criteria.
1. Inthe left pane, select INSURANCE.

2. For each criterion, select a logic option, and then type or select a value. For example, to hide
studies under litigation, under Insurance Provider Type:

e Select the Is Not option

e In the box, select Litigation, and then select the plus button.
3. Select SAVE.
See also:

Create a user worklist filter

Manage who is online

Users with user management rights can view a list of users who are online, view a user’s activity log, and
terminate their session.

Procedure

1. Go to SETUP > Office > User Management > USERS ONLINE.
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LUSERS OMLIMNE

USER MAME LOGEED th DATE CLIENT IF LAST ACCESSED =
ORI E0EE 031 402023
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2 Serece, Admin 0341412023 881 AM ETT 77 mago Termingle
= serice, Admin O3/14/2023 7:41 AMEDT 37magn Temminadse

2. Optional: To view a session log for a user, select the log & button.

View assigned studies and patients

You can view lists of studies and patients that are assigned to you (the current user).

Procedure

1. Go to SETUP > Office > User Management.

ASSIGNED STUDIES

Ls IRE E
UEER ASSHINED & ACCEESIOH ME AESIGHED STUMEE STUDY STATUE ASSHEHED BY ABEIANED DAT
| Radialagist, Richard 1148k 30 RWDA IER CT MAI LS/0TH X REQ POSTFCX Apgoved Test, Rad 03031073
[ Reestlicsbongiat, Richiand a4 BOME LENOTH STUDIES Apprived Rty Kirmila o111 82023
| Eadizdagist, Richard 29 ANGREFH ADRML LN ELCTY REA] Approved Fay, Kirmila O1/TB/ 2022

2. Do one or both of the following.

e To view studies assigned to you, select the ASSIGNED STUDIES tab, and then select a sub-
tab to filter by user type.

e To view patients assigned to you, select the ASSIGNED PATIENTS tab.

Assign access to third-party tools

You can configure which users have access to which third-party tools, such as Updox.

Procedure

1. Go to SETUP > Office > User Management > THIRD PARTY TOOLS.
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THERD PARTY TODLE
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Attorney, Test
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2. If the Search users box does not appear, select Ungroup users.
3. Select one or more users:

e To select a single user, in the Search users box, type all or part of the user name, select
Ungroup users, and then select the correct user in the list.

e To select one or more user groups, select the Remove All Users button (to show the Select
All Users button), select the user group to select, and then select Select All [Group] Users.

4. In the Third Party Tools list, select which tools to make available to the selected user or users by
turning the tool’s switch from off [ Jto (=] on.

5. Optional: Edit tool configuration settings.

Configure an nVoq user account

To use nVogq for voice recognition, KM staff must configure nVoq user accounts in Exa PACS/RIS. Obtain
user account information from the nVoq website.

Procedure
1. On Go to SETUP > Office > User Management > THIRD PARTY TOOLS.

2. On the left side, use the group boxes to select a user.
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THIRD PARTY TO0LS
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APPLY TO SELECTED USERES

3. On the right side, in the nVoq box, enter the user’'s account information.

4. Turn on nVoq ) [ _u]

5. Click APPLY TO SELECTED USERS.

See also:

Dictation and transcription with Exa Trans and nVog

Copy settings from one user to another

To create new users more quickly, you can add a user and then copy settings from an existing user.

Procedure

1. Go to SETUP > Office > User Management > COPY PROFILE SETTINGS.
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COEY PFROFILE BETTINGS

Soniic= Llgar *

Destination User * | Sulect Deslaulion .

2. Inthe Source User dropdown list, select the user whose settings you want to copy.

3. Inthe Destination User dropdown list, select a user to configure with the source user’s settings,
and then select the plus button.

4. Optional. Repeat to configure additional users with the source user settings.

5. Select SAVE.
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Configure Mobile RAD

You can set up mobile radiology including vehicles, technologists, and geographical information.

See also:

Mobile billing

Configure assets for Mobile RAD
To use mobile RAD you must first configure assets by carrying out the following procedures.
Procedure
1. Configure a technologist, and assign a schedule template to that technologist.
Configure an ordering facility.

2
3. Configure a place of service (Add a POS map).
4

Configure vehicles.

Configure vehicles

You must register in Exa PACS/RIS vehicles that you will use for Mobile RAD. Perform this procedure for
each vehicle in your fleet.

Procedure
1. Onthe burgerE menu, select SETUP.

2. On the OFFICE menu, select Mobile RAD.

3. On the VEHICLE REGISTRATION tab, select ADD, and then enter the following settings.

Vehicle Name Type any hame.

Make Type the manufacturer of the vehicle.

Model Type the model of the vehicle.

Device ID (GPS) Type the ID number of the GPS device for the vehicle.
Color Type the color of the vehicle.

VIN Type the vehicle identification number of the vehicle.
License Plate No. Type the license plate number of the vehicle.
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License Plate State Type the state of issue of the license plate.

Facility Select facilities for which the vehicle is used.
Inspection Expiration Date Select the date of next required inspection.
Registration Expiration Date Select the date of expiration of the vehicle registration.
Vehicle Note Types notes.

4. Under Equipment Type, select the plus + button, and then in the Equipment dialog, enter
settings for each piece of radiology equipment in the vehicle.

5. Under Maintenance, select the plus + button, and then in the Maintenance dialog, enter
vehicle maintenance information.

6. Under Location, select the plus * button and then enter settings for each location where the
vehicle is parked on particular days.

7. Select SAVE.
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Configure general settings
You can set up study forms, custom forms, templates, and queues, and perform limited database
queries.

Create a study form

Study forms are interactive electronic forms that people inside and outside your organization can use to
gather or provide needed information quickly—and often automatically. Examples include consent forms
for HIPPA or treatments, screening forms, pain sheets, affidavits, customer payment plans, and
procedure checklists. For information on how to use forms that you create, see Add a study form to a
patient record and Add a custom form to a patient record.

Set up a study form

Use the following procedure to initially set up the form, and then see other topics later in this section
to add and edit form contents.

1. Go to SETUP > Office > General > FORM BUILDER.

FORM BUILDER

DOCLMENT MAME KARKETE

E centrast Consens for kedinatod Dye
[ & CT Seresning Frnm

* B Echocardmsgram watkshest

2. Select ADD.

3. Type a Form Name, and then select the the ASSIGN sub-tab.
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Form Name* Test

m

ASSIGHN MERGE FIELDS

Document Type Select., w

O wiewable on Patlent Portal

O auto Assign to Study
Insurance

Provider *

E] Allow All with Empty
O allew All withaut Empty

Physician *

O Allow All with Empty

-

| g TS T ¥ -

4. Enter the following settings to define the scope of the form and filter its availability.

Document Type Select a type in order to group forms and make them easier to find.

Viewable on Patient Portal Select to make the form available from the patient portal and in Patient
Kiosk.

Auto Assign to Study Select and then enter criteria for studies to which to automatically assign

the form. Assigned forms appear in the Study Forms tab of the Edit Study
screen, making them available to users without performing dedicated

searches.
Insurance Provider Select to restrict availability to the form to specific insurance providers.
Allow All with Empty Select to make all providers available if none are specified.

500-000594A 161



Exa® PACS/RIS 1.4.32_P5 User's Manual

5.

Add a header to a study form

1.

2
3
4.
5

EeXQ-PLATFO

Allow All without Empty

Select to make the setting required.

Physician
Allow All with Empty

Allow All without Empty

Select to restrict availability to the form to specific physicians.
Select to make all physicians available if none are specified.

Select to make the setting required.

CPT Codes
Allow All with Empty

Allow All without Empty

Select to restrict the form to studies with specific CPT codes.
Select to make available for all CPT codes if none are specified.

Select to make the setting required.

ICD Codes
Allow All with Empty

Allow All without Empty

Select to restrict the form to studies with specific ICD codes.
Select to make available for all ICD codes if none are specified.

Select to make the setting required.

Markets The form is available to patients in, or having exams scheduled in the
markets you select. All facilities in the selected markets become selected in
the Facilities dropdown list.

Facilities The form is available to patients in, or having exams scheduled in the
facilities you select.

Modalities Select to restrict availability to the form to studies from specific modalities.

Male Patient Only

Select to restrict availability to the form for male patients only, such as for
prostate exams.

Female Patient Only

Select to restrict availability to the form for female patients only, such as
for HSG exams.

Mammo Patient Only

Select to restrict availability to the form for mammography patients only.

Select SAVE.

At the top of the FORM BUILDER tab, select the Header checkbox.

In the form area, select the word “Header.”

In the left pane, on the properties tab, select CHANGE LOGO.

Browse for and select a logo, and then select Open.

In your form header, select the word “Header” and then replace it by typing a new field name.

For example, type St udy Date:

In the left pane, on the MERGE FIELDS tab, in the search box, type search term to look for a

relevant merge field.

For example, type st udy.
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% Overwrite "Header” with new header text, for example:
Study Date:"$$StudyDate$$ Patient: $SLastname$s, $SFirstName$s

FCHITA MINOLTA

o

MERGE FIELDS -

name

Merge Fields J‘f}

E—' Patient

FirstNamsa

Fullname

Lastname

7. 1Inthe list of results, double-click a merge field to add it to the form header.
For example, double-click StudyDate.

8. To the right of the $$StudyDate$$ merge field, type a new field name. For example:
Pati ent Name:

9. Repeat earlier steps to find and add a merge field for the patient name.
Hint: Search for “name” rather than “patient.”

10. In the left pane, on the PROPERTIES tab, use the Spacing and Style controls to modify the
layout.

11. Select Save.

Another example header:

®
Study Date: $$StudyDate$$
Patient Name: $5Fullnames$
Study Description:
$$5StudyDescription$$
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Add controls to a study form

Use controls to gather information from or provide information to the person filling out the form.
To add a control, drag its button into the body of the form. To configure the control, select it and

enter options in the left pane.

:

o All

Italic O underline

W

Details on form controls

% Overwrite "Header” with new header text, for example:
Sty Date:"85StudyDatess Patient: S5Lastnamess, SSFirstNar

HRCHICA MINGLTA

This is a Text Box

|

These are Checkboxes

O Mew
[ walk-in
[ emergency

This is a Text Area

The user can enter text here.

These are Radio Buttons

) optien 1

O optien 2

This is a Free Text box
F:I'Z-..-r same static 1ext

The following sections in this topic provide additional information and instructions about form

controls.

Text boxes

Text Boxes to gather one-line user input

Text Areas to provide boilerplates

Free Text boxes to gather or provide information longer than one line.
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The following compares the properties of text controls.

Text Variable Scrollable Printer Inline
. Height . Controls
Formatting Friendly
Text Box | No Yesi No 1 line Yes Yes
Text Area| No No Yes 1 line No No
Free Text | Yes2 No Yes 5 lines Yes No

1. With Dynamic Input selected.

2. Font family, size, emphasis, and alignment.

To add a text control:

1. Drag the Text Box, Text Area, or Free Text button onto the form.

eXQ-PLATFORM

2. Select the word “Untitled,” and then in the left pane, in the Question box, type text to introduce
or label the text input box. For example:

For an information gathering box, type Pl ease |ist all allergies.

For an information providing box, type Li abil ity wai ver.

3. If the text control is for providing information, enter the information in the box.

Adjust vertical spacing:

e To adjust the space between the question and the box, use the Line Height slider.

e To adjust the space before and after the text control, use the Padding slider.

e To apply adjustments to all controls on the form at once, select Apply Spacing to All
checkbox, and then use the sliders.

o Ifusing a Text Box, select the following options for Inline Controls.

Fit on One Line

Select to place the label one the same line as, and to the right of, the text
input box.

Inline Multiple Controls

Select this option for two adjacent text boxes to place both on the same
line.

Question First

Select to move the label to the left of the text input box.

Append Text Input

Select to add a new input box between the label and the original input box.
This new input box is only available to the person filling out the form.

Dynamic Input

Select to fit the height and width of the text box to the text it contains.

e If using Free Text to provide information, apply formatting to your text as needed by using the

Style controls.

e To adjust the width of the text control, select an option in the Size dropdown list.
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4. Select SAVE.

Add animage to a study form

1. To add an image, drag the Image button to the form.

2. To give the image a title, select Untitled, and then type a title.

3. Double-click the box below the title, and then browse for and select an image file.
4. On the left pane, use the controls to modify the alignment and size.

Note: If you select a size of Original, the image expands to fit the width of the page.

Add checkboxes to a study form
1. To add a group of checkboxes, drag the Checkbox button onto the form.

2. Select the word “Untitled,” and then in the left pane, in the Question box, type text to label the
checkbox group.

For example, type: Al | er gi es.

3. Adjust the vertical Spacing, Inline Controls, and checkbox label Style (see “Add text controls to
your form” earlier in this topic).

4. To add a new checkbox to the group, select ADD ANSWER.
5. To label individual checkboxes, type labels in the boxes under Answers.
For example, type Peanut s for the first checkbox, and Mol d for the second.

6. To arrange the checkboxes in columns, select a number in the No. of columns for Answers
dropdown list.

7. To add an “Other” checkbox with accompanying text input box, select the Add Other checkbox.
8. Select SAVE.

Add options to a study form

While checkboxes make the person filling out the form able to select more than one option, options
provide an “either/or” setting. You add an option group to your form by using the same procedure as
for checkbox groups, except that you drag the Radio Button button onto the form instead of the
Checkbox button.

Add a group box to a study form

A group box is a named group that can contain one or more checkbox groups and/or one or more
option groups. To add a group box:

1. Drag the Group button onto the form.

500-000594A 166



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

2. Select the word “Group Title,” and then in the left pane, in the Question box, type text to label
the group.

3. To add a background image to the group, in the left pane, select CHANGE IMAGE, browse for
and select an image, and then select Open.

4. To divide the group into columns, in the Grid Columns dropdown list, select a humber of
columns.

5. To add a checkbox group or radio button group into a particular column, in the New Control
Placement dropdown list, select the number of the column, and then drag the Checkbox or
Radio Button button onto the group.

6. Configure the checkboxes and/or radio buttons as described in “Add checkboxes to your form.”

7. Select SAVE.

Add a footer to a study form

You can add and modify footers in the same way as headers. However, we often recommend using
the footer for a signature line with a signature merge field. After the person electronically signs the
form, their signature appears in the location of the merge field. To create a signature line in the
footer:

1. At the top of the FORM BUILDER tab, select the Footer checkbox.
2. Inthe form area, select the word “Footer,” and replace it by typing Si gnat ur e.

3. Inthe left pane, on the MERGE FIELDS tab, search for “signature” and then double-click
SudyFormSignature in the list of results.

4, Select SAVE.

See also:

Add a study form to a patient record
Add a custom form to a patient record

Export and import a study form

To save time creating a form for “Facility A,” it may be helpful to import an existing form from “Facility B”
and then modify it.

Export an existing study form

1. Go to SETUP > Office > General > FORM BUILDER > EXPORT.
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FORM BUILDER

DOCURENT HAME MoRKETE

# B Contrast Consanl for dodingled Dye
Result: The form appears in the Windows Downloads folder as a JSON file.

2. Copy the JSON file to the computer at Facility A.

Import a study form

1. Go to SETUP > Office > General > FORM BUILDER > IMPORT.

2. In the Import Study Forms dialog, select CHOOSE FILE, browse for and select the copied JSON
file, and then select Open.

3. On the FORM BUILDER tab, find the new form and edit it for use at Facility A.

Create a custom form
Custom forms are non-interactive electronic forms intended for delivering information. For interactive
electronic forms that can both deliver and gather information, see Create a study form.

Set up a custom form

1. Go to SETUP > Office > General > CUSTOM FORMS > ADD.

CUSTOM FORMS

Jocument Name *  Custom Form Test Labels
O inactive
Jaseription An example

i:] Patient Review
!.:l Patient Mammo Form
O Education Matarial

Reference Document
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2. Enter the following settings.

Document Name Type a name for the form.
Description Type a general description.
Labels [Unused]
Patient Review [Unused]

Patient Mammo Form

Education Material Select to make the form available in the EDUCATIONAL MATERIAL area of
the patient chart.

Reference Document Select to make the form available in the DOCUMENTS and CUSTOM FORMS
areas of the patient chart.

3. Move down the page to Assign Document.

Assign Document

Muaodalities Select modality . m
Facility My Company x |*

ICD Codas * X (v

ADD.9 Cholera, uns
O Allow All with Empty
[ Allow All without Empty

Medication * Medicatio +

[1 Allow All with Empty lbuprofen

[0 allow all without Empty

4. Enter the following settings.

Modalities Select modalities to which to assign the custom form.
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Allow All with Empty

Allow All without Empty

Facility Select a facility to which to assign the custom form, and then select the
add + button.
ICD Codes Select to restrict availability for specific ICD codes.

Select to make available for all ICD codes if none are specified.

Select to make the setting required.

Medication
Allow All with Empty

Allow All without Empty

Select to restrict availability for specific medications.
Select to be available for all medications if none are specified.

Select to make the setting required.

Lab Codes
Allow All with Empty

Allow All without Empty

Select to restrict availability for specific lab codes.
Select to make available for all lab codes if none are specified.

Select to make the setting required.

Male/Female/Mammo Patient
Only

Select to restrict availability of the form to male, female, and/or
mammography patients.

5. Select SAVE.

About adding contents to a custom form

The custom form word processing area provides commonly recognizable tools to type, align, and
apply formatting to text, and insert images and merge fields. You can copy and paste contents by
using the Ctrl+C and Ctrl+V keyboard shortcuts. To change font sizes, select text that you want to
resize, and then select a size in the Font Size dropdown list.

File- EdE- Wnser- Wi Foemat - Tabie

B fF EE=EE

Lo Formats

Patient: S&lestname$s, SSFirstNamets
Provider: SSapprovingPhysicianFullNamess

=il

i
Il
Jnal
B
[ 3

Add merge fields to a custom form

In this example we show you how to add a signature merge field to a custom form. You must add a
signature merge field to be able to electronically sign the form.
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4.

In the right pane, in the Merge Fields area, in the search box, type search term to look for a
relevant merge field.

For example, type si gn.

In the list of results, double-click a merge field to add it to the form.

For example, double-click CustomFormSign.

To the left of the $$CustomFormSignature$$ merge field, type a new field name.
For example, type Si gnat ur e:

Select SAVE.

Editing a custom form

Note: If you edit an existing form, your changes will not appear on forms that are already attached to
a patient chart. To edit a form:

1.
2.

On the burgerE menu, select SETUP.

On the OFFICE menu, select General.

IR
On the CUSTOM FORMS tab, select the form |
edit.

button of the custom form that you want to

Edit the form as needed, and then select SAVE.

Perform a quick query of database totals

As an alternative to reports, you can quickly search the PACS and RIS databases with customizable
queries. A "DB total" search tells you how many patients, studies, and images in your databases match
the search criteria.

Procedure

1.

Go to SETUP > Office > General > DB TOTALS.
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DB TOTALS

Date Range 02/14/2023 @ || 0371472023
(8 study Date (O Study Received Date () Approved Date
Facility All .
Modalities All
Study Description All
Institutions
All

wosrerons

2. Enter the following search criteria.

Note: If you performed a search previously during the current session, refresh your browser
before entering new criteria.

Date Range Select a date range within which to search.
Study Date Select a category for the date range:
Study Received Date Search all studies with a study date within the date range.

Search studies whose DICOM receive date is within the date range.

Approved Date Search studies that were approved during the date range.

Facility Filter the search by facility.

Modalities Filter the search by modality.

Study Description Filter the search by study description.

Institutions Filter the search by institution.

ADD To add a new institution to the list, clear the All checkbox, type the name

of the institution in the box, and then select ADD.

3. To run the search, select UPDATE TOTALS.

4. The search results appear below the button under DB Details.
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5. Optional. To export a more detailed report of your search and results, select CSV REPORTS.

About email templates and notification templates

Email templates and notification templates contain pre-formatted text that you can have Exa PACS/RIS
automatically send through and along with various media. Note that the original term email template now
also applies to non-email media such as faxes. Commonly, you use email templates to auto-send
reports to providers and patients, and notification templates to auto-send study status changes to
referring providers. The following table summarizes the differences in auto-sending media based on the
type of template.

To create templates, see Configure an email template and Configure a notification template. To configure
auto-sending of media using the templates, see Set up emailing of exam results and Set up sending of
notifications.

Auto-Sending of Media Based On:

Email Templates Notification Templates

Feature

Where to Setup > [all caps button menu] > General > | Setup > [all caps button menu] > General >
configure Email Template Notification Templates

template

Who can receive | Referring provider locations/contacts, Referring provider locations/contacts

media referring provider group, referring provider's

patient (in Patient Portal)

What media are | In addition to text defined in the template: Email or fax of status changes, including text
sent defined in the template.

Reports

PDF attached to email
Link attached to email
Print and mail

Print on selected printers
Fax to referring providers

Fax to referring provider's office

Images

CD, Film, Paper

How to turn Select checkboxes in "Reports to Me" e Select checkboxes is "Notification Settings," and
ON/OFF auto-
sending e Select notification template in each status at

which you want to auto-send.
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Configure an email template

Follow the steps in this topic to configure an email template. To use the template to auto-send emails
and other media, see Set up emailing of exam results.

Procedure

1. Go to SETUP > Office > General > EMAIL TEMPLATE.

EMAIL TEMPLATE

|
‘ TEMPLATE HAME REPOWT TYPE = SURJECT FACILITY MARKET
All - Ll w | A -
|
| 1 Meatfication Bhy Study Cancelation Test Angie FaciltyMy Companydimmlla Test Fa
£ W Datault Confirmation Scraen Copfirmaton Screen Dedaul Anoalrtmant Confirmat on Scresm Mty Company Himilla Test Facliby srink F
|

2. Select ADD.

Template Name * Default Confirmation Scre [ Inactive
Category Canfirmation Screen bd

Sulbject * Appaintment
Confirmation Email

3. Enter the following settings.

Template Name Type a name for the template.

Category Select the type or purpose of the template.

Subject Type text to appear on the Subject line.

Markets Select the market for which the template is available. All facilities associated
with the select market become selected in the Facilities list.

Facilities Select the facilities to whose studies the template applies.

4. Use the word processing tools to compose the body of the email.
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Formats

Dear S&FirstMamess S5Lastnamess,

This |5 a reminder for your SsAppointmentTypeDescriptionss Imaging study
on SSS5tudyDatess at $50fficeNamess. 4

FIETE

Haige Pk
o Patiet

Below are the prep instructions for your exam.
S£ExamPreplnstructionss$

If wou have any questions or need to reschedule, please call our office at S5Facilil
Otherwise, we look forward to sesing you on $SStudyDatess,

Best regards,
s3CompanyNamess

s30fficeNamess 1 Frovie
s50fMicenddresslss, ss0fMiceCityss, $s0fficestatess e

5. To automatically insert exam details into the email:
a. Inthe right pane, in the Search here box, type a category of information (e.g. Pat i ent ).
Note: Category searches are case-sensitive.
b. Inthe resultant Merge Fields list, select a merge field group (e.g. Patient).
c. Double-click a merge field to add it (e.g. FirstName).
6. Select SAVE.

See also:

About email templates and notification templates

Set up emailing of exam results

By completing the following tasks, Exa PACS/RIS automatically sends exam results and reports to the
referring provider locations/contacts you modify.

Prerequisite:

Administrators must configure the company’s email server (see General settings).
Tasks:

e Configure an email template.

e Add a facility, and configure all email- and fax-related settings.

e If you want to email a provider group or location, Add a provider group or location.

e Configure a referring provider location/contact, including the email address, fax numbers, and
options under Reports to Me (see Add a resource).
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See also:

About email templates and notification templates

Configure a notification template

Follow the steps in this topic to configure a notification template. To use the template to auto-send status
change emails or faxes, see Set up sending of notifications.

Procedure

1. Go to SETUP > Office > General > NOTIFICATION TEMPLATES.

MOTIFICATION TEMPLATES

TEMFPLATE MAME S ELIESETT FACAmY MIAHKET

" Al o

¢ B AsfPhytotificason Tast Arrgie Faciity My Companyhrmiils Test Facilgyann

2. Select ADD.

MOTIFICATION TEMPLATES

Template Mame © Subject Iarkat

RefPhyMatification Test MONE SELECTED =

Fagiligies *

i. name{ | s

Formats B F

'
[
lld
M
1
In
liid
il
%
kl

$3Fullnamess SSACCessioNNOSS Merge Fiolds
& Patient

FirgtMama
Fudlname
Lastname
Middianame

Lisemama

£ Provider
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3. Enter the following settings.

Template Name Type a name for the template.
Subject Type text to appear on the email’s Subject line.
Market Select the market for which the template is available. All facilities associated

with the select market become selected in the Facilities list.

Facilities Select the facilities to whose studies the template applies.

4. Use the word processing tools to compose the template.
5. To automatically insert exam details into the notification:
a. Inthe right pane, in the Search here box, type a category of information (e.g. Pati ent ).
Note: Category searches are case-sensitive.
b. In the resultant Merge Fields list, select a merge field group (e.g. Patient).
c. Double-click a merge field to add it (e.g. Fullname).
6. Select SAVE.

See also:

About email templates and notification templates
Merge fields

Set up sending of notifications

By completing the following tasks, Exa PACS/RIS automatically sends status change email notifications to
the referring provider locations/contacts you modify.

Prerequisite:
Administrators must configure the company’s email server (see General settings).
Tasks:

o Configure a notification template.

e For each status of which you want to auto-send notification, select the notification template under
"Notification Settings" (see Configure study statuses ).

e Configure a referring provider location/contact, and select the location/contact's Email/Fax and/or
Receive When Added as a CC Provider checkboxes (see Add a resource).

See also:

About email templates and notification templates
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Create fax cover sheets

You can create a cover sheet to automatically attach to faxes. You can create one cover sheet for each
facility. To create a cover sheet:

Procedure
1. Go to SETUP > Office > General > COVER SHEETS tab, select ADD.

2. Type a name for your cover sheet, select the facility where the cover sheet will be available, and
then select SAVE.

3. Use the word processing tools create your cover sheet, and then select SAVE.

4. Select SAVE & CLOSE.

Work with the report queue

You can open a report queue that shows reports that you previously generated or that are currently in
process. You can resend (reprocess) individual reports, or reprocess them in batches.

Procedure

1. Go to SETUP > Office > General > REPORT QUEUE.

R SHEETS REPORT QUELIE

REFROCESSFAILED ~ RELDAD

CGUELRED DATE £ LAST UPDATED STUDY DATE ACCEEL RECEIVER TYP-COCUMENT RECEVER MAMI PATIENT DELNE DELTVERY ADDRES CLURRENT PR

all w0 Al L Al W all L

L T G P 8 £ P GG T T A A 0 o TV WY P A AT A W ORI Cri
EDWS)Z‘I]IS TS O30AR023 1001165 Rafems Tesl; Farmer- ~ Fax {7AG54-5454 Quauad
Fesand
035052023 14803032023 104 030352023 10011846 Rafomi = n Test, Farmer Email  mirmillaroy@kaniciSent
Ces
(#03/02/2023 135 Q3032023 1231165 Refening ProviApproved Re Test Reterring  Tes1, Frank Fax [7453454-5454  CQueued

2. To resend a report, right-click it in the list and then select Resend.

3. To resend a batch of reports, at the top of the list, select REPROCESS SELECTED or REPROCESS

FAILED.

4. To resend a report automatically at a later time, right-click it in the list and then select Requeue.

View logs

To view the various logs that are available in Exa PACS/RIS, do the following.

Procedure
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1. Go to SETUP > Office > Log.
2. Select tabs (AUDIT LOG, USER LOG, etc.) to view different logs.

[ To Gdf1aanea 1i-sesaemEn | [ B s I Pecrvicar w7 oF BF

Sromosi:

LEOED (ATE & BCHEEW LaEs BATEM Lo DEECRIP TN
R .
M B 03402033 1 [AS & EDT M Craw procadans compheted, ineguency 1000, stedees pending {0, stdic
|
% e acada 1 e A DT hjﬁ'ﬁ}_' farw frassethaie chailed
|
(4 B 030452003 1A A EDT M Draw proceduns completd, nsquency {100}, shakes pending 40, studs

3. Double-click entries to view details.
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Work with the hamburger menu

The hamburger (burger) menu is the main menu of the program. To open it, select the burger menu
button circled in red in the following figure. Some of the options in the figure may not be available
depending on your product and configuration.

Worklist

WORKLIST

PATIENT ARRIVAL WORKLIST

PATIENT

DISPATCHING DASHBOARD

QUERY/RETRIEVE

SCHEDULE

BILLING

PAYMENTS

REPORTS

E
=]
@
@®
Q
&
£
B
B
3

TOOLS

—0
=

SETUP

INTERFACE

HOMICA MINOLTA

The burger menu button... ...and menu (your options may vary)
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Work with the dashboard
What is the Dashboard?

The Dashboard is a page that displays gadgets, which contain information in graph, table, and other
formats to help you understand the status of work at your facility. The Dashboard is separate from the
Dispatching Dashboard, which is dedicated to scheduling mobile exams.

See also:

Work in the dispatching dashboard

Open the dashboard

e Onthe burgerE menu, select DASHBOARD.

Add or remove gadgets from the dashboard

The dashboard displays an array of user-customizable gadgets, and a gadget with a button for adding
more gadgets.

Procedure
1. To remove a gadget, select its remove % putton.

2. To add a gadget, find the Add Gadget gadget and select the add [+] button.

3. Inthe list of gadget types, select a type.

Change the graph type of a gadget
You can select a graph type of bar, column, line, or pie.

Procedure

1. On a gadget, select the graph bl pytton.

2. In the button shortcut menu, select a type.

Change the facility of a graph

You can change the source facility of the graph in a gadget. The available facilities are ones that you set
up in advance in Exa PACS/RIS.

Procedure

1. On a gadget, select the facility B button.
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2. In the button shortcut menu, select a facility or select All Facilities.

Change the date range of a graph

You can change the date range of the data source of the graph in a gadget.

Procedure

1. On a gadget, select the date range button.

2. In the button shortcut menu, select a date range and then select Apply.
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Work with the worklist

The worklist is the starting point for most operations in Exa PACS/RIS. The worklist is a searchable and
highly customizable list of patients, studies, and series, providing full access to demographics and
images.

Procedure

1. Go to burger menu E > WORKLIST.

= Worklist

ALl STUDIES

4 0 STATUS STUDY DATE ¢ PATIENT MODALITY STUDY DESC

All v

-

+ B0@ =22 %E BB o * @ 01/18/2023 8:30 PM PST Test, Helen XA ANGRPH &
+ 2 [ ¢ xE mA S C * @ 01/18/2023 7:15 PM PST Test, Tom CR CHOLANG!
+ 2O FxE =B S O * @ 01/18/2023 7:00 PM PST Test, Tom CR BRONCHO

See also:

Worklist settings

Use the worklist

User settings

Viewer settings

PACS Actions menu
Worklist shortcut menus
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Worklist settings

About toolbars and elements in the worklist

The worklist provides the following toolbars and other items. Notice that there is a settings menu ﬂ
button in both the upper and lower toolbar, but they open different menus.

Upper toolbar

The upper toolbar contains the following elements, from left to right.

1 Tasks Shows the number of tasks by urgency. Select to jump to the Tasks list.
2 STAT meter Shows the number of studies at each STAT (urgency) level.

3 TAT meter Shows the number of studies at each TAT (turnaround time).

4 Settings Opens the settings menu.

5 Log off Logs off the current user.

Lower toolbar

1 2 3 45 6 7 8

The lower toolbar contains the following elements.

1 Move tabs left/right Left/right justifies the worklist filter tabs.

2 Filter menu Select from any available filter tab.

3 Refresh Updates the worklist, but keeps manually entered filters.

4 Refresh all Updates the worklist, clearing all filters.

5 PACS Actions Opens the PACS Actions menu.

6 Filters Opens the Study Filters dialog.

7 Search tools Shows/hides the search bar.

8 Disagreements Opens the disagreements queue (requires a separate license for

Advanced Peer Review).
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= WorkList

PRE ORD

ALL STUDIES

Filter tabs (figure above) appear on the left side of the worklist by their labels. The Exceeds Maximum

Time Limit filter (figure below) appears at the bottom of the worklist.

S O

Exceeds Maximum Time Limit 162

4 ® ! scheduled 02/17/20237:55PM PST

The following table describes the four types of filter tab (filters) that are available in the worklist.

Optional
(Can be hidden)

PRE ORDERS Lists unscheduled orders. Pre orders often have no
referring physician, and come from the patient portal (such
as exams requested by the patient).

QC Lists studies needing reconciliation.

Permanent

(Cannot be hidden)

ALL STUDIES

Lists all DICOM studies and scheduled RIS orders that are
not currently on the QC tab.

User Filters

(Can be hidden)

[user defined]

Provide a highly customized view of the worklist.

Temporary

Exceeds Maximum
Time Limit

When you select the Exceeds Maximum Time Limit link at
the bottom of the worklist, this tab opens and lists relevant
studies. Select the pushpin button on the tab to display a
dialog with options, including "Remove."

Display a filter of the worklist

You can display optional filters (such as PRE ORDERS or QC) in the following two ways. To display user
filters, you can use these steps if the filter was configured to appear as a tab or in the tabs list.

Procedure

1. On the worklist, in the filter bar, select a tab to display the filter.

= WorkList

PRE ORL

2. Inthe lower toolbar, select the Show all Tabs by list H button, and then select a filter.
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Create a user worklist filter

Exa PACS/RIS comes with the PRE ORDERS, QC, and other filters, but you can also create your own
filters to customize the worklist at a high level of precision.

Procedure

1. On the worklist lower toolbar, select the ﬁIterE button.
2. Inthe Study Filter dialog, select ADD.

3. Enter the following criteria. See an example below the table.

Filter Name Type a name for the filter
Show Encounters Only Shows only studies for outpatient encounters.
Joined Filters Selects another filter to combine with the current filter. Studies must

meet the criteria in both filters to appear in the worklist.

Filter Order Determines the order in which filters appear as tabs or list items, from
low to high.

Is Private Restricts availability of the filter to the user who created it.

Display as a Tab Shows the tab for the filter on the worklist.

Display in Dropdown Shows the filter in the Show Tabs by list list on the worklist.

Show Only Exceeding Max Time Shows only studies that are exceeding their max time as specified in

“Configure study statuses.”

Show DICOM Studies Only Shows only DICOM studies (studies containing images).

Show RIS Orders Only Shows only RIS orders.

Show Assigned Studies Only Shows only studies that were assigned to the current user.

Show Pre-Orders Only Shows only preorders.

Deleted Shows all (deleted and non-deleted) studies, no deleted studies, or

only deleted studies.

Assign Available when you select Is Private. Administrators can use these
settings to assign the filter to specific users or user groups.

Default Column/Sort By Sorts the worklist by the column and order that you select.
DATE/TIME Filters studies by a range of dates and times.
PATIENT INFORMATION Filters studies by patient or account number.
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STUDY INFORMATION

Filters studies by institution, facility, modality, body part, and other
categories.

RESOURCE

Filters studies by physician or attorney.

INSURANCE

Filters studies by insurance provider.

Note: When available, you can use the Is operator and Blank criteria to search for studies that
are missing information. For example, in the INSURANCE category, under Insurance Provider,
select Is, and then select Blank to search for studies with no insurance.

Example

The settings in the figure below define a filter with the following properties:

e Appears as the first available user filter

e IsPrivate (only available to the user who created it)
e Appears as a tab on the worklist

e Appears as a menu option in the list of filters

e Shows only DICOM studies

e Isonly available to users of type Radiologist
e Only displays studies in Unread status.

Study Filter

Filar Hama *

Joined Filters MOME SELECTED =

Fifter Ordur *

Danplay 85 3 Tab

Shaw DICOM Stadies Crily

Dabutad

Aasgn

Detault ColurmniSen By

5 Privats

Deeplay in Drogdown O show Qndy Exceading Mak Time

irky [ Shaw Asgigned Studies Only

u O shay
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Institution Facility

C‘ s . angie Fagility
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Schedule - : T

4, Select SAVE.

Edit or delete a worklist filter
You can edit or delete a filter that you created.

Procedure

1. On the worklist lower toolbar, select the filter . button.

Study Filter

Default Tab All Studies v
FILTER MAME FILTER TYPE FILTER ORDER £
al w
Al Studies Glokal o
& [ fDelete or Edil Me Private 2
* [ fTest Private 3

2. Select the edit & or delete (i button of the filter to delete.
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Show or hide a worklist filter

You can show filters as tabs on the worklist, as items in the filter menu, as both, or as neither (you can
hide them for later use without deleting them).

Procedure

1. On the worklist, on the lower toolbar, select the ﬁlter- button.
2. In the Study Filter dialog, double-click the filter to show or hide.

3. Inthe second Study Filter dialog, select or clear the Display as a Tab checkbox and the Display
in Dropdown checkbox.

Select a quick filter of the pre orders tab

At the bottom of the PRE ORDERS tab, you can select from the following checkboxes to quickly filter the
list of preorders.

Nirmilia Test Facifity Test, Martin CR BOME aGl

| O & % o 03017/20238:20 AM POT

03172023 8:20 AM POT Ordered Mirmilla Test Facility Test, Martin HA 30 RNDR

[ 2 % 4 030472023 11:06 AM PD Nirmillia Test Facifity Test, Justin XA ANGRPH .

O Walting For Authorization Ol show Cnly Expired [ show Only Physictan Orders O show Only Ordering Facility Orders

Waiting for Authorization Shows only unauthorized preorders.

Show Only Expired Shows only preorders that are past the authorization date.
Show Only Physician Orders Show only preorders created from Referring Provider Portal.
Show Only Ordering Facility Orders Show only preorders created from the ordering facility portal.
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User settings
User settings (from the worklist) control how the worklist appears and functions when the user who
configured them signs in. User settings override global settings, except for security settings.

Configure worklist columns

You can show, hide, and order columns in the worklist.

Procedure

1. Go to Worklist > Settings > User Settings.

User Settings

Column Order

2. Do one or more of the following.

Note: You can also drag columns directly on the worklist.

Status

B study Date
Facility

Patient
Modality

Study Description

Account No.

To show or hide a column, select or clear its checkbox.

To reorder a column, drag the column to a new position in the list.

3. Select SAVE.

User Set

O Showt
Show [
Show (

She
Stow (
O aute-o

Auto-Q
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Configure other user settings

You can configure a variety of behaviors and settings for worklist tabs, columns and rows, and other user

settings.

Procedure

1. Go to Worklist > Settings > User Settings.

User Settings

[ Show Bow Mumber Double-Click Behavior Web " w
Show Priots Double-Click (Sched.. EditC
Show QC S
Default Tah A5t w
how Completed in Pending List
Show Completed in P L
Default Filter (Local ... e
Show Orders Tab
[ Autc-Open New Order Bstaut eump Fucy,
Auto-Open Appaintment Confirmation  Sart By Desc +
Audio Player Lag Time 4580 ¥
Auto Open Pricra on -
COpen Prior Reporta On w
Veice recognition Dicta »
Delay Load of Exa Tr off W
Exa Trans Font W

2. Enter the following settings.

Show Row Number

Select to display the row number column in the worklist. The column is
labeled as “#" or “No.”

Show Priors Select to show prior studies on the worklist, or clear to show series and
images instead. Whether you choose to show priors or series, you can
view them by selecting the expand + or collapse ™ button in a study
row.

Show QC Select to show the QC tab, and select the Show Completed in Pending

List checkbox to show include completed orders in the QC tab.

Show Orders Tab

Select to show the PRE ORDERS tab in the worklist.

Auto-Open New Order

Select to automatically open the Edit Study screen after selecting the
CREATE ORDER button (Exa PACS/RIS only).
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Auto-Open Appointment Select to automatically open the appointment confirmation screen after
Confirmation selecting the CREATE ORDER button (Exa PACS/RIS only). This screen
provides a convenient summary to read to the patient on the phone, or
to send as an email.

Double-Click Behavior The view or app in which a study appears when double-clicking a row,
unless the study is scheduled.

Double-Click (Scheduled) The view in which a scheduled study appears when you double-click it.
Default Tab The default tab for the worklist.

Default Filter (Local Cache) The default filter for the workilist.

Default Column The default column for the worklist that determines the sort.

Sort By Whether the list is sorted in ascending or descending order.

Audio Player Lag Time The amount of delay before starting audio playback.

Auto Open Priors Turns automatic opening of priors in the viewer on and off.

Open Prior Reports Automatically opens prior reports when opening a study.

Voice recognition When opening a DICOM study in the Exa PACS/RIS viewer:

Dragon (Exa Trans): Opens Dragon Naturally Speaking for radiologist
transcriptions rather than Exa Dictation. You must install Exa Trans on
the local workstation to use this option.

Dictation (Web Trans): Opens Exa Dictation.

Off (None): Does not open a voice recognition tool.

nVoq (Exa Trans): Opens Exa Trans with nVoq voice recognition.

Delay Load of Exa Trans Delays loading of the Exa Trans transcription screen, to focus attention
on images before the transcription.

Exa Trans Font Sets the font used by Exa Trans.
Exa Trans Font Size Sets the font size used by Exa Trans.
Default Time Increment Sets the default time increment for time blocks in the schedule book.

3. Select SAVE.

Viewer settings
See Configure the viewer.

Local service settings
See Install local cache in the appendix.
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Use the worklist

Find preorders and studies
You can find a study and open it to view or edit details.
Procedure
1. On the Worklist, select PRE ORDERS or ALL STUDIES.
2. Inthe search bar, do one or both of the following:

e In a column header (such as FACILITY), type or select one or more criteria and press Enter.

= Worklist
ALL STUMES
I I Fecwmy Tsrams  stovs
MY COMPANY | =
+ B0 ¥ W 17 * @ 1 MyCompany WEUEHT-’E
+ B0 & % % 7  ®@ i MyCompany Seheduled (03/17/2
O &k Y * @ I MyCompany Schedlled (03/17/:

e Select a column header to sort the list.

3. Double-click a study in the list to open it for viewing or editing.

See also:

Search syntax
View approved reports

View series and images
You can view series and images of any study in the worklist that includes them.
Procedure

1. In User Settings, clear the Show Priors checkbox and select SAVE.
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User Settings

O show Row Number

[0 show Priors

Show QC

B choew Camamlatad in Bandine @iz

2. Inthe worklist, find a study containing images and select its expand + button.

= B[®%® =7 & © 5 & (] H Hluf'ﬂ-‘_"[ﬂ! 1224 P EDT  Sarnpler, Jahn Sample Ferrur (L) AP Shudy

r 01,07,/ 1900 12:00 Akd EST
12392 200034,91 07,500,305 12 200810101 23946,1032 CH Imags Stor
3 01,/07,/1900 1200 AM EST
4 C1/011900 12200 AM EST
K] G110 1200 AM EST

3. Expand series rows by selecting the + button.

4. To view a thumbnail of an image, select the ™ button.
Note: To view an image thumbnail, the status must be Incomplete or Unread.

5. To open series and images in the viewer, double-click the main study.

View priors
You can view the prior studies of any study in the worklist that includes them.
Procedure

1. In User Settings, select the Show Priors checkbox and select SAVE.
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User Settings

O show Row Number

B show Priors

B showac

Shaar Prnelatad in Bandina 1 et

2. Inthe worklist, find a study and select its expand + button.

e R T M R T B B e T 1 A A D 0
Hm sl BER o & O | Nemilla Test Facility 01 0212024 715 PM PST Emidral. Emdrat &
Marmills Tesl Facdity -Ill1.'lll‘-"_.'232,ﬂ FASPM PET s Emdral, Ersdral Tead, walas ey
[y

Mermilla Test Faciity Checkdn | 03/17/2024 1.00 PM PDT Teat, Valere o7

mrmilla Test Faciity O2/067 2023 Y200 AM FST Test, Vakome e
Priors

tarmilla Test Faciity 0052023 700 PM PST T Legs Test, Valang XA
Double-click to open

Marmiiia Test Fachity 013172023 475 FM PET Test. Walane CR

Mirmiila Test Facaity 01/3172023 400 PM PST Test, Walara CR

Marmilla Tesl Facdity 01/3172023 Z00 PM PET e Tiest, Walene CR

Result: The priors appear in rows below the study row.
See also:

View roved r rt

Open a pop-up window for physicians and ordering facilities

From the worklist, you can open a pop-up window to display the contact information of a study's
physician or ordering facility.

Procedure

1. On the Worklist, in the REFERRING PHYSICIAN or ORDERING FACILITY column, select the
doctor & symbol.

4 ou o w0 k@ b MyCompany B 021 7/2023 7% PM ECT e, 5

= &0 ol % * @ Wy Company AF VTR0 625 PM EDT Emdzed Erramef &

+ 20 &k B LF & | Wy Compamy

+ 80 £ iy, 11 e i yCampary 0317073 BAS R ;';::C;Trlﬁnl-:;:;ym&u [
+ W[ > B L5 * @ Wy Company ORATIANRESESP Fax N tha
+ &0 =k o L T b Wiy Comgpany 3T/ 023 455 Pl Wer Exthat
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Use the study toolbar buttons

Each study on the ALL STUDIES tab or corresponding user filters of the worklist has its own toolbar on the
left side of the study row. Depending on the properties of the study, one or more of the following tools
are available.

+ /™ | Expand/Collapse Expands or collapses the study row to show or hide series or priors.
Prior Select to display a list of prior studies in a custom filter.
Checkbox Select to select the study for further processing by commands in the PACS

Actions menu.

DICOM Viewer Open the study in the Exa PACS viewer. This button is only available for
studies that contain images.

G O=

Opal Viewer Open the study in the Opal viewer (see Install Opal Viewer). This button is
only available for studies that contain images.

Edit Opens the study for editing in the Edit Study screen.

VIP If solid green, the study is conducted on a VIP.

View Transcription | Opens the dictation and transcription editor.

Multipanel Opens the study in the multipanel, an operating panel for working with
dictation, transcription, documents, notes, and other information.

Approved Report Opens approved reports of the study.

Linked Studies Opens the Link Studies dialog where you can link approved reports.

External app. Opens the current study in an external application if configured.

- 4 Authorization

BEREDED DN B

Red*star: Select to manually authorize.

Green*star: All insurance levels (primary, secondary, tertiary) that
require authorization have been authorized.

Gray star: No authorization is needed.

. Unread DICOMs Select to view unread images. In the Unread DICOMs dialog, select MARK
AS READ, or OPEN IN VIEWER to read the images in the Exa PACS/RIS
viewer.

Notes Opens a screen for entering and viewing notes related to patient, study,

schedule, and reason for study, and for updating the call log. The button
turns blue if study notes are available.

n Study menu Displays the study shortcut menu (you can also right-click anywhere on theg
study row to display the shortcut menu).
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See also:

Work with the Exa PACS/RIS viewer

Edit study screen

About Linked Reporting

Dictation and transcription with WebTrans
Worklist shortcut menus

Configure opening of a third-party program
About VIPs

Manually authorize an exam

Use the order toolbar buttons

Each order on the PRE ORDER tab or corresponding user filters of the worklist has its own toolbar on the
left side of the order row. Depending on the properties of the order, one or more of the following tools
are available.

Select Select to select the order for deletion.
£ | Edit Select to open the order in the Edit Order screen.
VIP If solid green, the study is conducted on a VIP.

* Authorization Red * star: Select to manually authorize.

Green * star: All insurance levels (primary, secondary, tertiary) that
require authorization have been authorized.

Black star: No authorization is needed.

See also:

Manually authorize an exam
About VIPs

About Linked Reporting

With Linked Reporting, radiologists can save time by dictating multiple related studies into a single report.
When the report is approved, all of the linked studies move to the Approved status automatically. When
you open an approved report from any of the linked studies (studies 1, 2, or 3 in the figure below), you
see the same combined report so that all information is available to you regardless of the study or report
you open.

Linking reports also links the studies containing those reports, so that all studies follow the main study in
terms of STAT levels, study statuses, and report approval statuses. For example, if the main report moves
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to the Dictated status, so do its linked reports. If you later decide to unlink a report, those statuses revert
to their previous states (with exceptions, see Details on Linked Reporting).

Main study and Main report: Siud\rl :

Linked studies and Study 2 Study 3
Linked reports: Report 2 Report 3

|
Once linked, Reports 1, 2, and 3 become one combined report

Note

e You can link reports any time before approval.

e You can unlink reports at any time.

e You cannot link a report that is already approved.

e Ifan addendum is added to a linked report, it applies to all linked studies, and is available for

viewing from any linked study.

What do linked reports look like?

Based on the merge fields you include in your report templates, Exa PACS/RIS automatically fills the
header with information about the main report and its linked reports. (Due to space constraints,
some fields only display information from the main report, such as the referring physician.)

The body of the report contains the radiologist's findings for the main study and all linked studies.

Approved reports always appear based on the transcription template of the main study, even if the
linked studies originally used different transcription templates.

An example of a linked report:
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Accession numbers
of linked studies

Patient Name: N Referring Physician: Reicher; Jloshua M.D.
Date of Birth:  04- Phone: 1650)493-5000
Patient |1D: WC1S77 Fax: (919)589-5574
Study Date: 07-Feb-2023 2:00 Accession: 5629,5630,5631 l

PMLO2/07/2023

¥R Ribs, 2 Views (Left),XR Thoracic Spine, 2 Views,XR Lumbar Spine, 2-3 View

Indications: Left b pain radiating to mid and lower back. No known traumia. “

Study descriptions of
Comparisons: Mone available at time of repo, linked studies
Technique: Two-vew radiographs of the left rbs, thomcic spine and lumbar spine obtained in the AP and
laterad position
Findings:

Left nbs: Multiple radiographic views of the nbs fail to reveal ewdence for displaced fracture, dislocation or
focal soft tissue pathology, Images are less than ideal and if there is further concem a bone scan might be
considensd.

Thoracic spine; No esdence for acute fracture, dislocation or focal soft issue abnormality, Thene s difuse
thoracic disc degeneration and spondylosis.

Lumbar spine: There is difuse degenerative disc disease without ewdence for fracture or dislocation, There
is lumbar scoliosis,

Impressions:
1. Diffuse thoracic disc degeneration and spondylosis.
2, Diffuse degenerative disc disease with levoscaoliosis in the lembar spine

3. No evwdence of a displaced fracture in the left nbs. Recommend a bone scan for follow up.
4. No acute fracture in the lumbar or thoracic spine.

Link reports
To link reports:
Prerequisite: Obtain the Link Report user right from your administrator.

Procedure

1. On the worklist, find a study that is available for linking, and select the gray link “© button.
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-
-

Gray: Available for linking

e
=
+ 80 & K % |0 * @ ! Scheduled 02/23/2023 12:30 AM EST
« B0 S *E B % * @ i -D?J"ID.-'ZZUZS']ZIE AM PST
'H-L;\_\_\H

T~ Blue: Linked, available for unlinking

2. Inthe Link Studies dialog, select the studies whose reports you want to link to the main report.

Link Studies: Test, Eric (Acc#TesE1077), 200007017, M, D23Y

3D RNDR &R CT MRI US/OTH X REQ POSTPCX

Siudy Date: 2023/83,08 Accensicn ko 1183 Facility: Hir=ella Tast Facility

Mindality: Lis Rafering Physician: Test. Referring

Select studies 1o link ar unlink for Reporling:

O salect a8
STUGY STATUS OALITY STURY (ESEE Tk Sy At ACCESHKIN R L FLRIRS] PHYSCIAN AL ITY
0 Schedued i) D0 VELOCMETRY FTL MIDOLE CZRE ART BRI LE EEGEERRIEY irteriing Prrvicers Lt RS
scheduled LS [OF ECHO FTL PLSD SPECTRAL CASFLAY REFEAT 579 Farra flan ey 8 Reflerming Prosvsders List
Test, Referring Lf
S - 20 DR SR x o7 e
P e £t T A (T K I P0e T i S ITUTUS Highway 70 East I

T G R Gh A A Com
Fad 85 rdsMsa-5a51

P MPE numbasFrovider alen o

3. Optional: Click the physician & symbol to display details, and click the physician's name in the
pop-up window to edit properties.

4. Select SAVE.
Result: The reports and studies are now linked.

See also:

About Linked Reporting
Unlink a report

View approved reports
Details on Linked Reporting

Unlink a report
To unlink a report:
Prerequisite: Obtain the Unlink Report user right from your administrator.

Procedure
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1. In the worklist, find a main or linked study (studies with the blue Linked Studies . button), and
select the button.

Result: Whether you chose a main or linked study, the Link Studies dialog opens with the main
study shown at the top with its linked studies listed below it.

2. Inthe Link Studies dialog, clear the checkboxes of the studies whose reports you want to unlink
from the main report.

3. Select SAVE.

See also:

About Linked Reporting
Link reports
Details on Linked Reporting

Authorize an exam

When you configure authorization rules (see Add authorization rules) Exa PACS/RIS automatically labels
exams on the worklist with these "authorization stars:"

* No authorization
* Needs authorization
Pending authorization

w Authorized

When you receive an authorization number from the insurance provider you can authorize the study,
either from the worklist or from the Edit Study screen. When doing so, you specify under which insurance
policy the exam was authorized by selecting the insurance level (primary, secondary, or tertiary
insurance policy).

Authorize from the worklist

1. On the worklist study row of the exam to authorize, select the red or yellow star, and then select
the study description in the pop-up window.

-8 & =) 0§ Scheduled TIHIN
MR ABD C-MATRL

2. In the Manual Authorization dialog, select the Insurance Level.

3. Fillin the remaining options with information from the insurance provider.

4. For studies in Need authorization status (red star *), select:
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SAVE - Authorize, and save the authorization number
PENDING - Place the exam in Pending authorization status

DENIED - Deny the exam

5. For studies in the Pending authorization status (yellow star = ), select:

SAVE - Authorize, and save the authorization number

RESET - Reset the authorization status to Need authorization (red star *)
DENIED - Deny the exam

6. Optional. Select Eligibility/Estimation, and then follow steps in the following topics to verify
eligibility and estimate insurance coverage. (Available with Eligibility user rights.)

Authorize from the Edit Study screen

1. On the worklist, open the study or order to authorize in the Edit Study screen.

2. Inthe left pane, select INSURANCE PROFILE, and then select the insurance level to authorize.

3. Under Authorization, enter the settings as needed and then select an authorization status
button (SAVE (authorized), PENDING, or DENIED).

Authorization ]

Study CPT 75658 (ANGRPH BRACH RTRGR RSB
Referral Humbes Autharization No.
Mates Expiration Date |53
Eftective Date [
|saus Date i}
Raason
Accident Date =
Accidsnt Type (B Employment
L—! Ao Acclident
[ other Accident
Aeeident State
Study CPT Select the CPT of the patient's study needing authorization.
Referral Number Type the referral number of the study needing authorization.
Notes / Reason Type notes and reasons for the study needing authorization.
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Authorization No. When authorized, type the authorization number.

Expiration / Effective / Issue Date| Select authorization dates.

Accident Date Select the date of the accident, if applicable.

Accident Type Select the type of accident.

Accident State Select the state or province in which the accident occurred.
Diagnosis Code Lists covered diagnosis codes.

What if an authorized exam changes before the appointment?

If you need to make certain changes to an exam, Exa PACS/RIS helps you manage its authorizations.
See the following topics.

About changing appointment types
Change an authorized appointment
Reschedule an appointment

See also:

What are authorization, verification, and estimation?

Add authorization rules

Verify eligibility of preorders and studies with PokitDok

Verify eligibility and estimate coverage with ImagineSoftware

Unauthorize an exam

If a previously authorized exam is no longer authorized, you can unauthorize the exam by deleting the
original authorization.

Procedure

1. In the worklist, find an authorized study (green star*), and then select the star.

2. Inthe Manual Authorization dialog, in the Insurance Level dropdown list, select an authorized
insurance level, and then select DELETE.

3. Optional. In the Insurance Level list, select Reauthorization Needed to place the exam in the

Reauthorization needed status (orange star ™).
See also:

What are authorization, verification, and estimation?
Manually authorize an exam
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Update the worklist or viewer

After performing tasks that modify studies it may be necessary to update the worklist or viewer to show
changes.

e To update the worklist or viewer, select F5.

About color highlighting on the worklist

When the globe = button for studies on the worklist is highlighted, this indicates the caching status as
follows.

Caching completed

Caching in progress

-l Some images could not be cached

About drawing attention to orders and studies

There are several methods to draw attention to orders and studies that are of special consideration. You
can use different individual or combined methods to best meet your needs. The following gives a general
description of the available options.

STAT level The medical urgency. Setting a STAT level places the study at the top of the worklist.
You can edit STAT levels and descriptions, and add new ones. STAT levels drive
workflows.

TAT The turnaround time. Studies that are near or beyond the TAT are flagged in red and
appear at the top of a radiologist’s unread studies worklist.

Priority By default you can set the priority to High, Medium, and Low, but you can edit these
and add more options. Priority is primarily used to sort the worklist (on the Priority
column).

Critical findings Medical findings that you can customize. In Exa Trans, you can select critical findings
in a list to send notification to the referring physician.

Flag With flags you can mark a study with a customized description that can serve as a
filter. You can only assign one flag per study.

See also:

Change the urgency of a study
Change the priority of a study
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Assign critical findings to an order or study

Flag an order or study
Change the priority of an order
Assign critical findings to an order

Use local caching

Prerequisite: Install local cache.

Perform a server prefetch

You can manually initiate a server prefetch from the worklist, whereby the server decompresses a
study and copies it to a “local” cache on the server. If large studies will be opened in the near future,
you can perform a server prefetch of those studies for faster loading.

1. On a worklist study shortcut menu, select Images > Server Prefetch.

+ 28 % el W S f * 0 1 MyCompany
= - Edit Study =
+ IR £ My Company
& Pallerd Inl
4+ 3 Hirmiila Test Facility
B Change Statua
+ E Eanr £ Minmitle Test Facility
+ 8 B @ Py ¥ Acllons 1 Miiraiiie Taad FailHv
) | B2 images B Sares Prefench
4 DICOM Send B Resel ack

Prefetch studies to your local cache
You can manually prefetch studies “on demand.”
1. On a worklist study shortcut menu, select Images > Add to My Local Cache.

Result: The server queues the images for sending.

Prefetch studies to other local caches
1. On the worklist, select the ALL STUDIES tab.
2. On a worklist study shortcut menu, select Images > Send to Local Cache.

3. In the Local Cache screen, in the list of available caches, select to the left of one or more
destination caches.

4. Do one of the following.

e To send to the selected caches, select LOCAL CACHE SELECTED.
e To send to all caches, select LOCAL CACHE ALL.
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Auto-route studies to local cache

You can create a routing rule to send studies that satisfy criteria to your local cache. Complete the
following procedures:

e Configure an application entity for your local cache.

e Configure a routing rule for type LOCAL_CACHE, and select the AE title you created.
Use an on call worklist filter to locally cache studies
You can configure a worklist filter that sends matching studies to local cache.
1. Create a user worklist filter.
2. In User Settings, in the Default Filter (Local Cache) dropdown list, select the worklist filter.
3. Select SAVE.
4

On your computer, in a text editor, open the localCache.cfqg file, located at the following path by
default:

C:\Viztek\exa\cfg\localCache.cfg

5. Find the line for “oncall_enabled” and set it as follows:

“oncal | _enabl ed”: "true",

6. Save and close the file.
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PACS Actions menu

The PACS Actions menu on the worklist provides top-level access to common functions.

Create a new study

To create a new study or create a new order (or to "enter a new study" or "enter a new order"), see the
following topics.

See also:

A typical scheduling workflow
Schedule an unscheduled order

Schedule a walk-in appointment

Schedule walk-ins

See Schedule a walk-in appointment.

Burn studies, series, or images to a CD or hard drive

You can burn studies to a CD or hard drive for sharing with other facilities, physicians, or patients. To burn
images and series, see later in this topic.

Prerequisite: Install Opal toals.

Burn studies
1. Place a CD in the drive.
2. Inthe worklist, select studies whose combined size does not exceed the capacity of the disc.

3. On the PACS Actions menu, select CD Burn.
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Oipal CD Burning - A
[Opal CO¥Burming

PID | Mare | pescatrTioN | pate
625589 B, suv I SKULL T THIGH W fCT Wed |
< »
¥ Inchude Viewer I Write to Bisk Only Fath [ |
[T Cathe images [ Create Annotasors Cveslay

Comprassion FEG 2000 Lossl x
[ Anorimize DICOMS [ Remove Annotalicns | e “‘j
I~ Fx Spit ETO [ -Force S0P Class ID for all files Repart |nmu15u:re :j

XML Leaded, Chck Start to Intiate Bumn Process
Current Step Progress
Total Progress
START | Cancel

4. Inthe Opal CD Burning dialog, enter the following settings as needed.

Include Viewer Burns a viewer program onto the CD along with the studies. Required
for viewing off site.

Write to Disk Only Writes the study to the hard drive instead of a CD. Browse for and
select a destination folder under Path.

Create Annotations Overlay Converts annotations to an overlay and includes them with the
images.

Compression Specifies a compression algorithm.

Anonymize DICOMS Removes identifying patient demographics.

Remove Annotations Omits annotations from the burned studies.

Report Specifies a report storing method.

5. Select START.

6. After burning, test the results by opening an image from the CD using the included viewer.

Burnimages and series
Use this procedure to burn individual images and/or series.

1. In User Settings, clear the Show Priors checkbox.
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User Settings

O show Row Number

[0 show Priors

Show OC
F cheuw Famnlatad in Bandinn izt
2. On the worklist, find images or series to burn by expanding the study row nodes and image
preview buttons.

= B[®& = 74 & H 5 a 0l i mluf'ﬂ:_{ﬂ! 1234 PM EDT  Sarnpler, Jahn Sample Ferur (L) AP Study

- B0 1900 1200 Akt EST
2392 10036, 6107, 500,205 1220081 0101 239463032 CH Images Stoe
3 D079,/ 79030 1200 AM EST
4 01/ 90012200 AM EST
4 O1LA/900 1200 &AM EST

3. Select the checkboxes of the images and series.

4. On the PACS Actions menu, select CD Burn.

Compare studies

You can open two studies of the same patient in separate viewer screens for purposes of comparison.
Prerequisite: Configure two or more monitors (see Set up connected displays).

Procedure

1. In Viewer Settings, clear the Single Instance Mode checkbox.

500-000594A 209



Exa® PACS/RIS 1.4.32_P5 User's Manual

eXQ-PLATFORM

Viewer Settings

GENERAL

INTERFACE

MODALITY

2. In the worklist, select two DICOM studies of the same patient to compare.

+ E L e ™

+ 3

3. On the PACS Actions menu, select Compare Study.

Result: The two studies open in the Exa PACS/RIS viewer.

Other Toolbar

LJ Asran Close

O single matance Mode

[0 Skip Frames in Gina to Maintain Flaybhack Speed

Joy L o

A o w @

* E*?T

18 o s * O

#Ha o tl@!

t & (0

Merge or split studies

In Exa PACS/RIS, merge and split refer to a category of operations in which you move series and images
from one study to another. Additionally, split refers to moving images from a study with an incorrect

accession number to the correct order. There are many ways to perform merge/split operations, but the
following procedures are useful examples. Moving all series and images out of a study deletes the study.

As an alternative to merging studies, see Use alternate account numbers.

Move or copy a series from one study to another study

1. In the worklist, select two different studies that contain series.

+ (MR

+ afgle » 2

+ O =

+ a >

+ A0 = 0%

o

E

J oy L w

R o & D

% o * O

BHAa =) t@_

% * [0

Rirmillg Test Facility
Hirmilla Test Facility
Mimmilla Teat Facility
Mirriills Teat Facility

Wirmilla Test Facility

Rirmillle Test Facility
Hirmilla Test Facility
Himmilla Teat FaE::IT‘}'
Nirmilla Test Facility

Wimmilla Test Facility

2. On the PACS Actions menu, select Merge/Split.

3. Select the button to choose Move Selected or Copy Selected mode.
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Merge/Split Study

Merge/Split Study

ey &=

4. in the Merge/Split From column, select the plus sign of the first study (the one on top) to reveal
its series.

Move Selected

5. Drag the series onto the second study (the one on the lower-right) in the Merge/Split To
column.

Hame: Test, Tom{fccd TesT102 Accession Mo 117 =
- Sudy. ANGRPH ADRML BI SLCTY Referring Physician: Test, Referi g
Mo of Seden: 1 Ha. of Instances: 1

Duesctiption: D Card

+ ﬂ'i"' ! ; ; : j Dascrption; 1D Card Madality
g Mo. of Inslepces ] y H -
Mo, ¢ Ml e Mo. of Instances: 1 Senco DT- 01119020

Mame: Tast, Tad(.i.ﬂcﬂ! TesT1004 Accession Mo 120
+  Study DOP ECHO FTL SPECTRAL Referring Physician: Test, Referri
Mo, of Sedem 7 Ha. of Instances: 1

Note: As you drag over the second study, it turns green to indicate when you can release the
mouse button.

6. Select SAVE CHANGES.

Move or copy all images in one series to a series in another study
1. Inthe Merge/Split To column, select the plus sign of a study to reveal its series.
2. Drag a series in the left column onto a series in the right column.

3. Select SAVE CHANGES.

Other moves or copies

In the same manner, you can expand nodes and move or copy any study, series, or image to another
study or series.

Splitimages into their correct order

1. Inthe Merge/Split Study screen, select SELECT ORDER.

Merge/Split Study

Monve Salected
Merge/Split From Merge/Split To
I Mame: Test, Tom(Acc#: TesT10Z Accession Mo 117 = II Hame: Test, Tom{Acc#; TesT 102!
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2. Find the correct RIS order, and then select its SELECT button.

Merge/Split Study

RIS Orders

STUDY DATE

STUDY DESCRIPTI ACCESSION NO.  ACCOLINT N{

PATIENT MAME

03/17/2023 4200 PTest, Valerie 01/007/2000 CTABD EPELVIS V1371 Tes\V10om
f17/2023 5:10 PTest, Andrew 01,/071/2000 DOP VELOCIMETR: 1370 TesABR3

m 03/17/2023 5:00 PTest, Andrew 01,/00/ 2000 BOME AGE STUDIET369 TesAR3

3. Drag the images to the correct order, and then select SAVE CHANGES.

Add a new series to a study

1. Inthe Merge/Split To column, select the new series = putton.
Note: The new series is added to the bottom of the list.

2. On the new series row, select the edit £ button.

3. In the Edit Study Info. dialog, type a description and then select the EDIT button.
Note: You can move series or images into the new series.

4. Select SAVE CHANGES.

Clone a study

1. Inthe Merge/Split From column, select the Clone Study 3 button.
Note: You can move series or images into or out of the new study.
2. Select SAVE CHANGES.

See also:

Add studies to the merge queue
About the PID, MRN, and account numbers

Import DICOM images

You can import DICOM images to a study.

Prerequisite: Install Opal toals.
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Procedure

1. In the worklist, select a study into which to import images.

On the PACS Actions menu, select Import Images.

2
3. Inthe pop-up window, select Open Opal Import.
4

In OpalImport, select Select Files/Folder or DICOMDIR to Import.

eXQ-PLATFORM

| 2.4.5.186 Bl Jun B 2021 19:365:33

Select Fies;Foider or DICOMDTR o trport

[ o ok Commprain [ Overarite CJ Enabie Cati Edhit Serql |
Oopsiomony [ Sewe Before Broode ;
] fzclate Fuis Hodéy Demographics

e Import Hetod [Cpad wfer =]

Masm [T
O stryker Producon Mode
[ Stryker 0F DATA Mode

[ Stryker 2iP fechooe Mode
[ strybar Enage Fuss

[ stomags Mode

O Fuj syragsts Mode

[ 11 FiesFriders Selecied For Import

& Upen

Lok jn: | Irages

Decompng

x| & EcrE-

5. Inthe Open dialog, browse for and select files to import, and then select Open.

6. In OpalImport, configure the settings in the following table.

Note: This is a partial list. Other settings are self-explanatory or generally unused.

Do Not Compress

Select to store in DICOM Little Endian format.
Clear to compress in DICOM JPEG200 Lossless format.

Overwrite

Select to replace any existing instances of the studies.

Opal DB Only

Select to import DICOM data only (no images).

Save before Encode

For troubleshooting purposes: Select to place the images in a folder
on the server, and not update the database.

Isolate Fails

Select to place files that could not be imported into a separate folder.

Modify Demographics

Select to reconcile demographics before import.

Max Files

Type a maximum number of files to import.

Max Size

Type a maximum data size to import.

7. Select Import.

8. Optional. If you selected the Modify Demographics checkbox, the Modify/Confirm Demographics

dialog appears. Do one of the following.
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e Under New Info, edit the demographics and then select MODIFY.
e Under New Info, confirm that the demographics are correct, and then select USE CURRENT.

9. Select Exit.

Purge all deleted

See Undelete or purge a deleted study.

Export the worklist
You can export the worklist to a CSV file.
Procedure

1. On the PACS Actions menu, select Export Worklist.

{- R
Export Worklist X
File Mame
Workllst
’ﬂ Include Timestamp
Include Filter Name é

2. In the Export Worklist dialog:

e Optional: In the Filename box, edit the default file name.

e Modify the name of the exported file by selecting or clearing the Include Timestamp and
Include Filter Name checkboxes.

Worklist shortcut menus

Exa PACS/RIS and Symmetry PACS have a study shortcut menu (for studies in the Unread and later
statuses). Additionally, Exa PACS/RIS has an order shortcut menu (for PRE ORDERS and studies in the
Ordered status). The tasks you can perform by using each shortcut menu are described in the topics in
this section. Note that the commands available on the shortcut menus vary depending on the order or
study status and other factors.

AN
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Any errors in patient and study information resulting from incorrectly performing the procedures in this
section can result in problems with data integrity. Take care to ensure that entered and imported data is
correct.

Open a shortcut menu

You can open a worklist shortcut menu by right-clicking a study or order row. The shortcut menu's
options differ depending on the status of the study or order.

Schedule an unscheduled order

If you previously entered an order (or a study with a status of “Ordered”) without scheduling it, you can
schedule it from the worklist.

Procedure

1. Worklist > right-click an order > Schedule Appointment.

| Ordered
B2 schedule Appointment :

Scheduled 01/
Edit Crdet
Bs Exam M 02/
i nﬂlﬂ
L Stat | )
Scheduled 0271
*  Priority
Schaduled 027
L Attach Files = :
B Log Schedufed (01/:
. Calllog Scheduted 01/,

Note: If messages appear, refer to related topics in this manual.

Result: The modified Find Slots screen appears.
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Test, Heather - 12/31/1999 - TesH1079, F, 23Y x>
i UPEMTE GROER
Drstamoe feoms Patiest  Patien ZIP Code  Patlent ZIF Plus  Patient Time Zore  Carnber Appointrnents =
{i ilkes 23529 %/Easler e 2
ol N i Hifbmstery 2023-03-22 755 AM - 210 AM US/Eactem
Appulsiment Type Facilgy Maodality Room KA Angle
| e | ey
& 1.0 @15
[eate Start Time End Time Ak PR L
B Taom 1 5 OO0 Ponding XA
Doayes of the Wt Addtonal T JedrT
gl s A0 RMGR IR G MR USAOTH REQ POSTREX
0000606 O & om
Mo Elats Faund Alers

Tast, Referring
Hio WP nurebarPravider alart 01

2. Filter available timeslots by entering the following criteria.

Distance from Patient

Type the patient’s ZIP code (see next row), and then select a distance.
Timeslots at facilities farther from the patient than the number of
miles you select are filtered out of the list.

Patient ZIP Code
(Postal Code and ZIP Plus)

Type the patient’s ZIP code, postal code, and/or ZIP Plus to make the
Distance from Patient filter available.

Carrier

Select the patient's insurance carrier.

Appointment Type

Shows the first appointment type in the order (read-only).

Facility Select one or more facilities where the exam could be performed.

Modality Room Select one or more modality rooms where the exam could be
performed.

Date Select to only show timeslots falling within a date range.

Start/End Time

Select to only show timeslots starting within a time range.

AM/PM

Select one or both to limit your search to daytime or nighttime.

Days of the Week

Select one or more days that the patient would be available.

Additional Time

Select if the exam requires more time than the standard duration.

3. Select a timeslot in the list, and then select UPDATE ORDER.

See also:

A typical scheduling workflow
Use the Find Slots feature

Schedule appointments back to back
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Edit an existing order
You can edit a previously entered order from the worklist.
Procedure

1. Worklist >right-click an order > Edit Order.

RN Ottared
B schedule Appointrent
Schaduled 01/
Edit Dedet
B Exam Scheduled 027
i nﬂlﬂ
L Stat e
Scheduled 021
= Priority
Schaduled 027
X Aftach Files i
B Log Schaduled 01/
% Calltog Scheduled 01/

2. Edit the order and then select SAVE.

Note: For details, see Edit order information.

Manually verify or clear eligibility of orders

If you determine that an order, preorder, or study on the worklist satisfies payment provider eligibility
requirements, you can mark it as Eligible (green check mark) on the worklist. If a study was previously
manually verified, you can clear the Eligible status. Verifying or clearing does not affect the eligibility
status in other parts of the program. To view the eligibility status, display the Eligibility column.

Prerequisite: Obtain Eligibility rights.
Procedure
1. Optional. In User Settings, display the Eligibility column.
2. Worklist > right-click an order > Manually Verify Eligibility.
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v iz =
I & schedule Appoiniment -
' N 01/26/202% 600 AM EST
B Edd Order
B Eam N02/16/2023 £:45 AM EST
e
O s ! cCritical Findings :
% Priority @ Marually Verify Eligibdity
X Ajtach Files B Modify duthorzation Daye
B Log [F1 Reset Authorization Beys r
% calliog & Copy &Pl URL T
[—

To clear the eligibility status, select Remove Manual Eligibility Verification.

3. Optional. In the Eligibility column, confirm that the green checkbox appears or disappears.

See also:

ELIGIEETY

Al w

N

What are authorization, verification, and estimation?

Veri ligibility of preor nd st

Verify eligibility and estimate coverage with ImagineSoftware

Configure worklist columns

ies with PokitDok

Change the priority of an order or study

You can set the priority of an order.

Procedure

1. Worklist > right-click an order or study > Priority.

i
' [ scheduls Appontment
Bl Edit Order

& Exam

k  Actions

(]

Stat
Fricaty

Attach Files

ik

Log

(o

Call Log

01,/28/2023 600 AM

pled N 07162023 645 AM

020172023 12:00 Ab

']
High

"]
hdedlinam
Lo W

g 01,28/ 2023 5:00 P
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2. Select a priority.

See also:

About drawing attention to orders and studies

Assign critical findings to an order or study

You can assign critical findings to an order or study (for example, “Acute Positive”).

Prerequisite: Configure critical findings. See Reason codes.

Procedure

1. Worklist > right-click an order or study > Actions > Critical Findings.

3T

I. Tt e o Ordered
B Schadule Appointment T
Scheduled | 01/28/2023 5:00 AM EST

Edit Crder

— Scheduled |02/16/2023 6:45 AM EST
Actions "™ Flag

O stat 1 Critical Findings

%+ Priosity & Manually Verify Eligibélity

X Attach Files & Modify Authorization Days

B Log 2] Reset Authorization Days

. CallLog & Copy APIURL

2. Inthe sub-menu, select a finding.

See also:

About drawing attention to orders and studies

Flag an order or study

You can flag an order or study in the worklist as being of special consideration. You can only apply one

flag to an order. Users can filter the worklist by individual study flags.

Prerequisite: Create a study flag

Procedure

1. Worklist > right-click an order or study > Actions > Flag.
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B Schadule Appointment

1 0 Q1/28/2023 6200 AM EST

B  Edit Grder

& Exam i Scheduled | 02/16/2023 6:45 AM EST
I £ Actions I ] W Flag ' ogT

O stat [ 1 Critical Findings

.

* Priosity &  Manually Verify Eligibility

2 Attach Files B Modify Authorization Days

B Leg M Reset Authorization Days T

L callLeg & Copy APIURL T

e

2. On the sub-menu, select one or more flags.

See also:

About drawing attention to orders and studies

Change the stat level of an order or study

You can assign or change the stat level or urgency (Stat 1-5, or Off) of an order in the worklist.

Procedure

1. Worklist > right-click an order or study > Stat.

& schedule Appointment

Ei Edit Order 1 01/28/2023 6:00 AN
& Exam Bd | 02/16/2023 6:45 AN

ik (24012092 17:00
O st [ 1 O statoff

% Priority B Stat1

X Attach Files B stat2

W Log B stat3

. CallLog B siata

2. In the sub-menu, select a stat level.
See also:

A t drawing attention to or nd studi
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Delete an order
You can delete orders from the worklist.

e On the worklist, select the PRE ORDERS tab.

Delete one order

e On the order shortcut menu, hover over Exam, and then select Delete Study.

Delete multiple orders

e Select the checkboxes of multiple orders, and then on the shortcut menu, select Delete
Study.

View or attach documents to an order or study

You can view attached documents, or scan documents to an order or study.
Procedure

1. Worklist > right-click an order or study > Attach Files.

L sl - amaTol - = E
' B schedule Appointment :I

Scheduled 01/
Ei EditOrder
B Exam Scheduled 02/
: MR -GZH
O sta 11| —
Scheduled 0211
*  Priority |
kel
I X Attach Files [
B Log Scheduled 01/
L

Call Log lﬂﬂiﬂﬁiﬁ' a1y

2. In the Patient Document dialog:

E‘,:' Test, Brad (Acc# TesB11713), 0T/ARIZ2000, M, 23

Patient Dacuments [ wocksomn |-] oo |

BB hoen A8 Dosuresntis

e Wirduh, Py TUIDA 1124 AMETT  INISeIE 11 2L AREST Fask

e To view a document, double-click it in the list.
e To attach a document, follow the steps in the following topics.
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See also:

Scan to a patient

Scan to an order or study
Require document review

Require document review

When creating a scan document (or "document") type, you can require that users review the document
before moving forward in the study workflow. For example, you can require technologists to review
physician orders prior to performing an exam to ensure order accuracy.

Procedure
1. In App settings, add a Scan Document Type and select the Requires Review checkbox.

2. Add a study status, select the Document Review checkbox, and then select the document types
to review.

See also:

View or attach documents to an order

Configure study statuses

Modify or reset the order authorization days

This command lets you quickly change the number of days specified in the authorization rule associated
with an exam. You can reset the days to the number of days set in the rule, or modify the days to an
arbitrary number.

Procedure

1. Worklist > right-click an order > Actions > Reset Authorization Days, or Modify
Authorization Days.
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io T Orde i
B Schadule Appointment -
. Scheduled | 01/28/2023 6:00 AM EST
£ Edit Order
B fyam 00« SGhHEdW eds 02/16/2023 6:45 AM EST
I Artions =™ Flag
O stat ! Critical Findings
%+ Priority & Manually Verify Eligibility
X attach Files B Modify authorization Days
B Log = Reset Authorization Days
. callileg & CopyAPIURL

2. Inthe Days Count dropdown list, select a new number of days.

Modify Authorization

Drays Count

Drays Left

3. Select SAVE.

See also:

Add authorization rules

Assign a study to users

You can assign one study to one or more users, radiologists, or peer reviewers. When the user signs in,
they can create a filter of the worklist that displays all studies assigned to them. This feature also works in
conjunction with the “Show assigned studies only” option under Setup > User Management > [user

profile] > WORKLIST FILTER.

Procedure

1. Worklist > right-click an approved study > Exam > Assign Study.

500-000594A

223



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

B it Study 21/2023 5:00 AM FL
& Patient Informaticn 03/21/2023 9:00 AM PL
B Change Status e e
I & Exam & Asslgn Study
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¥ Actions B Lock Study
B send Report = Merge/Split gt
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O Delete Study
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2. Inthe Study Assignment dialog, in the Assign to User dropdown list, select a user and then
select the add button.

Note: You can repeat this step to assign additional users.

Study Assignment X

Ausciign 1o Ui A=sign o Radislogiss HAasign bs P Ruviswar m
TLEAR ASSIGHNED FEER RENTEWER
Sudy Dale Study description Fascility
DIATIZ0Z3  ANGRFM ARYLN SINT R Mirmiliz Test
Fazilimy

Select a new provider to perform peer review above, or clear the current appointee to unassign.

3. Optional. In the Assign to Radiologist dropdown list, select a radiologist as the referring
provider.

4. Optional. In the Assign to Peer Reviewer dropdown list, select a radiologist as the peer
reviewer.

5. Select SAVE.

See also:

Assign a peer reviewer for a study
Create a user worklist filter
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Add studies to the merge queue

You can add studies to a merge queue from the worklist, and then merge or split them by following the
procedures in Merge or split studies.

Procedure
1. Worklist > right-click a study > Exam.

2. Optional. To start merging or splitting with one study at a time, on a study shortcut menu, select
Merge/Split.

e TTIT T
B cChange Status nm’?‘ /2023 9:00 AM PDT

Aetione & Lock Study
IPM PDT
O ‘stat = Merge/split
# Priority O Add to Merge Queus
Reset Study A View Merge Queus
& Attach Files
; B Delete Study B Clear Merge Queue

& DICOM Upload

=

3. On the Merge Queue sub-menu, select Add to Merge Queue.
4. Repeat the previous step for all studies that you want to work with.

5. Right-click one of the studies that you added to the merge queue, hover over Exam, hover over
Merge Queue, and then select View Merge Queue.

6. Merge or split studies.

Create a teaching study
You can create a teaching study based on an existing DICOM study. The teaching study is anonymized.
Procedure

1. Worklist > right-click a DICOM study > Images > Create Teaching Study.
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Edit Study

|

1 B
& Pstient Information Checksn  07/19/2023 B:15 AM
@ Change Status Mlumqrznzaamm
B& Exam (e
- Scheduled !umafzuzaazsnm
¥ Actions i

1

[Ead images I = garver Prefeteh
4 DICOM Send 3 Reset Stack i
O stat B Create Teaching Study 4

> Priority
-DTHEIZDZEE 15 PM

2. Inthe Teaching Study dialog, in the AE Title dropdown list, select an AE title.

Teaching Study A
AL
EXA-W32-W32 | 10.227.26. 76 - 33536 ) w
| e
Finld Current Valua Mew Yalua
Accession No. 105 wvAMvcHBR G 11X
Patignt 1D Sla L0 BUTHTRY
Pationt Hame Tast, Susie Teaching %A_105
Study Description ANGRPH BRACH RTRGR RS&I ANGEPH BRACH ATRGR ASAl
Patient Gender F Oahet b
Referring Phys. Name |Ma Valua)
Instriution Name Mo Valua]

3. Inthe New Value column, type or select anonymous values for the new study.

4. Select CREATE TEACHING STUDY.

Reset a study
If the status of a study is beyond “Scheduled” in the study flow, you can reset the status to “Scheduled”
Procedure

1. Worklist > right-click a study > Reset Study.
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2. Inthe confirmation dialog, select YES.

Delete a study

When you delete a study it remains on the worklist but Exa PACS/RIS applies strikethrough text

formatting to it and disables access. You can undelete or purge a deleted study.

Procedure

1. Worklist > right-click a study > Exam > Delete Study.

-
a

Patient Information

Change Status

Exam

L

Actions
Sand Raport
Stat

Priority

Attach Fites

-03.-'21.!2{}‘23 9:00 At PC
e R R F e L ] -I.I-‘ Pt

& Assign Study

APC
B Lock Study
= Merge/split AEC
= Merge Queus AEE
= [Reset Study

AED
@ Delete Study

AEC

2. In the confirmation dialog, select YES.

Delete Reason

Cancel/Delete Reason *

nass W |

SAVE
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3. In the Delete Reason dialog, select a reason

4, Select SAVE.

Download approved reports

If an approved report is attached to a study, you can download the approved reports directly from the
worklist.

Procedure

1. Worklist > right-click an approved study > Send Report > Download.

1/19/2023 10:15AMPST ~ Teet, Refarring 4

& Patient Information m ujmﬁmmmm
B cChange Status Checkdn  01/19/2023 8:15 AM PST
= Exam e
ed | 01/19/2023 8:00 AM PST
¥ Actions b i et
o Scheduled | 01/18/2023 8:30 PM PST Test, Referring 4
Eal images -
A DiCoM Send -‘:'” H/EDe AN ENPET
I B SendReport M8 Fax: Test, Refarring 15 BM PET
O stat ™  Fax/Email
‘00 FM PST
% Priosty O Send Report via Opal
& pownload 3 POF
& Aftach Files o1/18/20232 B TxT
& DICOM Upload =

o1hs/eo2ay W TP

2. Select the format of the report.

Result: Exa PACS/RIS downloads the report to your Windows Downloads folder.

Undelete or purge a deleted study

Undeleting a study removes the strikethrough text formatting and restores availability. Purging a study
permanently removes it from the worklist and the database.

Procedure

1. Worklist > right-click a deleted study.
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I

@ i R Sebaduind g3y
" Restore Study
* @ i GohbikaTes 03
#  Purge (Permanantly)
* @ GobikaTesl auny om0

e To undelete, select Restore Study.
e To purge a deleted study, on the study shortcut menu, select Purge (Permanently), and
then select OK.

2. To purge all deleted studies at once, on the PACS Actions menu, select Purge All Deleted.

Copy the API URL
If you need the API URL, you can copy it from the worklist.

Procedure

1. Worklist > right-click a study > Actions > Copy API URL.

LTRArIe SRS -——- rr—m—— e
Exam A1O2NIL 1015 P

=
Actions ™ Flag
Ay
O Stat ! Critical Findings
£ Prisdity @ Manually Verify Elgibility
& Copy AP1URL 115
X AtiachFiles
Erhadilad! 1999 /9095 0-47 B
Result: A pop-up window appears with the API URL.

2. Press Ctrl + C to copy, and then select OK.

Reset a stack

To reset a stack means to restore its images to their last-saved ordering. It can also be helpful to reset
the stack if any problems occur when displaying it in the viewer.

Procedure

1. On the worklist, select the ALL STUDIES tab.

2. On the shortcut menu of a study that contains images, hover over Images and then select Reset

Stack.
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Edit Study

—
Patient Information WI

01/19/2023 5:15 AM

=
&
L]
L~

Change Status [ 01/19/2023 8:00 AM
FE d |01/18/2023 8:30 PM

¥ Actions
& images ] = Server Prefetch ‘
O stat | B Create Teaching Study 4

Ak

Priority
01/718/2023 2115 PM

3. In the confirmation dialog, select YES.

Lock and unlock a study

You can lock a study to warn other users attempting to open it, and to prevent other users from using
transcription. You can unlock a study that someone previously locked.

Procedure

1. Worklist > right-click a study > Exam > Lock Study.

Edit Study

01/19/2023 2:00 |
Patient Information

01/19/2023 1:45 |

B
&
B Change Status
|

I ‘Exam I | & Assign Study 5
%
¥ Actions & Lock Study I &
Images = Merge/Split

m

=

«d DICOM Send Merge Quele

Bi SendReport . Z  ResetStudy i

O Stat } W Delete Study i

Prinrity s

2. To unlock a locked study, on the study shortcut menu, hover over Exam > Unlock Study.
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Edit or view a patient, study, or order

To edit a patient, study, or order you can access the Edit Study screen from the worklist by selecting the
Edit Study, Edit Order, or Patient Information commands on the shortcut menu.

B scheduls Appaintmant Scheduls Appoimtment
B Edit Order
5 Exam
Actions
E Exam O siat
¥ actions = Pricrity
[ Stat o Attach Files
2 Prinrite o Log
% CallLog
Study shortcut menu Order shortcut menu
See also:

Edit study screen

Change the study status

You can assign or change the status (such as Approved or Transcribed) of a study in the worklist.
Prerequisite: Configure study statuses. See Configure study flow.

Procedure

1. Worklist > right-click a study > Change Status, and then select a status.
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AT HEE

E Editstudy

-U'I 192023 2:00
& Patient Informaticn
B Change Status B Unread i

B Exam 0 Approve/Coded

¥ Actions

=l tmages =
Chackdn  01/19/2023 1131
4 DICOM Send

o de

B Send Report
: e
O stat ﬁmnwﬂza 11331
] Prirritar . ;

DICOM-send studies, series, or images

s Jmngsznzs 11:01

You can DICOM-send studies, series, or images to PACS or another destination. You can include any
approved reports in the study, but note that the report status (such as Approved or Transcribed) is not
sent. To send an approved report with its status, send as XML via Opal.

Prerequisite: Configure send destinations (see Configure application entities).

Send studies

1. Worklist > right-click a DICOM study > DICOM Send.

B Edit Study

& Patlent Information
B Change Status

& Exam

¥ Actions

Eal Images

A DICOM Send

O Stat

&  Brinetbe

2. Inthe Send Study dialog, to filter the list of available AEs, type at least one character in the filter
box and then select Enter.
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Send Study x

ACCESSION MO, -STUDY DATE MODALT STUDY. DESCRIPTION ACCOUNT MO PATIENT (ie]c] FEFERRING PHYSICIAN

FISHNGA2EE08  CVOEM20E2 TO0 ACY PiEKULL TO THIGH W/CT  4X5E3 Bill, Suav J 0a/03r1eia Zasselti, Dennis Randolph

- Prietiy 0 = O inclute Approved fepart

W EXAVEZVIR EXAVIZVI2)
CPAL 3Z 33 {0PAL 32 33)

opal_v32_v33 {opal_v32 _v32)
3. In the Priority dropdown list, select a priority.
4. Do one of the following.

e Select destinations in the list, and then select SEND TO SELECTED.
Optional: To send any attached approved reports, select the Include Approved Report
checkbox.

5. Optional. To manage in-process send jobs, see Manage jobs in the transfer and SR queues.

Send series or images
1. In User Settings, clear the Show Priors checkbox.

2. On the worklist, find images or series to send by expanding the study row nodes and image

preview buttons.
& 0 H H 1090/ 2008 1234 PMEDT  Sarngler, Jahn Sample Fermwr (L) AP Study

[

r O1,07/ 1900 1200 Ak EST
1 2392 7000346, 91 07,500,305 12 200810101 23944,1032 CH Imags Stor
3 01,/07,/1900 1200 AM EST
4 01/01/1900 12200 AM EST
a 01/07/1900 1200 AM EST

3. Select the checkboxes of the images or series to send.
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Right-click and select DICOM Send.
In the Send Study dialog, in the Priority dropdown list, select a priority.

Select the send destinations in the list, and then select SEND TO SELECTED.

N v A

Optional: To send any attached approved reports, select the Include Approved Report
checkbox.

8. Optional. To manage in-process send jobs, see Manage jobs in the transfer and SR queues.

Send an approved report via Opal
You can send approved reports of DICOM studies to another Opal/Exa system.

Prerequisite: Ensure that the referring physician is configured on the sending server (your Exa PACS/RIS
server) and receiving server. You may need to contact the receiving facility to confirm.

Prerequisite: Install OPAL tools.
Procedure

1. Worklist > right-click an approved study > Send Report > Send Report via Opal.

Edit Study
& Patient infarmation Dictated  01/19/2023 8:3
B Change Status Checkdn  |01/19/2023 8:1
B Exam
Scheduled | 01/19/2023 8:00
ACtions
. Scheduled | 01/18/2023 8:3(
&l Images
J’ DICOM Send -D 11872023 4231
B sendReport IE Fax Test, Referring 1:
O stat ™ Fax/Email
i
& Priority O Send Report via Opal
i
X  Download
+ ila
2. i AgohFIes R 1 8/2023 2:00

3. Inthe Send Report via Opal dialog, to filter the list of available AEs, type at least one character
in the filter box and then select Enter.
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Send Report via Opal

ACCESSS0N RO STUDY DATE MCDALT STUDY DESCRIPTICHN ACCOUNT NO. PATIENT D0 REFERFIMG FHYSICIAN

130 D116 2033 200 FUS OOP ECHO FTL SPECTRAL [ TesT1040£ Te=t, Ted a0 2000 Test, Reforring

Filter Descrption 3 F‘rlnrn:.- [1] L SEND TO SELECTED

OPAL_3Z 33 (OPAL_32-33)

opel_v3Z w33 (opal_v32_v32)

4. In the Priority dropdown list, select a priority.
5. Select send destinations in the list.

6. Select SEND TO SELECTED, or SEND TO ALL.

Send an approved report via fax or email
You can send approved reports of DICOM studies via fax or email.
Procedure

Worklist > right-click an approved study > Send Report.

.] TR ' e

kB

Patient Infarmation [ AEe L m

Change Status

[ D

Exam

¥  Actions

(Y]

Images
DICOM Send
sendReport |

Stat

Fan: Test, Referring 1

Ol &

Fax/Email 2

L1

Pricrity Send Report via Opal

= O} W

il
Download

I+

Attach Files EERE 11 8/2023 200
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To fax to the default recipient (1), select it.
Result: The report is sent to the fax queue.
2. To send to selected recipients (2), select Fax/Email.

3. Inthe Send Report dialog, select recipients and then select the SEND FAX and/or SEND EMAIL

button.
Send Report X
Send Fax Report Queue
Send To = Ordering Physician Ordering Physician | Teat, Rafatring [(745)454-5454)
SEND FAX
Send Email
Send To * Grdering F'-I1'§,'5iciEll'I W Drdering Ph","sil:iaﬂ lest, Refarring (rirmilla; ovitkonicaminoliae.

SEND EMAIL
4. Optional. Repeat the previous step to send to additional recipients.

View and export audit log entries
You can view audit log entries, and export them to an XLS file.
Procedure

1. Worklist > right-click an order or study > Log.

| Schedule Appoinmtment |

=]
Scheduled 01/
Ei Edit Order
B Exam Schreduled ) 02/
O Stat
Priority [ .
Scheduled 02/
X Atiach Files =
B Log Scheduiad 01/
L CallLog Schaduled 01/
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2. Inthe Activity Log screen, select a date range for the log entries to view, and then select
RELOAD.

L Test, Laiica [Acc#:Tesl 43), 01/01/2000, F 23Y

From DRI PTOOTAMES [ T MaiE T ssredes i thrr I P

- it
Ersa T
CRETH

FRIFET O [P B peict s Octas barrw [Tosarty crmatsd
k) Y (1] e [ |irrerms panar

i E L ] i
f (U 1125 A BT elack o \hstekFa | Crond sy o

I3 11 AT AN ST ey - M | et Moy Pk i A 1

3. If any entries match the date range, they appear in the list.
4. Optional. To export an entry from the list, select it and then select EXPORT TO EXCEL.
5. To view information in a log, double-click the log entry in the list.

See also:
View activity logs

About linking patients
Two ways to handle duplicate patient records are linking and merging.

Linking patients means to merge patients to the master patient record by using alternate account
numbers. You can link patients from the worklist "on the fly" by following the procedure in Link patients,
or from the patient chart by following the procedures in Use alternate account numbers.

Merging patient charts is generally used to move studies, series, and images between patients.
Note: Linking patients is different from Linked Reporting.
See also:

Use alternate account numbers

Merge or split studies
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Link patients

If a patient has multiple records, each with different account numbers (or MRNs or PIDs), you can link
them from the worklist.

AN

Linking an external patient record to an internal one results in deleting the external record.

Prerequisite: Configure alternate account number functionality.

Procedure

1. Worklist > right-click an order or study > Link Patient.

Edit Study
& Patient Information
B Change Status
= Exam
Actions
= Images
«<d DICOM Send
Bi SendReport

L siat

]

* Pripmy

& Attach Files

& DICOM Upload

B Log

. Calllog

H &+ Link Patlent !

2. In the Alt Account No search box, enter the exact account number to link to the current account
number, and then select Enter.
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Link Patient

Main Account Mo TesS51034

Al Account Mo 753 n

| g5 Select w

kain Account No Alt Account No Issuer Merge Status

[ |
3. Inthe Issuer dropdown list, select the issuer of the PID, and then select ADD.

Note: If the account number was found (it already exists in Exa PACS/RIS), a message appears.
Type a different number or select a different issuer.

4. Select SAVE.

See also:

About linking patients

About attaching documents to patients, orders, and studies

The following is a list of topics in this manual that describe how to attach information to patients, orders,
and studies.

e Upload a DICOM file to a study - Attach existing DICOM files to a study.

e Scan to a patient - Scan paper or forms to a DICOM file and attach to the Documents section of the
patient chart.

e Scan to an order or study - Scan paper or forms to a DICOM file and attach to all studies in an order
or a selected study.

Upload a DICOM file to a study
You can upload DICOM-compatible files and add them to a study.
Procedure

1. Worklist > right-click a DICOM study > DICOM Upload > Upload File.
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Edit Study L
Patient Information

Change Status

VB =

Exam

¥  Actions

¥

images

DICOM Send

O =

Stat

i*

Prisrity

X Aftach Files

= Log
% CallLog

i+ Link Patient

O1/19/2023 2

01/19/2023 21

01/19/2023 1.

01/1972023 1;

011852023 1N

0141952023 1

B 0192023 1

01182023 1

I

£ Scanto Study =
Scan to Order

7

0111872023 5

2. In the DICOM Upload dialog, do the following.

DICOM Upload for Comelius, Barbara (MHSPT2109141129)

Barien Deseiption

ABH w

Mammim fe size 30 W2

SELECT FILES

a. Select a series description.

& Zpen

[= = 4 # OesHop » Image:

Dogaetize = Pl fplder

B The B¢
B 30 0bjes
I Ceskiop
4 Decumuni
& Damnivag:
B Munic
& Prmarss
B viden:

= 05D

File pame: |

Dicom preg

Search mages

&« [ a

b. Select SELECT FILES, browse for and select a file to upload, and then select Open.

c. Select UPLOAD.
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Open the call log

You can use the call log to save a record of communication to and from a patient regarding an

appointment or order.

1. Worklist > right-click a study or order > Call Log.

Schedule Appointment

Edit Order

L LI

Exam

Actions

0 =»

Stat

Priority

Ak

Attach Files
Log

Call Log I

clm I

2. The Notes tab of the patient chart opens. See Update the patient call log.

Scan to an order or study

You can scan an image to a DICOM file and attach the file to one or all studies in an order.

1. Worklist > right-click a study or order.

7 ACTIONS
&l Images
02/08/2023 7
<A DICOM Send
B SendReport b 02/08/2023 41
I O stat
¥ Priority
01/19/2023 2L

X Attach Files 01/19/2023 1:2

B Log

t. Calllog &

TR L f e, B ) 1
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2. Do one of the following:

e To scan to the study, select Scan to Study.
e To scan to all studies in the order, select Scan to Order.

Edit Study screen

In the Edit Study screen you can view and edit most information about an order or study.
Open the Edit Study screen

To open the Edit Study screen, follow the procedure below.

-:|'-__ Caution: When working in the Edit Study screen, ensure that you enter all information
| correctly and with correct spelling. Incorrect information can result in failure to find patient
records in future operations.

Procedure

e On a Worklist study row, click Edit < .

+ 2 ChE mBMA % O * O -usmwznzaz:ﬁFMPST

Result

The Edit Study screen opens to the EXAM INFORMATION screen, with the most recent study sub-
tab selected.

LU patient, New [Acc#PalN1120), D1/07/1977 , M, 46Y

LLE
IR TN | PG Hi I _I_':_':‘i
KEIENT IHFOINA 00 —
Ordar Mo \ TS Reason
Acreesion Mo T
Stady LI Sy Nobes
Diane M P0TE B4AS PMEST
Shudy SARTIL
Bexsy Fart Eolect - Dragnasia Codes
Orfwenation [
Aspoinirant Type
Code feafarring Fhyaician

" Ordeing Priyscian
G-loda

Feadieg Physician
BLIE Aude i okl s

Astnme
Mrerdakts Binm 1
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See also:

Screens in the Edit Study screen

View patient alerts

You can quickly check whether the patient of a study has any alerts that might affect billing, scheduling,
exam preparation, or other factors.

Procedure

1. Go to Worklist > Edit Study screen, and then select the alert button.

f,]'.'3 Test, Brad (Acc#:TesB1113), 01/01/20

SLIMMARY

EXAM INFORMATION S
The number of alerts appears in red

Result

The Patient Alerts dialog box appears.

filerts
+ Badance Cue
+ T Contrast Alkengy
 Fall Alerl

Maotes

=
2. Optional: Enter notes and click SAVE.

View a summary of an order
You can view a summary of an order and its studies.

Procedure

1. Go to Worklist > Edit Study screen, and then click SUMMARY.
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L1 Test, Brad (Acc#TesB1113), 07/01/2000 , M, 23Y

SUMMARY

Order Information

Tiitia

conedsy

T

Accaunich Na,! 70

Result

The order summary appears in the right pane.

Edit order information

Exgeactud Arrival D2N/I0ZE 4% PM PET

Drdared Data! OROE2023 136 AM PET

Stdies - View Exum Preg. Inslruetions

Sudy Doscrption A0 RN ER CT MRIUSAOTH REG
POSTRCE

Dirdiar Status:

ICTD Caddina:

Inmzance Prafile;

Check-

TBY

An order defines information for one or more studies. You can edit properties of an order.

Procedure

1. Go to Worklist > Edit Study screen > EXAM INFORMATION, and then select the ORDER sub-

tab.

L)" Test, Brad (Acc#:TesB1113), 01/01/2000 , M, 23Y

GROER L]

Fazilily

Modaliy O o
0 e
Oer
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Patient Location Smlct W

ALEITE

Patient Boom ko

Fatint Conditicn Splact -

Soigrce Sakcl

Flace al Seraice Salect

Euparding

Physstinn

Srhadule Notes

Junlification of
Matile Series
Technaloght
Diechargs

Inatructions

Phigsicuan Drdar

Halus
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Result: The Edit Order screen appears.

settings.

2. Near the top of the screen, select the ORDER sub-tab and make changes to the following

Facility The facilities performing the studies (to change, reschedule).
Modality The modalities used for the studies (to change, reschedule).
Resource The resources used for the studies (to change, reschedule).

Ordering Facility

Available with Mobile RAD only. Select the ordering facility or location of
the studies. If the patient resides at the ordering facility location, select Set
as Home Address.

Patient Location

Select the current location of the patient.

Patient Room No.

Type the room number of the patient location.

Patient Condition

Select a patient condition to consider for studies (such as "wheelchair").

Source

Select the source of the patient (such as referral or previous medical
facility).

Place of Service

Select the place of service for billing purposes (Box24B).

Supervising Physician

Select the supervising physician (Medicare requires a supervising physician
to be present in the department or location during the exam).

Functional Status

Select the patient's functional status.

Cognitive Status

Select the patient's cognitive status.

Transition of Care in

[Unused]

Patient Visit No.

The enterprise-specific serial number for the study.

SDE Study

Select the checkbox if the order contains an echo ultrasound-related
study.

Schedule Notes

Type or select schedule notes (such as messages from the front desk).

Justification of Mobile Service

Type the justification of mobile service for reference by the physician.

Technologist

Select the technologist performing the studies.

Discharge Instructions

Type any discharge instructions.

Physician Order Status

Status from the Referring Provider portal.

PRINT ORDER

To print a summary of the order information, select one or more of the
following options, and then select PRINT ORDER.

Include Disclaimer/ Signature
Area

Includes a pre-configured disclaimer to be signed by the patient.

Include Notes

Includes schedule and study notes on the printed order.

Include Barcode Page

Prints a barcode on the order.
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3. If DICOM settings are not available to edit, at the bottom of the screen, select DICOM STUDY,
and then make changes to DICOM settings as needed.

4. To edit or add CPT codes, at the bottom of the screen, select the edit 74 or add button,
enter changes, and then select SAVE.

5. Select SAVE.

Edit study information
You can edit properties of an ordered study, including DICOM settings and CPT codes.

Procedure

1. Go to Worklist > Edit Study screen > EXAM INFORMATION, and then select a study sub-tab.

L1 patient, New [Acc# PalN1120), D1/07/1977 , M, 46Y

GURMERY - m
EXAM INFORMATION | S ) =
] . |
Ordar Mo A I E Raason
Acomemion Mo ™
Sty LI P
Diane AN P0EE BAS PMEST
Stady STatua
THOH Bty Purt Salect - Dagnosis Codis
Oriwration Galect

Azpoinirent Type

Faafarring Fhyakcian

[
. Dirdering Prysecian
G-{gde

Reading Physiciar
AL A chei il e

Asinmey =

Mrerdnkts Binm

An order containing studies with accession numbers 773 and 774

2. Make changes to the following settings.

Order No. The order number to which the study belongs (to change, reschedule).
Accession No. The accession number of the study (users with rights can edit here).
Study UID The study UID as determined by the selected appointment type.

Date The date of the study (to change, reschedule).

Study Status The current status of the study in the Exa PACS/RIS study flow.
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Body Part Select the relevant body part for the study (for example, hand).

Orientation Select which side of the body (for example, right).

Appointment Type Select the study's appointment type (the type of exam for scheduling purposes).

Code The internal procedure code of the study (associated with the appointment type).

G-Code If CDSM was used to create the order, the G-Code appears, which identifies the
CDSM application (such as LogicNets).

AUC Audit If CDSM was used to create the order, a link is available to the AUC audit, which
shows the AUC decision tree used by the physician.

Modality Room The modality room where the study is performed (to change, reschedule).

Reason Type the patient-specific reason for performing the study.

Study Notes Type or select study notes (such as basic study history or notes from technologist to
radiologist).

Diagnosis Codes Select diagnosis (e.g. ICD10) codes for the study.

Referring Physician Select the physician who referred the patient for the study.

Ordering Physician Available when using Mobile RAD. Select the physician who ordered the study. If left
blank, Exa PACS/RIS automatically enters the referring physician.

Reading Physician Select the radiologist or other physician who will read the study.

Attorney Select the attorney for the patient. This attorney is given access to the study through

Attorney Portal.

Department Type the department of the facility performing the study.
Institution Type the institution of the facility performing the study.
Station Type an identifier for the station of the location performing the study.

3. If DICOM settings are not available to edit, at the bottom of the screen, select DICOM STUDY,
and then make changes to DICOM settings as needed.

4. To edit or add CPT codes, at the bottom of the screen, select the edit & or add button,
enter changes, and then select SAVE.

5. Select SAVE.

About changing appointment types

Authorized appointments

Appointment types contain one or more CPTs. If you change a study's appointment type from one
that has only one CPT to another than also has only one CPT, Exa PACS/RIS automatically copies any
authorization information from the original CPT to the new one. However, if the old and/or new
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appointment types have multiple CPTs, you can copy insurance authorization information from
selected CPTs in the original appointment type to any matching CPTs in the new one.

Clinically relevant Medicare appointments (CDSM)

If you change the appointment type of a study that was approved by CDSM and there exists a CPT
that matches the old and new appointment types, the approval remains (Exa PACS/RIS copies the
AUC modifier and G-code, and retains the original AUC Audit link). However, if a matching CPT does
not exist, new modifiers and codes are not copied, and the AUC Audit link is removed.

See also:
Change an authorize intment

Change an authorized appointment
The following feature is not available on all installations. To change an appointment type:
Procedure

1. Go to Worklist > Edit Study screen > EXAM INFORMATION > study sub-tab.

L1 patient, New (Acc#PalN1120), 01/07/1977 , M, 46Y

INFORMATION | i "

AEIENT MPOIRMA TN

Ordar ho HIE Fem

Acnession Mo T4
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Dizee L 08/ 2023 545 PMEST

Shudy SetuL

Besdy Pirt Samlmor - ey
Diriesvation Gmlpct

Aspintirant Type

Bodd Fafe

2. In the Appointment Type dropdown list, select a different appointment type.

3. In the Change Appointment Type dialog, to copy authorization information, select YES.
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I:l Ragin, Tess [Acc#:RagT1078), 01/07/2000 , F, 23Y
KO Becossien Mo, Date CFT Coula CFT Deacriplion |15} Rz

o+ 1254 DA I0TE T3 PM THAOSH

Biate Amourd Pymt, Mode Check/Card He Pymit, Feazon Recaived By Byme, il Hainn

Tartad Payrmaar - 000

=
mm fah

Efigibility / Estionation

4. In the Authorization screen, select the COPY button of any CPTs whose authorization
information you want to copy.

Authorization

Existing Authorization information exists for this exam. Select the updated
appointment type procedure codes that you wish to copy the authorization
information over to.

EXISTING APPRINTMENT TYFE CPFT CODES HEW AFPOINTMENT TYPE CPT CODES
CODE DESCRIPTRON AUTHORZATION COLE DESCRIPTHOM AUTHORIZATY
73192 CTPELVIS C-AATRL Tzt hith 7658 ANGRPH BRACH RTRIR RS
23191 CT ANGIOGRAPHY PELVES W/CONTRAST, firstAuth

5. Select SAVE.

See also:

About changing appointment types
Authorize an exam

Edit basic patient demographics
The Edit Study screen gives you convenient access to some patient demographics in the patient chart.
Procedure

1. Go to Worklist > Edit Study screen > PATIENT INFORMATION.
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2. Make changes, and then select SAVE.

See also:

Create and modi

a patient chart

Add or edit a patient’s portal account

BTUDY.: 30 RO IR

Lirnae fa Skale
Enp. Date

Emp. Stalud Balect
Ennploma o

Emp Addimai

Gt Sipbar IR

BrursFas

O megzon fe

Motes

You can edit a patient’s portal credentials and other account information.

Procedure

1. Go to Worklist > Edit Study screen > PATIENT INFORMATION > PORTAL ACCOUNT.

Create Porlal Account

Patient Account m Representative Account + [
Mlgine Sabea e
- ek Mlamo
sl
Secondary Eman bt
Ema

Secordany Ernad

Relatarss
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Create a patient account

1. In the Create Portal Account dialog, under Patient Account, type the patient's email address,
and then click CREATE.

Result: A email is sent to the patient to verify and finalize their patient portal account.

2. Click SAVE.

Create a representative account

e Under Representative Account, fill in the options and click the save md button.

Result: A email is sent to the representative to verify and finalize their patient portal account.

Assign a representative account

If you created more than one representative, you can select which one to assign to the current
patient.

e Under Representative Account, select the account in the dropdown list and then click the save
i button.

Edit a representative account

1. Under Representative Account, select the account in the dropdown list.

2. Change information as needed, and then click the plus + button.

Reset passwords

After an account is verified, you can reset the password.

1. Under Patient Account or Representative Account, click RESET PASSWORD.
2. Type a new password, and click the corresponding Save button.

See also:

Generate a patient check-in code

View and print a patient statement from the claim inquiry
You can view and print a patient statement from the claim inquiry.
Procedure

1. Go to Worklist > Edit Study screen > PATIENT INFORMATION > INQUIRY.
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Patient Claim Incuin

J P B 0 M Fradiany i 2 catil WLl DPELETR

2. Optional. In the Patient Claim Inquiry dialog, select PRINT.

A printable claim summary appears in a separate browser window.

Scan a patient’s driver’s license

You can search for a patient by the name and DOB on their driver’s license. If Exa PACS/RIS finds a
matching patient in the system, it opens a dialog in which you can reconcile that record against the
information on the license. If it does not find a matching patient, it uses the information on the license as
a basis for you to create a new patient.

Procedure

1. Go to Worklist > Edit Study screen > PATIENT INFORMATION > SCAN LICENSE.

Ready for Driver's License Scan

2. When the Scan License dialog appears, scan the driver’s license.

Result: Relevant information appears in fields.

Generate a patient check-in code
You can generate a code that the patient can use to check-in for an exam when using Patient Kiosk.
Procedure

1. Go to Worklist > Edit Study screen > PATIENT INFORMATION > CHECK-IN CODE.
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Check-in Code

Test, Richard

B1QPQK

O TO CLIaOARD

2. Optional. Select COPY TO CLIPBOARD, and then paste the code in an email to send to the
patient.

See also:

Use Patient Kiosk as a patient

Export a patient CCD

A patient CCD (continuity of care document) contains medical information that you can send to other
providers without loss of meaning. You can export the information, download it to your Windows
Downloads folder, and send it to an email recipient.

Procedure

1. Go to Worklist > Edit Study screen > PATIENT INFORMATION > EXPORT CCD.

Export CCD

® Roadable XML Encrypted XML
® ccoD cocrO ccoaD Clinical Summary

O =sHai

[J sHazss

[ sHAz84

O sHas1z

O mps

] File Dewnloaded for Physician Referral

2. Select type and encryption functions.
3. Select PROCESS PATIENT INFO, and then select DOWNLOAD.

4. To send the zipped file, select SEND and follow the on-screen instructions.
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Enter a new charge
You can modify charges from the Edit Study screen.
Procedure

1. Go to Worklist > Edit Study screen > CHARGES/PAYMENTS.

I:l Ragin, Tess [Acc#:RagT1078), 01/07/2000 , F, 23Y

STINDY - ANGRPH BRACH RTHGR REEl - - STUDIES:SELECT -

HDC Bpcoschen Mo, Dato CPT Cela CFT Deacriplion M1 2

......
1

"Hﬁ.RﬁEl.'FA'I'I'ENTE | + | 1254 O3/ TV INES T3P

LT

Biate Amourd Pymt, Mode Check/Card He Pymit, Feazon Recaived By Byme, il Hainn

Tartad Payrmaar - 000

| R AT T AR, i

2. Edit settings for an existing charge, or select NEW CHARGE, enter charge information, and then
select SAVE.

3. Optional. Select Eligibility/Estimation follow the steps in the following topics to verify eligibility
and estimate coverage. (Available with Eligibility user rights.)

4, Select SAVE.

See also:

Enter a claim for a study
Verify eligibility and estimate coverage with ImagineSoftware

Verify eligibility of preorders and studies with PokitDok
Manually veri r clear eligibility of orders

Enter payments and print receipts

You can enter payments, print receipts, and create an invoice for the balance due from the Edit Study
screen.

Procedure

1. Go to Worklist > Edit Study screen > CHARGE/PAYMENTS.
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2. Select NEW PAYMENT, enter payment information, and then select SAVE.

3. Optional. To print a receipt, select PRINT RECEIPT.

4. Select SAVE.

See also:
Record a payment

View payment history and print receipts

You can view a history of payments made on behalf of the current patient, and print receipts.

Procedure

1. Go to Worklist > Edit Study screen > PATIENT PAYMENT HISTORY.

Fa recondi dzunc

ETUOY L 30 FNCE L8 T W

2. Select a payment for which to print a receipt, and then select PAYMENT RECEIPT.

Result: The receipt opens in a browser tab.

3. Use the functions of the browser to download or print the receipt.
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Add or edit an insurance profile

An insurance profile contains all relevant information about an insurance policy applied to an order. By
creating primary, secondary, and/or tertiary insurance profiles for your patients who have insurance
policies, you can take advantage of billing and other features throughout the patient encounter
workflow.

You can create an insurance profile from the patient chart or the Edit Study screen, but in the Edit Study
screen you can modify authorization information specific to the associated order or study.
Editing an insurance profile with authorizations

When you edit an insurance profile (change the carrier or policy number) of an order that is partially
or fully authorized, and the new profile contains one or more of the authorized studies, Exa PACS/RIS
prompts you with the choice to copy the authorization information to the edited insurance profile.
This saves you from having to reauthorize studies unnecessarily.

Procedure

1. Go to Worklist > Edit Study screen > INSURANCE PROFILE.

I Test Brad (Accs:Tes81113) 07/01/2000 , M, 237

ETO0Y ; 10 RHEH IR T N L/OTH Fo P
DD

e Twnrt, Brad

2. Select ADD.
Insurance Details mmm

Level * Prismear v | Inactive Addrezs PO BOX 25519
Insurance Cerrier * | AETMA HEALTH PLAN K |= RICHMOND, VA 23260
[P T s Phane Mo (B00)222-5553
Tya iehsite
Palicy Numbar * TessAaina? Group Mame
Group Mo Walid From Date AN/ DE A
Pre-Cert. Phone Valid To Date MKODMYYY | B
Pre-Cerl. Fax Medicare Ins. Type | Select w

O Accept Assignment

3. Enter the following insurance details.
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Set As Default?

Select to set the current policy as the default policy. Useful when the

patient has multiple policies at the same level.

Level Select whether the insurance is the patient's primary, secondary, or
tertiary policy.
Inactive Select to inactivate the policy while retaining its information.

The Valid To Date is automatically set to the current date.

Existing Insurance!

To edit a previously entered policy, select it in the dropdown list.

Insurance Carrier

Select the insurance carrier.

Insurance Provider Type

Entered automatically.

Policy Number

Type the patient's insurance policy number.

Group No.

Type the insurance group number of the policy.

Pre-Cert. Phone / Fax

Type contact information getting pre-certification.

Accept Assignment

Select if the insurance policy can accept assignments.

Address / Phone No.

The contact information of the insurance carrier.

Website

The website of the insurance carrier.

Group Name

Type the name of the insurance group.

Valid From/To Date

Select the period during which the current policy is effective.

Medicare Ins. Type

Select the Medicare insurance type of the policy.

Available:

1. When adding from Edit Study; 2 = On the Patient chart

Enter contact information for the patient, and determine eligibility and/or obtain an insurance

estimate (your options may vary).
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Eligibility & Estimation

Eligibility / Estimation

Contact Information

Ralationzhip Salf w Do * ov/orsz000 |
Subscriber Mame *  Tess Employee Status Seloet w
Rangin
. Wark Phane
1 r w

Home Plone

Country United Stafes
Address Line 1
Addraas Linwe 2

City/State/Z1IP selact-

Service Type Select to search for and select a service type.
Benefit On Date Select the date on which the policy becomes effective.
Eligibility & Estimation Select to verify eligibility and/or estimate coverage.
Relationship Select an emergency contact person for the patient.
Subscriber Name Type the name of the insurance policy subscriber.
Sex Select the sex of the subscriber.

Country Select the country of the subscriber.

Address Type the address of the subscriber.

DOB Select the date of birth of the subscriber.

Employee Status Select the employment status of the subscriber.
Work / Home Phone Type the phone numbers of the subscriber.

5. Optional: To authorize the study, see Authorize an exam.
6. Select SAVE.
See also:

About active and inactive insurance
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Verify eligibility of pre-orders and studies with PokitDok

If the insurance provider is a PokitDok trading partner, you can verify eligibility by using the following
procedure.

Procedure

1. Go to Worklist > Edit Study screen > INSURANCE PROFILE.

IV Test, Brad (Acca:TesB1 113} 01/01/2000 , M, 23¥

ETUY : I RMIA WS CT MR ISOTH B85 POS
TN ADD

L oCLE CapLs FIrATILY [T HEHE WD, POLICT FUMEL TRGL H TLLaT TS e et

13345 a6l Tord, Erad

2. Double-click a profile to open it.

3. Select a service type, and then select the green Eligibility / Estimation button.

Eligibility & Estimation

Sarvice Type SURGICAL (2) =

Benefit On Date 03, 14,2023 E

Eligibility / Estimation

Result: If the verification succeeds, an eligibility report appears.
See also:

Verify eligibility and estimate coverage with ImagineSoftware

Manually verify or clear eligibility of orders

Verify eligibility and estimate coverage with ImagineSoftware

If configured for your installation, you can verify insurance eligibility through ImagineSoftware.
Additionally, you can estimate coverage from your primary insurance policy. The following procedure
describes accessing the verification and estimation screen from the Edit Study screen, but the verification
and estimation steps are the same when you access the screen from other parts of the program.

Prerequisites:

e Add the primary insurance provider and include the trading partner ID for ImagineSoftware.
e Obtain Eligibility user rights from your administrator.
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1. Go to Worklist > Edit Study screen > INSURANCE PROFILE.

L0 Test; Brad (Acc#:Tes&1113), 01012000 , M, 237

STUDY : J0 RHDIA WS CT MR IR/OTH FE0 POS
MDD

# & Prmmy AEECATE TOTAL CARD 173422 ael Torl, Erad

2. Double-click a profile to open it.

3. Under Eligibility & Estimation, select a service type, and then select the green Eligibility /
Estimation button.

4. Continue to the topics below.
Verify eligibility
1. Select the ELIGIBILITY sub-tab.

Result: If eligible, a check mark appears under Eligibility Status, the benefits on date appears
under Benefits Date, and policy details are shown.

Eligibility / Estimation: Xx100, Xx (XX1X1181

Eligibility Status 0 Benefits Date
ELIGIBILITY ESTIMATION
Plan Details

Co-Insurance
Co-Pay
Deductibie
Out-of-Pocket

Additional Insurance Information

2. To view patient, study, and insurance details, select the down arrow '°' button.
3. Optional. If conditions changed since the benefits on date, select RECHECK ELIGIBILITY.

4. Optional. To print a copy of the verification, select PRINT.
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Estimate coverage
1. Select the ESTIMATION sub-tab.

Result: If eligible, coverage details are shown including the estimated patient balance.

Eligibility / Estimation: Xx100, Xx (XX1X114

Eligibility Status 0 Benefits Date

ELIGIBILITY ESTIMATION

To view patient, study, and insurance details, select the down arrow 9 button.
Optional. If conditions changed since the benefits on date, select RE-ESTIMATE.

Optional. To print a copy of the estimate, select PRINT.

LA S

Optional. To generate a formal estimation letter, select LETTER.

a) To print the letter, select PRINT.

b) To send the letter in an email, type the recipient's email address and select EMAIL.
See also:

Verify eligibility of preorders and studies with PokitDok

Manually verify or clear eligibility of orders
Add an insurance provider

View or add patient documents

You can view all documents attached to a patient record and their metadata, and add new documents.
Procedure

1. Go to Worklist > Edit Study screen > DOCUMENTS.

I:',-" Test, Brad (Acc# TesB1113), DTARZ000, M, 23

Patient Docamaents

B Sk 28 Domareinti

Virtwh, M L=l OO 1724 AMELT . D2 I0I00S 11 28 ANEST Mk

2. To view a document in the list, double-click it.
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3. To add a document by scanning, place the document in the scanner, and do one of the following.

e To scan one page without scanning options, select QUICK SCAN.

e To scan with scanning options, select the QUICK SCAN arrow . button, and in the shortcut
menu, select a scan type.

4. To upload the document to RIS, select UPLOAD. To add document to the patient chart, select

the arrow . button for and select Patient Document.

STUDY : 3D RNDR IER CT MRI US/0TH REQ POSTPCX - STUDIES:SELECT =

Patient Documents m m
SCRATCH bl 0.66 KB

Dacument Type * Crther w

Greated Date/Time *

031472023 il
1226 PM ED t_}
Requested By Select v
Motas Sample

Maximum file size 20 MB

SELECT FILES

Reviewsd

e Enter metadata for the document.
e Select SELECT FILES, browse for and select a file, and then select Open.

5. Select SAVE.

View approved reports
Procedure

1. Go to Worklist > Edit Study screen > APPROVED REPORTS to open a window and display the
report.

Result: If an approved report is available, it opens (may take time).
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L1 Test, Brad (Acc#:Tes81113), 01,/01,2000 , M, 237
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Tochniqua: P&, abigue and el vews ol the  Ford e subimfied
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Prior Siudsas
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Open the transcription screen

Use this procedure to open the transcription multipanel from the Edit Study screen.

Procedure

1. Go to Worklist > Edit Study screen > TRANSCRIPTION to open a window and display the

transcription editor within the multipanel.
Test, Laura (MR TesL4:

at Test, Laura (Acc#:Tesl - Accession No: 167, Modality: CT, Study Date:

OO fustoctipen Evn Trana Study Description: 30 RMDR ISR CT MBI L

‘_;C_".\ Skip
U Aggaeren & Nl

WO, ke Temupleres i
Repat =

Forduwal inaigan
artdeal Wi poieil TR,

Exaen: RADIQGGRAPH OF THE __ HAND

See also:

Dictation and transcription with WebTrans
Dictation and transcription with Exa Trans and Dragon
Dictation and transcription with Exa Trans and nVoq
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Manage other physicians

You can add or delete other physicians (ones other than the primary, referring, or reading physicians)
who are associated with the current study.

Procedure

1. Go to Worklist > Edit Study screen > OTHER PHYSICIANS.

LU Test, Laura (Acc¥:Tesl43), 07/07,/2000 , F 22Y

STUDY ; A0 RRDE 168 CT MR USAITH AR POSTACE
TFFECE Mo

LI DL AL EE KOHLEHO

L FREF Tt Aeferag Y i Aghealy 70 Ean AR iy IREN]

2. Optional. To add a physician, in the Select Other Physician dropdown list, select a physician.

3. Optional. To remove a physician, select the trash i button.

Enter notes and reasons for study

You can enter patient notes, study notes, schedule notes, and reasons for the patient’s studies.
Generally, you can use: patient notes for patient specific information; study notes for basic study history
or notes from technologist to radiologist; schedule notes for messages from the front desk; and reason
notes for more specific study history.

A

Notes are permanent, and may be visible to the patient.
Procedure

1. Go to Worklist > Edit Study screen > NOTES.
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.E:L Test, Laura (Acc#: TesL43), 01/01,/2000, F, 22

ETUDY - 30 RNDR IER CT ME] UENETH

ETUDY BITES PATIENT NOTES SCHEDWLE MOTES REASOM FOR STUDY CALL LOG

DATETIRGE 5 SN KOSER

o Wik Pacs CEArTOUOR Y 1055 AM EST dy Bl A, ey enilires

2. Select the PATIENT NOTES, STUDY NOTES, or SCHEDULE NOTES sub-tab.
3. Select ADD, type notes, and then select SAVE.

STUDY NOTES PATIENT NOTES SCHEDULE NOTES REASON FOR STUDY

CALL LOG
Wser Virtek, Pac
Date/Time 13 52023 AhA E
Nates ~ Patient requested a second opinion.
4. Select the REASON FOR STUDY tab.
STUDY NOTES PATIENT HNOTES SCHEDULE NOTES REASOM FOR STUDY CALL LOG

Reason for Study Patient complained of chronic headaches.

5. Type reasons in the box, and then select SAVE.
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Update the patient call log

You can use the call log to save a record of communication to and from a patient regarding an
appointment or order. The worklist has columns for displaying the following information that you enter in
the call log: last call made, last call category, and last call notes. To update the call log:

Prerequisite: Add call categories (see App settings).
Procedure

1. Go to Worklist > Edit Study screen > NOTES.

FA Test, Laura (Acc# Tasl43), 01/01/2000, F, 22¥

ETUDY BITES

PATIENT NOTES SCHEDWLE MOTES REASOM FOR STUDY CELL LG

= DATETIRGE 3 SO KOCEE.

o Wik Pacs CEArTOUORE 1055 AM EST dy Bl A, ey enilires

2. On the CALL LOG sub-tab, select ADD.

STUDY NOTES PATIENT MOTES SCHEDULE NOTES REASOM FOR STUDY CALL LOG
Usﬂr ._I"..-.E i' CH
Date/Time 03/18/2023 5:48 AM ED
Call Category * Schedule W
Call note = Don't schedule on Wednesdays.

3. In the Call Category dropdown list, select a call category.

4. Inthe Call Note box, type notes, and then select SAVE.
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Enter employment and transfer-related information

You can enter various information on whether the illness or injury was employment-related, the dates of
illness, work absence, and hospitalization. You can also enter information related to the source of a

transferred patient.

Procedure

1. Go to Worklist > Edit Study screen > ADDITIONAL INFORMATION.

1':_'1. Test, Lowra (Acc#Tesl43), 07/07,2000 , F 22

- ETUDY : 30 RADS 1R8O MR CS50TH REQ POSTRCH. -

Pariksais Coratiton 1a Bebrisd i Binrca

[ Emplayman [ auin Arrives L] s seeidam

O Ousdaish

Elam Awshonzshon

2. Enter the information as needed and then select SAVE.

Assign or remove patient alerts

Adeikr S
i ol Elegrs Orsat, Infuerprdolosar, o Pragrancy [LMP]:
Do E
Chis Cirls
Dates Paiiant Urakls bo Wark at Cemest Sccupstion:
W Ta ]
urbis Patiens Hobaitalined Refaned o Dameal Semies
ramd T i3] T
5 hamdude M

A Failure to add a needed patient alert could result in incorrect treatment or diagnosis.

You can assign or remove alerts for a patient.

Procedure

1. Go to Worklist > Edit Study screen > PATIENT ALERTS.
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i:'-,? Test, Laura (Acc+#:TesL43), 01/01/2000 , F, 22¥

B Balancn Dus

B 7 Contrast ABsegy
O Falt tart

MR Comtrast Alengy
Hama Alar

Patient Clausiraphekiz
Fatient has pacemaker

PFatlent ls combatie

Ooooooao

Patient needs physical axsistance

2. Select or clear the checkboxes corresponding to the alerts that you want to assign or remove.

3. Optional. To create a new alert, type it in the Custom Alerts box and then select the plus
button.

4, Select SAVE.

Add allergy information
If your facility uses Rcopia, you can add information about a patient's allergies.
Procedure

1. Go to Worklist > Edit Study screen > ALLERGIES.
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[\" Test, Laura (Acc#:TesL43), 01/01/2000 , F, 22Y

ALLERGY DESCRIPTIO ALLERGY GO0 REACTION

Mo records found

ALLEROIES

PROOLTMS

2. Select ADD, and then add the information as needed.

3. Select SAVE.

View problems
You can view problems associated with the study.
Procedure

1. Go to Worklist > Edit Study screen > PROBLEMS.
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I:'L? Test, Laura (Acc#:TesL43), 01/01/2000 , F, 22Y

Wl CODE CESCRIPTION

Mo regords found

View prior studies and add a new study

You can view a list of prior studies for a patient, and view reports attached to the priors. You can also
start the workflow to add a new study from this part of the Edit Study screen.

Procedure

1. Go to Worklist > Edit Study screen > STUDIES.

A7 Test, Loura (Aco&TesLa3), 01/01/2000 , F 22Y

FTRIGY | A0 BHOU IR0 CT Wb U0 TH BEQ pbETee. - FILGES

HEWETUDY

DEOM SCFEIFAL OS7E & OFFGE RODALTTY AMOTMLITY NGO ACTESTION b ETULNEEETAINTON PRI
Wareldla Segi Facikyy A o Recpeag Fasm Cxds
Lo R o L 188 Febpntiins]) B CHla
Firrnfn Soat Facitdy (=] LLad 10 FHDA MECT MMLSOTH Crdw
[ Firrnin Tt Faciby [} o) 50 FRIA BRECT WS oTh (e
I e Tran B T P T m ). BB D50 VELGSRAETHY I U 2 i BT e Sl S
o ANTRI 03T 2 FH Fareda Tat Fac By AN Xy o1 0 FHDN BE G7 HE VS OTHAASF ST LEVERT D0 M Sche-
¢ QN2 5303 3 %ol AN el n Tt Facikoy & =i Scund =0 A0 FHDR MR CT MR UROTH =
Ho PRI IR 11 el Raredla St Facdy (1 Ry S0 PR G R ST A
[ AUTTIIIE TN P e Sl Faodly (- T SO e [0 LCHD FTL FLSD GFECTE Fim
L] CLTIEOE 1l Fhl Flrrale Tecd Faciliy CE R ==1) A0 RHDA BRE CT W UE0Th Schm
i T A b el Rarvedle T Fag iy us (5P RT kS D VELERETHY FTL v Hoha

2. Optional. If a prior study includes reports, select the reports & button on the study row to open
the reports.
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3. Optional. To add a new study, select NEW STUDY and then see Set up a patient.

About custom forms and study forms

Custom forms have basic formatting options, and cannot accept electronic signatures. Study forms have
more advanced formatting options, and can accept electronic signatures.

Add a custom form to a patient record

You can open a custom form template, fill it out, save the completed form to the current patient record,
sign it electronically, fax, and print it.

Prerequisite: Create a custom form.

Procedure

1. In the worklist, select the edit button of a study.
2. Inthe Edit Study screen, on the left pane, select CUSTOM FORMS.

£ Test, Laura (Acc#-Test43), 01/07,/2000, F 22¥

3. Inthe Select Custom Forms dropdown list, select a form to add it to the forms table.

4. To view, modify, or sign a form, select the form Ej button in the table.

5. Optional. To add an electronic signature, select SIGNATURE, enter signature information, sign
by drawing with the mouse, and then select SAVE.

Note: To make electronic signatures available, add a signature merge field when setting up the
form.

6. Optional: To print the form, select PRINT.
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7. Optional: To fax the form, select FAX, select the recipient physician, enter optional information
under Other, and then select SEND FAX.

Add a study form to a patient record

You can open a study form template, fill it out, save the completed form to the current patient record,
sign it electronically, and print it. You can also make forms available on the patient portal so that they can
fill them out before an appointment.

Prerequisite: Create a study form.

Procedure

1. Go to Worklist > Edit Study screen > STUDY FORMS.

| | Fosren Homa Slgned By

0O & |# EKGWorkehest

E STUDY FORMS

2. Inthe Select Study Forms dropdown list, select a form to add it to the forms table.

3. To view, fill in, or sign the form, double-click it in the table.
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CT Screening Form b,

ADD SIGNATURE mm SAVE TO PATIENT DOCUMENTS

Computed Tomography (CT) Screening

PATIEMT:Eric Test
DOB:01/01/2000 MRN:TesE1077
ACCESSION:1192

REFERRING PHYSICIAN: Referring Test

CHIEF COMPLAINT/REASON FOR STUDY:

[ Mo [] Yes Isyour reason for this explain related to an injury? Date of injury:
How wera you injured? [ Mva [ work [ Gther
4. Fillin as necessary, and then select SAVE.

5. Optional. To add an electronic signature, select ADD SIGNATURE, enter signature information,
sign by drawing with the mouse, select SAVE or SAVE TO PATIENT DOCUMENTS, and then
close the signature dialog.

6. Close the form.
7. Optional: To print forms in the list, select their checkboxes and then select PRINT SELECTED.

8. Optional: In the forms table, next to the Patient Portal column header, select the checkbox to
make the forms available in the patient portal.

See also:

Draw on a study form image

Draw on a study form image

While filling out a form, you can draw basic shapes on any images included in the form.
Prerequisite: Create a study form

Procedure

1. Go to Worklist > Edit Study screen > STUDY FORMS.
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| Fosren Homa Slgned By

0O & |# EKGWorkehest

E STUDY FORMS

2. Double-click the form name to open it.

2. Hover over an image on the form to display the drawing toolbar.
COO0Ox+ 1M

12 345 6 7
Do any of the following:

Select Color Picker (7) and then select a color to apply to items that you draw.

Select Rectangle (2), Ellipse (3), and then drag on the image to place the shape.

Select X-Stamp (4), and then click to place the stamp.

To edit a shape, select Select (5), select the shape, and then drag to move the shape, or
drag the shape’s handles to resize.

e To delete selected shapes or stamps, select them and then select Delete (6).

e To delete all shapes and stamps, select Clear (1).

See also:

Add a study form to a patient record

Specify a follow-up exam

If a patient needs a follow-up exam, you can specify the need for the follow up and the general time
frame. To schedule follow-up exams, see Schedule a follow-up.
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Procedure

1. Go to Worklist > Edit Study screen > FOLLOW UP.

L0 Test, Lnura (Acc®TesLA3), 01/01/2000 , F 227

Frdlems [P st vty

m]

o Py u) wh bl g lgal
B Finding

[m]

o Tty g ST gl L

2. Inthe Follow Up column, select a reason for the follow-up.
3. In the Next Follow-Up column, select a time horizon for the follow-up.

4. Select SAVE.

Refer a patient
You can refer a patient to a provider, and view existing referrals.
Procedure

1. Go to Worklist > Edit Study screen > REFERRALS.
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L\* Test, Laura (Acc#:TesL43), 07/01/2000 , F, 22Y

REFER TD REFERRING PROWIL

e records found

2. Inthe upper-right part of the editing pane, select ADD.

ipecialty * General Surgery b
.EE"-E'"IHQ F‘hysl:.:ii.irl * Salest Rat, Phyaician
{iefarral Mo * -sas

Jate 0a/1s/2023 &
Hotes

1 Summary of Care Provided | MM/DDSYYYY |
1 Electronically Transmitted MM/ YY Y &
J Transition of Care Out hAkA/LTYY Y'Y B

DOWNLOAD CCDA m

3. Enter referral information and then select SAVE.
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4. To send the referral to the provider, select SEND, enter message information and attach
documents, and then select SEND.

View activity logs
You can view a log of program activity and export the log to Excel.
Procedure

1. Go to Worklist > Edit Study screen > ACTIVITY LOG.

L4 Test, Laura [Aced:Tesl 43), 0107/2000, F 22Y
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2. Change the range of dates to filter the activity that you want to view.
3. To view details of an entry, double-click the entry.

4. Optional. To export the longs, select EXPORT TO EXCEL.
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Exam screen for technologists
Users signing in with a technologist user account see a technologist-specific version of the Edit Study

screen that helps them work more efficiently. To open the screen, select the edit button in a worklist
study row.

Censusl4, Censusf4 - 01/01/1999 - CenC103 L E3ER

1236

Appointment Type
Body Part Select w

Crientation Select W

Scheduled Date

r 1 e
Duration minitae

Study Girder Sxiely Nojtex

I eeation

Exam screen for technologists: top left (left) and top right (right)

See also:

Configure a technologist
Use the exam screen for technologists

Use the exam screen for technologists

To use the exam screen for technologists (the Technologist screen):

Prerequisites: Configure a technologist.

Procedure
1. Signin to Exa PACS/RIS as a technologist or a user linked to a technologist.
2. Select the edit button in a worklist study row.
Result: The Technologist screen opens.
3. Near the upper-left part of the screen, select a study tab (an accession number).

4. Proceed with technologist workflow, using the settings and tools described in the following table.

E] View patient alerts.
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Appointment Type If the original appointment type was incorrect or otherwise changed
after scheduling, you can select a new one.

Note: It may be necessary to authorize all or parts of any new
appointment type you select.

[Other settings] Select as needed.

TECH START/END Select upon starting and ending the exam. Exam duration statistics
are recorded based on the times these buttons are selected, and are
used in reporting.

TECH PAUSE Select when an exam is interrupted, such as by a difficult patient.

UNREAD Select to reset the study's status to Unread.

Notes (Study, Schedule, Patient, | Select a category of note, and then type notes. If macro notes were
Reason) configured (see Configure macro notes), you can select them from
the dropdown list.

ABORT Select to abort the exam, such as in an emergency.

5. Select SAVE.

6. Optional. In the lower-right part of the screen, select one or more of the following.

Documents Select to view or add documents to the study or order.

See Scan to a patient.

Studies Select to view a list of prior studies for the current study. Opens the
STUDIES tab of the Edit Study screen.

Study Forms Select to add, edit, or delete study forms from the study.

Opens the STUDY FORMS tab of the Edit Study screen.

Add Charges Add new charges to an exam (see Add charges and NDCs in the exam
screen for technologists).

7. Select SAVE.

Add charges and NDCs in the exam screen for technologists

Technologists can add charges to an exam if needed for such things as when contrast is used. The
charges correspond to CPT codes, and any associated NDC codes.

Procedure
1. Open a study in the Technologist screen, and then select Add Charges.

2. Inthe Add Additional Charges dialog, select ADD CHARGE.
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3. Inthe CPT Code column, select the CPT code for the additional charge.

Note: Alternatively, you can select the CPT Description.

4. Optional. In the NDC column, select the add [+ button, and then search for a code to add in the
Search NDC Codes list.

5. Modify the following settings as necessary.

NDC Package Code Type the code from the manufacturer.

Strength Type the strength of the active ingredient, then select the units of
strength in the list.

Unit of Measure Type the unit of measure.

Lot Number Type the lot number of the drug.

Amount Used Type the amount of drug administered.

Route Select the administration method for the drug.

Needle Gauge If a needle was used, select the gauge.

Reaction Select if any reaction occurred.

Package Description Type the description of the package from the manufacturer.

Labeler Name Type the name of company corresponding to the labeler code

segment in the Product NDC.

Expiration Date Type the expiration date of the drug.

Units Type the number units (e.g. vials) used.

Admin Site Select the site where the drug was administered.
Administered By Select the person who administered the drug.

6. Select SAVE.

See also:

Use the exam screen for technologists
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Dictation and transcription with Exa Trans and nVoq

With Exa Trans, you can dictate and transcribe simultaneously with nVoq voice recognition. One
advantage of nVoq is that it is a "zero footprint" solution for higher performance. Alternatively, you can
dictate findings in Exa Dictation and transcribe them manually. If your implementation of Exa PACS/RIS
offers nVoq, the Dragon feature is not available. Before using nVoq with Exa Trans, you must:

e Obtain account credentials from the nVoq website, or Create an nVoqg user account.

e Configure an nVoqg user account.

Turn on Exa Trans and nVoq
You must turn on Exa Trans and nVoq before using them.
Prerequisite: Install Exa Trans.

Procedure

1. On the worklist, select the settings E button, and then in the button shortcut menu, select User
Settings.

2. On the right side, under Voice recognition, select nVoq (Exa Trans).
3. Select SAVE.

4. Sign out of Exa PACS/RIS, and then sign in again.

Create an nVoq user account
To create an nVoq user account from within Exa Trans:
Prerequisite: Turn on Exa Trans and nVoq.
Procedure
1. In the worklist, find an unread study and select its transcription button.
2. In Exa Trans, on the nVoq Options tab, select Account.
3. Inthe Account dialog, on the right pane, type account information, and then select Save.
4. Configure your account in Exa PACS/RIS.

See also:

Configure an nVog user account
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Configure substitutions

You can add substitutions (voice macros) to nVoq.

Prerequisite: Turn on Exa Trans and nVoq.

Procedure
1. In the worklist, find an unread study and select its transcription button.
2. In Exa Trans, on the nVoq Options tab, select Add New Substitution.
3. Optional. To view previously saved substitutions, select Substitution List.
4. In the New Substitution dialog, enter the following settings.

Level Select Account to make the substitution available only to you. Select
Organization to make the substitution available to all.

Spoken Type the voice macro command (the word or phrase spoken to activate
the substitution).

Description Type a description of the substitution.

Written Type the text that nVoq substitutes (inserts) when the voice macro
command is spoken.

5. Select Save.

Configure vocabulary

You can add words and phases to nVoq's vocabulary for better recognition.

Prerequisite: Turn on Exa Trans and nVog.

Procedure

1. In the worklist, find an unread study and select its transcription button.
2. In Exa Trans, on the nVoq Options tab, select Vocabulary.
3. In the Vocabulary screen, select one of the following:

e Account - The current vocabulary is available only to the current user.
e Organization - The current vocabulary is available to all users in the facility.

4. In the Written box, type a word or phrase.
5. In the Sounds Like box, type pronunciation.

Note: Usually leave this blank. Try adding pronunciation if nVoq frequently fails to recognize the
word or phrase.
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6. Select Save.

Dictate and transcribe a study

With the integrated nVoq application, you can use Exa Trans to dictate and transcribe findings
simultaneously. If you pause dictation, during the next 30 seconds you can use voice commands or
resume dictation without losing the connection to nVoq. After the 30 seconds, dictation "stops," and the
connection closes. To dictate multiple studies at once, see About Linked Reporting.

Prerequisite: Turn on Exa Trans and nVog.

Procedure

1. In the worklist, find an unread study and select its transcription button.
2. Inthe Exa Trans window, in the Templates dropdown list, select a template.

3. Press the button on the microphone, and then begin dictating. Press the button again to
pause/stop.

Note: You can also select the dictation ® button in the bottom-right corner of the screen to start

recording, and 9 to pause.

4. Optional. To view the hypothesis during dictation, select the Show Hypothesis link.

5. Select Save.

Use voice commands

When using nVoq in Exa Trans, in addition to substitutions, you can use the voice commands described in
the following table.

[voice macro command] Runs the pre-configured voice macro to open a transcription template.

Select [word or phrase] Selects words and phrases.

Example: Say, "Select cardiac arrest" to select the word "cardiac" followed
by the word "arrest."

Select [word] through [word] Selects a range of words

Example: Say, "Select food through department" to select the phrase "food
and beverage department.”

Next variable Selects the next set of brackets within the report and their contents.
Next field
Previous variable Selects the previous set of brackets within the report and their contents.

Previous field
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Scratch that If text is currently selected, deletes the selection. If text is not currently
selected, deletes the previously transcribed phrase. Repeat the command to

Delete that delete the 10 most recently entered instances of stable text.

Undo Undoes the 10 most recent user actions, including dictation of text or use of
other voice commands (same as the Windows Undo command).

See also:

Add a transcription template

Edit and approve transcriptions
You can edit and approve saved transcriptions.

Note: If approving a main study, any activity related to TAT recording affects any of its linked studies (see
About Linked Reporting).

Prerequisite: Turn on Exa Trans and nVogq.
Procedure
1. In the worklist, select the transcription button of a dictated study.
2. In the editing screen, review the transcription, make any needed changes, and then select Save.

3. Select e-Sigh & Approve, or Approve and Next.

Add a dictation or transcription addendum

After approval, transcriptions cannot be edited. However, physicians and transcriptionists can add
addendums in order to correct mistakes or insert new information.

Prerequisite: Turn on Exa Trans and nVog.

Procedure

1. In the worklist, select the transcription button of an approved study.

2. To add a dictation addendum, repeat the steps in Dictate and transcribe a study.
Exa PACS/RIS reverts the status of the dictation from Approved to Dictated.

3. To add a transcription addendum, select Add Addendum.

4. Type new text, and then select Addendum Save.

5. Select Addendum Submit for Review.

Exa PACS/RIS reverts the status of the dictation from Approved to Transcribed.
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Dictation and transcription with WebTrans
You can dictate findings in Exa Dictation and transcribe them in Web Trans. Web Trans features a
multipanel interface with advanced functionality.

See also:

Dictation and transcription with Exa Trans and Dragon
Dictation and transcription with Exa Trans and nVoqg

Turn on Exa Dictation and WebTrans

Depending on your installation configuration, you must turn on Exa Dictation and Web Trans before using
them by following these steps:

Prerequisite: Install Exa Dictation.

Procedure

1. On the worklist, select the settings E button, and then in the button shortcut menu, select User
Settings.

2. On the right side of the screen, under Voice recognition, select Dictation.

3. Select SAVE.

Dictate a study

The Web Trans transcription editor does not currently support dictation, but radiologists can use the
following procedure to record dictation without simultaneous transcription (while Dragon is OFF). This

feature uses a dictation toolbar $KPRL with record, rewind, play/pause/stop, fast forward, and
upload buttons.

Procedure
1. In the worklist, double-click an unread study to open it in the viewer.

2. Select a template from the dropdown list, or use a voice macro to open it.

3. On the dictation toolbar, select the record kil button, and then dictate your findings.
Note: If needed, you can select pause during dictation.

4. When finished, select the stop button.

5. To review your dictation, rewind the recording and then select the play button.

Note: You can record over parts of your dictation that you want to change.
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6. When you are satisfied with the results, select the upload button to add your dictation to the
study.

Note: Skip this step if you selected Auto Upload Dictation on Close.

See also:

Add a transcription template
Configure autosave options

Open and organize WebTrans

The WebTrans window contains dedicated panels for managing transcription, notes, documents, and
prior reports.

Prerequisite: Turn on Exa Dictation and WebTrans.
Procedure
1. In the worklist, find an unread study and select its multipanel transcription B3 button.

2. Inthe WebTrans multipanel, on the toolbar, select one or more of the following buttons:

1 2 3 4 5
1 Open or close all panels
2 Open or close the Notes panel
3 Open or close the Documents panel
4 Open or close the Prior Reports panel

3. Drag panels within the WebTrans screen to reposition them.

Edit and approve transcriptions in WebTrans

The WebTrans transcription editor does not currently support dictation playback, but you can edit and
approve submitted transcriptions.

Note: If approving a main study, any activity related to TAT recording affects any of its linked studies (see
About Linked Reporting).

Prerequisite: Turn on Exa Dictation and WebTrans.
Procedure

1. On the worklist, in the relevant study row, select the multipanel EH button.
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In the Transcription editor panel, review the transcription, make any needed changes, and then
select Save.

Select Approve or Approve & Next.

In the Providers dialog, select the approving provider and select Approve.

Enter notes in WebTrans

You can add study notes and reasons for study in the Notes panel of WebTrans.

Procedure

1.

2
3
4.
5

On the worklist, in the relevant study row, select the multipanel B3 button.
In the multipanel, open the Notes panel.

In the Notes panel, select the STUDY NOTES or REASON FOR STUDY tab.
If entering a study note, select a study date.

Type notes in the space provided, and then select SAVE.

Manage documents in WebTrans

You can view all documents attached to a study in the Documents panel of WebTrans. The Documents
panel displays up to two documents at once, and you can select which documents to display.

Procedure

1.
2.

On the worklist, in the relevant study row, select the multipanel B3 button.

In the Documents panel, select the document buttons to show or hide currently open documents
in viewing frames.

m ID CARD REPORTS

The buttons labels indicate the document selected for viewing, the default document type set by
the user in the panel, or the last-viewed document types

If more than two documents are available, you can open a new one by dragging a document
metadata block from the top of the panel into a document viewing frame.
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Manage prior reports in WebTrans

You can view, download, and print prior reports from the Prior reports panel of WebTrans.

Procedure

1.
2.

On the worklist, in the relevant study row, select the multipanel B button.

In the Prior reports panel, in the left pane, select the block of metadata corresponding to the
report that you want to view.

To download or print the report, in the right pane, hover over the report, and then select the
download or print button in the toolbar that appears.
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Dictation and transcription with Exa Trans and Dragon

With Exa Trans, you can dictate and transcribe simultaneously with Dragon voice recognition.
Alternatively, you can dictate findings in Exa Dictation and transcribe them manually. If your
implementation of Exa PACS/RIS offers Dragon, the nVoq feature is not available. To use the features of
the Exa Panel for transcription related tasks, see Dictation and transcription with WebTrans.

Turn on Exa Trans and Dragon

You must turn on Exa Trans before using it by performing the steps that follow. You turn on Exa Trans
indirectly by turning on the Dragon speech-to-text option in the user settings.

Prerequisite: Install Exa Trans.

Procedure

1. On the worklist, select the settings E button, and then in the button shortcut menu, select User
Settings.

2. On the right side, under Voice recognition, select Dragon.

3. Select SAVE.

Dictate and transcribe a study

With the integrated Dragon speech-to-text application, you can use Exa Trans to dictate and transcribe
findings simultaneously.

Prerequisite: Turn on Exa Trans and Dragon.
Procedure
1. In the worklist, find an unread study and select its transcription button.
2. Inthe Exa Trans window, in the Templates dropdown list, select a template.

3. Optional. To use a voice command, with the Templates dropdown list open, say, “Macro
[template name].

4. Place the cursor where you want to add text.

5. On the Dragon toolbar, select the record = button, and then begin dictating.
Select stop when finished.

6. Select Save.
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Edit and approve transcriptions

You can edit and approve saved transcriptions. If approving a main study, any activity related to TAT
recording affects any of its linked studies (see About Linked Reporting).

Prerequisite: Turn on Exa Trans and Dragon.
Procedure
1. In the worklist, select the transcription button of a dictated study.
2. In the editing screen, review the transcription, make any needed changes, and then select Save.

3. Select e-Sigh & Approve, or Approve and Next.

Add a dictation or transcription addendum

After approval, transcriptions cannot be edited. However, physicians and transcriptionists can add
addendums in order to correct mistakes or insert new information.

Prerequisite: Turn on Exa Trans and Dragon.

Procedure

1. In the worklist, select the transcription button of an approved study.
2. To add a dictation addendum, repeat the steps in “Dictate a study.”
Exa PACS/RIS reverts the status of the dictation from Approved to Dictated.
3. To add a transcription addendum, select Add Addendum.
4. Type new text, and then select Addendum Save.
5. If not using Dragon, select Addendum Submit for Review.

Exa PACS/RIS reverts the status of the dictation from Approved to Transcribed.

About using Exa Trans and WebTrans

Exa Trans and WebTrans (with the multipanel) are designed to work in sync. Exact behavior depends on
various user rights, actions, and settings, as in the following examples.

Close Exa Trans Also closes WebTrans
WebTrans rights assigned WebTrans available
Exa Trans rights assigned Exa Trans available only if the Dragon user setting is also turned ON.
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Action/ Condition

Auto-Open Orders + “Documents” If an order auto-opens, the Documents screen auto-opens.
selected
Auto Open Orders enabled AND Documents auto-open in the Documents screen of the multipanel in Monitor

Viewer Settings > General > Display | 1.
Settings > Monitor 1 = Documents

Auto Open Orders disabled AND Documents do not auto-open, but if manually opened, they open in the
Viewer Settings > General > Display | multipanel in monitor 1.
Settings > Monitor 1 = Documents

Exa Trans and WebTrans enabled Exa Trans and WebTrans both open when an order auto-opens.
within Auto Open Orders
You can configure which monitor they open in in the Display Settings, or
leave blank to open in the main monitor.

Exa Trans set to auto-open AND Only Exa Trans opens when a study opens (but you can still manually open
WebTrans not enabled in Auto Open | WebTrans).
Orders

Set Exa Trans or WebTrans to open Manually opening Exa Trans or WebTrans opens it in the specified monitor.
on a specified monitor

WebTrans set to auto open in Auto WebTrans auto opens when the viewer is opened, in the specified monitor, if
Open Orders, but not Exa Trans so configured.

User selects the Exa Trans or Exa Trans or WebTrans opens on the same monitor as the worklist.
WebTrans button on the worklist

Exa Trans Study is approved, viewer closes, Exa Trans minimized.

Esign & Approve

Exa Trans Study is approved, viewer and Exa Trans open with next available study.

Approve & Next

Exa Trans Study status changes to Not Approved, viewer closes, and Exa Trans
minimizes.
Not Approve

Exa Trans Study stays in Unread status, viewer and Exa Trans open with the next
available study

Skip

Exa Trans Study status changes to Draft, viewer and Exa Trans remain open with
current study

Save

Exa Trans Study status changes to Pre-Approved, viewer closes, and Exa Trans
minimizes

Pre Approve

Exa Trans and WebTrans Exa Trans closes, WebTrans minimizes or closes

Esign & Approve

Exa Trans and WebTrans Study status changes to Approve, viewer, Exa Trans, and WebTrans open

with the next available study
Approve & Next
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Exa Trans and WebTrans Study status changes to Not Approved, viewer, Exa Trans, and WebTrans
minimize or close.
Not Approve

Exa Trans and WebTrans Study status remains Unread, the viewer, Exa Trans, and WebTrans open the
next available patient or study.

Skip

Exa Trans and WebTrans Viewer, Exa Trans, and WebTrans remain open. If the user closes the viewer,
Exa Trans and WebTrans also close.

Save

Exa Trans and WebTrans Study status changes to Pre-Approved, viewer and WebTrans close.

Pre Approve
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QC operations

All DICOM studies from other AEs initially appear on the QC tab, and are automatically evaluated for
conflicts with PACS studies, RIS orders, and other data based on user-defined receiver rules. The topics in
this section describe how to resolve conflicts.

See also:

Understanding receiver rules

Prepare the QC tab

When received studies fail to match studies in the database, they appear on the QC tab of the worklist.
To find conflicts needing reconciliation more easily, you can sort studies in the QC tab of the worklist by
their QC status.

Procedure
1. On the worklist, select Settings > User Settings.
2. Under User Settings, select Show QC.
3. To show exams in Completed status, select Show Completed in Pending List.

To show exams in Confiict status only, clear the checkbox.

4. Select SAVE.

5. On the worklist, select the QC tab.

6. On the search bar, click inside the STATUS box.

7. Select a status (such as “Conflicts”) and select APPLY FILTER.
See also:

Reconcile conflicts by matching to a RIS order
Reconcile conflicts by manually editing demographics
Reconcile conflicts by creating an order

Move QC studies to the All Studies tab

Reconcile conflicts by matching to a RIS order

When received studies fail to match studies in the database, they appear on the QC tab of the worklist.
To reconcile conflicts, start by trying to match the conflicting study to a RIS order.

Prerequisite: Prepare the QC tab.

Procedure

1. On the worklist QC tab, find a study whose status is Conflicts, and select the "reconciliation dot."

500-000594A 294



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

L [ - - - DECrdUL RULD
+ H“ £ ! DEFAULT RULE
+ /7 @ & ® i DEFAULT RULE

2. In the Reconcile dialog, under Suggestions, if an order in the list matches the Current Study,
select its SELECT button, and then select OK. If no suggestion matches, skip to the next step.

Result: The conflict is reconciled.

3. Under RIS Orders, search for more potential matches by typing criteria in the search boxes. If a
match is found, select its SELECT button and continue as above.

Hint: Find patients in your EHR or other sources for possible matches.

See also:

Reconcile conflicts by manually editing demographics
Reconcile conflicts by creating an order
Move QC studies to the All Studies tab

Reconcile conflicts by manually editing demographics

When received studies fail to match studies in the database, they appear on the QC tab of the worklist. If
the conflict reason on screen is Multiple matches/Account# conflicts for patients, you can edit the
demographics of the conflicting study to match a patient in the Exa PACS/RIS database, or vice versa
(edit a patient in the database to match the conflicting study).

Prerequisite: Prepare the QC tab.

Procedure

1. On the worklist QC tab, find a study whose status is Conflicts, and select the "reconciliation dot."
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2. In Chrome, open another instance of Exa PACS/RIS, and on the burgerE menu, select
PATIENT.

3. Search for a patient chart that is likely to be the match for the conflicting study.

Hint: Find patients in your EHR or other sources for possible matches.

Starts With || all * [ show lnactive [ Break the Glass

123456

PATIENT SEARCH RESULTS

boost"breast - FIX_123456, 123456
DOB: 01/00/1900

BErowning, Patrick - 12345677128756
DOB: 02081977

Dental*Patient - 12345677, 12345677
DOB: 10/10/2000

FOOT*ULTRA - 123456, 123456
DOB: 04/05/2015

In the example, the MRN matches multiple studies -- select the correct one

4. Open the likely matching chart, edit demographics as necessary, and then select SAVE.
5. Confirm that the study no longer has a status of Conflicts.

See also:

Reconcile conflicts by matching to a RIS order
Reconcile conflicts by creating an order
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Move QC studies to the All Studies tab

Reconcile conflicts by creating an order

When received studies fail to match studies in the database, they appear on the QC tab of the worklist. If
you cannot find a RIS order that matches or should match a conflicting study, you can reconcile by
creating a new order that matches.

Prerequisite: Prepare the QC tab.
Procedure
1. On the worklist QC tab, find a study whose status is Conflicts.

Record demographics you need to create an order (patient demographics, MRN, study
information, etc.).

2. Create an order for the conflicting study by following the steps in A typical scheduling workflow.
3. On the QC tab, in the conflicting study’s shortcut menu, select Reconciliation.

4. In the Reconciliation dialog, under RIS Orders, find the order you just created and select its
SELECT button.

5. Confirm that the study no longer has a status of Conflicts.

See also:

Reconcile conflicts by matching to a RIS order
Reconcile conflicts by manually editing demographics
Move QC studies to the All Studies tab

Move QC studies to the All Studies tab
You can move a study in the QC tab to the All Studies tab without reconciling.
Prerequisite: Prepare the QC tab.
Procedure
1. In the worklist, select the QC tab, and then find a study that you want to move.
2. In the study’s shortcut menu, select Move to All Studies.

See also:

Reconcile conflicts by matching to a RIS order
Reconcile conflicts by manually editing demographics
Reconcile conflicts by creating an order
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Work with the Exa PACS/RIS viewer

Standard viewing tasks

Open a study in a viewer

In this manual, viewer refers to the Exa PACS/RIS viewer unless otherwise specified. To open a study, on
the worklist, do one of the following:

e To open in the Exa PACS/RIS viewer, select the E button of a study.

e To open in the Opal viewer, select the E button of a study.

¢ Configure Exa PACS/RIS to open studies in the viewer when you double-click them. Follow the steps
in “Miscellaneous user settings” to configure the double-click behavior setting.

YA

CAUTION: Check for the presence of the lossless indicator in the lower-left corner of the image frame
before proceeding with a diagnosis. If you adjust the image, wait until the lossless indicator turns green
before diagnosis.

The red lossless indicator means the image has not yet fully loaded.

View priors and prior reports
From the Exa PACS/RIS viewer, you can open priors from a list, open then from the prior bar, and open

prior reports.

Open a prior from a list

1. On the viewer toolbar, select the Show Prior List ﬂ button to open the list.

Other Patient Exams
Prior Patient Exams

R M Description Referring Exam Date Status
R US DOP VELOCIMETRY FTL UMBILICALART  Test, Referring 01/19/2023 11:15AM _ Approved
R* US ggﬁEEHO FTL SPECTRAL DISPLAY Test, Referring 01/19/2023 1100 AM  Approved

If an R appears in the R column, the prior includes a report. If the priors are linked:
R’ The report is the main report.

R* The report is a linked report (linked to the main report).
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2. Inthe list, double-click a prior to open it in the viewer.

View priors with the Prior bar

If priors are included in a study that you open, you can view them by using the Prior bar. To show the
Prior bar in the viewer, configure the Use Modified Toolbar setting (see Configure other interface

settings).

| 09M11/2015 10:47 AM 01/18/2018 3:35 PM
MG, MAMMOGRAPHY, MG, Standard
SCREENING DIGITAL TomoHD

| CURRENT 1¥Y5Mi6D

RCC LMI:$ RMLO CWIEWRC | BTC RCC

The Prior bar contains the current and prior studies on the top row, and their image thumbnails on
the bottom row (see figure). The study boxes show the age of the study, and depending on
configuration, let you do one or more of the following:

e Hover over a study to display its details.

e Select a study to open the thumbnail bar.

e Double-click a thumbnail to open its image or series (for example, the right box in the top row
of the figure).

e Ifareportisincluded, select its symbol to view.

Open a prior report

1. On the viewer toolbar, select the Prior Reports ﬂ button.
2. Inthe Approved Reports screen, on the left pane, select a prior report.
Result: The report appears in the right pane (may take time to load).

Note: If reports are linked, the link symbol appears (in the red circle in the figure).
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i Approved Reports - Google Chrome

A Not secure | btps//10.227.2693 /studyReports?study_id=1188&session_id=LV9GdnASTOdEOXNONGICZ1BiSUVQZON

=  TranscriptionHa... 1. i — 8% + ] o:)

%01/19/2023 11:00
Al

US. DOP ECHO FTL
SPECTRAL DISPLAY
COMPL

IKONICA MINOLTA

Medical maging

Patient Mame: Test, Ted Patient ID: TesT1004
@ /19/2023 10:45 ing Physician:  Test, ing Date of Birth: 01-Jan-2000
4 Procedure: DOP ECHO FIL PLSD SPECTRAL Date of Study:  18-Jan-2023 10:45

DISPLAY REPEAT STD,DOP AM;01/19/2023
VELOCIMETRY FTL UMBILICAL

ART,DOP ECHO FTL SPECTRAL

DISPLAY COMPL

Us, DOP ECHO FTL
PLSD SPECTRAL
DISPLAY REPEAT
sSTD

Test

About viewing CAD findings

The Exa PACS/RIS viewer automatically displays image markers contained in SR data from supported
manufacturers such as iCAD, DiA, Hologic (Malc findings, see below), and CureMetrix (such as the
CureMetrix mammography calcification and density markings). To control which markings to display,
select options in the SR CAD list (see Configure mammography).

Exa PACS/RIS uses tracking IDs in the SR data to ensure that when you click a 2D/synthesized image
annotation it jumps correctly to the corresponding 3D/BTO image. Additionally:

o Ifthe BTO series is not already open, it opens next to the 2D/synthesized view in a 1 x 2 layout. You
can go back to the original layout by selecting the backslash key (if the DM was not interrupted).

e When 3D CAD SR markings are present and you hover over a CAD SR marking on the synthesized or
2D view, the color changes to the hover color configured in viewer interface settings.

Hologic Malc findings

Hologic ImageChecker CAD has a finding type called a Malc, which is a combination of one
mammography breast density and one calcification cluster. When Malc findings are present in a CAD
SR, the Exa PACS/RIS viewer displays them as a “compass” shape. The center point marking of the
compass is determined by the center point of the child breast density. The total count of Malc findings
appears in the top overlay next to the count for densities and calcifications.
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The Malc “compass” marking and count

See also:

Configure annotation colors
View studies with CAD findings

View studies with CAD findings

The Exa PACS/RIS Viewer supports 2D CAD findings for mammography and 3D tomographic series.
Findings are displayed as overlays. To view CAD findings:

Prerequisites: Configure mammography (especially SR CAD options)
Procedure
1. Open a study containing CAD findings in the Exa PACS/RIS viewer.

Result: The CAD button becomes available.

2. Select the CAD m button, and then select findings to show.
Example: Calcification Clusters(3) > Show
3. Optional: Select a finding to select a value for the 2D or synthesized view.

Result: The screen changesto a 1 x 2 temporary view with the 2D image in one cell and the BTO
series moved to the slice with the finding in the other. For example, if you select the RCC finding,
the BTO series opens at the RCC slice.

CAD-related keyboard shortcuts

To easily move through series that include 3D CAD findings, you can use keyboard shortcuts (see
Assign toolbar keyboard shortcuts). For example, you can use a keyboard shortcut to jump to the
next finding in a BTO study, or turn Malc markings on and off.

See also:

About viewing CAD findings
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View priors with the Prior bar

If priors are included in a study that you open, you can view them by using the Prior bar. To show the
Prior bar in the viewer, configure the Use Modified Toolbar setting (see Configure other interface
settings).

09/11/2015 10:47 AM 0171872018 3:35 PM

MG, MAMMOGRAPHY, MG, Standard Screening -
SCREENING DIGITAL TomoHD

|| CURRENT 1YSM16D

LMI$ RMLO CVWIEWRC BTO RCC
; ;

The Prior bar contains the current and prior studies on the top row, and their image thumbnails on the
bottom row (see figure). The study boxes show the age of the study, and depending on configuration, let
you do one or more of the following:

e Hover over a study to display its details.

e Select a study to open the thumbnail bar.

e Double-click a thumbnail to open its image or series (for example, the right box in the top row
of the figure).

e Ifa reportisincluded, select its symbol to view.

Send an image from the viewer

You can send the current image in the viewer to an application entity. If the image includes annotations,
those annotations are included with the image according to the method you specify in the Send
Annotations as setting (see Configure application entities).

Procedure

1. Optional: To send an annotated image back to its original AE, select Viewer Settings > General
> Auto Send Annotated Images on Close.

2. Open an image in the viewer.
3. Optional: Add annotations.
Note: ROI annotations are automatically sent as weighted.

4. Right-click the image and select Send Image/Annotation.
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5. In the Send Study dialog, in the bottom pane, select one or more AEs.

6. Select SEND TO SELECTED or SEND TO ALL.

DICOM-print a study

You can print the currently viewed image to a preconfigured DICOM printer. The current image prints,
including any displayed annotations and overlays.

Note: You cannot print multiframe MR/CT or MG tomography images, or US echocardio series.

Prerequisite: Add the DICOM Print command to the shortcut menu (see Add or remove tools from the
image shortcut menu).

Procedure
1. Open a study in the Exa PACS/RIS viewer, right-click any image, and then select DICOM Print.
2. Inthe DICOM Print dialog, in the Printer dropdown list, select a printer.
3. Enter the following remaining settings.

Annotations Select to include annotations, or clear to exclude.

WY/L (Default) Select to print the image with its original window/level settings. Clear to
select the current window/level setting.

Overlay Text Select to include the DICOM overlay (as per-image detail), or clear to
exclude.
Selected Image Select to print the selected image, selected series, current page of images,

or all images.
Selected Series

Current Page

All Images
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Prev / Next

Select to move through pages of the print preview.

Printer

Select a printer (selected earlier in this procedure).

Configuration

Select a printer profile.

4. Select DICOM Print.
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Configure the viewer

In the Viewer Settings dialog, you can configure a wide variety of viewer options including display,
interface, modality, toolbars, and shortcut menus. For details on operations in the Viewer Settings dialog,
see other topics in this section. There are two ways to open the Viewer Settings dialog.

e Inthe worklist, on the upper toolbar, select the settings - button, and then in the button
shortcut menu, select Viewer Settings.

e Inthe Exa PACS/RIS viewer, in the upper toolbar, select the setting - button.

Viewer Settings

GENERAL ) )
Display Settings
INTERFACE Monitors on System 3 RCY
Monitor Current Prior Full Screen Orders Type
MODALITY
[J DISPLAY1 @] @) a None v
MAMMOGRAPHY DISPLAY2 ® (0] ] None v Y
%
OVERLAYS & oispLaYs O @ L None v v
TCOLS
Autosave Options
EXTERNAL 0O
TOOLS Autosave Image Properties on Close

[0 Autosave Image Annctations on Close
[0 Auto Mark Read Study on Close

O Auto Upload Dictation on Close

O Autosave Viewer Settings on Close

O Auto Open Next Study

[0 Auto Send Annotated Images on Close

Set up connected displays

Configure all connected monitors that you intend to use with Exa PACS/RIS. These settings act as default
behavior for what study items open in which monitor. If DMs conflict with the settings you enter here, the
DM takes precedence.

Prerequisite: Add the Chrome extension.

Procedure
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In the Exa PACS/RIS viewer, in the upper toolbar, select the setting E button.

In the Viewer Settings dialog, in the left pane, select GENERAL.

-
[

Under Display Settings, in the Monitors on System box, select the update "~ button to update

the monitor count (or enter manually), and then select the identify O button.

In the table of monitors, enter the settings in the following table.

Note: At any time you can select the update < button to preview your changes.

studies on the monitor, clear this option.

Monitor Select to make monitors available for image viewing. To display orders and

Current Select to make monitors available to display current studies.

Prior Select to make monitors available to display prior studies, if available.

Full Screen Select to default to full screen view.

Orders Select a section of the patient chart to open in the corresponding monitor

when manually opening that section with a viewer tool, or when configured
to open automatically.
Document in the Orders dropdown list for DISPLAY2, the Document section

of the patient chart will appear in DISPLAY2 when you select the button
in the viewer.

Type

The color or grayscale display type.

Calibration Width/mm

Type a manual calibration width (appears on horizontal calipers)

Calibration Height/mm

Type a manual calibration height (appears on vertical calipers)

5. Select SAVE.

Configure autosave options

You can configure how the viewer performs automatic saving and other functions.

Procedure

1. Inthe Exa PACS/RIS viewer, in the upper toolbar, select the setting E button.

2. Inthe Viewer Settings dialog, in the left pane, select GENERAL.

3. Under Autosave Options, enter the settings in the following table.

Setting

Autosave Image Properties on Close Automatically saves image properties such as the W/L when

the image is closed. Saved properties are restored the next
time the image is opened.
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Autosave Image Annotations on Close Automatically saves image annotations when the image is
closed. Saved annotations are restored the next time the
image is opened.

Auto Mark Read Study on Close Automatically marks the study as “Read” when the study is
closed.
Auto Upload Dictation on Close Automatically uploads recorded dictations to add to the

study when the study is closed.

Autosave Viewer Settings on Close Automatically saves any changed viewer settings such as
toolbar configuration when closing the viewer.

Auto Open Next Study When the current study is closed, automatically opens the
next study in the worklist that is not partially deleted.

Auto Send Annotated Images on Close Automatically sends images if they include annotations when
the current study is closed.

4, Select SAVE.

Configure the toolbar
You can configure the appearance and other properties of the viewer toolbar.

Procedure

1. Inthe Exa PACS/RIS viewer, in the upper toolbar, select the setting E button.
2. Inthe Viewer Settings dialog, in the left pane, select INTERFACE.
3. Under Toolbar, enter the settings in the following table.

Note: You may need to update the viewer for changes to take effect.

Seios peswwen

Toolbar Button Scale Adjusts the size of toolbar buttons.

Thumbnail Bar Scale Adjusts the size of the thumbnail bar.

Magnifying Glass Size Adjusts the size of the area affected by the magnifying glass.

W/L Acceleration Sets the rate or sensitivity of W/L adjustments. Typical range is 100-
600.

Span Sensitivity Sets the rate or sensitivity of span adjustments.

Auto - Adjusts the speed automatically based on the number of images
in the series.

Dflt - The default sensitivity after upgrading to version 1.4.32_P1. This ig|
the same sensitivity as the "0/Auto" sensitivity used in version 1.4.29.

Low/High - Spans slowly or quickly.
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Saiog [peswwn

Thumbnail Column/Rows Sets the number of columns and rows for the thumbnail bar.

Thumbnail Bar Orientation Sets the position and resultant orientation of the thumbnail bar. If you
select Mirror, the thumbnail bar in the left monitor appears on the left
side of the screen, and the thumbnail bar in the right monitor appears
on the right side of the screen (available when the modified toolbar is
not available).

Header Menu Sets the position of the toolbar and other header items.

DM Toolbar Sets the position of the DM toolbar.

4, Select SAVE.

See also:

Configure other interface settings

Configure calipers

You can configure the number and placement of calipers.

Procedure
1. Inthe Exa PACS/RIS viewer, in the upper toolbar, select the setting E button.
2. Inthe Viewer Settings dialog, in the left pane, select INTERFACE.

3. Under Caliper Position, select checkboxes for each caliper that you want to display, and then
select SAVE.

Configure other interface settings

You can configure miscellaneous viewer toolbar and other settings.

Procedure
1. Inthe Exa PACS/RIS viewer, in the upper toolbar, select the setting E button.
2. Inthe Viewer Settings dialog, in the left pane, select INTERFACE.

3. Under Other Toolbar, enter the settings in the following table.

Ask on Close Prompts you to specify which items to save before closing
the viewer.

Single Instance Mode Limits the viewer to one display frame per browser.

Skip Frames in Cine to Maintain Playback Skips large images in a cine loop so that the cine plays a

Speed fixed speed.
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Show Cutlines for First/Last Images

Shows any available cutlines only on the first and last images
of a series.

Open Key Images as Single Images

Displays any available key images separately in the thumbnail
area. When cleared, shows all series images in the key image
thumbnail area.

Use Modified Toolbar

Temporarily hides the thumbnail bar, and adds a Prior bar af
the top of the screen that displays patient priors in order.
You can hover over a prior to display series/image
thumbnails, and select the thumbnails to open the images.
Works in conjunction with the Auto Show Priors Bar option.

Caliper Zoom

If selected, you can drag the calipers to zoom the current
image.

Auto-Play Cine Loops

Automatically plays cine loops when opened.

Auto Play Cine Wait Time (ms)

Sets a pause time before auto-playing cine loops.

Default Frame Rate for MP4

Sets a default frame rate for MP4 files.

Default Cutline Thickness

Sets a default thickness for cutlines.

Auto Open Orders

Selects the options that appear in the Orders dropdown list
in the Viewer Settings dialog, General Info. screen, under
Display Settings.

Auto Show Priors Bar

Shows all prior studies in a separate bar at the top of the
viewer.

Focus-In on Zoom Point

When selected, the user can drag on an image to zoom in
and out at the initial pointer position.

Fill Empty DM Cells

Fills undefined DM frames with images in the current study.

High-Quality Interpolation

Select to use high-quality image interpolation. Frequently
used to enhance X-ray quality. You can use this compression
option to remove unwanted “gridlines” if switching between
earlier and high-resolution monitors.

Enable RGB/YBR Swap

Makes the color settings supported by the user video settings
available.

Enable Developer Mode

Shows development mode logs, and displays a vertical green
line in the right side of each frame when the server performg
a prefetch.

Show Calibrated Ultrasound Region

Server side setting.

Hide Partial Close Button

Hides the partial close button, an “X” that appears next to
the logoff button. Partial closing closes the study, but leaves
the viewer open for faster loading of future studies.

Hide All Monitor Layout Change Button

Hides the toolbar’s monitor layout change button that
appears when two or more monitors are made available.

Show Label in DM Preview

Shows the previews of hanging protocols in the DM bar.
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Show Middle Slice Thumbnail Shows only the thumbnail of the middle slice in a series on
the thumbnail list.

Enable Cardio Viewer [Unused]

Disable Queuing Forces synchronous communication; client message and
server response occur one at a time. CAUTION: We do not
recommend changing this setting. Consult with your Konica-
Minolta representative.

Stretch Prior Bar Extends the prior bar across multiple monitors. If the prior
bar exceeds the total available screen width, a scroll bar
appears.

Show Prior Index Displays the Prior index number in the thumbnail and Prior
bars.

Auto open STAT When you open a study in the Exa PACS/RIS viewer, this
option automatically opens any STAT images, if included.

Split W/L Region [Unused]

Color Only as Last Monitor Chooses the color monitor as the last monitor on which to

display images.

Client-Side Window/Level for US Processes the Window/Level for ultrasounds on the client
side. May reduce lag by bypassing the server.

Show Span Overlay Shows a span sensitivity adjustment slider on images.

4. Select SAVE.

See also:

Configure the toolbar

Configure annotation tool functionality
You can configure annotation tool functionality.

Procedure
1. Inthe Exa PACS/RIS viewer, in the upper toolbar, select the setting E button.
2. Inthe Viewer Settings dialog, in the left pane, select INTERFACE.
3. Under Annotation, enter the settings in the following table.

Show Annotation Shows annotations by default. The user can still hide them
manually in the viewer.

One-Click Annotations Changes from the selected annotation tool to the default
cursor after each use. If cleared, the user can reuse the tool
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repeatedly without re-selecting the tool.

Show One-Click Annotations Button Shows a button for turning one-click annotation on and off.

Annotation Edit Mode Selects the Edit command in the image shortcut menu by
default.

Use Dot Cursor Changes the standard pointer to a dot pointer.

Edit Annotations after Creating Causes the viewer to enter Edit mode after initial placement

of an annotation.

Allow Drag Create Creates annotations by dragging instead of selecting.
ROI Show Size Displays the size of the selected ROL.
Confirm Annotation Delete Prompts the user for confirmation when deleting

annotations.

Persistent Annotation Tool Makes a selected annotation tool available until the user
selects a different tool. If cleared, the pointer changes to the
default operation after using the tool.

Show Measurements In Sets the units for any length measurements taken.

4, Select SAVE.

Configure annotation colors

You can configure the color of annotations to indicate whether they are selected, in edit mode, or
applied.

Procedure

1. In the Exa PACS/RIS viewer, in the upper toolbar, select the setting E button.
2. Inthe Viewer Settings dialog, in the left pane, select INTERFACE.

3. Under Colors, to add an annotation color, select inside a color or grayscale box and then use the
color picker to select a color.

Anno Color 1-5: Annotations appear in these colors by default.
Anno Color Edit: Annotations change to this color when you edit them.
Anno Color Hover: Annotations change to this color when you hover over them.

4. Select SAVE.
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Configure annotation size and scaling
You can configure the pixel or font size of annotations, and scale annotation points.

Procedure

1. In the Exa PACS/RIS viewer, in the upper toolbar, select the setting E button.
2. Inthe Viewer Settings dialog, in the left pane, select INTERFACE.

3. Under Miscellaneous, enter the settings in the following table.

Scale in Pixel Size Determines the annotation font size by the pixel size.
Scale Annotation Font By Sets the font size for annotations.
Scale Annotation Point By Sets the line thickness for annotations.

4. Select SAVE.

Configure recording

You can configure audio recording options for Exa Dictation.

Procedure

1. Inthe Exa PACS/RIS viewer, in the upper toolbar, select the setting E button.
2. Inthe Viewer Settings dialog, in the left pane, select INTERFACE SETTINGS.

3. Under Record Control, enter the settings in the following table.

Hold for Record Requires you to hold down the button for the duration of
recording.

Beep on Record Beeps when recording starts.

Blink on Record Pause Causes the microphone light to blink when recording is paused.

Monkey Chatter on Rewind Plays “monkey chatter” sound when rewinding.

FFWD/RWD Factor (200-500) Changes the rate of fast forward and rewind, in milliseconds.

Lag (0-5000) Delays the response after selecting play or record by the
specified amount of time, in milliseconds.

4. Select SAVE.

500-000594A 312



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

Show or hide tool buttons
You can hide certain tool buttons.

Procedure

1. In the Exa PACS/RIS viewer, in the upper toolbar, select the setting E button.
2. Inthe Viewer Settings dialog, in the left pane, select INTERFACE.

3. Under Tool Buttons, select the checkboxes of the items that you want to hide.
4

Select SAVE.

About ROI and SUV values and units

Exa PACS/RIS can calculate selected types of SUV values and display them in selected units. When using
these functions, consider the following.

e DICOM data from Philips — To calculate SUV values based on DICOM data from a Philips
modality, if the data uses CNTS units, Exa PACS/RIS converts pixel values to BQML by using
Philips private tags Scaling Factor [7053,xx00] and Activity Concentration Factor [7053,xx09].
However, if those tags are missing, the CNTS units are retained regardless of the SUV type
you configure.

e If data required for calculations is not found in the DICOM source file, Exa PACS/RIS displays
N/A in place of measurements.

o If ROI Selection Weighting is set to Exclusive, largest-valued or smallest-valued pixels falling
partially outside an ROI are excluded from calculations.

¢ If DICOM-sending images with ROI annotations, they are automatically set to Weighted
regardless of the user selection.

See also:

Configure fusion, ROI, and SUV options

Configure fusion, ROI, and SUV options

You can configure options for fusion, ROI, and SUV.

1. In the Exa PACS/RIS viewer, in the upper toolbar, select the setting E button.
2. In the Viewer Settings dialog, in the left pane, select INTERFACE.

3. Under Fusion, and under ROI & SUV, enter the settings in the following table.

Group  JSetting _|Description

Fusion Auto Adjust for CT/PT Frame Count Select to reconstruct PET anatomy on fusion
Mismatch overlays between absent slices. Disable to display
PET overlays only for slices originally included in
the PT series.

ROI & SUV | ROI Show Size Adds length and area measurements to ROI.
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Show Number of Pixels in ROI Selection | Select to show the number of pixels selected when
annotating an ROI or selecting with the freehand
tool.

Show Number of Slices in ROI Selection | Select to show the number of slices selected when
annotating an ROI or selecting with the freehand
tool.

ROI Selection Weighting Select which pixels are included in an ROI. When
DICOM-sending images with ROI annotations,
they are sent as Weighted regardless of this
setting.

Weighted: Include pixels touching or within the
ROI border, and assign a value based on the
percentage of the pixel lying within the ROI.

Inclusive: Include pixels touching or within the
ROI border, and use the full pixel value.

Exclusive: Include only pixels completely within
the ROI border, and use the full pixel value.

Enable SUV Calculations Select to add SUV calculations to ROI annotations
of PET SUV series and CT-PET fusion studies.
Prerequisite: Your system administrator must also
enable SUV in a separate procedure.

Show SUV Type and Measurements in Select to include the SUV type and measurements
the ROI Header in the ROI header.

Show SUV Units after Measurements Select to include the SUV units following the
measured values in the ROI header.

Use Standard SUV Type Units (g/ml, Select to display SUV values using standard units
cm2/ml) for the SUV type. Clear to use the values stored in
the DICOM file.

Default SUV Type Select the type of SUV calculation to perform.

4. Select SAVE.
See also:

About ROT and SUV values and units

Configure modality-specific viewing options
You can configure how studies appear in the viewer for all modalities, or for each specific modality.

Procedure

1. Inthe Exa PACS/RIS viewer, in the upper toolbar, select the setting E button.
2. Inthe Viewer Settings dialog, in the left pane, select MODALITY.

3. In the list of modalities, select a modality to configure.
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4. Enter the settings in the following table.

Layout Screen Layout Changes the layout of frames.

Series Layout Changes the layout of series frames within
screen layout frames.

Mouse Buttons Left/Right/Middle/Left+Right Assigns functions to mouse buttons. This is
frequently used by CAD users to assign
functions to extra mouse buttons.

Compression Sets the image quality, which inversely affects
viewer performance.

Presets Key Assigns shortcut keys to W/L presets.
Description Type a name for the W/L preset.
Window Width Sets the window width of the W/L preset.
Window Center Sets the window center of the W/L preset.
Set Select when finished entering Preset settings.
Options Auto Linking Turns on the Auto Linking function.
Assume Color Study Forces studies of the selected modality to

appear in the default color monitor set in the
display settings regardless of color.

Assure All Viewed Displays a check mark in thumbnails of images
that were opened, and warns the user when
closing before all images are opened.

Auto CLAHE Turns on the CLAHE function.

Auto Hang DM Enables the use of DMs. Makes the first instance
on the DM preview available to hang on the
viewer.

Auto DM Wrap Enables moving from the final step of a DM
directly to the first step, and back again.

Auto Hang Priors Automatically loads the first prior when the
viewer opens. Works in conjunction with Auto
Open Priors.

Auto Replace Priors Automatically replaces prior images in the

current layout.

Auto-Invert SC Images Inverts white and black of scanned documents
such as reports. Reduces eye fatigue.

Auto Next Series When moving beyond the last image of the
current series, automatically opens the next
series.

Auto Next Series Cine Automatically starts cine play of the next series

when the user opens it.
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Auto Next Series Wrap

Automatically opens the first series after
viewing the last image of the last series in a
study.

Auto Next Study

Automatically opens the next study in the
worklist after closing the current study.

Auto Swap Red/Blue

Inverts colors that may not be displayed from
the modality properly (such as with non-DICOM
ultrasounds).

Auto Show DICOM Overlays

Automatically displays DICOM overlays, if
present.

Auto Show SR Overlays

Automatically displays SR overlays, if present.

Auto Show Cutlines

Automatically displays cutlines, if present. Note,
this setting also applies to synthesized
mammogram views, in which the cutlines
indicate the position of the currently viewed
image on the corresponding BTO view.

Auto Show Cine

Shows the media control bar when a series is
opened.

Auto Show W/L Bar

Shows the window/level bar when the viewer
opens.

Detect Pixel Padding

Turns detection of pixel padding ON/OFF.

DM Allow Missing Cell

Shows a blank cell in the DM if the assigned
image is not available.

DM Save W/L

Saves the window/level with the DM.

Save Study DM on Close

Creates a new DM for each study when it
closed, or when the next study auto-opens. The
DM is named with the accession number, and
contains the last displayed stack and monitor
position.

Show PDF in Last Stack

Moves PDF files to the last place in the stack: in
the viewer, they are loaded last, if an empty cell
is available.

Instance Window/Level

Select to show each image with its own W/L

Clear to show each image with the W/L of the
first instance.

Do Not Skip Images

Prevents moving forward if subsequent images
are not yet loaded.

Ignore Frame of Reference within
Study

Disables referencing of the study’s DICOM frameg
of reference UID when performing linking and
cutline functionality.

Ignore LUT

If LUT values are corrupted, Exa PACS/RIS
ignores the LUT values, and attempts to render
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the best image possible.

Ignore Presentation LUT

Same as Ignore LUT, but select for certain
vendors that use a “Presentation LUT.”

Keep Rotate

Applies the current rotation to all images in the
series.

Keep W/L Applies the current W/L to all images in the
series.
Keep Zoom Applies the current zoom level to all images in

the series.

Extend Image Display (if Stretch)

When Stretch Across Monitors is selected,
extends a single image across multiple
monitors.

Pixel Padding as Background

Interpolates missing pixel data to fill in “dead”
spots in an image.

Note: When using this feature, reading
physicians should be aware that some pixels
may be synthesized.

Pre-generate Bitmaps

Pre-generates bitmaps automatically if
imported into PACS.

Reset W/L for Individual Images

Select to use the original W/L of each individual
image.

Clear to use the first W/L sent by the modality
for all images.

Frequently used to optimize MRI images.

Select Last Contrast Entry

When DICOM tags include multiple W/L values,
uses the last value for all images in the series.
Clear to use the first value.

Show 3D Spine Labels

Shows the 3D spine label tool on the toolbar.

Show ‘Bone Enhance’ on Toolbar

Shows the Bone Enhance tool on the toolbar.

Show DM Toolbar

Shows/hides the DM toolbar on initial load.

Show Spine Labels

Shows the spine labels tool on the toolbar.

Sort Thumbnails by Date/Time

Sorts thumbnails by date/time.

Stop Thumbnail from Updating

Prevents W/L changes to the current image
from affecting its thumbnail.
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Turns on extending of items across multiple
monitors.

Cine Direction

Sets the cine playback to forward or backward.

Default FPS Causes cine play to occur at the default frames
per second, depending on modality.
Enable 4DM Opens the 4DM viewer for post-processing.

(Requires configuration to integrate with the
4DM viewer.)

Disable CINE Scrolling

Disables cine play of series.

Active Frame Based Cineplay

Playing a cine loop on one series automatically
plays all linked series.

Disable Caliper

Hides calipers for the modality.

Auto-Split Rules

Always

Splits US series into individual images.

Differing Echo Time

Splits by echo time.

Differing Series Number

Splits by series number.

Differing Series Time

Splits by series time.

Differing Acquisition Number

Splits by acquisition number to create stacks
for separate acquisitions/scans.

Differing Diffusion Value

Splits images within similar series UID by b-
value (0018,9087 MR Diffusion Value) into
separate series.

Differing Trigger Time

Splits by trigger time (0018,1060).

Isolate MPEG

Splits by MPEG file.

Isolate Multiframe

Splits cine loops into multiple images.

Premium View

Bone Enhance

Displays the contrast enhance menu.

Auto Bone Enhance

Highlights the bone portions of images.

Auto WL Type

Selects the default W/L to use for the selected
modality.

Auto Reorder Images

Automatically changes the order of images in a
series to the selected order.

Prior Options

Auto Open Prior

Automatically opens prior studies.

Relevant Priors

When automatically opening priors, also opens
relevant priors from other modalities. See
“Define relevant priors” later in this topic.

Auto Open Prior Count

When automatically opening priors, opens the
selected number of studies.
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Force Relevant Only Opens only the defined relevant priors (see
"Define relevant priors" later in this topic).

Prioritize Current Modality First When opening relevant priors, display same-
modality priors first.

5. Select SAVE.

6. Optional. If you selected Relevant Priors, see the next section, “Advanced options for displaying
relevant priors.”

Define relevant priors

Defining relevant priors allows you to auto-open only priors that are relevant to the current study
based on study description, modality, or body part. To write definitions for which priors are relevant
you use a syntax called relevant prior logic:

STRING or (STRING STRING ...){.*(STRING STRING ...)}

"A single string, or multiple strings delimited with a bar, optionally followed by ".*" plus multiple
strings delimited with a bar."

Example 1

When the main study description contains "CHEST" or "THORAX," the relevant priors to auto-open
are CT studies whose descriptions also contain "CHEST" or "THORAX."

Prior Options

Ao Dpery Prior

Relevant Priors

Ao Open Prior Count | Force Relevant Prioritize Current Modalrty

Dindy Fars1

hain
Study
Description Body Part | Main Stuely Description

(CHESTITHORAX) (CHESTITHORAX)

Prior settings on the left... ...main study settings on the right

Example 2

e When the main study description contains "CLAVICLE," SCAPULA," or "SHOULDER" followed
by "LEFT," "LT," or "BI," the relevant priors to auto-open are those whose descriptions also
match those criteria.

e The same is true for the RIGHT shoulder.

e Priors of the same modality as the main study are opened first.
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Prior Options

pen Prior

Fielavem Priors

| Modality | Body Part | Description

APLUILA|SHOULDER).

APLILA|SHOLLDER) *

Note: You can also define relevant priors to auto-send (see Configure routing rules).

Configure mammography
You can configure mammography viewing options.

Procedure

1. In the Exa PACS/RIS viewer, in the upper toolbar, select the setting - button.

2. Inthe Viewer Settings dialog, in the left pane, select MAMMOGRAPHY.

3. Enter the settings in the following table.

Mammography Use 2+ Year-0Old Priors

Makes available the display of priors that are 2
years old or more.

Stack Same View

When Auto Next Series is turned on, stacking off
100% matches for a cell becomes available in
the Display Manager.

Auto Orient Mammo Views

Automatically orients mammo views.

Swap Left/Right Breast Positions
(with AutoOrient Only)

When Auto Orient Mammo Views is selected,
switches the left and right breast images.

Remove BTO Projections

Hides the BTO orientation overlay.

Allow Mammo Switching via
Overlay

When selected, the user can switch the side of
the overlay if it obscures the image.

Show BTO Orientation Overlay

Shows a bar in lower left indicating the cranial
or caudal location in the breast when moving
through a 3D image.
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secton | sotig

Show Quick History Show the Quick History of studies.

List US Breast Priors after MG Orders priors in the prior bar.

Priors

Enable DM Scroll Turns on moving through DMs in the DM

toolbar by using the mouse wheel.

Enable Stack Scrolling In special cases like BTO there will be multiple
images present in the same series, which is
received as a single DICOM. In these cases, turn
on the stack scroll.

Disable BTO Scrolling Turns off moving through BTO views.

Group DM Preview by Prior Saves space on the prior bar by stacking DMs
with the same prior logic. You can hover over g
prior to display matching priors in a vertical

pop-out.

Show Priors in Chronological Orders priors in the prior bar.

Order

Auto Slab Tomo Automatically applies a slab thickness to
tomosynthesis studies.

Stack By View And Prior Makes it possible to move through prior

Sort By mammo images within a hanging protocol
without needing a specific DM. Select Asc or
Desc to move by age of prior.

Enable SkinLine Maximizes breast anatomy based on the skin
line without degrading image quality.

SR CAD Options [Select] Sets what CAD overlays (data) are displayed in

the viewer, if present.

Apply Changes to All Images Shows all available SR CADS in the images.

Malc - Select to view Malc findings when
viewing Hologic studies.

Enable CAD Findings on ALL BTO | Displays all findings within the series on all
Images images. CAD findings on non-referenced
images are 67% transparent.

4, Select SAVE.

Configure overlays
You can configure the appearance and contents of overlays.

Procedure

1. Inthe Exa PACS/RIS viewer, in the upper toolbar, select the setting E button.
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2. Inthe Viewer Settings dialog, in the left pane, select OVERLAYS.

3. Enter the settings in the following table.

Font Family Select the font used for overlays.
Size Select the font size used for overlays.
Modality Select to which modality the overlay settings apply. You can enter

modality-specific settings or select all modalities.

Left/Right Field Click inside the box and then:

Overlay
e Select a property from the list, or

e Type a DICOM tag (e.g. 0020,0010)

Prefix If you typed a DICOM tag in the Field box, type a tag prefix.

Mask Optional. Type attributes that describe mask operations for a
multiframe image (see the DICOM standard).

Bottom FOV/MAG/W/L Displays the field of view, magnification, and W/L for each series in
Overlay the bottom corner.

4. Select ADD
Result: The tag appears at the bottom of the list.
5. Optional. Drag the tag to a new position in the list.

6. Select SAVE.

Add or remove toolbar tools

You can add or remove tools from various viewer toolbars in the program, and customize your choices by
modality.

Note: Not all toolbar tools can be removed.

Procedure

1. Inthe Exa PACS/RIS viewer, in the upper toolbar, select the setting E button.
In the Viewer Settings dialog, in the left pane, select TOOLS.

Under Toolbar, select the modality whose toolbar you want to customize.

A W N

In the list, select one of the following toolbars to customize.
MAIN - The toolbar at the top of the viewer.

TOP/BOTTOM/LEFT - The toolbar accessible by pointing to the top, bottom, or left edge of an
image.
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5. Under Tools, select or clear the checkboxes of the tools that you want to add or remove.
6. Select SAVE.
See also:

Viewer toolbar tools

Add or remove tools from the image shortcut menu

You can add or remove tools from the shortcut menu that appears when you right-click an image, and
customize your choices by modality.

Procedure
1. In the Exa PACS/RIS viewer, in the upper toolbar, select the setting E button.
In the Viewer Settings dialog, in the left pane, select TOOLS.
Under Toolbar, select the modality whose shortcut menu you want to customize.

2

3

4. 1In the list, select CONTEXT MENU.

5. Under Tools, select or clear the checkboxes for tools that you want to add or remove.
6

Select SAVE.

Assign toolbar keyboard shortcuts
You can assign keyboard shortcuts ("hot keys") to tools, and customize shortcuts by modality.

Procedure

1. Inthe Exa PACS/RIS viewer, in the upper toolbar, select the setting E button.
In the Viewer Settings dialog, in the left pane, select TOOLS.
Under Toolbar, select the modality for which you want to assign shortcuts.

2

3

4. Inthe list, select KEYBOARD SHORTCUTS.

5. Under Tools, select the checkboxes of the tools to which you want to assign shortcuts.
6

In the Shortcut box, type the keyboard shortcut. The shortcut can be one of the following, either
by itself or preceded by the Ctrl key:

e Alphanumeric character (A-2Z, a-z, 0-9)
e Arrow key (Up, Down, Left, or Right)
e Basic math operator (+, -, *, /)

7. Select SAVE.
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Configure opening of a third-party program

You can configure Exa PACS/RIS to open third-party programs such as Ikonopedia, PowerScribe 360, and
MModal.

Prerequisites: Install Exa Launch, Add a trusted IP or URL.

Procedure

1.
2.

8.
9.

In the Exa PACS/RIS viewer, in the upper toolbar, select the setting E button.
In the Viewer Settings dialog, in the left pane, select GENERAL.

Under Display Settings, in the table of monitors, on the row corresponding to the monitor on
which to open the third-party application, select the row’s DISPLAY checkbox.

In the row’s Orders dropdown list, select the application (such as PS360 or MModal).
In the left pane, select INTERFACE.

Under Other Toolbar, in the Auto Open Orders group, select the application (such as PS360 or
MModal).

In the left pane, select TOOLS.
Under Toolbar, select MAIN, and then in the right pane, select the External Tools checkbox.

In the left pane, select EXTERNAL TOOLS.

10. Enter the settings in the following table, and then select ADD.

Title Type a title for the program.
Description Type a description of the program.
Command Type the command to run when you select the toolbar button (such as the path to

the executable, or a URL).

Arguments Type arguments to pass to the command at runtime.
Exa PACS/RIS supports the following arguments:
{{account_no}} (patient ID)

{{id}> (study ID)
{{accession_no}}
{{facility_id}}

{{username}}
{{user_id}}

{{patientName} }
{{patientDOB} }
{{patientSex}}
{{studyDescription}}
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{{series_uid}}

{{image_uid}}

Initial Directory Type the path to the root folder.

Keyboard Shortcut| Optional: Type a keyboard key sequence to use as a shortcut for opening the
program.

Toolbar Button Optional: Select to add a dedicated button for the application on the viewer toolbar.

Do not Base-64
Encode URL
Arguments

Use Facility ID for | Do no select (reserved for PenRad).
Subdirectory

See also:

Configure opening of PenRad
Configure opening of OrthoView

Configure opening of PenRad

You can configure Exa PACS/RIS to be able to open mammography and ultrasound breast studies in
PenRad by selecting a PenRad button on the viewer toolbar. Each instance of PenRad automatically
opens in the configuration corresponding to the facility ID of the study. You must perform this
configuration procedure for each user.

Prerequisite: Install Exa Launch.

Procedure

1. Inthe Exa PACS/RIS viewer, in the upper toolbar, select the setting E button.

2. Inthe Viewer Settings dialog, in the left pane, select GENERAL.

w

Under Display Settings, in the table of monitors, on the row corresponding to the monitor on
which to open PenRad, select the row’s DISPLAY checkbox.

In the row’s Orders dropdown list, select PenRad.
In the left pane, select TOOLS.
Under Toolbar, select MAIN, and then in the right pane, select the External Tools checkbox.

In the left pane, select EXTERNAL TOOLS.

© N o u ok

Enter the following settings, and then select ADD.
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(variable filename)

Title PenRad

Description PenRad

Command exal : / /1 aunch/ q=

Argumentsi pati ent _i d={{account _no}}&accessi on_no={{accessi on_no}}

&cmd=penr ad&study_id={{id}}& acility_id={{facility_id}}

Arguments2

(filename)

pati ent _i d={{account _no}}&accessi on_no={{accessi on_no}}
&cmd=penr ad&study_id=file&facility id={{facility_id}}

Initial Directory

[Leave blank]

Keyboard Shortcut

Optional: Type a keyboard shortcut.

Toolbar Button

Select (adds the PenRad button to the viewer toolbar).

Do Not Base-64
Encode URL
Arguments

Use Facility ID for
Subdirectory

Optional: Select to open different instances of the application that are configured
for different facilities on the same Exa PACS/RIS installation.

1. Creates a study_id.xml file (e.g. if the study ID is 1234, the file created is 1234.xml).

2. Always creates a file.xml file regardless of the study ID.

See also:

Configure opening of a third-party program

Configure opening of OrthoView

You can configure Exa PACS/RIS viewer to open a study in OrthoView by selecting the external app

button on a worklist study row.

Prerequisite: Install Exa Tool.

Procedure

1.

eXQ-PLATFORM

On the server, use a text editor such as Notepad to open the exatool.toml file (default location is

C:\viztek\exa\cfg).

Add or edit the file to include the following within the [tools] section:

# Materialize OrthoView

[tool s. orthoview

| aunchURL = ‘http://server_address: 90\ Ort hoVi em start. htmi
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e Where server_address is the IP or fgdn of the server hosting OrthoView.
e If needed, substitute htt p with ht t ps.

3. Save and close the file.

4. Onthe burgerE menu, select Setup.
5. On the OFFICE menu, select User Management.
6. On the EXTERNAL APPS tab, select Add, and type the following settings.
Integration Name OrthoView
URL exatool :///?tool =orthovi ew&st udy_id={{study_id}}&usernanme={{usernane}}

Note: You can use the following variables in place of, or in addition to those shown in colored text
on the previous line.

{{accession_no}} The accession number of the study

{{account_no}} The account number of the patient
{{facility_id}} The database ID for the facility of the study
{{study_id}} The database ID for the study

{{user_id}} The database ID for the currently signed-in user

7. Select SAVE.

See also:

Configure opening of a third-party program

Open a study in OrthoView

If OrthoView is installed on your server, you can use the Exa PACS/RIS worklist or viewer to open studies
in OrthoView.

Prerequisite: Configure opening of OrthoView.
Procedure
1. On the worklist, select the external app button.
2. In the button shortcut menu, select OrthoView.
Result: Your browser downloads a .jnlip file.

3. Open the .jnlp file.
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Configure opening of Visage RIS
You can configure Exa PACS/RIS to integrate with Visage RIS.

Prerequisite: Install Exa Launch and Install Exa Tool.

Enable integration with Visage RIS

1. In the Exa PACS/RIS viewer, in the upper toolbar, select the setting - button.
2. Inthe Viewer Settings dialog, in the left pane, select INTERFACE.

3. Inthe Auto Open Orders list, select Visage RIS.

Select a monitor
1. Inthe left pane, select GENERAL.

2. Under Display Settings, on the Orders list of the monitor to use, select Visage RIS.

Viewer Settings

GEMERAL ) )
Display Settings
INTERFACE Monitors en Sysiem 3 L E
Manibor Current Priar Full Screen orders
MODALITY
O oispLav) 0 (0] O Mane vl
MAKMMOGRAPHY . DISELAY2 @ O D Enabled Hems
Tramscriplion
Others
OVERLAYS B oispLavs o @ e |
TOOLS
Autosave Options
EXTERMNAL . I ;
TOOLS [0 Mnosave iImage Properties on Close
[0 Autosave Image Annotations on Close R W
[ fuste Mark Read Study on Close
[ Awsto Upload Dictation on Close

[0 tustosave Viewer Settings on Close

Create a profile for Visage RIS
1. Inthe left pane, select EXTERNAL TOOLS.
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Viewer Settings

GEMERAL Title *

Visage
Descriplion * Visage RIS
INTERFACE
Command exatflaunch/fg-
MODALITY

Arguments | aceession_no={{accession_nc NI |

Initial Directory
MAMMOGRAPHY

Keyboard Shortcut

OVERLAYS

Toolbar Button

[ Do not Base-64 encode URL arguments
TOOLS

O use factlity 1D lor subdireclory
TOOLS

2. Enter the following settings, and then select ADD.

Title Any, such as "Visage"

Description Any, such as "Visage RIS"

Command exal : / /1 aunch/ gq=

Arguments accessi on_no={{accessi on_no}} &nd=vi sageri s
Initial Directory [Leave blank]

Keyboard Shortcut Optional: Type a keyboard shortcut.

Toolbar Button Select (adds a Visage RIS button to the viewer toolbar).

Do Not Base-64
Encode URL
Arguments

500-000594A 329



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

Use Facility ID for [Leave cleared]
Subdirectory

3. Select SAVE.
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Lines, curves, shapes, and text
You can draw linear shapes and add text to images.

Draw lines and shapes

You can draw rectangles and ellipses on images.
Procedure

1. On the viewer toolbar, select one of the following tools.

e Rectangle E
e Ellipse
e Straight line ﬂ
o Arrow

2. Drag on the image to create the shape.
Optional:

¢ To move a shape, drag any part of its outline.
e To resize a shape, drag any of its handles.

Draw freehand lines
You can draw freehand lines on images.

Procedure

1. On the viewer toolbar, select the pencil tool.

2. Drag on the image to draw a freehand line.

3. Optional. You can drag any points along the line to modify it.

Draw a curved shape
You can draw curved shapes on images.

Procedure

1. On the viewer toolbar, select the curve ﬂ tool.

eXQ-PLATFORM

2. Select at least three times on the image to specify a start point, a vertex, and a second vertex.

3. Double-click to close the shape.
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Add text

You can add a text annotation to an image.

Procedure

1. On the viewer toolbar, select the text tool.
2. Inthe box, type text and then select Enter.

Note: There is no character limit, but carriage returns are not supported, and long text may
extend beyond the visible image boundary.
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Markers
You can add markers to images, such as for left and right.

Add a dot
You can add a dot marker to an image.

Procedure

1. On the viewer toolbar, select the dot ﬂ tool.

2. Select on the image to place the dot.

Add a vertical or horizontal line
You can add a vertical or horizontal line to an image.

Procedure

1. On the viewer toolbar, select the vertical I. or horizontal . line tool.
2. To add the line, select on the image.
3. Drag the line to position it.

Note: To reveal the endpoints, you can drag a vertical line up or down, or a horizontal line left or
right.

Add a left or right marker

You can add a left or right marker to an image.

Procedure
1. On the viewer toolbar, select the left or right marker tool.
2. To add the marker, select on the image.

3. Drag the marker to reposition it.
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Measurements
You can take various linear and angular measurements of images. Completed measurements remain as
annotations. To adjust measurements easily, we recommend turning on Edit mode before taking

measurements (see Edit annotations).

Measure an angle
You can measure an angle on an image.

Procedure

1. On the viewer toolbar, select the angle E tool.
2. Select on the image three times to place a vertex and two endpoints.

3. Move the pointer to position the angle measurement, and then select to finish.

Measure a Cobb angle
You can measure a Cobb angle on an image.

Procedure

1. On the viewer toolbar, select the Cobb angle E tool.
2. Drag on the image to place the first angle line.

3. Drag again to place the second line.
4

Move the pointer to position the angle measurement, and then select to finish the angle.

Measure an HO angle

You can measure an HO angle on an image. An HO angle measures the degrees of the angle drawn
relative to true vertical and horizontal.

Procedure

1. On the viewer toolbar, select the HO angle ﬂ tool.
2. Select on the image to place a starting point.

3. Select to place the end point.
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Measure a radial angle or length
You can measure a radial angle or length on an image.

Procedure

1. On the viewer toolbar, select the radial angle or radial length mal tool.
2. Select on the image to place the axes.

3. Drag the axes or their endpoints to take measurements.

Measure an elliptical or freehand ROI
You can measure properties of an ROI by drawing an ellipse or a freehand shape. The viewer displays the

ROI's length (mm), area (mmz), and the minimum, maximum, mean, and standard deviation in

Hounsfield units.

Procedure

1. On the viewer toolbar, select the ROI ﬁ or free ROI E tool.
2. Drag on the image to place the ellipse or the freehand shape.

3. Drag the outline or handles of the shape to adjust the ROIL.

Measure a length

You can measure a length (mm) on an image.

Procedure
1. On the viewer toolbar, select the measure tool.
2. Drag on the image to place the measurement line.

3. Drag the outline or endpoints of the line to adjust the measurement.

Measure and compare two lengths

You can measure the lengths (mm) from two starting points to an endpoint for comparison.
Procedure

1. On the viewer toolbar, select the M compare H tool.

2. Select three times on the image to place a starting point, endpoint, and second starting point.

3. Drag any of the three points to adjust the measurement.
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Take a freehand measurement
A freehand measurement is similar to freehand ROI, but it measures different values: angle; radius
(mm); area (mmz); and length (circumference in mm).
Procedure
1. On the image shortcut menu, select Annotations > Measures > FH Measure.
2. Select three times on the image to place a vertex and two endpoints.

3. Move the pointer to position the circle measurements, and then select to finish.

Find a center point
You can find the center between two reference points.
Procedure
1. On the image shortcut menu, select Annotations > Measures > Center Point.
2. Select twice on the image to place the first and second reference points.
Note: The center point is indicated by an x.

3. Drag either of the reference points to adjust the measurement.

Draw a circle and measure its radius
You can draw a circle and measure its radius (mm).

Procedure

1. On the viewer toolbar, select the circle @ tool.

2. Select twice on the image to place two loci.

3. Move the pointer to adjust the circle, and then select to add a third locus.
4

Drag any locus to resize or reposition the circle.
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Spine labels

You can add preset labels for spinal vertebrae and discs to MR images. Labels are grouped by region
(cervical, thoracic, lumbar, and sacral), plus another group for all discs. Basic labels do not include height
and width measurements, whereas non-basic labels do. 3D labels appear in all frames and planes,
whereas non-3D labels appear only in the individual frames to which you add them.

Add basic spine labels
You can add basic spine labels to vertebra in ascending or descending order.

Procedure

1. On the viewer toolbar, select the basic spine label tool.
2. In the button shortcut menu, select a region and starting vertebra.
Note: Choose “Up” to apply labels in ascending order, or “Down” for descending.

3. Select on the first vertebra to add the first label, and then select on the second vertebra, and so
on.

Add basic 3D spine labels
You can add basic 3D spine labels to vertebrae in ascending or descending order.

Procedure

1. On the viewer toolbar, select the quick 3D spine label tool.
2. In the button shortcut menu, select a region and starting vertebra.
Note: Choose “Up” to add labels in ascending order, or “Down” for descending.

3. Select on the first vertebra to add the first label, and then select on the second vertebra, and so
on.

Add 3D spine labels
You can add 3D spine labels in ascending or descending order.

Procedure

1. On the viewer toolbar, select the 3D spine label shortcut tool.
2. In the button shortcut menu, select a region and starting vertebra.

Note: Choose “Up” to add labels in ascending order, or “Down” for descending.
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3. Select twice on a vertebra to place a starting point and endpoint.

4. Repeat the previous step to label additional vertebrae.

Use a spine label shortcut
You can use a spine label shortcut to quickly start labeling from a common starting vertebra.

Procedure

1. On the viewer toolbar, select the spine label shortcut , 3D spine label shortcut , or 3D quick
spine label shortcut tool.

2. In the button shortcut menu, select a starting vertebra.

3. Add labels.
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3D

3D labels appear in the image where you add them, and the same slice in other series.

Use the 3D cursor

When you place the 3D cursor on one series, the cursor also appears in the corresponding location in any
cell of the same study that is open in the viewer.

Procedure

1. Open two or more series of the same study (for example, an axial, sagittal, and coronal view).

2. On the viewer toolbar, select the 3D cursor bl tool.
3. Hover over an image in one cell.

4. The cursor appears in the same location in the other cells.

Add a 3D point

You can mark a 3D point on an image. The point you place in the current image appears in the
corresponding position in all frames and planes.

Procedure
1. On the image shortcut menu, select Annotations > 3D Point.

2. Select on the image to place the point.

Add a 3D ray

You can mark a 3D ray on an image. The vertex you place in one frame extends as a ray through the
stack and is visible in other planes.

Procedure
1. On the image shortcut menu, select Annotations > 3D Ray.

2. Select on the image to place the vertex of the ray.

Add a 3D ROI

You can mark a circular ROI in one image, and the program adds the ROI to the same image in other

series in the viewer. The viewer displays the ROI's length (circumference in mm), area (mmz), and the
maximum, minimum, mean, and standard deviation in Hounsfield units.
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Procedure
1. On the image shortcut menu, select Annotations > 3D ROLI.

2. Select twice on the image to place the center point and a tangent point.

Add a 3D length measurement

You can take a linear measurement (mm) in one image, and the program adds the measurement to the
same image in other series in the viewer.

Procedure
1. On the image shortcut menu, select Annotations > 3D Measure.

2. Select twice on the image to place the first and second endpoints of the measurement line.

Add a 3D angle measurement

You can take a 3D angle measurement in one image, and the program adds the measurement to the
same image in other series in the viewer.

Procedure
1. On the image shortcut menu, select Annotations > 3D Angle.

2. Select three times on the image to place the vertex and the first and second endpoints of the
angle.
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Shutters

You can add rectangular, elliptical, or freehand shutters.

Add a rectangular or elliptical shutter
You can add a rectangular or elliptical shutter to “crop” unwanted areas of an image.

Procedure

1. On the image shortcut menu, select Annotations > Shutters > Shutter Box or Shutter Ellipse.

2. Select twice on the image to place a starting point and endpoint for the shutter.

Add a freehand shutter
You can add a freehand-drawn shutter to "crop" unwanted areas of an image.

Procedure
1. On the image shortcut menu, select Annotations > Shutters > Freehand Shutter.

2. Drag on the image to draw the shutter.
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Other annotation tasks

Add an AR annotation
You can plot points to represent angular rotation.

Procedure

1. On the viewer toolbar, select the AR ﬂ tool.

2. Select six times on the image to place guide points.

Edit annotations

After you finish an annotation, it is fixed in place to prevent accidental alteration. To move, edit, or delete

an annotation, either select the tool that created it, or select the edit tool to enter Edit mode. You
can select the edit tool again to exit Edit mode.

Saving and deleting annotations

You can save or delete annotations as follows.
- |
e To save the current annotations, on the toolbar, select the save annotations button.

e To delete all annotations, on the toolbar, select the delete all annotations ﬂ button.

e To delete all annotations for the current series, on the image shortcut menu, select Delete Series
Anno.

e To delete all annotations for the current study, on the image shortcut menu, select Delete Study
Anno.

Annotate ultrasounds with DIA

With the DIA ultrasound analysis application you can automatically annotate 2-, 3-, and 4-chamber
cardio ultrasounds, and populate SDE reports with SR measurements.

A Incorrectly tagging cardio images can result in misdiagnosis. It is the user's responsibility to
correctly tag series as 2-, 3-, or 4-chamber studies for purposes of DiA analysis. Neither Konica Minolta
nor DIA Imaging Analysis are responsible for any outcomes resulting from mis-tagged images.

Prerequisite: Purchase a license for DiA.

Procedure
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1. Open one or more ultrasound images or series in the Exa PACS/RIS viewer.

2. On the toolbar, select the DIA H button.

3. Inthe center of each open frame, select the 2CH, 3CH, or 4CH button to tag the image or series
as a 2-chamber, 3-chamber, or 4-chamber item.

Note: Select only one type.

4. Inthe upper right corner of each frame, select the SG, EF, or Both button to perform annotation
and measurement.

5. To save the results, select the save annotations button.

6. To view the SR data, open the study in the cardio report editor.

Reset an image in the viewer
When making non-permanent modifications to images in the viewer (zoom, rotation, Window/Level
etc.), you can reset the image to its original state.

e On the viewer toolbar, select the reset viewerﬂ button.
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Change elements in the viewer
Show or hide overlays

You can turn overlays on or off. Note, PR (GSPS) DICOM objects from Intelerad are supported as
overlays.

e On the viewer toolbar, select the overlay ﬂ button to turn overlays on or off.

e To show a preset DICOM overlay, in the image shortcut menu, select DICOM overlay, and then select
an overlay.

Show or hide annotations
You can turn annotations on or off. Note that

Procedure

1. In the upper-right corner of a frame, right-click the menu icon E

2. In the shortcut menu, select Show Annotations.

Show series and stacks

If the viewer is showing only a single frame of a series or stack, you can change it to display all series and
stacks.

e On the viewer toolbar, select the reset series and stacks @ button.

Show or hide cutlines

Cutlines show the intersection between two open series. The cutlines update dynamically as the user
moves through a series. A dashed cutline indicates where the first image starts and the last image ends.
A solid cutline indicates the intersection of the currently displayed locations in the series. If a series
includes intersecting images, you can show or hide cutlines.

¢ On the viewer toolbar, select the cutlines button.

Split series by image thickness
You can use slab tools to split series by image thickness.

Procedure

1. Inthe upper-right corner of a frame, right-click the menu icon E
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2. In the shortcut menu, select Slab Tools, and then select a slab thickness.

Recalibrate the scale

You can manually recalibrate the scale measurement, which is shown on the caliper of the current
series.

Procedure

1. In the upper-right corner of a frame, right-click the menu icon E
2. In the shortcut menu, select Recalibrate.

3. Inthe dialog, type a new value (mm) for the scale, and then select OK.

Change the series layout
You can change the number of series panels displayed in the viewer.

Procedure

1. In the upper-right corner of a frame, right-click the menu icon E

2. Inthe shortcut menu, select Series Layout, and then select a layout.

Reorder a series
You can change the order of images in a series.

Procedure

1. Inthe upper-right corner of a frame, right-click the menu icon E

2. In the shortcut menu, select Reorder, and then select one of the following options.
Image Number - Arranges the images by number in ascending order.
Image Number Inverse - Arranges the images by number in descending order.

Slice Location - Arranges the images by relative location (in mm) in the plane in ascending
order.

Slice Location Inverse — Arranges the images by relative location in the plane in descending
order.

Image Time - Arranges the images by the time they were taken.
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Change the appearance of images

How the viewer chooses the initial window/level

There are many sources of window/level settings. When the viewer displays an image, it chooses the
window/level settings from the first available of the following sources, in order.

e Last display state, if “Auto saved image properties on close” is turned on

e LUT (from prefetch), unless “Ignore LUT” or “Ignore Presentation LUT” is turned on
e DICOM tags - the window center and window width tags

e VOI LUT DICOM tags - value of interest LUT tags

¢ Manual W/L settings, if adjusted by the user

Turn on auto window/level

The viewer can automatically adjust the window/level so that images are, to the extent possible, neither
too dim nor too bright.

e On the viewer toolbar, select the auto window/level button.

Adjust the window/level

You can manually adjust the window/level.

e On the viewer toolbar, select the window/level ﬂ button.
e Drag horizontally over the image to adjust the window.

e Drag vertically over the image to adjust the level.

Apply a window/level preset
You can apply a window/level preset to the current study.

e On the image shortcut menu, select Presets, and then select a preset.

Apply CLAHE enhancement

You can apply CLAHE to enhance local contrast.

e On the viewer toolbar, select the CLAHE button to turn CLAHE on or off.
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Apply bone enhancement

You can use different levels of bone enhancement to optimize the contrast between bone and other
tissues. You can also apply color inversion to further highlight fractures and other features of bone.

Procedure

1. On the viewer toolbar, select the bone enhance ﬂ button.

2. Inthe button shortcut menu, select a percentage.

Invert colors

You can invert black and white values to make certain images easier to read.

e On the viewer toolbar, select the invert colors IJ button.

Add color to images
You can add color to images.
Procedure

1. Right-click the overlay in the lower-right of the image, and then in the shortcut menu, select
Palettes.

2. Select a colorin a palette.

Apply sigmoid processing
You can apply sigmoid processing to enhance low-contrast images.

e Right-click the overlay in the lower-right of the image, and then in the shortcut menu, select
Sigmoid.

Reset and Reset study object

You can access the Reset and Reset study object commands in the image shortcut menu. Reset undoes
all unsaved changes (such as W/L and annotations) made to the current series. Reset study object
updates the viewer after new images are added to a study that is currently open.
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Add to new UNQ study

A UNQ (unique) study is a teaching study. When you select this command in the image shortcut menu, a
button appears on the toolbar to open the teaching study screen. See, “Create a teaching study.”
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Scaling images

Zoom images

You can zoom in on (enlarge) or out of (reduce) images for optimum viewing. There are several ways to
zoom:

e On the viewer toolbar, select the zoom E tool and then drag on the image.

e Select the zoom tool in the image shortcut menu: Tools > Zoom.

e Drag the pointer across a caliper (if Caliper Zoom is selected, see Configure other interface settings).
¢ Right-click the lower-right overlay, select Enter Zoom, and then type a value from .05 to 7.5.

e “Quad zoom”: Use the left or right angle bracket keys (< >).

Display one to one

If you zoomed an image you can restore it to its original DICOM size. This is essentially “life size.”

e On the viewer toolbar, select the one to one button.

Display images in their actual size

You can display images in their original size.

¢ On the viewer toolbar, select the actual image size E button.

Fit images to window

You can automatically zoom an image so that its longest dimension fits in the visible frame.

¢ On the viewer toolbar, select the fit to window E button.

Use the magnifying glass

You can use the magnifying glass tool to zoom an area of the current image.

e On the viewer toolbar, select the magnifying glass ﬂ tool, and then select and hold over the area to
magnify.
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Linking images
When two series are open side-by-side in the viewer, linking them causes moving through images in a
second series when you move through images in the first series.

Auto link images

Auto linking means that linking turns on automatically when two or more series of the same plane (such
as axial) are open. With auto-linking, the system uses the image numbers to automatically match up the
frames in each series so that the frame in the second series is as near in stack order to the image in the
first series as possible.

¢ To auto link images, on the viewer toolbar, select the auto link button.

Manually link images

Manual linking means that you turn linking on and off manually when two or more series are open. This is
frequently used to move through a recent image and a corresponding prior, side-by-side.

e To manually link images, on the viewer toolbar, select the manual link button.

Note: For mammogram images, you can only link LCC and RCC with each other; similarly you can
only link LMLO and RMLO with each other.

Use the context tool

You can automatically jump to an image in a linked series that most closely matches the angle (X, Y, and
Z position) of the image in the current series.

e On the viewer toolbar, select the context tool .

Reset linked series

You can reset (undo) image linking by selecting the reset linked series button. This may take time
depending on the size of the series.
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Moving and jumping to images
Pan images

You can pan an image to view any portions that extend beyond the visible frame.

Procedure

1. On the viewer toolbar, select the pan tool.

2. Drag the image in any direction.

Move or span through images

You can move or span through images in a series. Spanning means to move rapidly with minimal hand or
wheel motion.

To adjust the span sensitivity, see Configure the toolbar.
e To move: Hover over the image and rotate the mouse wheel.

e To span: On the image shortcut menu, select Tools > Span Images, and then drag on the image.

Flip or rotate images
You can flip images 180 degrees, or rotate them 90 degrees. From the image shortcut menu:
¢ Select Transformation > Flip Horizontal or Flip Vertical.
¢ Select Transformation > Rotate Right or Rotate Left.
Play cine loops
When viewing a series, you can play cine loops and shuttle between frames.
Procedure
1. On the viewer toolbar, select the cine button.
2. Cine play starts, and the media control bar appears.

3. Use the media control bar to pause, move to the first or last frame, and move to the previous or
next frame.

500-000594A 351



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

Specify key images

You can specify key images in a series that you can jump to at any time. You can add key images
thumbnails on reports.

Procedure
1. Display the image that you want to be a key image.

2. On the image shortcut menu, select Set Key Image.

Jump to a key image
If you specified a key image in the current series, you can jump to it (display it in a frame in the viewer).
Procedure
1. At the top of the thumbnail pane on the left side, select Keyimage.
The thumbnail pane shows thumbnails of your key images.

2. Double-click a key image thumbnail.

Open a series image in a 1x1 frame

If a series is open in a layout other than 1 x 1, double-click any image to openitina 1 x 1 layout.

Jump to a BTO image by SR finding
To quickly open a BTO image that has a specific SR finding:
Procedure
1. Open the tomosynthesis series that contains the image.
2. On the 2D or synthesized view, select the SR finding of interest.
Result: The corresponding slice opens. Note the following:

e The slice that opens is of the same view type (e.g. select a finding on an RCC to open a BTO
RCC slice).

e Ifthe BTO series is not displayed within the current layout, the series opens next to the 2D or
synthesized view in a 1x2 layout. To restore the original layout, select the backslash (\ ) key.

Triangulate images
You can move to images and points in multiple series at the same time.

Procedure
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1. On the viewer toolbar, open two or more series.

2. Select the Triangulation ﬂ button, and then do one or both of the following.

e Double-click a series to open the corresponding slice in the other series.
e Move the pointer in one series to move the pointer to the corresponding position in the other
series.
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Use MPRtools
Multiplanar reformation (MPR) creates images in orthogonal planes (axial, coronal, sagittal or MIP)
relative to a base image. The MPR tool is hidden until you open a series.

Perform simple MPR

You can perform simple MPR to generate a single alternate planar view from the base view.
Prerequisite: If performing MPR on a fusion study, wait until both series are fully pre-fetched.
Procedure

1. Open a series, and then double-click an image to view it full screen.

2. Select the arrow on the right side of the MPR m button.
3. In the button shortcut menu, select a plane.

4. The viewer performs MPR and displays the new plane.

Perform standard MPR
You can perform standard MPR to generate three additional planar views of the base image.

Prerequisite: If performing MPR on a fusion study, wait until both series are fully pre-fetched.

e Open a series, and then select the MPR m button.

Note: The plane of the base image determines the default MPR plane.

Handle MPR images

You can handle MPR images in the following ways by using controls in the base image.

e To move through MPR images, drag the blue region bars. You can also drag the endpoints to adjust
the viewing angle.

e To move both region bars at the same time, on the toolbar, select the context tool , and then drag
on the base image.

e To change the slice thickness, double-click the thickness value, and then type a new value (or drag
the thickness value).

e To change the slab width, select Region, double-click the slab width value, and then enter a new
value (or drag the slab width value).

e To display an MPR image full screen with a large thumbnail of the base image, double-click an MPR
image.
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Save an MPR series
After you perform MPR, you can save the resultant images and series for later viewing.
Procedure
1. Perform MPR.
2. Right-click a generated cell, point to Save MPR, and then select Instance or Series.
3. Inthe Create MPR Series/Instance dialog, type a description, and then click save.
Result: A thumbnail for the saved instance or series appears on the thumbnail bar.
See also:

Perform simple MPR
Perform standard MPR
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Work with PET fusion studies

Turn PET fusion display on and off

If a PET study was fused with another study such as a CT scan, you can turn display of the fused study on
or off.

Procedure

1. To turn on fusion display, hover over the top of an image to display the image’s top shortcut
menu, and then select PT.

2. Inthe PT button shortcut menu, under PET selection, select a source study.

UE TN

“Fused” appears in the lower-left part of the image to indicate the display state.

3. To turn off fusion display, in the PT button shortcut menu, select Remove current PET.

See also:

Color and blend PET fusion source studies

Color and blend PET fusion source studies

You can add color to source studies in a PET fusion study, and control alpha blending of the two studies.
Specifying a color in one image applies the color to all images in the series.

Prerequisite: Turn PET fusion display on.

Procedure

1. Inthe PT button shortcut menu, under PET selection, select the source study to color.
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In the PT button shortcut menu, under Palettes, select a color.

In the PT button shortcut menu, under Alpha Blending, select a blending option.
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Work with Display Management

With the viewer’s display management functions you can create and manage highly customized “DMs.”
The term DM refers to display management in general, or to an implementation of a hanging protocol. By
using DMs you can precisely customize how images “hang” in the viewer.

Configure viewer settings for DMs

Before working with DMs, configure the settings described in the following sections in this manual.

Configure modality-specific viewing options
Configure mammography

Set up connected displays
Next, configure viewer settings as follows.

Procedure

1. On the worklist, select settings E, select Viewer Settings, and then in the Viewer Settings
dialog, on the left pane, select MODALITY.

2. In the list of modalities, select a modality that you work with (such as CT or MG).
3. To turn on DMs, in the settings area under Options, select the following checkboxes.

e Auto Hang DM
e DM Allow Missing Cell
e Auto Hang Priors

4. To view priors, under Prior Options, configure the following.
a. Select the Auto Open Prior checkbox.

b. In the Auto Open Prior Count dropdown list, select the maximum number of priors to open
at once.

5. Select SAVE.

6. Repeat for each modality that you work with.

Show the DM toolbar

The DM toolbar gives you quick access to DM related functions. You can manually display the DM toolbar
in the viewer, or configure the viewer to display the DM toolbar automatically for selected modalities.

e Manually: In the viewer, select the display managern button, and then in the button shortcut
menu, select Show DM Toolbar.
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e Automatically: On the viewer toolbar, select the settings ﬂ button. Select MODALITY, select
modalities, select the Show DM Toolbar checkbox, and then select SAVE.

See also:

Use the DM toolbar

Display images with a DM

You can select from a list of previously configured DMs to hang the current study. If you show the DM
toolbar in the viewer, you can select a DM on the toolbar. If you did not show the DM toolbar:

Procedure

1.

2.

Open a study in the viewer.

On the toolbar, select the DM ﬂ button.

On the button shortcut menu, select one of the DMs in the list.

Note: DMs are listed between the first item in the menu, “None,” and “DM Manager.”
Optional. You can change the view as follows.

e Rotate the wheel to page through any additional images in the study that the DM can hang.
e Drag a thumbnail onto a cell to display it there.
e Use the left or right bracket keys ( [ or ] ) to move to the next or previous DM step.

Use the DM toolbar

As in the following figure, the toolbar contains tools on the left, and DMs (RCC 3D and RCC/LCC Tomo)
on the right side of the tools. Use the toolbar as follows.

BTO RCC BTO RCC BTO LCC

RCCILCC Tomo

e Save: Saves a new DM based on the current layout.

e Save Study: Saves the current configuration for the current study only.

e Update: Overwrites the current DM with properties taken from currently displayed images.
CAUTION: Selecting this button deletes all settings of the current DM.

Manage: Opens the DM manager.

Reset: Select to apply any newly created or edited DMs.

Refresh: You can also refresh DMs to update the list of applicable DMs.
[DM]: Select any DM on the DM toolbar to apply it in the viewer.
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Find and open a DM for editing
If you have a large number of DMs you can find a specific one, and then open it for editing.

Procedure

1. On the viewer toolbar, select the display managern button.
2. In the button shortcut menu, select DM Manager.
3. In the DM Manager dialog, enter one or more of the following search criteria.
User Groups — Select the group to which the DM user belongs.
Users - Select the DM user.
Filters — Select whether the DM is private (user-specific) or public.
Modality - Select the modality associated with the DM.
Name - Type all or part of the name of the DM.
4. Select SEARCH.

Result: DMs matching your search criteria appear in the list at the bottom of the dialog.

5. To open the DM for editing, double-click it, or select its edit 74 button.

Edit, delete, duplicate, or copy a DM

Each DM has four buttons on the right side of the list: ¢ I W3

These buttons do the following.
Edit - Opens the DM for editing (for configuration, see Add a DM).
Delete - Deletes the DM from the list.
Duplicate - Duplicates the DM and prompts you to name the duplicate.

Copy - Sends a copy of the DM to a user group or user.

Export and import DMs
You can export DMs for use in other Konica Minolta systems.
Procedure

1. Find and select one or more DMs to export.

2. Select EXPORT SELECTED or EXPORT ALL.

The DMs are added to a single JSON file and downloaded to your computer.
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3. Copy the file to the destination system, display the DM Manager dialog, select IMPORT, and
then open the exported JSON file.

Add a DM
To add a DM:

Procedure

1. On the viewer toolbar, select the display managern button.
2. In the button shortcut menu, select DM Manager.
3. Inthe DM Manager dialog, select ADD NEW DM.
4. In the second DM Manager dialog, enter the following settings.
Name - Type a name for the DM.
Inactive - Select to disable the DM until ready for use.
Private - Select to make the DM available only to you.
Modalities - Select one or more modalities to which the DM applies.
Body Part - Prevents all but the selected body part to display.
To display any body part, leave blank.
Page Count - The number of monitors that the DM uses to display images.

5. Under Preview, in the upper-left corner of the frame, select 1*1 and select a cell layout for the
study-level series/images within the monitor.

6. Optional. Select 1*1 in of the cells, and select a series layout for the series-level images within a
cell.

7. Optional. To allow missing cells, in the upper-right corner of a page or cell, select the checkbox

(see About missing cells).
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Figure. In this example, 3 pages (monitors) are configured, with 1, 2, and 4 cells added to each page,
respectively. On the second page, Allow Missing Cells is selected at the page level, which means that either the
left, right, or both cells can be blank. On the third page, the study will hang if images for the lower-right cell are
missing, but not if they are missing in any other cells. The upper left cell is selected for adding a matching rule
group and/or matching rule. Because the validation percentage is not yet 100%, matching rules must be added.

8. Note the validation percentage, and then select SAVE.

9. If the validation percentage was not 100%, you must add a matching rule that yields 100%.
Continue to “Add a matching rule group.”

About the order of DMs in the DM manager

When you open a study in the viewer, Exa PACS/RIS finds all DMs that match the study, and then hangs
the study using the one that was highest in the list in the DM manager. It also makes all matching DMs
available to you in the DM toolbar and in the DM button shortcut menu. You can change the default order
of DMs in the DM manager by dragging them in the list.

About missing cells

By default, DM pages and cells do not allow missing cells. This means that if no image exists in the study
that can hang in one of the cells on a page, no images hang at all on the page. For example, if you
configured a DM to display a current image in the left cell and a prior in the right cell, but no prior is
found, then the current image does not hang.

Sometimes it is preferable to allow missing cells. For example, if you configured your DM to display up to
three priors, but only two priors are found, you still want to display the current image and the two priors.
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Add a matching rule group

You can group matching rules and apply AND/OR logic to them. If set to AND, all rules in the group must
be true to hang images, and if set to OR, at least one rule must be true. Adding a matching rule group is
optional, but we recommend doing so for most applications.

Procedure

1. In the DM Manager, in the list of DMs, double-click to open the DM to which you want to add a
matching rule group.

2. Under Preview, select a cell.
3. At the bottom of the window, on the MATCHING RULES tab, select ADD GROUP.
The new group initially appears as a row of buttons under the ADD GROUP button.

MATCHING RULES DISPLAY MANAGEMENT

D0 GroUP] ADD GENERAL RULE[ADD MANIO RULE] DD PRIOR RULE DELETE GRouF &

The matching rule group is the row of buttons on the bottom. No rules have been added to the group.
4. Add one or more rules to the group.
5. In the list on the right side of the dialog, select a relationship of AND or OR.
6. At the top of the dialog, select SAVE.

See also:

Add a general matching rule to a DM

Add a prior matching rule to a DM

Add a mammo matching rule to a DM

Add a mammo rule for breast implant displacement

Add a general matching rule to a DM

When you add a DM, the modality, body part, and allow missing cell settings you enter roughly determine
which images hang where in the DM. You can also finely determine this by using general matching rules.
In most cases you should use a general matching rule, but for mammography, see Add a mammo

matching rule to a DM.
General matching rules consist of an argument, logical operator, and matching value. For example:

Study Date (arg.) is Less/Equal (operator) to 01/02/2003 (matching value).

Procedure
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Open the DM to which you want to add matching rules.
Under Preview, select the cell to which to apply the rule.
At the bottom of the window, on the MATCHING RULES tab, select ADD GENERAL RULE.

Note: If you created a group and you want the rule to be included in the group, select the button
that is inside the group.

In the Matching Tag dialog, enter the following settings.

DICOM Tag/Field - Select a tag to use as the argument.

Operator - Select an operator.

Matching Value - Type a matching value, and then select the plus sign.
Modify the rule until the validation percentage is 100%, or add another rule.
Select SAVE.

In DM Manager, select SAVE.

Add a mammo matching rule to a DM

If you assigned the MG modality to a DM, you can add mammography matching rules to it. Mammo rules
take the form of mammography-specific properties; if an image matches all properties the DM is applied.

Procedure
1. Open the DM to which you want to add mammo rules.
2. Under Preview, select a cell.
3. At the bottom of the window, on the MATCHING RULES tab, select ADD MAMMO. RULE.
Note: If you created a group and you want the rule to be included in the group, select the button
that is inside the group.
4. In the Mammo Rule dialog, enter the following settings.

Side Left Left breast
Right Right breast
? Either
View [Various] Select the primary breast view.
DON'T CARE [Various] Select the secondary breast view. Selecting DON'T CARE
allows any of the secondary views to display except ID.
Processing Type | Unprocessed Raw images
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5.
6.
7.

Tomosynthesis 3D images
CView 2D images taken from a tomosynthesis study
Processed Standard 2D images
? Images without the “0008,0068” Presentation Intent Typeg
DICOM tag.
Image Index ANY Images of any index can hang

1-20 Only an image of the selected index can hang.

Modify the rule until the validation percentage is 100%, or add another rule.

Select SAVE.

In DM Manager, select SAVE.

See also:

Build a mammography DM

Add a prior matching rule to a DM

To hang priors, add a prior matching rule to the destination DM cell.

Procedure

1.
2.

Open the DM to which you want to add prior rules.
Under Preview, select a cell.
At the bottom of the window, on the MATCHING RULES tab, select ADD PRIOR RULE.

Note: If you created a group and you want the rule to be applied to the group, select the button
that is inside the group.

In the Prior Rule dialog, select the index of the prior that you want to hang in the cell.
Note: Selecting ANY allows you to move through all available priors when viewing a single DM.
Select SAVE.

In DM Manager, select SAVE.

Add a mammo rule for breast implant displacement

You can create a DM for breast views that allows you to displace (effectively hide) the implant.

Procedure

1.

Add a mammo rule to a DM cell, and in the DON'T CARE list, select ID.
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2. When viewing implant images, rotate the wheel to switch between displaced and non-displaced
views.

See also:

Build a mammography DM
Mammography views

About the DM validation percentage

The DM validation percentage helps you by indicating, roughly, the percentage of cells in a DM you are
configuring that would not display any images under the current settings. To achieve 100 percent, apply
a valid condition or rule to each cell in the DM. If the percentage is not 100, Exa PACS/RIS prevents you
from using the DM at all. You can view the percentage by opening a DM for editing; the percentage
appears on the right side of the Preview area title.

Use the Display Management tab

To automatically apply additional processing to all images that hang in a DM, you can use the Display
Management tab in the DM manager.

Procedure
1. In DM Manager, open a DM, and then select a cell.

2. On the DISPLAY MANAGEMENT tab, enter the following settings.

Auto-Orient [Unused]

Rotation Select a degree of clockwise rotation.

Mirror Select to switch the left and right breast view.

View Select a zoom type.

Invert Select one or more processing functions to apply.

Sigmoid

Linear

CLAHE

Fusion

CAD

Current MG Only Exempts the current cell from the Stack by View and Prior option.

CAD Select to display CAD values according to the SR CAD settings when the
user reaches this step of the hanging protocol.
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LUT Select an LUT to apply.

Bone Enhance Select a percentage of bone enhancement.

Window/Level Select Default or Custom. If Custom, type the values to apply.
Reprocess Select to generate an additional view from the base view.

3. Select UPDATE, and then SAVE.

See also:
Configure mammography

Create a DM from an existing layout

To create a DM more quickly, you can arrange a layout in the viewer, and then save it as a DM.

A The rules that are created with this method include as many parameters from the source studies
as possible, and may be overly restrictive for general use, or apply unexpected image processing.
Therefore to ensure proper hanging and rendering, review the resultant rules in both the MATCHING
RULES and DISPLAY MANAGEMENT tabs and modify if necessary.

Procedure
1. Open a study in the viewer and configure the display to your liking.
2. On the toolbar, select the DM button, and then in the button shortcut menu, select DM Save.
3. In the DM Information dialog, type a name for the DM and select or clear the Private checkbox.
4

Select SAVE.

Example DM with a general matching rule

In this example we add a DM for viewing chest X-rays with an AP view on the left and a lateral view on
the right. Continuing after step 3 of “DM examples:”

Add the DM

1. In Name box, type CHEST TEST.

2. the Modality list, select CR, and then select DX.
3. Inthe Page Count box, type or select 1.

4. Under Preview, on the page header, select 1*1 and select a 1 x 2 cell layout.
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Add a rule group and general rules for the left cell
1. Select the left cell, and on the MATCHING RULES tab, select ADD GROUP.
2. Inthe new group, select ADD GENERAL RULE.
3. Inthe Matching Tag dialog:
e Inthe DICOM Field/Tag list, select Modality.
e In the Operator list, select Equal.
e In the Matching Value box, type CR, select the plus (+) button, and then select SAVE.
Note: In practice you may also want to add the DX modality.
4. Following the previous step, add another general rule:
o DICOM Field/Tag = SeriesDescription
e Operator = Contains
e Matching Value = ap
5. On the right side of the matching rule group, in the list, select AND.

This means that the image must satisfy both rules to hang in the cell.

Add general rules for the right cell
1. Select the right cell, and select ADD GENERAL RULE.
2. In the Matching Tag dialog, add the following rule:
e DICOM Field/Tag = SeriesDescription
e Operator = Contains
e Matching Value = lat
3. Next to Preview, confirm that the validation percentage is 100%.
4. Select SAVE, and then close the DM manager.

5. Select F5 to update the viewer with your new DM.

Add a DM group

To keep different sets of hanging protocols for different appointment types and studies, you can combine
DMs into groups.

Procedure

1. Onthe burgerE menu, select SETUP.
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2. On the OFFICE menu, select DICOM.

3. On the HANGING PROTOCOLS tab, under DM Group, select the plus button.
4. In the DM Group dialog, on the left, type descriptive information for your DM group.
5. Under Associate group to study by, do one of the following:

e Select APPOINTMENT TYPE, select one or more appointment types in the list, and then
select SAVE.
e Select STUDY DESCRIPTION. In the Study Description box, type a description, and then

select the plus button.

6. Click SAVE.

Share DMs with a DM group
To add (share) DMs with a DM group:

Procedure

1. Onthe burgerE menu, select SETUP.
2. On the OFFICE menu, select DICOM.
3. On the HANGING PROTOCOLS tab, find a DM to add to a group.

4. On the right, select the share < button.

5. In the Share dialog, select the group with which to share the DM, and then select SHARE.

Share DM groups with users

By default, DM groups that you create are only available to you. To share a DM groups with other users
Or user groups:

Procedure
1. Onthe burgerE menu, select SETUP.

2. On the OFFICE menu, select DICOM.

3. On the HANGING PROTOCOLS tab, under DM Group, select a DM group to share.

4. On the right, select the edit 74 button.
5. In the Edit DM Group dialog, select SHARE.

6. Inthe Copy dialog, select users or groups with which to share the DM group, and then select
COPY.
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About DM groups and private DMs
When a DM is created by a member of a DM group, the following apply.

Private** Original Creator Read/Write
All Others None
Copy Shared with users Read/Write
Shared with user groups Read-Only
Copy of shared copy Shared with users or user groups Read/Write
Non-Private Original Creator Read/Write
Group members Read-Only
Copy Shared with user group or DM group Read-Only
members

*Read here means view, use to hang studies, or copy to other users.

**Imported DMs are automatically marked as Private for the importing user.

Build a mammography DM

The following is an example of how to build a DM that displays priors on top and current images (RCC,
LCC, RMLO, LMLO) on the bottom. This DM shows all main views and specialty views such as spot and
cleavage, synthesized views, and implant displaced views.

1. In the viewer, on the toolbar, select the DM button, and then in the button shortcut menu, select
DM Manager.

2. Select ADD New DM.
3. Type a name for the DM, and then enter required settings.

OPTIONAL: In the Body Part list, select Breast.

DM Manager
HP Properties n
Hame * MG TEST O tnactive [ Private
HP Identifier Modality
Modalities m
Body Part * Breast ¥
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4. In the Page Count box, type the number of monitors.

Preview 0% Page Count *|2

& Allow missing cells
202 o [ 0DL{3 ..

Salect to always show tha call

11 D 141 D D even of chilena do nol maich

™1 D ™5 D

5. Select the layout numbers (such as 2*2 or 1*1), and then select the number of cells.

6. Select the Allow missing cells check box for each page and/or cell that you want to always
display, even if empty.

7. Select a cell, and then on the MATCHING RULES tab, select ADD GROUP.

8. In the list, select OR, and then select ADD MAMMO RULE.

MATCHING RULES DHSELAY MANAGEMENT

ADD GENERAL RULE ADD MAMMO RULE ADD PRIOR RULE
ADD GENERAL RULE ADD MAMMO RULE mmm I

e “OR"” means "this rule, OR any subsequent rules." We build mammography DMs in a group to
have the system look for multiple views, which allows us to use one DM for multiple scenarios.

e Groups allow you to have the system look for multiple views, and use one DM for multiple
scenarios.

9. For the top left cell, add the following rule criteria.
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Mammo Rule
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& Processed
Oz

Image Indax Ay

This means, “Right side, CC Family (All views), any specialty view except ID (Implant
displacement), and processed.”

10. Select SAVE.
Result: Rules matching your criteria appear in the list.
11. Within your group, select ADD MAMMO RULE and add the following additional rules.

e Right, CC Family, Don't Care, Synthesized
e Right, CC Family, ID, Processed
¢ Right, CC Family, ID, Synthesized

12. From outside the group, select ADD PRIOR RULE for this cell.

MATEHING RULES

ADD GROUP ADD MAMMO RULE ADD PRIOR RULE
R ¥

DONT CARE / CC / / ANY - Side: Right| Processing Type: Processed |

DONT CARE / XCC / / ANY - Side: Right| Processing Type: Processed | 0
Note: The button outside the group applies the rule to the entire group.

13. For Study Index, select one of the following options.

¢ Any: Display all allowable MG priors (the allowed number depends on Auto Open settings for
the MG modality).

e 1: Show the first prior

e 2: Show the second prior

14. In the Display Management tab, customize the way the image displays with the following
options.
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Auto orient, rotate, Mirror flip (for Radiologists who view Left on Left, Right on Right), Zoom,
Invert, Sigmoid, Linear, Clahe, Fusion, LUT, Bone Enhance, Window/Level, Reprocess.

15. Repeat steps above to configure each cell of your DM.
16. Select SAVE at the top.
See also:

A mammo matching rule t DM

Add a prior matching rule to a DM

Add a mammo rule for breast implant displacement
Add a DM group

Mammography views

Example DM for ultrasound

In this example we add a DM that hangs a 3 x 2 series layout (3 rows, 2 columns) of only ultrasound
images. Continuing after step 3 of “DM examples:”

Add the DM

1. In Name box, type US TEST.

2. the Modality list, select US.

3. Inthe Page Count box, type or select 1.

4. Under Preview, select the 1*1 cell (not the page header), and select a 3 x 2 series layout.

Add a general rule for all images
1. Select inside the page’s 1*1 cell to highlight everything around the 3 x 2 series-level cells.
2. Add the following general rule.

o DICOM Field/Tag = Modality

e Operator = Equal

¢ Matching Value = US

3. Confirm that the validation percentage is 100%, and then save the DM.
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Gather information from images
View pixel values in Hounsfield units

You can view the value of a selected pixel in Hounsfield units.

e On the viewer toolbar, select the Hounsfield units W tool, and then select and hold the mouse button
on the pixel of interest.

Display DICOM values

You can display the DICOM tag values associated with the current image by doing one of the following.

e On the viewer toolbar, select the DICOM values button.

e On animage shortcut menu, select View > DICOM Values.

Export DICOM values

When you view DICOM values in the viewer you can export them to a CSV. This CSV file can only be
displayed correctly in Notepad, Notepad++, or Wordpad.

Procedure

1. On an image shortcut menu, select View > DICOM Values.

2. In the title bar of the screen that appears, select the download button.

Result: The file is downloaded to your Windows Downloads folder.

Print images to a standard printer

You can print the current image, series, or study to a TWAIN (non-DICOM) printer. It is a convenient,
less-expensive alternative to DICOM printing, but is not suitable for diagnostic purposes.

Procedure

1. On the viewer toolbar, select the print E button.
2. Inthe Print Image dialog, enter the following settings.
Layout - Select the number and arrangement of frames per page.
Page Size - Select the paper size and print orientation.
Compress large images — Select to compress large images (for lower quality but faster printing).
Selected Image - Select to print the current image.

Selected Series - Select to print all images in the current series.
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Current Page - Select to print the current image in all displayed frames.
All Images - Select to print all images in the current study.
3. Select Print.

4. In the Windows print dialog, configure options and select Print.

Open a third-party application or function
If you configured a third-party application or function, you can open it from the toolbar.

¢ On the viewer toolbar, select the external tool button corresponding to the item to open.

Download images
You can download images and series from studies to your desktop in various formats.

e To download the selected image as a PNG (regardless of the current series layout), on the image
shortcut menu, select Download Image.

e To download each image in the current series as a separate file, on the image shortcut menu, select
Download Series, and then select the file format.

About viewing CAD findings

The Exa PACS/RIS viewer automatically displays image markers contained in SR data from supported
manufacturers such as iCAD, DiA, and CureMetrix (such as the CureMetrix mammography calcification
and density markings). To control which markings to display, select options in the SR CAD list.

Exa PACS/RIS uses tracking IDs in the SR data to ensure that when you click a 2D/synthesized image
annotation it jumps correctly to the corresponding 3D/BTO image. Additionally:

e Ifthe BTO series is not already open, it opens next to the 2D/synthesized view in a 1 x 2 layout. You
can go back to the original layout by selecting the backslash key (if the DM was not interrupted).

¢ When 3D CAD SR markings are present and you hover over a CAD SR marking on the synthesized or
2D view, the color changes to the hover color configured in viewer interface settings.

See also:

Configure annotation colors
View tomographic studies with CAD findings
Configure mammography
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Work with Advanced Peer Review

Configure peer review

With purchase of a separate license, Exa PACS/RIS provides an advanced workflow for conducting peer
reviews of approved studies. Before using advanced peer review, perform the following configuration
tasks included in this section.

e Set up peer review by using existing roles, groups, and users
<OR>

e Set up peer review by creating new roles, groups, and users

e Link peer review users to resources
e Configure peer reviewing provider filters

Set up peer review by using existing roles, groups, and users

Current users of Exa PACS/RIS probably already configured user roles, groups, and users. If so, perform
the following steps to give peer review functionality to users by adding the appropriate rights to the
relevant user roles. If one or more roles, groups, or users are not yet configured, see Set up peer review
by creating new roles, groups, and users.

Procedure
1. Onthe burgerE menu, select Setup.
2. On the OFFICE menu, select User Management.
3. On the USER ROLES tab, double-click the relevant user role.

Note: The user role must be one that is assigned to the user group whose members you want to
be peer reviewers.

4. In the User Role Permission area, select the PeerReview checkbox.

5. Select SAVE & CLOSE.

6. Continue to Link peer review users to resources.

Set up peer review by creating new roles, groups, and users

To add peer review to an existing user role, group, or user, see Set up peer review by using existing
roles, groups, and users. To create a new user role for peer review, complete the following steps.

Procedure
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1.

Following the steps in Create a user role, create a user role for peer review.
Give the role a fitting name and description, such as PRand Peer Revi ew.

In the User Role Permission area, select the PeerReview user right, and any other rights that
you want to assign to peer review users.

Select SAVE & CLOSE.

Following the steps in Create a user group, create a user group for peer review, and select the
user role you created previously.

Select SAVE.

Following the steps in Create a user, create peer reviewing users, or edit existing users to add
them to the peer review group you created previously.

Select SAVE.

Continue to Link peer review users to resources.

Link peer review users to resources

To make peer review workflow available, you must link your peer review users to a Provider-Radiology

resource.
Procedure
1. Onthe burgerE menu, select Setup.
2. On the OFFICE menu, select Providers & Resources.
3. On the RESOURCE tab, select ADD, and then enter the relevant settings. Most are self-
explanatory, but note the following.
Type Select Provider-Radiology.
Code Type your internal resource code.
Facilities Select the facilities that can use the resource.
4. Select SAVE.
5. On the LOGIN DETAILS sub-tab, select a user, and then select LINK USER.
6. Select SAVE & CLOSE.
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Configure peer reviewing provider filters

Exa PACS/RIS automatically assigns random studies to each peer reviewing provider that are relevant to
those providers. To specify which studies are relevant to which providers, configure filters for each peer
reviewing provider as follows.

Procedure

1. Onthe burgerE menu, select Setup.

2. On the OFFICE menu, select Providers & Resources.

3. On the RESOURCES tab, double-click the provider to configure.

4. On the PEER REVIEW sub-tab, enter filtering criteria.
For example, if the provider can only review studies from the “Radiology Mart” facility:
a. Under Facility, select Is.
b. In the list of facilities, select Radiology Mart.

Note: A study must meet all of the criteria you specify here to be available to the provider for
peer review.

Note: Leave settings blank to include all items in the filter. For example, leave the Study
Description setting blank if the provider can review studies with any description.

5. Select SAVE.

500-000594A 378



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

Use peer review
Assign a peer reviewer for a study

Exa PACS/RIS automatically appoints peer reviewers and adds studies to their MY PEER REIVEW worklist
filters. Additionally, users with “Peer Review manual appointment” rights assigned to them by a radmin
can manually appoint peer reviewers for their studies with the following procedure.

Prerequisite: Configure peer review.
Procedure
1. On the worklist, right-click a DICOM study, hover over Exam, and then select Assign Study.

2. Inthe Study Assignment dialog, on the Assign for peer review dropdown list, select a peer
reviewer.

3. Select SAVE.

Reassign peer review
You can reassign a previously appointed peer review.

Procedure

1. Onthe burgerE menu, select Setup.

2. On the OFFICE menu, select User Management.

3. Select the ASSIGNED STUDIES tab, and then the PEER REVIEW sub tab.
4. Select one or more studies, right-click, and then select Reassign.
5

In the Appoint Peer Reviewer dialog, appoint a new peer reviewer and select SAVE.

Conduct a peer review of a study

When peer reviewing users sign in to Exa PACS/RIS, a MY PEER REVIEW worklist filter appears with all
studies assigned to the user for peer review.

Procedure
1. On the worklist, on the MY PEER REVIEW tab, double-click a study to peer-review.

The symbols accompanying studies indicate the following:
® Awaiting first review

@ Awaiting second review

(@

Awaiting third review (disagreement)
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2. Inthe Peer Review panel, select buttons on the toolbar to open any panels you need to conduct
the review.

- LN

Buttons: Peer Review (always ON), Prior Reports, Documents

3. Optional. To add documents, in the Documents area, select FULL SCAN (display options before
scanning) scan or QUICK SCAN (scan without options).

4. In the top-right corner of the Peer Review area, select an agreement level, and then type
comments as needed.

5. Select one of the following:
SKIP - Withhold your review temporarily and return to the study later.
SUBMIT & NEXT - Submit your review and open the next study in your list.

SUBMIT - Submit your review.

About peer review disagreements

The worklist provides a Peer Review Disagreements tab for administrators that lists all peer-reviewed
studies for which a reviewer selected Disagree. On the Peer Review Disagreements tab, administrators
can reassign a study to a specific user for a third opinion, or dismiss the study, such as when a third
opinion is not available. Users who are assigned for a third opinion peer review receive the study in their
My Peer Review tab, and perform the new peer review in the usual manner.

Manage peer review disagreements
To manage peer review disagreements:
Prerequisite: Sign in as an administrator with the Peer Review manual appointment user right.

Procedure

1. In the upper right corner of the worklist, select the disagreement button.

2. Inthe PEER REVIEW DISAGREEMENTS tab, right-click a study, and then:

e To get a third opinion, select Reassign for Additional Review, and then assign a new peer
reviewer (see Assign a peer reviewer for a study).

e To dismiss the study, select Dismiss Study.
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Create a peer review report
You can generate a report that shows details on studies that were peer-reviewed.
Prerequisite: The user’s user role must include the Peer Review Operational right.
Procedure

1. Onthe burgerE menu, select Reports.

2. Next to the burger button, select the word REPORTS, and then select Peer Review
Operational.

3. Enter filtering criteria, and then select a button corresponding to the format in which you want to
generate the report.
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Work with Patient Kiosk
What is Patient Kiosk?

Patient Kiosk is an add-on module for Exa PACS/RIS that streamlines the check-in process. You must
purchase a separate license to use it.

For Patients

Patient Kiosk is a web-based program on a touchscreen device at a healthcare provider’s facility to check
in for appointments, view and update demographic and insurance information, and complete and sign
electronic forms. Checking in through Patient Kiosk ensures that patients are correctly matched to their
records.

For Staff

Staff can use functionality within Exa PACS/RIS to process appointments and information coming from
patients using Patient Kiosk.

Configure Patient Kiosk

Make study forms available on Patient Kiosk

You can configure study forms to be available for viewing and signing on Patient Kiosk. To add a study
form to a study, see other sections in this manual.

Procedure

1. Onthe burgerE menu, select SETUP.

2. On the OFFICE menu, select General.

3. On the FORM BUILDER tab, double-click the form that you want to make available.

4. Inthe left pane, on the ASSIGN sub-tab, select the Viewable on Patient Portal checkbox.
5

Move down to Facility, and select the checkboxes for the facilities where the form will be
available.

6. Select SAVE.

Configure the wait time monitor

The wait time monitor appears in the upper right corner of the patient arrival worklist. It is similar to the
TAT and STAT monitors on the traditional worklist, but indicates how long and how many patients have
been waiting since sign-in. By default, the monitor includes three time bands (10, 20, and 30 minutes),
but you can change the number of bands, their colors, times, and descriptions.
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Procedure

1. Onthe burgerE menu, select SETUP.
2. On the OFFICE menu, select Office.

3. On the COMPANY tab, select the APP SETTINGS sub-tab, and then in the left pane, select
Patient Arrival Wait Time.

4. In the right pane:
e To add a new band, at the bottom of the list, enter settings (such as Description and Color).
e To edit an existing band, double-click it in the list, and change settings as needed.

5. Select SAVE.
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Use Patient Kiosk as a patient

Signin as a patient

Patients can use Patient Kiosk to sign in at the point of care.

To start, tap a facility or type its name to search. Next:

Procedure

1.

On the Welcome page:

¢ New patients: Tap New patient, and then skip to step 3.
o Existing patients: Tap Existing patient.

On the Check-in page:

e If you were given a check-in code prior to arrival, tap Check-in code. On the Check-in Code
page, enter your code, select the I agree to the HIPAA privacy notice checkbox, and then
tap Check In.

e If you do not have a check-in code, tap Patient portal credentials, enter your credentials,
select the I agree to the HIPAA privacy notice checkbox, and then tap Check In.

On the Demographics page, enter or edit your personal information, and then tap Next.
On the Contact information page, enter or edit your contact information, and then tap Next.

On the Responsible party page, enter or edit information for the entity paying for the procedure,
and then tap Next.

On the Primary insurance page, enter or edit information for your primary insurance provider, if
any, and then tap Next.

Note: If you do not know the policy number or other details, you can leave them blank for now.

On the Secondary insurance page, enter or edit information for the secondary insurance
provider, and then do one of the following.

e If the Submit button appears, tap it to finish sign-in.
e Tap Next, and continue to the next step.

On the Forms page:

a. Inthe Who Is Signing list, select the signer.

b. Inthe Name box, type the name of the signer.

o

Tap a form in the list, read/edit the form, and then tap SAVE.

d. Use your finger or stylus to sign your name in the signature box, and then tap Save
Signature.
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e. Repeat for all other forms in the list, and then tap Submit.
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Use Patient Kiosk as a healthcare staff member

What is the patient arrival worklist?

The patient arrival worklist is a screen within Exa PACS/RIS that staff can use to manage the patient
check-in process. When a patient signs in for an appointment by using Patient Kiosk, a patient row is
added to the patient arrival worklist. In that worklist, staff can quickly view which patients have arrived,
check in patients for scheduled or unscheduled appointments, add or edit patient demographics, take
receipt of electronically signed patient intake forms, and perform other registration tasks.

Generate a check-in code for a patient

To facilitate patients checking in for their appointments through Patient Kiosk, you can either configure a
patient portal account or provide them with a check-in code.

Procedure
1. On the worklist, on the PRE ORDERS tab, open an order.
2. Inthe Edit Study screen, on the left pane, select PATIENT INFORMATION.
3. Select CHECK-IN CODE.
4. Send the code to the patient by using email, phone, or other means.

See also:

Add or edit a patient’s portal account

|dentify a patient’s registration status
The color of each patient symbol on the patient arrival worklist indicates the registration status.

Procedure
1. Onthe burgerE menu, select PATIENT ARRIVAL WORKLIST.
2. On the left of each patient row, find one of the following symbols.
& Existing patient, no verification required.

New patient, or matching record not found. Requires searching for a matching record and/or
verification.

& Sign-in information differs from the patient chart, requires verification.

See also:

Find a patient chart by entering search criteria
Find a patient chart by scanning a driver’s license
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Verify eligibility of preorders and studies with PokitDok
Verify eligibility and estimate coverage with ImagineSoftware

View patient details
You can quickly view primary demographics and insurance information from the patient arrival worklist.

Procedure

1. Onthe burgerE menu, select PATIENT ARRIVAL WORKLIST.
2. In the Facility button list, select your facility.

3. Select a patient row to view details.

|dentify a patient’s wait status

The color of the square on each row of the patient arrival worklist indicates how long the patient has
been waiting to be checked in. By default, the colors indicate the following wait times.

B Waiting for less than 10 minutes
Waiting for up to 10 minutes
I Waiting for 11 to 20 minutes

@ Waiting for 21 to 30 minutes

See also:

Configure the wait time monitor

Find or create a patient chart

If a patient checks in as an existing patient but the system could not find a matching patient chart, the

patient’s registration is indicated by the “* symbol. For such patients you can manually search for and
attach the patient chart or create a new patient chart directly from the patient arrival worklist.

Find the patient’s chart

1. On the burger E menu, select PATIENT ARRIVAL WORKLIST.
2. In the Facility button list, select your facility.

3. In the patient shortcut menu, select Patient Search.

4

In the Patient Search dialog, enter search criteria and then double-click a patient in the list of
results.
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5. On the patient arrival worklist, within the patient record, select:
Accept - Use the demographics entered by the patient
Reject - Use the demographics from the patient chart

6. Optional. Select Edit Patient Information to edit demographics.

Create a new patient chart

1. On the burger E menu, select PATIENT ARRIVAL WORKLIST.

2. In the Facility button list, select your facility.

3. Select the patient row to expand the record and then select Create New.
4. Fillin the patient chart.

See also:

Create a patient chart
Edit basic patient information

Verify patient demographics and sign-in information
You can check information that a patient entered in the kiosk upon sign-in.
Procedure

1. On the patient arrival worklist, select a patient row to view details.

The information appears as follows.

Green Information that the patient added or edited during check-in.
Black Original, unchanged information.
(Parens) Information prior to editing by the patient during check-in.

2. Select one of the buttons to accept or reject all new and edited information.

3. If you want to accept some, but not all changes, first accept the changes, and then open the
patient chart and modify the incorrect information.

Open the patient chart from the patient arrival worklist
You can open a patient chart of an existing patient from the patient arrival worklist.

Procedure

1. Onthe burgerE menu, select PATIENT ARRIVAL WORKLIST.
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2. In the Facility button list, select your facility.

3. On the patient row, select the patient & button to open the patient chart.

Check in a patient for a scheduled appointment

If the patient symbol is blue, and has a study scheduled within the next 12 hours, you can check in that
patient. If a patient has multiple studies scheduled for a single visit, all of the studies are checked in at
once.

Prerequisite: Verify patient details.

Procedure

1. On the burger E menu, select PATIENT ARRIVAL WORKLIST.
2. In the Facility button list, select your facility.
3. Select the patient row, and then select Check In All.

The patient is checked in, and the row is removed from the patient arrival worklist.

Create a walk-in appointment

If a patient signs in to the patient kiosk who does not have an appointment, you can create a walk-in
appointment for that patient.

Procedure
1. Onthe burger E menu, select PATIENT ARRIVAL WORKLIST.
2. In the Facility button list, select your facility.
3. Select the patient row, and then select Walk-in Appointment.
4

In the New Appointment screen, create the walk-in appointment.

Add documents at check-in
If you receive documents to attach to the patient's record or study, follow these steps.

Procedure

1. Onthe burgerE menu, select PATIENT ARRIVAL WORKLIST.
2. Right-click a scheduled patient row, and then select Upload.

3. In the Patient Document screen, scan or upload documents as needed.
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Work with the patient chart

Exa PACS/RIS gives you full viewing access to patient demographics, and lets you add, edit, and import a
patient chart (or an electronic medical record or EMR). The Edit Study screen contains much of the same
information as the patient chart.

Find and open a patient chart

Find a patient chart by entering search criteria
You can find an existing patient chart by searching on various patient demographics.

Procedure

1. Onthe burgerE menu, select PATIENT.

2. On the Patient screen, select the SEARCH tab.

Note: If the tab bar is hidden, select the arrow next to Patient to display it.
3. In the Starts With dropdown list, select a target for your search criteria.

This target applies to all boxes in the search bar.
4. In the All dropdown list, type or select a search filter (these are typically facilities).
5. In the search bar, in one or more of the boxes, type one or more characters.

The results appear in the PATIENT SEARCH RESULTS list.

Example

To find “John Smith:”
1. Select Starts With.
2. Select All.

3. In the Last Name box, type Sm , and in the First Name box, type Jo.

Find a patient chart by scanning a driver’s license
You can find an existing patient chart by scanning a driver’s license.
Procedure

1. Onthe burgerE menu, select PATIENT.

2. On the Patient screen, select the SEARCH tab.
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Note: If the tab bar is hidden, select the arrow E next to Patient to display it.
3. Select SCAN LICENSE.
4. Use your barcode reader to scan the driver’s license.

The results appear in the PATIENT SEARCH RESULTS list.

Open and view the patient chart

After finding a patient chart, you can open it to view patient demographics and other information. For
more information about each of the settings within the patient chart, see Edit Study screen and other
topics.

Procedure
1. Find a patient chart, and then double-click it.

The patient chart opens with the PATIENT INFORMATION tab.

2. To view more information, next to the Patient page title, select E, and then select a tab (such
as PATIENT GUARANTOR, or INSURANCE PROFILES).

See also:

Fin atient chart entering search criteri

Find a patient chart by scanning a driver’s license
Edit basic patient information
Edit other patient information

Send reports from the patient chart
You can send approved reports by email or fax directly from the patient chart.
Procedure

1. Open a patient chart, and then select the STUDIES tab.

2. Inthe list of studies, right-click a study containing an approved report, select Send Report, and
then select Fax/Email.

3. Inthe Send Report dialog, in the Send Fax and/or Send Email sections:
a. In the Send To dropdown list, select a category of recipient.
b. In the dropdown list on the right, select an individual recipient.

4. Select SEND FAX and/or SEND EMAIL.
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Access confidential patient records (break the glass)
In emergencies you can use the Break the Glass function to open patient records that are usually off
limits. All Break the Glass operations are added to the audit trail report. Users of type Associated Patients
Only can also “break the glass” from the New Appointment screen. To "break the glass" on the
physician's portal, orin the patient chart search screen:

On Physician Portal

Prerequisite: Configure access reasons (see App settings).

1. On the My Exams worklist, select the Break the Glass checkbox.

2. Inthe Break the Glass Warning dialog, use the search tools to find a patient, and then double-
click the patient record.

3. In the second Break the Glass Warning dialog, in the Access Reason list, select a justification
for accessing the confidential record.

4. In the Verify Your Credential boxes, type your portal sign-in credentials, and then select
ACCEPT.

Result: Studies for the selected patient appear in the My Exams screen.

On the Patient screen

1. Onthe burgerE menu, select Patient, and select the Break the Glass checkbox.

2. Find a patient chart in the usual manner.

About VIPs

VIPs (very important patients) are patients who the facility wants to identify for special consideration by
healthcare staff. A gray star appears next to patient names on the worklist, the patient chart, and other
areas of the program. With the appropriate user rights, a user can select the VIP star to change it to a

solid star and thereby designate the patient as a VIP.
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Create and modify a patient chart

Create a patient chart
You can create a patient chart.

Procedure

1. Onthe burgerE menu, select PATIENT.

2. On the Patient screen, select the SEARCH tab.

Note: If the tab bar is hidden, select the arrow next to Patient to display it.
3. Select CREATE NEW.
4. Type, select, or scan information in the available options.
5. Select CREATE PATIENT.

See also:

Edit basic patient information
Edit other patient information

About the PID, MRN, and account numbers

The patient ID (PID) is usually the same as the MRN or account number. When they differ, it often is
because the PID comes from DICOM sources and the account number comes from RIS sources. This can
happen when an incoming DICOM study with an existing PID conflicts with a receiver rule, and Exa RIS
compensates by creating a unique account number. Also, staff often enter account numbers manually
when creating preorders for new patients, because no PID would exist yet.

Alternate account numbers

Patients receive a different MRN, PID, or account number when they undergo exams at different
facilities. When Exa PACS/RIS receives such external studies, you can merge them into the master
patient record by linking the external MRNs, PIDs, or account numbers as alternate account numbers of
the Exa PACS/RIS account number. The benefits of this are:

e The viewer opens images from all records at once

e Any subsequently incoming studies having one of the account numbers are automatically linked to the
other account numbers

e Helps prevent duplicate patient records
¢ Reduces the need to merge patient records

See also:

500-000594A 393



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

Configure alternate account number functionality
Use alternate account numbers

Edit basic patient information

You can edit or add new information to a patient chart. You can access the same settings from an order
tab in the Edit Study screen.

Procedure
1. Find and open a patient chart.

2. On the PATIENT INFORMATION tab, type or select information for the following options.

Market Select the markets that serve the patient.

Facilities Select facilities that serve the patient.

DICOM Patient ID Type the PID or patient MRN.

Account No./Alt. Type the patient's account or alternate account number. See About the PID, MRN

and account numbers

Name Type the patient's first, and last name.

Optional: Type the middle name, middle initials, and/or suffix.

/ Grey = Non-VIP. Click to change to Yellow (VIP).
Alias Type first and last aliases.
DOB Select the patient's date of birth.
Marital Status Select the patient's marital status.
Smoking Status Select the patient's smoking status.
Racial/Ethnic Checkboxes: Select all that apply.

Dropdown list: Select the Hispanic or Latino ethnicity or non-ethnicity.

Physician Select the patient's primary physician.

Ordering Facility Available when using Mobile RAD. Select the ordering facility location or contact that
serves the patient.

Sex Select the sex of the patient.

Height/Weight Type the patient's height and weight.

Patient Flag Select a patient flag.

Language Select the patient's preferred language.

HIE Consent Select whether the patient has consented to release of demographics and medical

data through a Health Information Exchange for treatment, payment, and health
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care operations purposes.

Select [more] next to words Patient Information to view the following settings

License No./Province Type the patient's driver's license number, and select the issuing state.

Exp. Date Select the expiration date of the driver's license.

Emp. Status Select the patient's employment status.

Employer Name Type the name of the patient's employer.

Emp. Address Type the street address of the patient's employer.

City/Province/Postal Type or select the city, state or province, and ZIP or postal code of the patient's
employer.

Phone/Fax Type the phone and/or fax humber of the patient's employer.

Reason for Death If the patient is deceased, select the checkbox and then select the reason for death in|

the dropdown list.

Notes Type any notes you wish to include in the chart.

Users Assigned Dynamically search for and select a user to to assign to the patient, and then click
the add button. Optional: Repeat to assign more users.

Home Address Enter the patient's primary contact information.

SMS / Email Consent: Select whether the patient consents to be contacted by SMS
text and/or email.

Contact Information Enter the patient's secondary contact information.

3. Select SAVE.

Edit other patient information

In addition to basic patient information, you can enter a wide range of other patient-related information
in the patient chart. Most of this information is mirrored in the Edit Study screen, giving you access to it
through multiple workflows. To enter or edit this other information from a patient chart:

Procedure

1. Open a patient chart.

Note: If the tab bar is hidden, select the arrow next to Patient to display it.
2. Select a tab in the following table, and then enter settings.

Refer to the descriptions and topics shown for details.
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Patient Chart Tab

PATIENT GUARANTOR Assign a guarantor for a patient

PATIENT ALERTS Assign or remove patient alerts

INSURANCE PROFILES Add or edit an insurance profile

STUDIES Manage studies in the patient chart

ORDERS Double-click an order in the list to open it in the Edit Study screen.
STUDY FORMS Add a study form to a patient record

DOCUMENTS View or add patient documents

PAYMENT HISTORY View payment history and print receipts

ALLERGIES Add allergy information
ACTIVITY LOG View activity logs
NOTES Enter notes and reasons for study

Open the call log

See also:

Find a patient chart by entering search criteria

Configure alternate account number functionality

To be able to use alternate account numbers, perform the following procedures.

Configure anissuer of a PID

The issuer of a PID is an alias for the facility that issued the incoming PID (or MRN, or account
number). You must configure an issuer of a PID in advance for each facility whose PIDs you want to

use as alternate account numbers.

Some issuers require a standardized formatting for account numbers. You can prevent users from
entering invalid account numbers by typing a regular expression against which the account number
must match. Exa PACS/RIS will validate all future account number entries against your regular

expression.

1. Onthe burgerE menu, select SETUP.

On the OFFICE menu, select DICOM.

2
3. On the ISSUERS tab, select ADD, and type a name for the issuing entity.
4

In the Pattern box, type a regular (pattern) expression for validating PID/account numbers for

the specified issuer.
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Example: AB? matches a PID starting with AB and followed by one character, such as AB1, ABC,
and ABz.

5. Select SAVE.

Configure an AE for use with alternate account numbers

For each application entity that receives studies whose MRNs, PIDs, or account numbers you want to
use as alternate account numbers:

1. Onthe burgerE menu, select SETUP.

2. On the OFFICE menu, select DICOM.

3. Onthe AE TITLE tab, double-click an AE in the list to open it.
4

Under Issuer Type, select Static or Dynamic. If you select Static, in the Issuer dropdown list,
select the issuer.

5. Select SAVE.

Configure a receiver rule for use with alternate account numbers

For each relevant receiver rule:

1. Onthe burgerE menu, select SETUP.

2. On the OFFICE menu, select DICOM.

3. On the RECEIVER RULES tab, double-click a receiver rule in the list to open it.
4

Under Rule Information and Filter, select the Issuer of Alternate Account Number
checkbox.

5. Select SAVE.
See also:

About the PID, MRN, and account numbers
Use alternate account numbers

Use alternate account numbers
To use alternate account numbers to link multiple patient records, complete the following steps.
Prerequisite: Perform the procedures under “Configure alternate account number functionality.”

Procedure

1. Onthe burgerE menu, select PATIENT.

2. On the Patient screen, find the patient and open the patient chart.
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3. Onthe PATIENT INFORMATION tab, select MANAGE ALTERNATE ACCOUNT
NUM/IDENTIFIERS.

4. In the Alternate Account Num/Identifiers dialog, select ADD.

5. Inthe Issuer Name and Type dropdown list, select an option, and then type the alternate
account number or identifier.

6. If using multiple alternate account numbers, select the Primary checkbox if you want the current
number to be the primary one.

7. Select SAVE.
You can repeat this procedure to add multiple alternate account numbers.
See also:

About the PID, MRN, and account numbers
Configure alternate account number functionality

Assign a guarantor for a patient

If the patient requires a guarantor for legal or insurance purposes, you can add one to the patient’s
chart.

Procedure
1. Find an open the patient’s chart.
2. Onthe PATIENT GUARANTOR tab, select ADD.

3. Enter the information for the guarantor, and then select SAVE.

Manage studies in the patient chart

From the STUDIES tab of the patient chart you can create, schedule, and view payment status of prior or
future studies of the patient.

Procedure

1. Open a patient chart.

Note: If the tab bar is hidden, select the arrow next to Patient to display it.

2. On the STUDIES tab, perform one or more of the following tasks.

Find, view, and edit a study Search for a study in the list. Double-click a study to open it in the Edit
Study screen.
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View approved reports Select the @ approved report button of a study.

View payment status An aggregate summary of study payments appears at the bottom of the
screen.

Fax/Email approved reports Right-click an approved study, point to Send Report and select
Fax/Email.

View the claim inquiry screen Right-click a study that has claim history, and then select Claim
Inquiry.

Schedule an ordered study Select an unscheduled study, and then select Schedule Appointment to

open the study in the Find Slots screen (see Use the Find Slots feature).

Create a study for the patient Select one of the following:

NEW STUDY: See Enter appointment information

WALK-IN: See Schedule a walk-in appointment

Order images 1. Select a study whose images you want to order in the list, and then
select ORDER IMAGE.

2. Select the patient and/or physicians to whom to send the images.

3. Type sending methods and notes, and then select PLACE ALL
ORDERS.

Import a patient

You can import a patient record (.CSV) into Exa PACS/RIS. If the patient already exists in Exa PACS/RIS,
you can update the existing record with the imported information, or create a new record.

Note: To view which options must be present for the update to be successful, select the help 7 button
on the right side of the PATIENT IMPORT button.

Procedure

1. Onthe burgerE menu, select PATIENT.

2. On the Patient screen, select the SEARCH tab.

Note: If the tab bar is hidden, select the arrow next to Patient to display it.
3. Select IMPORT PATIENT.

4. In the Import Patient dialog, select Choose File, and then browse for and select the file
containing the patient record.

5. Optional. To update an existing patient record, select the Update Existing checkbox.

6. Select IMPORT.
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Merge patient charts

If two patient charts are accidentally created for a single patient, you can merge the charts.

1. Onthe burgerE menu, select PATIENT.
2. On the SEARCH tab, in the MRN box, enter the account number of the records to merge.

3. Inthe list of results, select the row containing the incorrect patient chart, hover and select the

settings E button, and then select Merge.

PATIENT SEARCH RESULTS

Test, Test MergeZ - test1057 ' « Select GEAR > MERGE

DOE: 01/01/2022, (333)333-3333, (586)200-0000
3 on INCORRECT chart

KISSIMMEE, FL 34742 s first

Active/inactive —
Tast, Test] Merge - test1056

DOB: 01/01/2022, (333)333-3333, (333)333-3333

123 main st
KISSIMBMEE, FL 34742

Delele

4. Repeat the previous two steps for the row containing the correct patient chart.

5. In the Patient Merge screen, confirm the contents of the merge and then select MERGE.

Merge a “FIX_” study

If the DOB, gender, first name, and last name of a new patient chart are the same as an existing
one, Exa PACS/RIS prepends “FIX_" to the account number in the worklist. You can fix these by
merging them with the existing chart. This can occur in such cases as a hame change due to
marriage or divorce, an updated account number, or an error in patient entry.

1. On the search bar of the worklist, in the ACCOUNT NO. box, type fix and then select Enter.
2. Inthe list of results, copy the account number (without the “FIX_" prefix) of a study.

3. Paste the account number in the ACCOUNT NO. box, and then select Enter.
4

In the list of results, compare the “FIX_" record with the other to determine whether they are for
the same patient.

5. Ifthe same, merge the records by following the earlier procedure.
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Work in the dispatching dashboard

The dispatching dashboard is separate from the dashboard, which provides an overview of current
orders. The dispatching dashboard provides a view of the worklist for entering and tracking orders for
mobile radiology. Technologists who execute those mobile orders use the Mobile RAD app from their
mobile devices. Before using the dispatching dashboard, you must configure the following study statuses
and add them to a study flow.

Assigned AS
Accepted ASAC
Rejected RJ

To customize any other statuses you may need, contact your Konica Minolta sales representative.
See also:

Configure study statuses
What is the Dashboard?

View, create, and assign orders

View the worklist from the dispatching dashboard
Procedure
1. Onthe burgerE menu, select DISPATCHING DASHBOARD.
2. To view all studies, select the ALL tab.
3. To view all preorders, select the PRE-ORDERS tab.
4. To view all orders with any order-related status that are not assigned to technicians or vehicles,

select the TO BE DISPATCHED tab.

Create a new order for dispatch

The Pre-Orders tab in the dispatching dashboard shows all studies in the Ordered status. You can
dispatch these orders (see Assign an order), or create a new order by following this procedure.

Procedure

1. Onthe burgerE menu, select DISPATCHING DASHBOARD.
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On the TO BE DISPATCHED tab, in the upper right corner, select a facility, and then select the
New Order E button.

In the New Appointment screen, find a patient and schedule a study as you typically would, but
note the following on the APPT. INFO. tab:

e In the Ordering Facility dropdown list, select only if that facility—rather than the place of
service—acquires the exam.

e Under Schedule Information, you must select options in the Place of Service dropdown list.

e Optional. Under Schedule Information, type an entry in the Justification of Mobile Service
box to appear in the mobile app.

Select CREATE ORDER.

Assign an order

All studies that do not have a technologist or vehicle assigned in an Ordered, Scheduled, Confirmed, or
other related status appear in the To Be Dispatched tab. To initiate these orders, assign them as follows.

Procedure

1.
2.

On the burgerE menu, select DISPATCHING DASHBOARD.

On the TO BE DISPATCHED tab, right-click an order, hover over Dispatch, and then select
Create New Dispatch.

In the Dispatch screen, enter the following settings.

[Dispatch resource Select Technologist to assign the order to a technologist.
dropdown list]
Select Vehicle to assign the order to a vehicle.

Date/Time Select a date and time to dispatch the resource.

Dispatch To Type to search for a resource of the type selected previously, and then select
a specific resource in the list of results.

Dispatch Orders Select all orders to which you want to dispatch the selected resource.

Select DISPATCH.

Note: A dispatch number is automatically created, which you can view in the worklist.

What happens after assignment?

After assigning an order, the order moves through the following steps.

e It appearsin the ASSIGNED tab of the dispatching dashboard, and in the mobile app.
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e The technologist accepts the assignment on the mobile app, and then the order moves to the
DISPATCHED tab on the dispatching dashboard in Exa PACS/RIS.

e The technologist taps Tech Start on the mobile app, performs the exam, and then taps Tech End.
The order moves to the COMPLETED tab in the dispatching dashboard.

e On the Exa PACS/RIS worklist, the order appears with images on the ALL STUDIES tab in the Tech
Start, Incomplete, Unread, or other related status.

Group orders by dispatch ID

When dispatch of one or more orders and exams is completed, the Exa PACS/RIS assigns the same
dispatch ID to all of the orders and exams. By grouping orders and exams by dispatch ID, you can apply
and evenly divide transportation fees, setup fees, and “after hours” pricing to the orders and exams.
These orders and exams remain open until set to Check Out/Complete, during which time they can be
modified (by adding, editing, or removing exams or other services).

Procedure

1. Ifan open dispatch ID exists, right-click an order, and in the Dispatch submenu, select Add to
Open Dispatch.

2. Select the open dispatch ID to add to the new dispatch group.

Work with Mobile RAD

Mobile RAD is a mobile Android app that technologists use to manage their mobile exams.

Install Mobile RAD

All technologists and other users of Mobile RAD must follow the steps in the following sub-topics to install
the Mobile RAD app on their Android mobile device. If you do not have access to the SETUP area of Exa
PACS/RIS, request assistance from an administrator.

Configure Exa PACS/RIS

1. In Exa PACS/RIS, on the burgerE menu, select SETUP > [full caps menu] > Scheduling &
Codes > STUDY STATUS.

2. Inthe Facility dropdown list, select your facility.
3. For each status in the list related to mobile orders:
a. Double-click the status to open its settings.

b. On the STUDY STATUS sub-tab, select the MobileRad Related checkbox.
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c. Select SAVE.
Install a PDF viewer
1. On your mobile device, go to the Google Play Store.

2. Install a PDF viewer, such as Adobe Acrobat, WPS Office-PDF, or Microsoft Office.

Install the APK

1. In Exa PACS/RIS, on the burgerE menu, select Tools > MOBILE RAD.
2. Copy mobilerad.apk to your mobile device (such as through email, chat, or File Explorer).
Result: The browser downloads the mobilerad.apk file.

3. On your mobile device, in the Blocked by Play Protect message, select INSTALL ANYWAY.

Configure Mobile RAD

1. Tap and hold the Mobile RAD icon, and then select App info > Permissions.

2. On the App permissions screen, on the options : menu, select All Permissions.

3. In the Storage folder of your mobile device, confirm that the MobileRAD sub-folder appears. If it
does not, create the sub-folder.

Sign-In to Mobile RAD

1. From your site administrator, obtain the host name for Mobile RAD.

2. In Exa PACS/RIS, on the burgerE menu, select SETUP > [full caps menu] > Office >
COMPANY.

Write down the value in the Code boxes.
Tap the Mobile RAD icon, and on the sign-in screen, select HOST NAME 2.

In the HostName field, enter the host name, and then select YES.

o v &> W

On the sign-in screen, enter the following:

Username Your user name for Exa PACS/RIS.

Password Your password for Exa PACS/RIS.

Company Code The code you wrote down earlier.

7. Select LOGIN.
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Perform query and retrieve

You can query a server and retrieve studies.

Prerequisite: Configure DICOM settings for the server to query and for Exa PACS/RIS on the server.

Procedure

1. On the burger E menu, select QUERY/RETRIEVE.
2. Inthe dropdown list on the left side of the QUERY button, select a server to query.
3. Type criteria in the search bar and do one or more of the following.

e To query the server, select QUERY.
e To retrieve all matching studies, select RETRIEVE.
e To retrieve some matching studies, select the studies, right-click, and then select Retrieve.
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Work with the fax manager: Updox

If you purchased Updox fax or reminder services, the fax manager function sends you to the My Updox
website where you can manage sending and receiving of faxes and reminders. Updox is a powerful tool
because it helps you sync faxed information with patient records in Exa PACS/RIS. This chapter gets you
started using Updox by describing some of the main configuration and operational tasks you can perform.

For full documentation, select the help 7 button in the upper-right corner of Updox.

Configure Updox
Users with administrator rights can configure Updox, including users and groups, queues, fax numbers,
and reminders.

Make Updox available in Exa PACS/RIS

By configuring Updox in Exa PACS/RIS, you make it available, specify what users, groups, and facilities
can use it, and ensure that all outbound faxes to go through Updox rather than another service or
implementation such as a fax modem.

Prerequisite: Obtain your Updox account information from your Konica Minolta representative.

Procedure

1. Onthe burgerE menu, select SETUP.

2. On the OFFICE menu, select USER MANAGEMENT.

3. On the THIRD PARTY TOOLS tab, in the left pane, select the user group that uses Updox.
4. Inthe right pane, in the Updox box, type your account information.

5. Select the Send fax with Updox checkbox, and then select the red switch to turn it ON.

15[ =]

6. To assign administrator user rights, select a user in the left pane, and then select the
Administrator checkbox.

7. On the USER GROUPS tab, open a group that uses Updox, and then under Navigation, select
the Fax Manager checkbox. Repeat for all groups that use Updox.

8. At the top of the screen, select USER MANAGEMENT and select Office.
9. On the FACILITY tab, open a facility, and under Updox Account ID, type the ID.
10. Select the Send fax via Updox checkbox.

11. Select SAVE, and repeat for all facilities that use Updox.
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12. Configure your web browser to allow pop-ups. For example, in Chrome:

a. On the overflow * menu, select Settings.
b. Under Privacy and security, select Site Settings.

c. Select Pop-ups and redirects, and then turn on the Allowed switch.

Configure users

Configuring users in Updox allows you assign Updox email addresses (for example, for individual users or
for an entire practice), add staff to queues, assign sign-in credentials, and send notifications to
individuals.

Procedure

1. Onthe burgerE menu, select FAX MANAGER.

2. In Updox, in the upper-left corner of the screen, select MENU.

3. On the Admin tab, select Users, and then select New.

4. On the User Information, Settings, and Notifications tabs, enter all relevant information.
5

Select Save.

Configure queues

Queues are useful for organizing and routing your faxes and emails to the intended location and person.
For example, you could create one queue for each department at a facility. Updox notifies specific users
of the queue that they have a fax waiting. In that sense, a queue can act as a task list.

Prerequisites: Configure users.
Procedure

1. Onthe burgerE menu, select FAX MANAGER.

2. In Updox, in the upper-left corner of the screen, select MENU.
3. On the Admin tab, select Queues, and then select New.
4

Type a name for the queue, select users who can access it, and then select Save.

Configure fax numbers

Konica Minolta provides you with a fax number that you can use for Updox, but your Konica Minolta sales
engineer can also work with the phone company to add your existing fax numbers to Updox.
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Procedure

1. Onthe burgerE menu, select FAX MANAGER.
2. In Updox, in the upper-left corner of the screen, select MENU.
3. On the Admin tab, select Fax Settings.

A list appears of all fax numbers configured for Updox.

4. Select a fax number to configure, and then enter the following settings.

Nickname Type an easily recognizable nickname for the fax number.
Route To Select the queue to which Updox routes inbound faxes.
Tag Tags are customizable labels that you can add to incoming faxes. For

example, if you assign a tag labeled Authorizations to a specific fax number,
Updox automatically adds the tag to all incoming faxes on that number.

5. Select Save.

Configure reminders

A reminder is an email, text, or voice message that Updox sends automatically to patients to remind them
of their scheduled appointments. Updox records the patient response to a reminder, and automatically
cancels appointments in Exa PACS/RIS if appropriate. To edit the contents of reminders, see Configure

scripts.

Procedure

—

On the burgerE menu, select FAX MANAGER.

2. In Updox, in the upper-left corner of the screen, select MENU.
3. On the Admin tab, select Reminders.

4. On the Rules tab, enter the following settings.

Practice Timezone The time zone of the practice performing the exam.

1st Reminder Select the type of reminder, and how long before the appointment
to send the reminder.

2nd Reminder Select the checkboxes to add a second and or third reminder.
3rd Reminder

Send reminders after confirmation is | Select to continue to send reminders even if the patient confirms
received the appointment.
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Blackout weekends Select to not send reminders on Saturdays and Sundays during the
times you specify in the start and end time boxes.

Allow patients to cancel an When selected, the reminder includes a button, link, or other
appointment from the reminder means to cancel the appointment.

Allow patients to call the office from When selected, the reminder includes a button, link, or other
the reminder means of calling the practice.

Filter out multiple reminders for Select to only send a reminder for the first appointment during the
patients within specified time frame time frame you select, and only once during the time frame you
select. Cuts down on redundant reminders that can annoy

patients.

Human Voice Select the type of voice for voice reminders.

5. Select Save.

Configure scripts

When configuring a text script, the variable names in the Text Script dialog bx are misleading, so note the
following

Procedure

On the burgerE menu, select FAX MANAGER.

—

In Updox, in the upper-left corner of the screen, select MENU.
On the Admin tab, select Reminders.
On the Scripts tab, select New.

In the pop-up window, select the type of script you want to add.

o v & W N

Enter the script and other information. To use the script, select the Active checkbox.

You can include variables in your script, as listed on the right. Note the following about variables:

[location] The facility in Exa PACS/RIS
[with] DO NOT USE
[practice name] The customer name in Exa PACS/RIS

7. Select SAVE.
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Use Updox

View a fax or emaill

You can view the contents of your faxes, and any available fax-related metadata and historical activity.

Procedure

1. Onthe burgerE menu, select FAX MANAGER.

2. In Updox, on the left pane, select Inbox.

3. Inthe list, select the arrow > button corresponding to the fax or email that you want to view.
4. Optional. If the item is a failed outbound fax, you can select RESEND to retry the fax.
5

Select the icon representing the item to open and view it.

View an appointment reminder

Appointment reminders are pre-configured emails, text messages, or voice messages that Updox sends
automatically to patients regarding their scheduled exams. If the patient cancels an appointment through
an appointment reminder, the appointment is automatically cancelled in Exa PACS/RIS. To set up an
appointment reminder, see Configure reminders. To view the contents, history, status, and patient
response to an appointment reminder, do the following.

Procedure

1. Onthe burgerE menu, select FAX MANAGER.

2. In Updox, in the upper-left corner, select MENU.

3. On the Home tab, select Reminders Dashboard.

4. Optional. In the left pane, enter criteria to filter the reminders list.
5

In the main list, select an appointment to view details about the reminder.

Process an order

Often referring physicians fax or email exam order documents, and you can attach them to the Exa
PACS/RIS patient chart.

Procedure
1. Onthe burgerE menu, select FAX MANAGER.
2. In Updox, on the left pane, select Inbox.

3. Inthe list, select the arrow (>) button corresponding to the order.
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In the left pane, select SEND ITEM.

In the dialog, type the patient name to search for the patient, select the correct patient in the list
of results, select the Send to EHR checkbox, and then select OK.

Note: If the patient does not exist, you can leave Updox open, create the patient in Exa
PACS/RIS, and then return to Updox and search for the newly created patient.

In the form that appears, fill in options as needed (such as the subject line), and then select the
checkbox for one or more relevant studies.

Note: The document is attached at the order level to the selected studies. If you do not select a
study, the document is attached to the patient.

In the Category list, select the Exa PACS/RIS document type.
Select SEND.

Result: The fax appears in the DOCUMENTS tab of the patient chart in Exa PACS/RIS.

Exchange secure text messages

With Updox, you can exchange secure text messages directly with a patient, and the thread is stored for
future reference. Like faxes and emails, if the patient texts you a document, you can add it to the patient

chart.
Procedure

1. Inthe Inbox, select Text Message.

2. Inthe Send a Text Message dialog, select Secure or SMS.

3. Inthe Send To list, search for and select a recipient (a patient who has a mobile phone number
recorded in their chart).

4. Type a message, or select a template or macro.

5. Select the Allow Responses and/or Attach a File options as needed.

6. Optional. If the patient attached a document that you want to attach to the patient chart, select
the checkbox for the document, select SEND ITEM, and then follow the same procedure for
attaching a faxed document.

7. Select Send Secure Text or Send SMS Text.
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Work with scheduling

A typical scheduling workflow
This section lists topics in the order that you would typically follow to schedule an exam. For other tasks,

see Other scheduling tasks.

About the schedule book

The schedule book displays a chronological list of appointments during a selected 24-hour period in each

modality room at a selected facility. You can open the schedule book from the burgerE menu by
selecting SCHEDULE.

= Schedule Book
RADIOLOGY FACILITY : MY COMPANY ~ FIND SLOTS WALK-IN APPOINTMENT QUICK BLOCK

[ NOVEMBER 29 2022 » SETNO-SHOWS & . TODAY PREV NEXT
Magnetic Resonance (MC) (, Computer Tomo, MC) [ Computer Radiography (MC) ¢,

06:45 am

Navigation bar

TEST 0109 07:00
WALEEIUN gg/31/2000022v82M) M 07:30
CARDIAC MRI MORPHOLOGY &
SETL Y| FUNCTON WIO CONTRAST Appointment

07:30 am

Find an available timeslot

You can begin scheduling by finding an available timeslot in the schedule book, which is a calendar-style
view of appointments by time and modality.

Procedure
1. Onthe burgerE menu, select Schedule to open the schedule book.
2. On the button bar, in the FACILITY button list, select the facility for the exam.
3. Optional. If you configured a schedule filter, you can select it from the FILTER button menu.
4. On the navigation bar, use the date picker to select a date.
5. Double-click an empty timeslot in the column corresponding to the exam’s modality.

6. Continue to Set up a patient.

See also:

Configure a schedule filter
Use the Find Slots feature
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Set up a patient
To set up a patient, perform one of the procedures that follows.

Prerequisite: Start the scheduling workflow from Find an available timeslot.

Find an existing patient chart
1. On the New Appointment screen, select the SEARCH tab.

2. Under Patient Search, select a search mode in the dropdown list (Starts With, Ends With, or
Contains).

3. Type all or part of a patient demographic in one or more of the boxes.

Optional: If the Break the Glass checkbox appears, you can select it to search for confidential

patient records. See Access confidential patient records (break the glass).

4. In the list of search results, double-click the patient for whom you want to schedule an exam.

5. Ifthe Recent Schedule dialog appears, select NEW SCHEDULE.

6. Continue to Enter appointment information.

Create a new patient chart
1. Onthe New Appointment screen, select the SEARCH tab.
2. Under Patient Search, select CREATE & SCHEDULE.

3. Under Personal Information, type the primary demographics (name, Patient ID, etc.) for the
patient.

4. Continue to Enter appointment information.

Import a patient chart

1. Onthe New Appointment screen, select the SEARCH tab.

2. Under Patient Search, select PATIENT IMPORT.

3. Select Choose File, and then browse for and select a patient file.

4. Inthe Open dialog, browse for and select the patient file, and then select Open.
5

Optional: To merge the patient file that you are importing with an existing patient chart in Exa
PACS/RIS, select the Update Existing checkbox.

6. Select IMPORT.

7. Continue to Enter appointment information.

500-000594A 413



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

Enter appointment information

You can enter general information about the appointment and exam, and add preconfigured studies to
perform.

Prerequisite: Start the scheduling workflow from Find an available timeslot.
Procedure
1. Inthe New Appointment screen, select the APPT. INFO tab.

2. Under Appointment Information, enter or modify the following settings.

Location The facility where the exam will be performed.
Modality The modality for the exam.
Appointment Type Type in the box to search dynamically for an appointment type, and then

select one in the list. You can search by description or code number. See

also About procedure codes, appointment types, and appointment type
procedures.

Available Date The timeslot you initially selected on the schedule book. To change the
timeslot, select the calendar button.

Resource The modality room you selected. Not available for editing in this screen.

Ordering Facility Available with Mobile RAD only. Type in the box to search dynamically for the|
ordering facility, and then select one in the list. For more advanced
searching, select the magnifying glass tool.

Referring Physician Type in the box to search dynamically for the referring physician, and then
select one in the list.

Ordering Physician Type in the box to search dynamically for the ordering physician, and then
select one in the list. For more advanced searching, select the magnifying
glass tool.

Attorney Select an attorney in the dropdown list, if applicable.

Stat Level Select an urgency for the exam.

Code, Units, and Modifiers When you select an appointment type, the corresponding code appears in
the Code box, and any available default units and modifiers for the code
appear. Edit the units and modifiers if needed.

[Settings in the right column| The Reading Physician and other settings in this column are optional. Exa
of the page] PACS/RIS will assign the Station, Department, Institution, and Accession
number automatically at another time during the scheduling workflow.

Select study detail options (Available when studies are added in the Find Slots screen.)

Select details to add to the appointment information that are not included by
default. Select APPLY TO ALL STUDIES to add the selected information to all
studies that you schedule.

3. Under Diagnostic Codes, type search criteria and select the search ﬂ button.
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4. Select a diagnostic code in the list.
5. Continue to Enter schedule information.

See also:

About procedure codes, appointment types, and appointment type procedures
A typical scheduling workflow

Enter schedule information

After entering appointment information, you can enter optional details about the appointment and the
attending patient.

Prerequisite: Start the scheduling workflow from Find an available timeslot.
Procedure

1. On the APPT. INFO. tab, move beyond Diagnostic Codes, and then under Schedule
Information, enter the following information.

Ordering Facility Select the ordering facility, if applicable.

Place of Service Select a place of service category.

Source Select the event that initiated the exam.

Patient Location Select the intended destination (such as department) of the patient at the
facility.

Patient Room No. Type the room number for the patient’s treatment.

Patient Condition Select the current mobility status of the patient.

Supervising Physician Type or select the supervising physician for the procedure.

Linked Technologist/Vehicle | Select the technologist or vehicle linked to the exam.

Requesting Date Select the requested date for the exam.

Remind Me for Earlier Select if the patient would like to be reminded of an appointment taking
Appointment place early in the morning.

Transportation Select the patient’s mode of transportation to the facility for the exam.
Injury Date Select the date of onset or injury.

Referral Number Type the referral number, if available.

Patient’s Condition Related Select whether the patient’s condition is related to their employment, auto
To accidents, or other accidents.

Accident State If you selected a condition previously, select the state or province where the
condition occurred.
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Schedule Notes Select a macro note, or type a note in the box.

Exa® PACS/RIS 1.4.32_P5 User's Manual

Justification of Mobile
Service

If dispatching mobile services, type the justification.

2. Continue to Enter insurance information.

Enter insurance information

After entering appointment information, you can enter information about the insurance provider handling
payment for the exam.

Prerequisite: Start the scheduling workflow from Find an available timeslot.
Procedure

1. In the New Appointment screen, select the INSURANCE tab, and then under Primary
Insurance, enter the following information.

If the patient record already includes insurance providers, they appear in the
dropdown list. Select one, if available. Information for the provider you
select appears in the other options.

Existing Insurance

Carrier If no existing insurance providers are available, select a carrier here.
Information for the carrier you select appears in other options, but you must
enter the policy number manually.

Provider Type

The provider type of the selected carrier is entered automatically.

Group Name

Type the provider group name.

Relationship Select the relationship of the subscriber to the patient. If available, the date
of birth and address of the person you select appear in other options.

DOB Select the subscriber’s date of birth.

Sex Select the subscriber’s sex.

Country/Address Type or select the country, city, state, and ZIP code of the subscriber.

Subscriber Name

Type the name of the subscriber.

Service Type*

Available after selecting a carrier. Select the service types available through
the insurer.

Benefit On Date*

Available after selecting a carrier. Select the date that benefits start.

Eligibility/Estimation

Available with Eligibility rights after selecting a carrier. Select to verify
insurance eligibility and/or view estimates. See topics on ImagineSoftware
and PokitDok for procedures.

Policy Number

Type the subscriber’s insurance policy number.
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Group No. Optional. Type the subscriber’s insurance group number.
Valid From/To Date Select the dates during which the policy is valid.
[Address] Type the street address of the subscriber.

*Available when not using ImagineSoftware

2. Optional. Select ADD SECONDARY INSURANCE, and enter information for the secondary
insurance provider.

3. Continue to Enter additional information and forms.
See also:

Verify eligibility of preorders and studies with PokitDok
Verify eligibility and estimate coverage with ImagineSoftware

Enter other information and forms

You can add other physicians to the appointment, view exam prep instructions, view provider alerts, add
patient alerts, and attach study forms such as for consent, HIPAA, and CT screening. You can have the
patient verify the accuracy of the information in the form at the time of the exam.

Prerequisite: Start the scheduling workflow from Find an available timeslot
Procedure
1. In the New Appointment screen, select a tab and perform the corresponding task.

Tab on the New Task
Appointment Screen

EXAM PREP. INSTRUCTIONS| View prep instructions for the selected appointment type.

OTHER PHYSICIAN In the Other Physician dropdown list, select a physician, and then select the
plus button to add the physician to the list. You can add multiple physicians.

Note: When the exam report is completed, if Reports to me is configured (see,
“Deliver reports”), Exa PACS/RIS automatically sends a copy of the report to
the physicians selected here.

PROVIDER ALERTS View alerts for the provider performing the exam.

PATIENT ALERTS Select one or more checkboxes relevant to the patient undergoing the exam.

Note: To add a new alert, at the bottom of the list of alerts, type a new alert
and select the plus button.

Sy HORs Select a form in the dropdown list. To fill out the form, select its edit fﬁ}

button and select SAVE. To make the form available on the patient portal,
select the Patient Portal checkbox.
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2. Continue to Create an order.

Create an order

After entering all information related to the appointment, you create an order. When you create an order,
the appointment is added to the schedule book (except for walk-in appointments) and becomes available
in RIS and the worklist.

Prerequisite: Start the scheduling workflow from Find an available timeslot.
Procedure
1. On the New Appointment screen, select the APPT. INFO tab.
2. Select ADD STUDY.
Result: A study appears in the list based on the information entered for the exam.
3. At the top right corner of the screen, select CREATE ORDER.
Result: Depending on settings, one of the following happens.

e The schedule book appears, showing the scheduled appointment
e The Edit Study screen appears
e The confirmation screen appears

4. Optional. To view a quick summary of the exam in the schedule book, hover over the study block.

See also:

Other scheduling tasks
Edit order information
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Other scheduling tasks
This section describes scheduling tasks that were not covered in A typical scheduling workflow.

Track referrals

As part of your scheduling “to-do” list, you can view a list of referrals that are awaiting scheduling, and
track their scheduling status. To enter referrals, see Refer a patient.

Procedure

1. Onthe burgerE menu, next to SCHEDULE, select the arrow ll and then select PENDING
REFERRALS.

2. On the Pending Referrals screen, enter the date range and facility of the referrals that you want

to view, and then select the search E button.
3. Double-click a referral in the list.

4. In the Referral Status dialog, select a status, type notes, and select SAVE.

Schedule a follow-up
If users specify follow-up exams, you can view a list of the specified exams and schedule them.

Procedure

1. Onthe burgerE menu, next to SCHEDULE, select the arrow ll and then select PENDING
FOLLOW-UPS.

2. On the Pending Follow-Ups screen, enter filtering criteria and then select Enter.
3. Double-click an exam in the list, and complete scheduling tasks.
See also:

Specify a follow-up exam

Create a quick block

You can create a quick block to specify timeslots for non-exam events such as lunch breaks, or for
dedicated use such as all-day training. Soft quick blocks are partial room reservations, and you can
schedule exams over them. Soft quick blocks are semi-transparent on the schedule book. Hard quick
blocks are full room reservations, and you cannot schedule exams over them. Hard quick blocks are
opaque on the schedule book.

Procedure
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1. Onthe burgerE menu, select Schedule.

2. On the button bar, select QUICK BLOCK.

3. On the calendar, drag within a column to place a block.

4. Inthe SCHEDULE TEMPLATES screen, create a schedule rule for the quick block.

See also:

Configure a schedule template and schedule rules
Edit or delete schedule blocks

About schedule blocks

Set no-shows

A no-show is a scheduled appointment that the patient did not attend. You can create a list of studies by
type and date range, and then change the status of all studies in the list to “No-show.”

Procedure
1. Onthe burgerE menu, select SCHEDULE.
2. Under or on the right side of the button bar (on the navigation bar), select SET NO-SHOWS.

3. In the filtering dialog, enter a date range, select one or more statuses, and then select NO-
SHOWS.

4. In the No-Shows for screen, if necessary, refine the list by adjusting search criteria.

5. To change the status of all studies in the list to “No-show,” select SAVE.

Print the schedule book

Procedure
1. Onthe burgerE menu, select SCHEDULE.

2. Under the button bar, on the navigation bar, select the print E button.

Edit an appointment from a schedule block

You can edit the information in an appointment directly from its schedule block on the schedule book.

Procedure

1. Onthe burgerE menu, select SCHEDULE.

2. Double-click a schedule block.
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3. In the Edit Order or Edit Study screen, edit the appointment.
4. Select SAVE.
See also:

Edit order information
Edit study information

Reschedule an appointment

On the burgerE menu, select SCHEDULE, find a schedule block on the schedule book, and then
choose one of the following methods to reschedule the appointment.
Same day: Drag the schedule block
To move the appointment to a later time within the same day and same modality room, you can drag
its schedule block to a new timeslot.
Different day: Use the reschedule bucket

To move the appointment to a different day, you can use the reschedule bucket to "hold" your
appointment while you switch the calendar.

1. Right-click a schedule block, and then in the shortcut menu, select Reschedule.
2. Inthe Reschedule dialog, select the reason for rescheduling, and select SAVE.

The schedule block moves from the calendar to the reschedule bucket.
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» The facilities, filters, and dates of the schedule book are independent from those of the
reschedule bucket. Changing the date in the schedule book does not change the date in the
reschedule bucket.

« If a study is in the reschedule bucket and you change the reschedule bucket date, the study will
“disappear” (be filtered out), but you can simply restore the original date to show the study
again.

3. Find an available timeslot on the calendar.
4. Drag the schedule block from the reschedule bucket to the new timeslot.

5. In the confirmation dialog, select YES.

Copy authorization

When rescheduling an exam, if authorization is past due, a pop-up window appears prompting you
whether to copy authorization to the rescheduled exam.

A Copy Existing Authorization

A date past the expiration date (02/01/2023)
has been selected. Do you want to copy the
existing authorization to this appointment ?

YES L CANCIL

e To copy authorization, select YES.
Result: The authorization expiration date changes to the rescheduled appointment date.
e To not copy authorization, select NO.
Result: The authorization status changes to Reauthorization Needed.
Shorten or lengthen the schedule block
To change only the duration of the appointment, change the end time of the schedule block.

1. Select a schedule block.

2. Hover over the bottom edge of the block, and then drag the orange bar up or down to shorten or
lengthen the appointment.

Make quick changes to appointments

You can make several quick changes to the status, priority, flagging, and other aspects of appointments
without having to open and edit them.

Procedure
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1. Onthe burgerE menu, select Schedule.

2. Right-click a schedule block and use the shortcut menu to do the following.

Schedule Appointment Select to change multiple properties of the appointment in the Find Slots
screen. See Use the Find Slots feature.

Change Status Hover over Change Status, and then select a new status. Modifies workflow
elsewhere in the program.

Priority Hover over Priority, and then select a new priority. Modifies workflow
elsewhere in the program.

Flag As Select to add flags in the submenu.

Stat Select to assign a new urgency level.

Edit Study Select to open the appointment in the Edit Study screen.

Exam Prep Instructions Select to view exam prep instructions. If no instructions were entered, an “x”

appears on the right side of the command in the shortcut menu.

Appointment Confirmation Select to display the appointment confirmation screen. See About the
appointment confirmation screen.

Cancel Select to cancel the appointment. See Cancel an appointment.
Reschedule Select to move the schedule block to the reschedule bucket. See Reschedule

an appointment.

Attach Files Select to open the Patient Documents screen. See View or add patient
documents.
Log Select to opens the audit log screen. See View and export audit log entries.
See also:

About drawing attention to orders and studies
Create a study flag

Cancel an appointment
You can cancel an appointment from the schedule book.
Prerequisite: The appointment must be in the Confirmed or subsequent status.

Procedure

1. Onthe burgerE menu, select SCHEDULE.

2. On the schedule book, right-click the appointment that you want to cancel, and then select
Cancel.
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3. Inthe Order dialog, in the Cancel/Delete Reason dropdown list, select a reason for the
cancellation.

4. If you select “others” in the previous step, in the Reason box, type a reason.

5. Select SAVE.

Use the Find Slots feature

Find slots is an advanced feature for finding appointment times. It can be easier to find a timeslot first,
and then schedule an appointment in it.

Procedure

1. Onthe burgerE menu, select SCHEDULE.
2. In the schedule book, on the menu bar, select FIND SLOTS.

3. In the Available Slots screen, in the Patient ZIP Code box, type the patient’s ZIP or postal
code.

Note: If you arrived at this screen from the patient chart or burger menu, the program does not
display this box.

4. Distance from Patient dropdown list, select a search radius.
5. Inthe Appointment Type dropdown list, select an appointment type.

6. Optional. To narrow results, enter additional criteria in the Referring Physician, Carrier,
Facility, Modality Room, Date, Start Time, and End Time options.

7. Optional. If more time is needed for the exam than the standard duration, select the Additional
Time L~ ] button.

Result: Available timeslots that meet the criteria appear in a list.
Note the following:

The program suggests slots at facilities nearest to the patient based on ZIP/postal code.
To select all facilities or modalities, make no selection or select Select all.

Timeslots overlapping soft quick blocks are accompanied by a pink square.

Timeslots overlapping hard quick blocks are omitted from the list.

8. In the list of timeslots, select a slot.

9. Optional. To schedule another appointment, select ADD APPOINTMENT, and then repeat the
steps.

10. Select CREATE ORDER.

11. Perform scheduling procedures.
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Schedule appointments back to back

You can select to schedule multiple appointments back to back, which means that Exa PACS/RIS will
display timeslots that are available for all of the appointments on the same day at the same facility.

Procedure

1. Onthe burgerE menu, select SCHEDULE.

2. In the schedule book, on the menu bar, select FIND SLOTS.

3. Select the Distance from Patient and Patient ZIP Code (or Postal Code).
4. Select the first Appointment Type in the dropdown list.
5

Select the second Appointment Type, and then in the Group Schedule dialog, select BACK-
TO-BACK.

6. Optional: In the Max Delay dropdown list, select the maximum amount of wait time between
appointments.

Note: The Same Day option returns all available timeslots regardless of delay.
7. Enter additional scheduling criteria, select SEARCH SLOTS, and then select a slot.
8. Select CREATE ORDER.

9. Perform scheduling tasks, such as in A typical scheduling workflow.

If you need to change slots part way through...
If you need to change the timeslots you selected for your appointments before creating the order:
1. Select the first appointment card, and then select the [UNDO] button.
2. Select a new timeslot.
3. Select the next appointment card, and select a new timeslot.
4. Repeat for all appointment cards.
See also:

Use the Find Slots feature

Schedule a walk-in appointment

To immediately admit patients who do not have a previously scheduled exam, you can schedule a walk-in
appointment. Walk-ins are considered exceptions and do not appear on the schedule book, but they do
appear on the worklist so that staff can make accommodations.

Procedure
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1. Onthe burgerE menu, select SCHEDULE.
2. In the schedule book, on the menu bar, select WALK-IN APPOINTMENT.
3. Perform scheduling tasks, such as in A typical scheduling workflow.

Note that Exa PACS/RIS fills in the Available Date box with the current date and time.

Change the time block duration on the schedule book

A time block is the amount of time represented by each block on the schedule book. By default time
blocks are 15 minutes, but you can change them.

Procedure

1. Onthe burgerE menu, select SCHEDULE.
2. On the schedule book, right-click anywhere in the left margin where the times of day appear.

3. Select a duration.

About the appointment confirmation screen

If configured (see the “Auto-Open Appointment Confirmation” setting in Configure other user settings),
the appointment confirmation screen appears after creating an order. This screen provides a convenient
summary of appointment-related information that you can share with patients. In the appointment
confirmation screen you can:

e Under Exam Details, select an appointment card to jump to the Edit Study screen.

o Inthe Send Emails To box, type an email address and select the email = button to send the
confirmation.

e Select the print ‘& button to print the information.

e Verify eligibility and estimate coverage.

Edit or delete schedule blocks
You can edit or delete schedule blocks directly on the schedule book.
Prerequisite: Sign in as a user with the Schedule Block user right.

Procedure
1. Onthe burgerE menu, select SCHEDULE.

2. On the schedule book, select a schedule block, and then select its edit & button.
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Result: Depending on the type of block, one or more editing and/or deleting option appears.
3. Select an option, and if editing, make changes in the editing screen.

See also:

User rights
Create a user role

Edit St screen

About auto-blocks

When you schedule an exam in a timeslot to which a schedule rule applies, and the schedule rule
specifies a particular resource to perform the exam (for example, a technologist), Exa PACS/RIS does the
following.

e Checks to see if the resource is also available to work in other modality rooms at the same time.

o Ifso, and if Autoblocking is selected in the schedule rule, Exa PACS/RIS automatically creates
schedule blocks in the other timeslots to prevent future users from double-booking the resource.

These auto-blocks appear on the schedule book as “Auto-Block with Study ID,” and the Allow Scheduling
option is disabled. You can edit auto-blocks like any other schedule block.
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Work with billing

Exa Billing is a module of the Exa platform that lets you manage all aspects of the billing workflow from
claim submission and receiving payments to preparing detailed financial reports.

Viewing claims

About claim summaries and inquiries

The following describes the levels of detail at which you can edit and view claims.

Claims screen The top-level list of claims.

Find and view studies or claims

Claim detail Double-click a claim in the Claims screen to view its contents.
Claim summary A pop-up window on the Claims screen showing the claim's primary
contents.

View a claim summary

Patient claim summary A patient-by-patient claim workspace with a billing provider focus.

View a patient claim summary

Claim inquiry A detailed patient-by-patient claim workspace with the ability to print
statements and invoices, view claim forms, and add transaction comments
and alerts.

View a claim inquiry

Find and view studies or claims
You can search for a study or claim and open it to view details.

Procedure

1. Onthe burgerE menu, select BILLING.

2. On the top navigation bar, select Studies or Claims.

3. Optional: Select a filter tab. The default filter is ALL CLAIMS.

4. To find a study or claim, in the search bar, do one or both of the following:

e Type or select one or more criteria and select Enter.
e Select a column header to sort the list.
Note: For tips on searching, see Search syntax.

5. Double-click a study or claim in the list to open it for viewing.
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See also:

Set the default filter for the study or claims list
Create a filter for the study or claims list

Create a filter for the study or claims list
You can create a new filter for the studies or claims list.

Procedure
1. Onthe burgerE menu, select BILLING.
2. On the top navigation bar, select Studies or Claims.

On the toolbar, select the ﬁlterﬂ button.
In the Study Filter or Claim Filter dialog, select ADD.

Type the Filter Name and Filter Order (the order of placement as a tab and list item).

o v & W

Select one or both of the following.

Global Filter - Select to make the filter available to all users.

Display as a Tab - Creates a tab on the Studies or Claims page with your filter applied.
Display in Dropdown - Adds your filter to the Default Tab dropdown list.

7. Under the blue line, enter filtering criteria.

8. Select SAVE.

Note: You may have to refresh your browser for changes to take effect.

Set the default filter for the study or claims list
You can specify which tab appears when you open the study or claims screen.

Procedure

1. Onthe burgerE menu, select BILLING.

2. On the top navigation bar, select Studies or Claims.

3. On the toolbar, select the ﬁlterﬁ button.

4. In the Claim Filter dialog, in the Default Tab dropdown list, select the default tab.
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View a patient claim summary

The patient claim summary screen is a patient-by-patient workspace in which you can view, print, and
fax a summary of available patient claims by billing provider and date.

Procedure
1. Onthe burgerE menu, select BILLING.
2. On the top navigation bar, select Claims.
3. Inthe list of claims, find a claim for a patient whose summary you want to view.
4. Right-click the claim, and then select Patient Claims.
5. In the Billing Provider dropdown list, select a billing provider.
6. Optional. To modify the contents of the summary, select or clear these checkboxes:

e Include Billing Provider Info - Select to include billing providers
e Include Third Party Payers - Clear to exclude insurance providers
e Include All Comments - Select to include claim comments

7. Optional: Select PRINT and/or FAX.

8. Optional. To move to through patient claim summaries, select PREVIOUS and NEXT.

View a claim summary
You can view a claim summary in a read-only pop-up window.
Procedure

1. Onthe burgerE menu, select BILLING.

2. On the top navigation bar, select Claims.

3. Inthe list of claims, find a claim for a patient whose summary you want to view, and select its

claim summary = button.

View a claim inquiry

The claim inquiry screen is a patient-by-patient workspace in which you can print statements and
invoices, view claim forms, and add transaction comments and alerts.

Open the claim inquiry screen

1. Onthe burgerE menu, select BILLING.

2. On the top navigation bar, select Claims.
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3. Inthe list of claims, find a claim for a patient whose history you want to view, and select its claim

inquiry E button.

4. To move through patients, select PREVIOUS or NEXT.

Add a transaction comment or alert

1. In the Transaction Detail area, select ADD.

2. In the left pane, type a comment.

3. Optional: Select checkboxes for screens on which you want your comment to appear as an alert.
4

. Select SAVE.

Other tasks

e To add a reminder to follow-up on the claim, in the Follow-Up Date box, select a date, and
then select SAVE.

e To add billing notes, under Billing Notes, select the notes = button, and then select SAVE.

e To print a statement, select PRINT STATEMENT.

e To print a statement for a selected recipient, select the PRINT STATEMENT button shortcut
menu, and then select a recipient.

e To print an invoice, select PRINT INVOICE.

e To move to the patient claims screen, select PATIENT CLAIMS.

e To view insurance forms, in the Insurance area, select a form button.
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Entering and submitting claims

Enter a claim for a study

For studies that are completed but unbilled, you can enter a claim based on the information in that study.
For other charges, see Enter a non-study-related claim.

Prerequisite: Configure a billing provider.

Procedure
1. Onthe burgerE menu, select BILLING.
2. On the top navigation bar, select Studies.
3. Right-click a study whose billed status is Unbilled, and then select Create Claim.
4. Optional: In the Claim Creation dialog, on the CHARGES sub-tab, select NEW CHARGE and do
the following:
a. Inthe CPT Description dropdown list, select an item.
b. Inthe CPT Code dropdown list, select a new code, if necessary.
c. Add pointers and modifiers as needed.
5. Inthe CLAIMS, INSURANCE, ADDITIONAL INFO, and BILLING SUMMARY tabs, enter all
necessary information.
6. Select SAVE.
See also:

Keyboard shortcuts for the claim entry screen
Settings in the claim entry screen

Enter a non—study-related claim

You can enter a claim for charges unrelated to studies, such as for CDs or medical records. Even though
this procedure is primarily intended for unrelated charges, you can also use these steps to associating
charges with a study.

Procedure

1.

2
3.
4

On the burgerE menu, select BILLING.
On the top navigation bar, select Studies, and then select NEW CLAIM.
In the Claim Creation dialog, search for a patient by name or MRN.

In the PATIENT SEARCH RESULTS list, select a patient, and then do one of the following.
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e To create a study-related claim, select the checkbox of the study, and then select WITH
STUDY.
e To create a non-study-related claim, select CREATE WITHOUT STUDY.

5. In the Claim Creation dialog, on the CHARGES sub-tab, select NEW CHARGE and do the
following:

a. Inthe CPT Description dropdown list, select an item.
b. Inthe CPT Code dropdown list, select a new code, if necessary.
c. Add pointers and modifiers as needed.

6. Enter the remaining options as necessary, and then select SAVE.

See also:

Settings in the claim entry screen
Keyboard shortcuts for the claim entry screen

Select a delay reason for a claim

If submitting a late claim, you can add a reason for the delay. Exa PACS/RIS comes with pre-configured
delay reasons, and you can configure additional reasons if needed (see Add codes and other basic data).

Procedure
1. While a claim is open for creating or editing, select the ADDITIONAL INFO tab.

2. At the bottom of the Additional Information section, on the Delay Reasons dropdown list,
select a reason.

3. Click SAVE.

Enter claims in batches

To make it easier to process large numbers of claims for different patients, you can enter, edit, and
validate then in batches.

Procedure

1. Onthe burgerE menu, select BILLING.
2. On the top navigation bar, select Studies.
3. Select multiple studies and then select BATCH CLAIM.
4. On the top navigation bar, select Claims.
5

On the search bar, in the CLAIM STATUS dropdown list, select Pending Validation.

500-000594A 433



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

Claims for all studies that you selected earlier are listed on the screen (along with any other claims
in Pending Validation status).

Open the first claim in the list, edit as needed, and then select VALIDATE.

Select NEXT, and then repeat the previous step until all claims in the batch are processed.

Create claims automatically with Auto Billing

With the Auto Billing function you can create auto billing profiles, which are sets of criteria evaluated
against study information. When a study matches all criteria in an auto billing profile, Exa PACS/RIS
automatically creates a claim for the study. To create an auto billing profile:

Prerequisites:

e Configure items for one or more criteria, such as facilities, modalities, and service codes.
e Your user role must include the Autobilling user right (contact your facility administrator).

On the burgerE menu, select BILLING.

1.
2. On the top navigation bar, on the Setup menu, select Auto Billing, and then select ADD.
3. In the Description box, type a name for the profile.
4. In the Results in Claim Status dropdown list, select the status to assign to claims created based
on this profile.
5. Under Study Status, Facilities, Ordering Facilities, and other categories, add one or more
criteria as follows.
e Select the Is or Is Not option (for example Is).
e Select a study status in the dropdown list (for example, Tech Start (TS))
6. Select the plus button.
7. Select SAVE.
Result: In this example, when a study changes to the Tech Start status, Auto Billing creates a
claim for that study.
See also:
Add a facility

Add modalities

Configure procedure codes
User rights

Create a user role
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Validate claims
You can validate claims to ensure that information is present in all required options.
Procedure
1. Onthe burgerE menu, select BILLING.
2. On the top navigation bar, select Claims, and then select one or more claims.
3. On the toolbar, select VALIDATE.
4. If any options are invalid, the program displays them.
See also:

Configure claim validation

Add a claim to the follow-up queue

If you know that a claim will need further attention in the future, you can add it to the follow-up queue.
To view the follow-up queue, in the upper left of the CLAIMS page, select the FOLLOW-UP QUEUE tab.

Procedure
1. Onthe burgerE menu, select BILLING.
On the top navigation bar, select Claims.
In the list of claims, right-click a claim and then select Add Follow-up.

2

3

4. In the Add Follow-up dialog, enter a follow-up date.

5. Optional. If the Follow-Up User list appears, select the person to whom to assign the follow-up.
6

Select SAVE.

Make quick changes to claims
You can make quick changes to claims without opening them for editing.
Procedure
1. Onthe burgerE menu, select BILLING.
2. On the top navigation bar, select Claims.
3. Inthe list of claims, right-click one (only) claim and then select one of the following.
Change Claim Status - In the submenu, select a new claim status.

Change Billing Code - In the submenu, select a new billing code.
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Change Billing Class - In the submenu, select a new billing class.

Change Billing Payer Type - In the submenu, select a new payer type.

Splita claim

If a claim has more than one charge, you can split the claim by moving some of the charges to a new
claim for the same patient.

Procedure

1. Onthe burgerE menu, select BILLING.

2. On the top navigation bar, select Claims.

3. Inthe list of claims, right-click a claim and select Split Claim.
4

In the Create/Split dialog, find a charge that you want to move to the new claim, and select its
plus ( + ) sign.

5. Select SAVE.

The new claim is added to the CLAIMS page.

Submit a claim
You can submit one or more claims of the same billing method.

Procedure

1. Onthe burgerE menu, select BILLING.
2. On the top navigation bar, select Claims.

3. On the search bar, in the BILLING METHOD column dropdown list, select a billing method (for
example “Paper Claim”).

4. 1In the list of claims, select one or more claims, select VALIDATE, and then resolve any issues.

5. Inthe upper-right corner of the screen, select the billing method selection ﬂ button, select the
same billing method that you selected previously (e.g. Paper Claim), and then select the button
(e.g. select PAPER CLAIM (B&W)).

6. In the dialog do one of the following.

e Electronic claims - In the EDI Claims dialog, select DOWNLOAD, and then upload the edi.txt
file the clearinghouse.
e Other claims and invoices - Download or print the invoice.
See also:

Configure columns on the Studies and Claims screens
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Other billing-related tasks

View and edit the patient chart in Billing
You can open and edit the Exa PACS/RIS patient chart from within Billing.

Procedure

1. Onthe burgerE menu, select BILLING.
2. On the top navigation bar, select Claims, and double-click a claim.
3. At the top of the screen, select the Patient Chart link.

Result: The Patient Information tab of the patient chart opens.

4. Optional. Edit patient information and select SAVE PATIENT.

View patient alerts in Billing

You can view patient alerts from the Studies screen. To view patient alerts from the Edit Study screen,
see, “View patient alerts.”

Procedure

1. Onthe burgerE menu, select BILLING.
2. On the top navigation bar, select Studies, and then open a study.

3. At the top of the Claim Creation or Edit screen, select Alerts.

View and enter notes and reasons for study

You can view previously entered patient, study, schedule, and reason for study notes, and enter new
ones.

Procedure

1. Onthe burgerE menu, select BILLING.

2. On the top navigation bar, select Studies.

3. Double-click a study or claim in the list

4. 1In the Edit screen, select Notes.

5. Inthe Notes dialog, select a tab (such as STUDY NOTES), and then do one of the following.

e Select ADD, type the note, and then select SAVE.
e To find an existing note, enter criteria in the search bar.
e To edit an existing note, double-click it in the list.
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View and download a patient document
You can download any patient documents that are available in Exa PACS/RIS.

Procedure

1. Onthe burgerE menu, select BILLING.

2. On the top navigation bar, select Claims.

3. Inthe list of claims, right-click a claim and then select View Documents.
4

Optional. In the Patient Documents dialog, narrow the list of documents by entering properties
in the search bar.

o

Double-click a document in the list.

6. In the second Patient Documents dialog, in the right pane, select the link of the document to
download.

Result: Exa Billing downloads the documents to the Windows Downloads folder.

Upload a new patient document

You can upload and attach a new document to the patient chart. You can upload files of the following
formats: TXT, PDF, and JPG.

Procedure

1. Onthe burgerE menu, select BILLING.

2. On the top navigation bar, select Claims.

3. Inthe list of claims, right-click a claim and then select View Documents.
4. In the Patient Documents dialog, select UPLOAD.
5

In the second Patient Document dialog, enter the required metadata and then select SELECT
FILES.

6. Browse for and select the file to upload, and then select Open.

Note: Exa Billing renames the file with a UID, and displays its icon in the right pane.

7. Select SAVE.
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Create a billing report

You can create various types of reports based on configurable criteria, and then export them in formats
including PDF, XLS, CSV, and XML.

Procedure

1. Onthe burgerE menu, select BILLING.
2. On the top navigation bar, select Report, and then select a report type in the list.
Enter criteria in the options provided, and then do one of the following.

e To preview the report, select VIEW.
e To export the report, select the button corresponding to the file format.

View approved reports associated with claims

You can view all available reports associated with a claim.

Procedure

1. Onthe burgerE menu, select BILLING.

2. On the top navigation bar, select Claims.

3. Inthe list of claims, right-click a claim and select View Reports.
4. In the Approved Reports dialog, double-click a report to open it.

See also:

View documents and reports in the multi-panel

View documents and reports in the multi-panel
When opening claims or studies in Billing you can open documents and reports in the multi-panel.
Procedure
1. Open a claim or study, and select DOCUMENTS AND REPORTS.
Result: The Priors panel of the multi-panel appears.

2. Inthe left pane, select a document or report to view.
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If linked prior reports are included, the main report appears at the top of the left pane with its
linked reports indented below.

Create and deliver a patient statement

If patients are in facilities such as nursing homes or hospice, and you send bills to their guarantor or a
third party payer, you can change the mailing address when printing the patient statement.

Procedure

1. Onthe burgerE menu, select BILLING.
2. On the top navigation bar, select Report, and then select Patient Statement in the list.
3. Select criteria for the report.

Note: In the US, some information such as the address is excluded from the patient statement if
the patient is a minor.

4. In the Statement Mode button shortcut menu, select select.
5. In the Mail To button shortcut menu, select a recipient.

6. Click a format button to generate the report (PDF, EXCEL, CSV, or XML).

View the patient claim log
You can view a log of patient claim activity.
Procedure
1. Onthe burgerE menu, select BILLING.
2. On the top navigation bar, select Claims.

3. Inthe list of claims, right-click a claim and select Patient Claim Log.
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Send claims to collections

You can prepare a report to review all claims that are in “collections review" status. You can generate
this report for the collection agency, change the claim statuses to "claim in collections," and adjust off the
claim balances.

Procedure

1. the burgerE menu, select BILLING.

2. On the Report menu, select Collections.

3. Select filtering criteria in the Claim Date, Facilities, and Billing Provider lists.
4

Optional. To send the report to the collections agency, select the Send claims to collections
checkbox.

5. To generate the report, select a report format button (such as PDF or EXCEL).

Open an insurance provider's website from a claim
When browsing claims, you can open the website of a claim'’s insurance provider directly from a claim.

Prerequisite: Configure the URL of the website for the insurance provider (see Add an insurance
provider).

Procedure
1. Onthe burgerE menu, select BILLING.
2. On the top navigation bar, select Claims, and then select ALL CLAIMS.

3. On the shortcut menu of a claim, select Change Billing Payer Type, hover over a payer type,
and then select the URL.
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Manage payments

Find and view payments

You can find and view existing payment information for reference or editing.

Procedure

1. Onthe burgerE menu, select BILLING.
2. On the top navigation bar, select Payments.
3. To filter the list of payments, in the search bar, do one or more of the following.

e Type or select one or more criteria and then select Enter.

e Select a column header to sort the list of claims.

e Inthe upper-left part of the screen, select the Payment Status button and then select one or
more payment status filters.

Note: For tips on searching, see Search syntax.

4. Double-click a payment in the list to open it for viewing or editing.

Record a payment

You can record a payment based on an EOB or an invoice. “Recording” a payment enters the bulk
payment in the system, but does not apply the payment to claims and charges. To apply recorded
payments, see the “Apply payments” topics later in this section.

Procedure

1. Onthe burgerE menu, select BILLING.

2. On the top navigation bar, select Payments.

3. At the top of the list of payments, select ADD.

4. Inthe PAYMENTS screen, enter the payment details, and then select SAVE.
5

Optional. New buttons appear in the middle of the screen that you can use as follows.

To record a new payment, select ADD.
To print a record of the payment, select PRINT.
To delete the current payment, select DELETE.

See also:

Apply payments against a list of unpaid claims
Apply payments against a customized list of claims
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Step through claims to add payments
You can step through claims and add payment information.

Procedure

1. Onthe burgerE menu, select BILLING.
2. On the top navigation bar, select Claims, and open a claim.
3. At the bottom of the PAYMENTS sub-tab, select NEW PAYMENT.
4. Enter payment information, select APPLY
5. In the detail screen, enter payment details.
Optional: To attach documents, select DOCUMENTS.
6. Select SAVE, then close the details screen.

7. Select PREV/NEXT to step through claims and add payments.

Apply payments against a list of unpaid claims
You can apply payments to an automatically generated list of unpaid claims for the payer.

Procedure

1. Onthe burgerE menu, select BILLING.

On the top navigation bar, select Payments.

In the list of payments, open a payment.

In the bottom pane, select the PENDING PAYMENTS tab.
Optional. Sort or filter the list with search criteria.

In the list of payments, double-click the payment to apply.

N o u & W N

In the dialog, edit payment information as needed and then select PAY IN FULL.

Result: Exa Billing applies payment to the line items in the list in order, until the payment balance
is 0.

8. Select SAVE.

Apply payments against a customized list of claims

You can apply payments to a list of claims that you can customize first by patient, and then by other
criteria.

Procedure
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o uor W N

On the burgerE menu, select BILLING.

On the top navigation bar, select Payments.

In the list of payments, double-click a payment.

In the bottom pane, select the PENDING PAYMENTS (BY PATIENT / CLAIM / INVOICE) tab.
Use the search tools to find a patient, and then double-click a patient in the list.

In the dialog, edit payment information as needed and then select PAY IN FULL.

Result: Exa Billing applies payment to the line items in the list, in order, until the payment
balance is 0.

Select SAVE.

Pay a claim in full

You can automatically apply a payment to adjust a claim to be paid in full.

Procedure

1.

2
3.
4

On the burgerE menu, select BILLING.
On the top navigation bar, select Claims.
On the shortcut menu of the claim to pay, select Adjust to Paid in Full.

In the Adjust to Paid in Full dialog, in the Adjustment Codes dropdown list, select an
adjustment code.

Select SAVE.

Look up and edit applied payments

You can look up applied payments for reference, and edit them if necessary.

Procedure

1.

2
3
4.
5

On the burgerE menu, select BILLING.

On the top navigation bar, select Payments.

In the list of payments, double-click a payment.

In the bottom pane, select the APPLIED PAYMENTS tab.

Edit the payment information and then select SAVE.
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Export the payments list
You can export the contents of the currently displayed payments list to a CSV or PDF file.

Procedure

1. Onthe burgerE menu, select BILLING.

2. On the top navigation bar, select Payments.
3. Filter the list of payments as needed.

4. Do one of the following.

e To download a CSV file, select EXPORT.
Result: Exa Billing downloads the list to your Windows Downloads folder.

e To download a PDF file, select GENERATE PDF, and then download the PDF from the preview
window.

Exchange files with healthcare agencies

You can exchange files such as payment records with healthcare agencies if supported by their
clearinghouse (or if the healthcare agency acts as its own clearinghouse).

Procedure

1. Onthe burgerE menu, select BILLING.
2. On the top navigation bar, select EOB.

3. Optional. To preview the file before importing it, select PREVIEW EOB FILE, browse for and
select the file, and then select Open.

4. To receive a file, select Download.

5. To send a file, select UPLOAD & PROCESS EOB FILE, browse for and select the file, and then
select Open.

Apply TOS payments

You can automatically apply TOS payments to claims having the same date. If the claim has more than
one charge, the payment is evenly distributed among the charges.

Procedure
1. Onthe burgerE menu, select BILLING.
2. On the top navigation bar, select Payments.

3. On the Payments screen, select the Payment Status button (ALL SELECTED) and then select
Unapplied.

500-000594A 446



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

4.

5.

On the search bar, select:

e PAYER TYPE = Patient
e An accounting date range

Select APPLY TOS PAYMENT.

Write off a small balance

If the patient's total account balance falls below a specified amount, you can automatically write them off
(adjust them to zero).

Procedure
1. Onthe burgerE menu, select BILLING.
2. On the top navigation bar, select Payments.
3. On the Payments screen, select SMALL BALANCE ADJUSTMENT.
4. In the Small Balance Adjustment dialog, type the total patient account balance at or below
which Exa PACS/RIS should write off that balance, and then select NEXT.
5. Confirm the contents of the results list, and then select COMPLETE.
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Mobile billing
If you purchased the necessary license, Exa PACS/RIS provides features that support mobile billing. To
work with mobile billing you must first configure ordering facilities.

See also:

Configure an ordering facility

About mobile billing
Mobile billing means managing billing for Mobile RAD studies. It does not imply the use of a mobile device
to perform billing tasks. Exa PACS/RIS provides separate functionality for mobile billing because the
healthcare organizations involved are different, and because insurance companies in the US require
claims for mobile services to be handled with different procedures and metadata.

Terminology

To explain mobile billing, we need to introduce the following terms.

Mobile radiology company

A company that dispatches technologists to a patient's location to perform an exam.

Ordering facility (herein, OF)

In mobile billing, a facility is typically a mobile radiology company, while an ordering facility is a
facility that hires them. For example, a skilled nursing facility is an ordering facility that contracts
with a mobile radiology company for mobile radiology services. Facilities use Exa PACS/RIS, while
ordering facilities do not. The term ordering facility is not used outside the context of Exa
PACS/RIS.

Ordering facility location or contact

A billable sub-division of an OF. For example, a skilled nursing facility may have multiple wings
(locations), which may have multiple halls (locations), which may have multiple stations or fax
lines (contacts).

Census

A billing type available to OFs in which the responsible payer and pay status may be unknown at
initial billing time. The term census refers to a weekly report from OFs detailing the payment status
of its residents, which is difficult to track because it can change over time.
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Example of mobile billing

Consider the following example of a mobile billing workflow. In this example, the OF is a skilled
nursing facility.

An OF needs an X-ray for one of its residents. The OF signs into Ordering Facility Portal, and orders
the X-ray from MRC (the mobile radiology company with whom they have a contract). The order
arrives at MRC in Exa PACS/RIS, and MRC uses Mobile RAD to dispatch a technologist to the skilled
nursing facility to perform the X-ray. When the technologist changes the order status to Completed,
an in-progress claim is created in the Census queue within Exa PACS/RIS. When the responsible
payer and payment status of the claim is finalized, MRC completes the claim (or split claims) and
sends them to the responsible payer or payers. Information and reports about the study and claims
become available in the ordering facility portal to those with access.

Procedures

To configure and use mobile billing, refer to the following topics in this manual.

Sign in to the OF portal. Sign in to the Exa platform
Configure OF types. App settings

Configure an OF (including providers, reps, Configure an ordering facility
users, and technologists).

Configure an OF location or contact. Add a location or contact to an ordering facility
Understand billing types. Wheat is a billing type?
Configure billing rules and charge types. About billing rules

"About procedure code charge types" in About procedure
codes, appointment types, and appointment type procedures

Add a billing rule

Link a user to an OF, manage access to Create a user

scheduling in the OF portal, and manage access

to studies.

Filter the preorders tab for OF orders. Select a quick filter of the pre orders tab

View OF contact information from the worklist. | Open a pop-up window for physicians and ordering facilities

Select an OF for an order or study. Edit order information

Edit basic patient demographics

Dispatch a mobile RAD study to an OF. Create a new order for dispatch
Add an OF location to an appointment. Enter appointment information
Automatically create claims for an OF. Create claims automatically with Auto Billing
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N

Mail a printed statement to an OF. Step through claims to add payments
Use Census billing. About the Census screen

Create a claim in the Census screen

About the Census screen

The Census screen shows a list of studies at ordering facility locations of type Census, and lets you create
claims for them. Such ordering facility locations process studies whose payer status is unknown or subject
to change, even up to the day of the study (for example, Medicare patients at skilled nursing facilities).
When the billing method for a study is finalized, you can create a claim directly in the Census screen,
which then moves to the Claims screen for further processing in the usual manner.

Create a claim in the Census screen
You can create claims directly in the Census screen.
Procedure
1. Onthe burgerE menu, select BILLING.
2. On the toolbar, select Census.
3. Inthe Ordering Facility list, select a facility.
4. Optional: In the Ordering Facility Notes box, type or edit notes, and then select SAVE NOTES.
5

Select a study in the list, assign the census type, and then select CREATE CLAIM.

Export the census queue
You can export the census queue to send your ordering facilities.

Procedure

1. Onthe burgerE menu, select BILLING.
2. On the toolbar, select Census.

3. Inthe Ordering Facility list, select a facility.

4. Select the export button.

Result: The census queue appears in your Windows Downloads folder as an Excel file.
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Work with reports

Create, view, and deliver reports

Create a report

You can create various types of reports based on configurable criteria, and then export them in formats
including PDF, XLS, CSV, and XML. Note that reports here does not include approved reports from
radiologists.

Procedure

1. Onthe burgerE menu, select REPORTS.

2. On the top navigation bar, select Report, and then select a report type in the list.
3. Below the Filter Fields label, select criteria to define the content of the report.

4. Select VIEW, or select an output format (PDF, EXCEL, CSV, or XML).

See also:

Create a billing report

Create a peer review report
Create and deliver tient statement

View your saved reports

You can view open and download reports that you previously saved.

Procedure

1. Onthe burgerE menu, select the arrow II next to REPORTS, and then select MY
REPORTS.

2. Select a report in the list, and then:

e Select to download
e Select @ to open

Send reports to providers

You can configure Exa PACS/RIS to automatically send reports and images through email to specified
provider locations/contacts and their provider groups.

Prerequisite: Add a referring physician or ordering physician to any studies whose reports you want to
send (see Edit study information).

Procedure
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1. On the burger menu, select SETUP > [full caps menu] > Providers & Resources > RESOURCE.
2. Inthe list of resources, double-click a provider type resource.

3. On the LOCATIONS/CONTACTS sub-tab, double-click a location/contact in the list.

4. Double-click a location/contact in the list. In the Contact Information area, in the Email box,

type the email address of the provider contact.

5. Inthe Reports to Me area, under Contact Information, enter the following settings. To send
reports to other members of the provider location/contact's provider group, under Reports to
Group, enter the same settings.

Email Report Link Select to send a link to the report in an email.

Postal Mail Select to send a hard copy of the report to the mailing address entered
in the Contact Information area.

Fax Select to send a fax of the report to the fax number entered in the
Contact Information area.

Email Attachment Select to send the report as an attachment to an email.

Auto-Print Available when you select postal mail. Select a printer in the dropdown
list to automatically print reports.

Office Fax Select to send a fax of the report to the office fax number entered in
the Contact Information area.

6. Optional: Under Report Password, type a password to require to open reports.
7. Select SAVE & CLOSE.

Note: You can view your sent reports at: Burger menu > SETUP > General > REPORT QUEUE.
Records are processed and sent to the specified user or group based on the email service
configuration.
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Work with Exa Chat
What is Exa Chat?

Exa Chat is a program within Exa PACS/RIS that provides secure chat (exchange of text messages) with
other members of your institution. You can hold private chats (instant messaging), or group chats with
individuals or departments. You must purchase a license to use Exa Chat.

What is the contact list?

The contact list is contained in the main Exa Chat window that appears in the lower left of the Exa
PACS/RIS browser window, and lists chat rooms in which you participated. You can select any room to
re-open it. When a user archives a room, it is removed from the contact list.
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About group (multi-user) chat rooms

Group and ad hoc are both types of multiuser chat room. Group chat rooms are managed, and ad hoc
chat rooms are not. If you start a private chat and then add a third member, the chat room becomes an
ad hoc chat room. The following table summarizes other differences.

Who can create the The “manager” (user with Group Any user with Personal Chat Allowed rights.
room? Chats Management rights).

Who can/remove add | The manager. No special user Any member can add anyone else with
members? rights are required to be added. Personal Chat Allowed user rights.

Who can delete/archive| The manager. Only the last remaining member.

the room?
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Use Exa Chat

Start a new private chat

To start chatting with someone for the first time, you can create a private chat room. After creating a
private chat room, it appears in the contact list for future use.

Procedure

1. On the contact list, select the add :] button.

2. Inthe Add room dialog, begin typing a contact name, and then select the name from the list.
The private chat room window appears to the left of the contacts list.

3. Inthe box at the bottom of the chat room window, type a message and select Enter.

Join a group chat room

You can join a group chat room that was configured in Exa PACS/RIS.
Prerequisite: Add a group chat room
Procedure

1. On the contact list, select the add :] button.

2. Inthe Add private room dialog, start typing the name of the group room, and then select the
name from the list. The group chat room window appears to the left of the contacts list.

3. Inthe box at the bottom of the chat room window, type a message and select Enter.

Start a new multi-user chat

To start a group chat, you create a multiuser chat room. After creating the room, it appears in the
contact list for future use.

Procedure

1. On the contact list, select the add button.
In the Add Room dialog, select CREATE ROOM.

In the Create new room dialog, type a title for the room, and then select CREATE NEW ROOM.

2

3

4. The multiuser chat room window appears to the left of the contacts list.

5. In the box at the bottom of the chat room window, type a message and select Enter.
6

The message is sent to all members in the chat room.
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Minimize or restore chat rooms

e To minimize a chat room, select its minimize H button.
¢ To minimize Exa Chat (all chat rooms and the contact list), select the minimize button on the contact

list.

e To restore a single chat room or all chat rooms, select the maximize - button at the bottom of the
browser window.

Open a previously used chat room

Each entry in the contact list corresponds to a chat room in which you participated. Select any room in
the list to re-open it and re-initiate a chat.

Add a member to a chat room

You can add a new member to an existing chat room. You can also add a group chat room as a
“member” of another chat room.

Procedure

1. On the header of a chat room, select the settings ﬂ button.
2. Select Add users or Groups.

3. Inthe Add user dialog, begin typing a contact name, or a group chat room name, and then
select the name from the list.

4, Select OK.

Change your status

Your status indicates your availability to chat. You can set a status of Busy (available for emergencies)
and DND (do not disturb, do not play sounds). Unless you assign a status manually, Exa Chat
automatically assigns a status of Online (available) or Offline (unavailable).

Procedure

1. On the header of the contact list, select the status button.

+ Viztek, Pacs Online N/
Online

@ Private Chat m
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2. Select a status.

Add a chat room to your favorites
When you add a chat room to your favorites, it moves to the top of the contact list.
Procedure

1. Open the chat room that you want to add.

2. In the chat room window header, select the Add to favorites ksl button.

Use an avatar for chat

An avatar is an image such as a photo that represents you in a chat room. To use an avatar in chat,
follow the procedure in “Add an avatar” and the avatar will appear in your chat rooms automatically.

Copy from one message to another
You can copy all or part of a message into another message.
o Select all or some text in one message, select Ctrl+C, and then paste into another message.

e Drag a message from one chat window into the message box of another chat window.
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Manage Exa Chat

Add user roles for Exa Chat

Administrators must add user roles for Exa Chat.

Procedure

1. Onthe burgerE menu, select SETUP.

1. On the OFFICE menu, select User Management.

On the USER ROLES tab, select ADD.

Type a name for the role (such as Chat), and a description, and then select SAVE.

On the USER ROLES tab, double-click the user role you just added.

v A N

Select one or more of the following checkboxes.

Personal Chat Allowed - Create and join private and ad hoc chat rooms.
Group Chats Management - Create and join private and multiuser chat rooms.
Chat - Apply both of the previous rights.

6. Select SAVE.

See also:

Manage users

Rename a chat window
You can change the name of an existing chat room.

Procedure

1. Select Settings E in the chat room that you want to rename.

2. Type the new title in the box, and then select SAVE TITLE.

Archive a chat

To save disk storage space, you can archive your chats. Archiving saves messages older than a pre-
configured date to a CSV file, and then removes them from the system. Archiving only works if the system
holds more than a pre-configured number of messages.

Procedure

1. Select Settings E in the chat room that you want to archive.

500-000594A 457



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

2. Select Archive the chat.
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Use Exa Links

What are Exa Links?

Exa Links are links to Exa PACS/RIS controls that you send to chat members. Recipients can select the
Exa Links to open patient charts, studies in the Edit Study screen or viewer, approved reports, notes, and
other assets.

Find and send an Exa Link

If you hover over a control in Exa PACS/RIS and its tooltip ends with “--- - Share to Chat,” it is an Exa
Link.

| Echit - Share to Chat

- = .
The following table lists the controls that are available as Exa Links at the time of this writing. More will be
added in future versions.

Study toolbar: Viewer,
Edit, Approved Reports

To send an Exa Link, drag it onto the message box at the bottom of a chat room window, and then select
Enter.

Send a document by using an Exa Link

In addition to the Exa Links on the worklist, you can send Exa Links to documents from the Patient
Documents screen.

Procedure
1. On a worklist shortcut menu, select Attached Files.
2. In the Patient Document dialog, double-click a document to open it.

3. Drag the Share to Chat button into a chat message.
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Work with tools

Exa PACS/RIS includes a suite of tools that provide a variety of functionality. Some tools must be installed
locally on the client computer (see Install and configure toals).

Use importtools

Import studies from CD

You can perform a “CD import.”

YA

Ensure that the data to be imported, and the data after import are correct.
Prerequisite: Install Opal tools.

Procedure

1. Onthe burgerE menu, select the arrow next to TOOLS, and then select CD IMPORT.

2. Ifthe “Open Opal Import?” message appears, select the checkbox, and then select Open Opal
Import.

3. Inthe OpalImport dialog, select Select Files/Folders or DICOMDIR to Import, and then
browse for and select files to import.

4. Enter customization settings and then select Import.

Import studies to a specific AE (APl mode)

You can import studies to a specific AE.

Procedure

1. On the worklist, on the PACS Actions E menu, select Import Images.

Note: If the “Open Opal Import?” message appears, select the checkbox, and then select Open
Opal Import.

2. Inthe OpalImport dialog, turn on API mode by typing 1g2w3e4r 5t .
Note: You only need to perform this step once. API mode will remain on permanently.
3. Select the Exa API transfer option.

4. Select Select Files/Folders or DICOMDIR to Import, and then browse for and select files to
import.
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5. Enter customization settings and then select Import.
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Work with Patient Portal

Patient Portal is a website that patients can use to view or modify information about their past and future
exams, demographics, insurance, guarantors, and representatives, and to schedule appointments.

About creating a patient account

Before the patient can use Patient Portal, clinical staff must work with the patient to create an account.
You can choose one of two workflows to create an account: initiated by clinical staff, or initiated by the
patient.

Create a patient account

To create a new patient portal account:

As clinical staff

1. Provide the patient portal URL to the patient. You can contact the patient directly, or add the URL
to the appointment confirmation screen or automated appointment reminders.

2. In the patient’s chart, select PORTAL ACCOUNT.
3. Enter information as needed, and then select CREATE.

Result: Exa PACS/RIS sends an email to the patient with a link they can use to set their
password.

3. Click SAVE.

As the patient
1. On the patient portal sign-in screen, select NEW USER.
2. Inthe New User Registration dialog, fill out the form, and then select Save.

3. Open the email from your healthcare facility, and then select the verification link to verify your
email address.

Link the portal account to a patient chart

When a patient initiates creating their own Patient Portal account, the demographics they enter are sent
to Exa PACS/RIS. You must reconcile that information to the patient’s existing chart, or use it to create a
new chart.

Procedure

1. Onthe burgerE menu, select PORTAL REG USERS.
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2. On the Portal Registered Users screen, open a user of Verified status.

3. In the Portal Registered Information screen, in the Patient Match area, search for a matching
patient. If no matching patients appear, select CREATE NEW, edit the patient’s information as
needed, and then select CREATE PATIENT.

4. Open the matching patient, and check the Registration Information pane on the right; if any
information appears in yellow, decide whether you want to update the patient chart with the new
information.

5. Do one of the following:

e To update the patient chart and link the account, select SAVE AND LINK, and then select
UPDATE.

e To continue linking the account without updating the patient chart, select SAVE AND LINK,
and then select CONTINUE WITHOUT UPDATING.

e To reject the registration request altogether, select REJECT.
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Use the patient portal
Only patients and authorized representatives can use the patient portal, but you can refer to these
instructions to assist patients. See also the Patient Portal user's manual.

Sign in to the patient portal

Procedure

1. Go to the URL given to you by your healthcare provider.

@ Login

example@email-address

LOGIN

In the Login pane, in the first box, type your email address.
In the second box, type your password.
Select the I Agree to the HIPAA Privacy Notice link to open the notice, and then read it.

If you agree, select the I Agree to the HIPAA Privacy Notice checkbox.

o U A W N

Optional. To automatically fill in your email address whenever you go to the sign-in page, select
the Remember Me checkbox.

7. Select LOGIN.

| forgot my password
If you forget your password, you can reset it from the sign-in page.
1. On the sign-in page, on the right pane, select FORGOT PASSWORD.

2. Inthe Forgot Password box, type your email address and select SUBMIT.
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3. Open the email sent to the address you entered, and use the link to reset your password.

Go to the Home screen

e Inthe left pane, select Home.

Find a location
You can search for a healthcare facility near you on a map.
1. In the left pane, select Our Locations.

2. In the list of locations, select a location to show it on the map.

View appointments and appointment confirmations

You c an view information about your past and future appointments, and view and print the appointment
confirmation card.

Procedure

1. On the home screen, select the Future Appointments or Past Appointments tab. Each
appointment appears in a row.

2. To open the appointment confirmation card, on the left side of an appointment row, select the

appointment card button.

3. To print the appointment confirmation card, open the confirmation card, and then select Print.

Upload a document

You can send us documents such as scans of your insurance card, forms, and reports from prior exams by
uploading them in the patient portal.
1. On the home screen, select the Future Appointments or Past Appointments tab.

2. Find the row containing the appointment that pertains to your document.

3. On the right side of the row, select the upload 1] button.

4. In screen that appears, enter any of the following that may be helpful to manage the document:

Document Type - Select the type of document to upload.

Document Notes - Type a description, or other notes, if needed.

Created By - Type the originator of the document (such as a doctor, or yourself).
Import/Upload Date - Type the current date.

5. Select Upload.
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View your appointments in a calendar

You can open a calendar view of your appointments.

e On the home screen, select the Calendar @ button.

Request an appointment

eXQ-PLATFORM

You can request an appointment for specific study on a specific date at a selected location. If you do not
know this information, leave the options blank (this does not affect how quickly your appointment will be

scheduled).

Procedure

e
-

1. On the home screen, select the menu **= button.

2. Select the Schedule button.

3. On the Appointments tab, select Add.

4. Under Add Information, enter the following settings.

Location

Select your first choice of healthcare facility for the appointment.

Modality

Select the type of imaging to receive from one of the following.

AT

BD Bone density

BR

BTO | Breast tomography

CR Computed radiography

CT CT (computed tomography)

DG Diaphanography

DX Digital radiography

MG Mammogram

MGK

MR MRI (magnetic resonance imaging)

NM Nuclear medicine

oT Other
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PT PET (positron emission tomography)

RF Radio fluoscopy

RT Record of treatment

SC Secondary capture

SP Stereo-photogrammetry

™

us Ultrasound

XA X-ray angiography

Referred By

Select your first choice of date for the appointment.

Requesting Date

Select your first choice of date for the appointment.

Schedule Notes

Type any special instructions or notes to the healthcare provider.

Appointment

The appointment type corresponding to the selected modality, if available. Filled in

Type automatically.
As Soon as If the appointment is urgent, select this checkbox.
Possible

5. Click Save.

Result: The appointment request is sent.

Update insurance information

If your insurance policy changes, you can update it.

Procedure

1. On the home screen, select the menu *:* button.

2. Select the Insurance @ button.

3. On the Insurance tab, find the policy you want to update, and on the right, select its edit (o)

button.

4. Edit the information as needed, and then select Save.

Add an insurance policy

If you obtain new a insurance policy, you can add it.

Procedure
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1. On the home screen, select the menu *:* button.
2. Select the Insurance 0 button.

3. On the Insurance tab, select Add.

4. Enter all relevant information.

Note: If this is your only policy, in the Level list, select Primary. Otherwise, select Secondary for
your second policy, or Tertiary for your third policy.

5. Select Save.

Add a guarantor

A guarantor is a person who accepts financial responsibility to pay the medical bill for the patient. To
designate a guarantor:

Procedure
1. On the home screen, select the menu sit button.
2. Select the Guarantor i button.
3. On the Guarantors tab, select Add.

4. Enter information about the guarantor, and then select Save.

Note: Options with an asterisk (*) are required.

Update my profile
If your personal information changes, you can edit it.

Procedure
1. On the home screen, select the menu 25 button.

2. Select the Edit My Profile ’ﬁ button.

3. On the Credentials tab, edit information as needed, and then select Save.

Reset my password
For security and protection of your personal health information, periodically reset your password.

Procedure

1. On the home screen, select the menu st button.
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2. Select the Edit My Profile 'ﬁ button.

3.

On the My Account tab, select Reset Password.

4. Type your current and new password (twice), and then select Save.

Add an email address

To add a new email address to your account:

Procedure
1. On the home screen, select the menu st button.
2. Select the Edit My Profile ’ﬁ button.
3. On the My Account tab, in the Secondary Email box, type an email address, and then select the
plus ® sign.
Result: An verification email is sent to the address you entered.
4. Use the link in the verification email to verify your new address.

View account activity

To see a history of activity on your account:
Procedure

1.

2.

On the home screen, select the menu 25 button.

Select the Activity Log @ button.

Optional. To search for a specific log entry, select Search, and then:

a. Select a search key (Logged Date, Screen Name, Email Address, or Log Description).
b. Type a value to search for (for example, 01/31/2021).

c. Select Search.

View authorized representatives

An authorized representative is a person you authorize to use your patient portal account. To view a list
of your authorized representatives:

Procedure

1.

On the home screen, select the menu **% button.
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2. Select the Authorized Representative & button.

Sign out of the patient portal

When finished using the patient portal, sign out immediately.

e In the upper-right corner of the screen, select the power d? button.
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Work with Physician Portal

The following are key topics regarding Physician Portal. For more information, see the Physician Portal
user's manual.

Create an order

About CDSM and AUC

The Protecting Access to Medicare Act (PAMA) of 2014 requires practitioners of advanced diagnostic
imaging services such as CT, PET, NM, and MRI to consult a qualified clinical decision support mechanism
(CDSM) before ordering exams for Medicare patients. CDSMs are online apps that use appropriate use
criteria (AUC) to determine whether exams are clinically relevant (or, "appropriate"). Exa PACS/RIS
offers access to the LogicNets CDSM app through the physician's portal.

Create an order with CDSM

When creating orders for advanced imaging (CT, MR, NM, or PT), physicians can use CDSM to determine
relevance for Medicare requirements.

Procedure
1. In Physician's Portal, in the left pane, select New Appointment.
2. Set up a patient:

e For new patient, click CREATE AND SCHEDULE.
e For existing patients, use the search tools to find and open a patient chart.

3. On the Patient Information screen, click the Show More, and then enter the following settings
as applicable.

Facility Select your facility.

Name Type the name of the patient.

Address, Email, Phone Type or select the address, email address, and phone numbers of the
patient.

Ordering Facility Type the ordering facility.

Ordering Physician Type the name of the physician ordering the exam.

Modality Select Computed Tomography, Magnetic Resonance, Nuclear Medicine, or
Positron tomography.

Appointment Type Select an appointment type available for the modality.

Requesting Date Type the date on which you want to perform the exam.
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Account No./Alt Type the patient's account number, PID, MRN, or alternate account
number (auto-filled for existing patients).

Place of Service Select a place of service.

Transportation Select the mode of transportation the patient uses to go to the exam.

Referral Number For referrals, type a referral number.

Patient Condition Select the patient's expected condition on exam day.

Patient Location If the patient is hospitalized, select the department.

Patient Room No. If the patient is hospitalized, type the patient's room number.

Diagnostic Codes Type in the box to dynamically search for a diagnostic code, and then
select a code that matches the appointment type. You can add more than
one code.

Reason Type a reason for the exam.

Schedule Notes Type notes for the scheduling staff.

Select ADD STUDY.

Optional. Repeat the previous steps to add another study.

Select CREATE ORDER.

N

If the AUC Requirement message appears, if the patient has Medicare insurance, select YES (or
select NO to skip CDSM).

8. On the LogicNets Decision Engine page, answer the questions to obtain a determination.

9. Ifthe CDSM recommends one or more different CPT codes, follow the on-screen instructions to
change the codes and match them with appointment types. Select OK.

10. On the Order Summary page, select to PRINT or UPLOAD the summary, and then select
CLOSE.
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Appendix

Reference
User reference

Search syntax

Various lists in Exa PACS/RIS have a search bar with column headers that accept search criteria. The
following general rules apply when entering search criteria.

e In most numeric boxes, you can search for any part of the number. For example:
In the account number box, type: 20
Exa PACS/RIS finds: 203, 1203, and 01203.
e In a name box (such as patient name or payer name), you can type the full name in the format:
lastname, firstname
bUt not:--
firsthame lastname.
e In a name box, you can type the first or last name only. For example:
Type: Anderson
Exa PACS/RIS finds: Cooper, Anderson
...and...
Anderson, John.

e In a name box you can type all or part of the first or last name, but using as many letters as possible
improves accuracy. For example:

Type: Oswa

Exa PACS/RIS finds: Oswald, Trevor
-3 nd e

Davis, Oswald

However, if you type: Os

Exa PACS/RIS finds only: Oswald, Trevor.
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Keyboard shortcuts for the claim entry screen

When creating or editing claims, the following keyboard shortcuts are available.

Charges sub-tab Alt+C
Claims sub-tab Alt+Shift+C
Insurance sub-tab Alt+1
Additional Info. sub-tab Alt+A
Billing Summary sub-tab Alt+B
Payments sub-tab Alt+P
Cursor moves to the payer name option Alt+(+)
Previous claim Alt+Shift+P
Next claim Alt+Shift+N
Notes screen Alt+N
Documents and Reports screen Alt+D
Validate claim Alt+V

Save All Alt+S

Close without saving Esc

Keyboard shortcuts and commands for Exa Trans

When using Exa Trans, the following keyboard shortcuts are available.

Remove last dictated piece undo that =

delete that

scratch that
Next variable placeholder next variable Alt+]
Previous variable placeholder previous variable Alt+[
Capitalize previous word capitalize that =

cap that
Remove word left of the cursor remove left Ctri+Alt+Back
Start recording Ctrl+F1
Toggle recording Ctrl+F3
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Stop recording stop recording Ctrl+F2

Merge fields

The following table describes the merge fields available in various parts of the program. Some merge
fields may not be available in your installation of Exa PACS/RIS depending on added modules, country,
and other factors.

1. SO = Study/Order; IN = Insurance; PA = Patient; PR = Provider; ET = Email Template; NT = Notification Templates,
RT = Report Templates; SF = Study Forms; CF = Custom Forms; TT = Transcription Templates

FamilyHealthHistory Family Health History SO, NT, SF, CF
FollowUps Follow Ups SO, NT, SF, CF
Immunizations Immunizations SO, NT, SF, CF
LabResults Lab Results SO, NT, SF, CF
Medications Medications SO, NT, SF, CF
Referrals Referrals SO, NT, SF, CF
PreLabResults Pre Lab Results SO, NT, SF, CF
Problems Problems SO, NT, SF, CF
VitalSigns Vital Signs SO, NT, SF, CF
Age Age PA, ET, NT, SF, CF
AgeatDOS Age at DOS PA, ET, NT, SF, CF
Address1 Address 1 PA, ET, NT, SF, CF
Address2 Address 2 PA, ET, NT, SF, CF
Ciy City PA, ET, NT, SF, CF
State State PA, ET, NT, SF, CF
ZipCode Zip Code PA, ET, NT, SF, CF
DOB DOB PA, ET, NT, SF, CF
FirstName First Name PA, ET, NT, SF, CF
Fullname Full Name PA, ET, NT, SF, CF
Gender Gender PA, ET, NT, SF, CF
Race Race PA, ET, NT, SF, CF
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Ethnicity Ethnicity PA, ET, NT, SF, CF
HomePhone Home Phone PA, ET, NT, SF, CF
MobilePhone Mobile Phone PA, ET, NT, SF, CF
WorkPhone Work Phone PA, ET, NT, SF, CF
Lastname Last Name PA, ET, NT, SF, CF
Middlename Middle Name PA, ET, NT, SF, CF
mrn MRN PA, ET, NT, SF, CF
uli ULI PA, ET, NT, SF, CF
ssn SSN PA, ET, NT, SF, CF
Suffix Suffix PA, ET, NT, SF, CF
Weight Weight PA, ET, NT, SF, CF
Height Heigh PA, ET, NT, SF, CF
Employer Employer PA, ET, NT, SF, CF
PreferredLanguage Preferred Language PA, ET, NT, SF, CF
Username PA, ET, NT,

Password PA, ET, NT,

ApprovingPhysicianAddressl

Approving Physician Address 1

PR, ET, NT, SF, CF

ApprovingPhysicianAddress2

Approving Physician Address 2

PR, ET, NT, SF, CF

ApprovingPhysicianCity

Approving Physician City

PR, ET, NT, SF, CF

ApprovingPhysicianFirstName

Approving Physician First Name

PR, ET, NT, SF, CF

ApprovingPhysicianFullName

Approving Physician Full Name

PR, ET, NT, SF, CF

ApprovingPhysicianLastName

Approving Physician Last Name

PR, ET, NT, SF, CF

ApprovingPhysicianMiddleName

Approving Physician Middle
Name

PR, ET, NT, SF, CF

ApprovingPhysicianState

Approving Physician State

PR, ET, NT, SF, CF

ApprovingPhysicianSuffix

Approving Physician Suffix

PR, ET, NT, SF, CF

CCProv1Addri CC Provider 1 Address 1 PR, ET, NT, SF, CF
CCProv1Addr2 CC Provider 1 Address 2 PR, ET, NT, SF, CF
CCProv1City CC Provider 1 City PR, ET, NT, SF, CF
CCProvlName CC Provider 1 Name PR, ET, NT, SF, CF
CCProv1State CC Provider 1 State PR, ET, NT, SF, CF
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CCProv1Zip

CC Provider 1 Zip

PR, ET, NT, SF, CF

CCProviAlerts

CC Provider 1 Alerts

PR, ET, NT, SF, CF

CCProv2Addril

CC Provider 2 Address 1

CCProv2Addr2

CC Provider 2 Address 2

CCProv2City

CC Provider 2 City

CCProv2Name

CC Provider 2 Name

CCProv2State

CC Provider 2 State

CCProv2Zip

CC Provider 2 Zip

CCProv2Alerts

CC Provider 2 Alerts

CCProv3Addri

CC Provider 3 Address 1

CCProv3Addr2

CC Provider 3 Address 2

CCProv3City

CC Provider 3 City

CCProv3Name

CC Provider 3 Name

CCProv3State

CC Provider 3 State

CCProv3Zip

CC Provider 3 Zip

CCProv3Alerts

CC Provider 3 Alerts

CCProv4Addri

CC Provider 4 Address 1

CCProv4Addr2

CC Provider 4 Address 2

CCProv4City

CC Provider 4 City

CCProv4Name

CC Provider 4 Name

CCProv4State

CC Provider 4 State

CCProv4Zip

CC Provider 4 Zip

CCProv4Alerts

CC Provider 4 Alerts

CCProv5Addri

CC Provider 5 Address 1

CCProv5Addr2

CC Provider 5 Address 2

CCProv5City

CC Provider 5 City

CCProv5Name

CC Provider 5 Name

CCProv5State

CC Provider 5 State

CCProv5Zip

CC Provider 5 Zip

CCProv5Alerts

CC Provider 5 Alerts
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ProviderSignature

Provider Signature

PR, ET, NT, SF, CF

ReadingPhysicianAddress1

Reading Physician Address 1

PR, ET, NT, SF, CF

ReadingPhysicianAddress2

Reading Physician Address 2

ReadingPhysicianCity

Reading Physician City

ReadingPhysicianFirstName

Reading Physician First Name

ReadingPhysicianFullName

Reading Physician Full Nae

ReadingPhysicianLastName

Reading Physician Last Name

ReadingPhysicianMiddleName

Reading Physician Middle Name

ReadingPhysicianState

Reading Physician State

ReadingPhysicianSuffix

Reading Physician Suffix

Ref_PhyAddress1

Referring Physician Address 1

Ref PhyAddress2

Referring Physician Address 2

Ref_PhyCity

Referring Physician City

Ref_PhyFax

Referring Physician Fax

Ref_PhyFirstName

Referring Physician First Name

Ref_PhyFullname

Referring Physician Full Name

Ref_PhyHomePhone

Referring Physisican Home
Phone

Ref PhyLastName

Referring Physician Last Name

Ref_PhyMiddlelnitial

Referring Physician Middle
Initial

Ref_PhyNameOrderFMLS

Referring Physician Name

Order First Middle Last Suffix

Ref_PhyState

Referring Physician State

Ref_PhySuffix

Referring Physician Suffix

Ref_PhyZip

Referring Physician zip

Ref_PhyMobileNo

Referring pHysician Mobile
Number

Ref_PhyOfficeNo

Referring Physician Office
Number

Ref_PhyAlerts

Referring Physician Alerts

Report Link

Report Link

SignatureText

Signature Text
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PR, ET, NT, SF, CF

PreApprovedSignatureTExt

PreApproved Signature Text

preApprovedProviderSignature

PreApproved Provider
Signature

PR, ET, NT, SF, CF

RadiologistFullName

Radiologist Full Name

PR, ET, NT, SF, CF

TechnologistFullName Technologist Full Name PR, ET, NT, SF, CF
SignatureBlockText Signature Block Text PR, ET, NT, SF, CF
preApprovedSignatureBlockText PreApproved Signature Block | PR, ET, NT, SF, CF
Text
AttorneyFirstName Attorney First Name PR, ET, NT, SF, CF
AttorneyFullName Attorney Full Name PR, ET, NT, SF, CF
AttorneyLastName Attorney Last Name PR, ET, NT, SF, CF
AttorneyMiddleName Attorney Middle Name PR, ET, NT, SF, CF
AttorneySuffix Attorney Suffix PR, ET, NT, SF, CF
AttorneyAddress1 Attorney Address 1 PR, ET, NT, SF, CF
AttorneyAddress2 Attorney Address 2 PR, ET, NT, SF, CF
AttorneyCity Attorney City PR, ET, NT, SF, CF
AttorneyState Attorney State PR, ET, NT, SF, CF
AttorneyZip Attorney Zip PR, ET, NT, SF, CF
AttorneyPhoneNo Attorney Phone Number PR, ET, NT, SF, CF
AttorneyEmail Attorney Email PR, ET, NT, SF, CF
AttorneyFaxNo Attorney Fax Number PR, ET, NT, SF, CF
AppointmentTypeCode Appointment Type Code3 SO, RT, ET, NT, SF, CF
AppointmentTypeDescription Appointment Type Description | SO, RT, ET, NT, SF, CF
ExpectedArrivalTime Expected Arrival Time SO, RT, ET, NT, SF, CF
AccessionNo Accession Number SO, RT, ET, NT, SF, CF
ApprovedDate Approved Date SO, RT, ET, NT, SF, CF
PreApprovedDate PreApproved Date SO, RT, ET, NT, SF, CF
TranscribedDate Transcribed Date SO, RT, ET, NT, SF, CF
BodyPart Body Part SO, RT, ET, NT, SF, CF
Department Department SO, RT, ET, NT, SF, CF
DictationDate Dictation Date SO, RT, ET, NT, SF, CF
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ICDCode ICD Code SO, RT, ET, NT, SF, CF
ICDDescripton ICD Description SO, RT, ET, NT, SF, CF
StudyICDCode Study ICD Code SO, RT, ET, NT, SF, CF
StudyICDDescription Study ICD Description SO, RT, ET, NT, SF, CF
Institution Institution SO, RT, ET, NT, SF, CF
Modality Modality SO, RT, ET, NT, SF, CF
ModalityRoom Modality Room SO, RT, ET, NT, SF, CF
OrderedBy Ordered By SO, ET, NT, SF, CF
OrderingFacility Ordering Facility SO, ET, NT, SF, CF
Orientation Orientation SO, ET, NT, SF, CF
PatientLocation Patient Location SO, ET, NT, SF, CF
PlaceOfService Place of Service SO, ET, NT, SF, CF
Priority Priority SO, ET, NT, SF, CF
ProcedureCode Procedure Code SO, ET, NT, SF, CF
ProcedureCodes Procedure Codes SO, ET, NT, SF, CF
ProcedureCodestabular Procedure Codes Tabular SO, ET, NT, SF, CF
ProcedureName Procedure Name SO, ET, NT, SF, CF
ProcedureNames Procedure Names SO, ET, NT, SF, CF
ProcedureNamesTabular Procedure Names Tabular SO, ET, NT, SF, CF
ReasonForStudy Reason for Study SO, ET, NT, SF, CF
RequestingDate Requesting Date SO, ET, NT, SF, CF
RoomNo Room Number SO, ET, NT, SF, CF
STAT STAT SO, ET, NT, SF, CF
StudyDate Study Date SO, ET, NT, SF, CF
StudyDescription Study Description SO, ET, NT, SF, CF
StudyFlag Study Flag SO, ET, NT, SF, CF
StudyReceivedDate Study Received Date SO, ET, NT, SF, CF
TAT TAT SO, ET, NT, SF, CF
TranscribingUser Trascribing User SO, ET, NT, SF, CF
VehicleName Vehicle Name SO, ET, NT, SF, CF
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studyUID

Study UID

SO, ET, NT, SF, CF

StudyFormsignature

Study Form Signature

SO, ET, NT, SF, CF

CustomFormSignature

Custom Form Signature

SO, ET, NT, SF, CF

ExamPreplnstructions

Exam Prep Instructions

SO, ET, NT, SF, CF

CPTCode CPT Code SO, ET, NT, SF, CF
CPTName CPT Name SO, ET, NT, SF, CF
visit_no Visit Number SO, ET, NT, SF, CF
CPTCodes CPT Codes SO, ET, NT, SF, CF
CPTNames CPT Names SO, ET, NT, SF, CF

CPTCodesTabular

CPT Codes Tabular

SO, ET, NT, SF, CF

CPTNamesTabular

CPT Names Tabular

SO, ET, NT, SF, CF

DateofInjury Date of Injury SO, ET, NT, SF, CF
Allergies Allergies ET, NT, SF, CF
CompanyName Company Name ET, NT, SF, CF
CurrentDate Current Date ET, NT, SF, CF

CurrentTime

Current Time

ET, NT, SF, CF

DateAndTime

Date and Time

ET, NT, SF, CF

OfficeAddress1 Office Address 1 ET, NT, SF, CF
OfficeAddress2 Office Address 1 ET, NT, SF, CF
OfficeCity Office City ET, NT, SF, CF
FacilityLogo Facility Logo ET, NT, SF, CF

FacilityContactNo

Facility Contact Number

ET, NT, SF, CF

OfficeName Office Name ET, NT, SF, CF
OfficeState Office State ET, NT, SF, CF
Zip Zip ET, NT, SF, CF

FormalName

Formal Name

ET, NT, SF, CF

PracticeType

Practive Type

ET, NT, SF, CF

Primarylnsurance

Primary Insurance

IN, ET, NT, SF, CF

PrimaryAddress

Primary Address

IN, ET, NT, SF, CF

PrimaryCity

Primary City

IN, ET, NT, SF, CF
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PrimaryState Primary State IN, ET, NT, SF, CF
PrimaryZipCode Primary Zip Code IN, ET, NT, SF, CF
PrimaryPhone Primary Phone IN, ET, NT, SF, CF
PrimaryFax Primary Fax IN, ET, NT, SF, CF
PrimarySubscriber Primary Subscriber IN, ET, NT, SF, CF
PrimaryDOB Primary DOB IN, ET, NT, SF, CF
PrimaryRelationship Primary relationship IN, ET, NT, SF, CF
PrimaryPolicyNo Primary Policy Number IN, ET, NT, SF, CF
PrimaryGroupNo Primary Group number IN, ET, NT, SF, CF
HealthNumber Health Number IN, ET, NT, CF
VersionCode Version Code IN, ET, NT, CF
Secondarylnsurance Secondary Insurance IN, ET, NT, SF, CF
SecondaryAddress Secondary Address IN, ET, NT, SF, CF
SecondaryCity Secondary City IN, ET, NT, SF, CF
SecondaryState Secondary State IN, ET, NT, SF, CF
SecondaryZipCode Secondary Zip Code IN, ET, NT, SF, CF
SecondaryPhone Secondary Phone IN, ET, NT, SF, CF
SecondaryFax Secondary Fax IN, ET, NT, SF, CF
Secondarysubscriber Secondary Subscriber IN, ET, NT, SF, CF
SecondaryDOB Secondary DOB IN, ET, NT, SF, CF
SecondaryRelatoinship Secondary Relationship IN, ET, NT, SF, CF
secondaryPolicyNo Secondary Policy Number IN, ET, NT, SF, CF
SecondaryGroupNo Secondary Group Number IN, ET, NT, SF, CF
FacilityNotes Facility Notes NT, SF, RT
FacilityFax Facility Fax Number RT, SF, CF, ET, NT
FacilityEmail Facility Email Address RT, SF, CF, ET, NT

Ord_PhyAddress1

Ordering Phys. Street
Address1

RT, TT, SR, CF, ET, NT, CS

Ord_PhyAddress2

Ordering Phys. Street Address2

RT, TT, SR, CF, ET, NT, CS

Ord_PhyCity

Ordering Phys. City

RT, TT, SR, CF, ET, NT, CS

Ord_PhyFirstName

Ordering Phys. First Name

RT, TT, SR, CF, ET, NT, CS
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Ord_PhyFullName Ordering Phys. Full Name RT, TT, SR, CF, ET, NT, CS
Ord_PhyLastName Ordering Phys. Last Name RT, TT, SR, CF, ET, NT, CS
Ord_PhyMiddleName Ordering Phys. Middle Name RT, TT, SR, CF, ET, NT, CS
Ord_PhyState Ordering Phys. State RT, TT, SR, CF, ET, NT, CS
Ord_PhySuffix Ordering Phys. Suffix RT, TT, SR, CF, ET, NT, CS
Ord_PhyZip Ordering Phys. Postal Code RT, TT, SR, CF, ET, NT, CS
Non-ProprietaryName Non-Proprietary Name RT, TT, SF, CF
AmountUsed Amount Used RT, TT, SF, CF
Route Route RT, TT, SF, CF
Supv_PhyAddress1 Supervising phys. Street Adrs. | RT, TT, SF, CF, ET, NT, CS
1
Supv_PhyAddress2 Supervising phys. Street Adrs. | RT, TT, SF, CF, ET, NT, CS
2
Supv_PhyCity Supervising phys. City RT, TT, SF, CF, ET, NT, CS
Supv_PhyFirstName Supervising phys. First Name RT, TT, SF, CF, ET, NT, CS
Supv_PhyFullName Supervising phys. Full Name RT, TT, SF, CF, ET, NT, CS
Supv_PhylLastName Supervising phys. Last Name RT, TT, SF, CF, ET, NT, CS
Supv_PhyMiddleName Supervising phys. Middle Name| RT, TT, SF, CF, ET, NT, CS
Supv_PhyState Supervising phys. State RT, TT, SF, CF, ET, NT, CS
Supv_PhySuffix Supervising phys. Suffix RT, TT, SF, CF, ET, NT, CS
Supv_PhyZip Supervising phys. ZIP RT, TT, SF, CF, ET, NT, CS
Canada only: Health Card Number RT, SF, CF, ET, NT
User rights

The following table describes the rights that administrator can assign to a user role. All of these rights
may not be available depending on your product and configuration.

Note: Shaded rows indicate that the right is not currently in use.

Billing/ Setup Billing Codes

Allows creating and editing billing codes

Billing Class

Allows creating and editing billing classes

Claim Status

Allows creating and editing claim statuses
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CAS Group Code

Allows creating and editing CAS group codes

Provider ID Code Qualifier

Allows mapping provider ID code qualifiers to billing providers

Payment Reason

Allows editing payment reasons such as co-pay, deductible, and
payment plan

CAS Reason Code

Allows creating and editing CAS reason codes

Status Color Code

Allows adding and editing colors for payment, claim, and billed
statuses

Supporting Text Templates

Allows mapping of preconfigured supporting text to specific
service codes.

Insurance EDI Mapping

Allows insurance mapping, such as billing method and
clearinghouse

Adjustment Codes

Allows adding and editing adjustment codes

Billing Provider

Allows adding and editing billing providers

Billing Messages

Allows editing billing messages that print on statements

Billing Validation

Allows selecting the data that are validated during claim
validation

Printer Templates

Allows editing some settings in printer templates such as page
margins

EDI Request Templates

Allows creating and editing EDI request templates.

Clearing House

Allows entering clearinghouse information

Autobilling

Allows creating auto-billing profiles for automatic generation of
claims

CollectionsProcess

Allows configuring the automatic claim collections process

Delay Reasons

Allows adding, editing, and deleting reasons for delayed payment

Billing

Claims

Allows working with claims

Edit Claim

Allows opening the edit claim screen

Claim Inquiry

Allows access to patient claim information

All Insurances

All insurances

Coordination of Benefits

Allows coordinating benefits

Explanation of Benefits

Allows access to billing ERA

ERA Inbox

Allows opening the ERA inbox

EOB Claims Process

Allows opening the EOB tab, and uploading and processing
electronic payment files

File Insurance

Allows managing billing claims
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Patient Claim

Allows viewing a patient's claim history within Billing, and makes
available the Inquiry buttons on the Patient Information tab in
the patient chart and Edit Study screen

Patient Report

Allows opening patient reports and documents within Billing

Payments

Allows viewing and processing payments

Apply Payments

Allows applying payments to claims

Refund

Allows processing refunds

Back to Ready to Validate

Allows changing claim status to Ready to Validate

Claim Validate

Allows validating claims

Create/Split Claim

Allows splitting a claim with more than one charge

Delete Payment

Allows deleting payment records

Delete Claim

Allows deleting claims

File Management

Allows opening the file management screen in Canadian versions

Edit Claim Status

Allows manually changing claim statuses

Invoice Activity Statement

Allows viewing and printing the activity statement

Query Claim

Allows querying of claims.

Adjust to Paid in Full

Adds a shortcut menu command to pay a claim in full.

Census

Allows viewing the Census screen.

Billing/ Report

All rights in this category allow creating the corresponding
report.

Aged AR Summary

Aged AR Detail

Charges

Claim Activity

Claim Transaction

Collections

Credit Balance Encounters

Diagnosis Count

Modality Summary

Monthly Recap

Patient Statement

Payer Mix
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Payment

Claim Inquiry

Patients By Insurance

Payments by Insurance
Company

Procedure Analysis by Insurance

Procedure Count

Reading Provider Fees

Referring Provider Count

Referring Provider Summary

Transaction Summary

Patient Activity Statement

Payments Realization Rate
Analysis

Send claims to collections

Allows using automatic collections to change claim statuses to
“Claim in Collection,” and make other changes.

Billing/Log Billing User Log Allows viewing the billing user log
Bulling Audit Log Allows viewing the billing audit log
Chat Personal Chat Allowed Allo_vx_/s using Exa Ch_at to send and receive messages with
individual users (private chat)
Group Chats Management Allows creating and managing group chat rooms
Dashboard Dashboard Allows opening the dashboard
Dictation Approve Allows approving a dictated study report

Approve (Addendum)

Allows approving an addendum (Edit or Addition) on a dictated
study report, and changing a study's status from Approved to
Approved-Coded.

Dictation

Allows creating a dictated addendum (Edit or Addition) on an
approved study report

Dictation (Addendum)

Allows creating a dictated report

Dictation (Delete)

Allows deleting a dictated report

Submit For Review

Allows submitting an addendum for review on a dictated report

Submit For Review (Addendum)

Allows submitting a dictated report for review

Transcription (Addendum)

Allows creating an addendum by using Web Trans

Link Reports

Allows linking reports (and studies)
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Unlink Reports

Allows unlinking reports (and studies)

EEpEtEing) Dispatching Dashboard Allows users of Mobile RAD to open the dispatching dashboard
Dashboard
General AE Scripts Allows managing AE scripts to receive, send, or print studies
API Users Allows adding and editing API users and rights
Application Entities Allows configuring application entities (AE).
Assign Study to Users Allows assigning studies to specific users from the worklist
Allows editing general settings including those related to:
Company company contact and billing, apps, MRN, AE filters, LDAP,
Rcopia, and HL7
File Stores Allows selecting folders to store various data (mainly images) on
the server
Notification Allows adding notifications that appear on the dashboard
Allows entering tasks that appear on the My Tasks gadget of the
Tasks
dashboard
HL7 HL7 Global Config Allows viewing global HL7 configurations
HL7 Queue Allows viewing the HL7 Outbound (Sender) log
HL7 Receiver Log Allows viewing the HL7 Inbound (Receiver) log
Home Allow Reset Approved studies Allows resetting approved studies to Scheduled status

Allow Reset of Canceled and No
Show Studies

Allows resetting studies from Canceled or No Show status to
Scheduled status

Appointment Confirmation

Allows viewing the Appointment Confirmation screen

Can Edit Public Filter

Allows editing public filters

Can Edit Public Template

Allows editing public templates

Cancel Reasons

Allows canceling appointments

CD Burn

Allows burning DICOM images to a CD or external device

DICOM View

Allows switching between DICOM preview or priors on the
worklist

DICOM Viewer

Allows opening images on the Exa PACS/RIS viewer

External App Icon

Allows opening third party applications from the worklist

Image Preview

Allows previewing images on the worklist

Import Images

Allows importing images by using the PACS Actions menu

Import Images from Portal

Allows importing images from the provider or attorney portal
into Exa PACS/RIS

500-000594A

487



Exa® PACS/RIS 1.4.32_P5 User's Manual

eXQ-PLATFORM

Link DICOM Study

Allows linking a DICOM study to another study

Marketing Rep Dashboard

Allows opening the Marketing Representative dashboard

Merge Study

Allows merging and splitting DICOM studies and RIS orders

Technologist

Allows associating a technologist to an order

Opal Viewer

Allows viewing studies with the Exa PACS/RIS viewer

Order additional

Allows opening the Additional Information tab within the Edit
Study screen

Order ICD

Allows adding ICD codes to an order

Order Referring Provider

Allows opening the Referring Provider tab within the Edit Study
screen

Order Studies

Allows opening the Exam Information tab within the Edit Study
screen

QC Delete

Allows deleting DICOM studies within the QC tab

QC Edit

Allows editing some information in a DICOM study within the QC
tab

QC Move to Studies

Allows manually moving a DICOM study from the QC tab to the
All Studies tab

QC Reconciliation

Allows manually matching or reconciling a DICOM study to a RIS
order

Worklist Menu

Allows opening the worklist shortcut menu

Send Fax

Allows sending approved reports and study forms by fax

Send Studies

Allows sending a DICOM study to another AE from the worklist

Show Priors

Allows viewing a patients' priors in a separate study filter on the
worklist

Studies

Allows accessing Exa PACS/RIS

Study Delete

Allows deleting studies from a patient chart

Study Purge

Allows permanently deleting a study

Study Edit

Allows opening the Edit Study screen

Study Forms

Allows opening the Study Forms tab within the Edit Study screen

Change Status

Allows changing the status of a study

Log

API Log Allows viewing the API log, which tracks API activity

Audit Log Allows viewing the Audit log, which tracks system-wide activity
Rcopia Log Allows viewing the Rcopia log, which shows Rcopia activity
Eligibility Log Allows viewing the Eligibility log
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User Log

Allows viewing the User log, which tracks system-wide user
activity

Patient

Activity Log

Allows viewing the Activity log within the patient chart and Edit
Study screen

Advanced Search

Allows expanded searching of patients by age, allergies, lab
results, problems, sex, medications, vital signs, smoking status,
and race/ethnicity

Allergies

Allows viewing the Allergies tab in the Edit Study screen, and
editing patient allergies

Allergies (Read only)

Allows viewing the Allergies tab in the Edit Study screen (only).

Break the Glass

Allows use of the Break the Glass function to access confidential
records.

Eligibility

Allows using third-party services to request confirmation of
insurance eligibility

Eligibility (Read only)

Allows viewing eligibility requests/results if previously requested

Clinical Summary Transmit

Allows creating, viewing, and transmitting the Clinical Visit
Summary/CCD file

Export CCD

Allows encrypting and downloading of patient charts for
physician referrals

Family Health History

Allows completing the Family Health History form for a patient's
first-degree relatives

Film Tracking

Allows check-out and tracking for 'hard' films from the library

Immunization

Allows adding and editing patient immunization records

Immunization (Read Only)

Allows viewing patient immunization records

Lab Orders

Allows adding, submitting, editing, and deleting laboratory tests
and results records

Lab Orders (Read Only)

Allows viewing laboratory tests and results records

Medications

Allows adding, editing, and deleting prescribed medications,
supplements, and OTC products through Rcopia

Medications (Read Only)

Allows viewing prescribed medications, supplements, and OTC
products through Rcopia

Merge Patients

Allows merging of patient charts

Outside Referrals

Allows importing CCD/CCR files into the patient chart from the
referring provider

Patient Alerts

Allows selecting alerts or adding custom alerts and notes to a
patient chart

Patient Arrival Worklist

Allows viewing the patient arrival worklist when patients use the
kiosk to check in
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Patient Clinical Rules Allows creating clinical support rules

Patient Documents Allows uploading and scanning documents to a study or patient

Allows viewing fees associated with CPT codes and associated feeq

Patient Encounter
or charges

Patient Guarantor Allows adding a guarantor to a patient's insurance

Allows opening the Patient Information tab in the patient chart

Patient Information and Edit Study screen

Allows opening the Insurance tab in the patient chart and Edit

Patient Insurance Study screen

Allows managing the list of messages sent from a patient send

Patient Messages from the patient portal

Allows submitting prescriptions to a pharmacy, formulary
Patient Prescriptions checking, and adding, editing, and deleting prescribed
medications through Rcopia

Patient Prescriptions (Read Only) | Allows viewing of prescribed medications through Rcopia

Allows searching for patients from the Patient tab in the patient

Patient Search
chart

Allows opening the Studies tab within the patient chart and Edit

Patient Studies Study screen

Patient Orders Allows viewing the Orders tab within the patient chart

Payment History Allows opening the Payment History tab in the patient chart

Pending Follow-ups Allows viewing follow-up appointments

Pending Referrals Allows viewing referrals

Problems Allows editi_ng ?n the Problems tab in the Edit Study screen (to
add and edit diagnosis codes)

Problems (Read Only) Allows viewing the Problems tab in the Edit Study screen

To Be Reviewed Allows opening the To Be Reviewed tab in the patient chart.

Transition of Care Allows exporting a CCD file and sending it to a referring physician

via email
Vital Sign (read Only) Allows viewing a patient's vital signs on the Edit Study screen
Vital Signs Allows adding and editing a patient's vital signs on the Edit Study
screen
Patient Claim Inquiry Allows viewing patient claim information

Patient Claim Inquiry (Read Only)| Allows viewing patient claim information

VIP Allows designating patients as VIPs
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Peer Review

Peer Review Allowance

Allows managing automatic peer review assignments

Peer Review Manual Appointment]

Allows manually assigning peer reviews from the worklist

Peer Review Operational

Allows generating the peer review operational report

Portal Reg Users

Portal Registered Users

Reports

All rights in this category allow creating the corresponding report

Cancellation Reason

My Reports

Completed Schedules

Date of Service Payment
Summary

Export Completed Studies

Export Peer Review

Insurance Balance Aging

Marketing Rep Activities

Monthly/Daily Study Goals

Patients Worksheet

Referrals Variance

Referring Physician Study Count

Report Filter

Report Provider

Relative Value Units

Scheduler Activity

Studies Breakdown

Studies by Modality

Studies by Modality Room

Modality Breakdown

Transcription Study Count

Turnaround Time (TAT) -
Calculated

Fees by Facility and Modality

Fees by Radiologist and Modality
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Unfinished Studies

Unsigned Orders

STAT Tracking

Insurance vs LOP

Marketing Report Export

Technologist Productivity

Audit Trail

Schedule

Add Study

Allows creating new studies, such as in the Edit Study screen.

Allow Double Booking

Allows double-booking an appointment if available for the facility

Allow to edit Accession

Allows editing study accession humbers

Approved Report

Allows viewing approved radiology reports

Assign Vehicle

Allows assigning a vehicle to a study for Mobile RAD

Available Slots

Allows using the Find/Available Slots screens

Billing

Allows viewing information from the Edit Study screen

Charge and Payments

Allows opening the Charges and Payments tab within the Edit
Study screen

TOS Payments

Allows opening the Payments area of the program

Patient Payment History

Allows viewing patient payment history and printing payment
receipts

Chief Complaints

Allows adding and editing chief complaints in the patient chart

Chief Complaints (Read Only)

Allows viewing chief complaints in the patient chart

Clinical Overview

Allows opening the patients clinical overview

DICOM Edit

Allows editing DICOM information within the QC and Exam
Information tabs within the Edit Study screen

Education Material

Allows opening the Educational Material tab in the Edit Study
screen

Follow Ups

Allows scheduling follow-up appointments in the Follow Up tab in
the Edit Study screen

Follow Ups (Read Only)

Allows viewing follow-up appointments on the Follow Up tab in
the Edit Study screen

Insurance Authorization

Allows adding and editing insurance authorizations for studies

Medical History

Allows adding, editing, and updating patient medical histories

Medical History (Read Only)

Allows viewing patient medical histories
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New Order

Allows creating new orders

Notes

Allows entering study notes, patient notes, schedule notes,
reasons for studies, and call log entries

Notes (Read Only)

Allows viewing study notes, patient notes, schedule notes,
reasons for studies, and call log entries

Order Forms

Allows adding custom forms to orders from the Custom Forms
tab in the Edit Study screen

Order Forms (Read Only)

Allows viewing custom forms added to a study from the Custom
Forms tab in the Edit Study screen

Order Images

Allows ordering images or reports from the Studies tab in the
patient chart

Order Summary

Allow opening the Summary tab in the Edit Study screen

Ordering Physician Search

Allows using the magnifying glass to search the Provider Setup
screen and NPPES website for an ordering physician to add to an
order

Quick Block

Allows creating a quick block (schedule block) from the schedule
book

Patient Demographics

Allows editing information in the Patient Information tab in the
patient chart and Edit Study screen

Priority

Allows assigning priority to the study from the worklist and in theg
Additional Information tab within the Edit Study screen

Recent Schedules

Allows scheduling/copying appointments in the Recent Schedules
screen if available for the facility

Recent Schedules (Read Only)

Allows viewing appointments in the Recent Schedules screen if
available for the facility

Reference Document

Allows assigning a reference document to an order and providing
it to the patient

Referrals

Allows entering information for referrals to another provider

Schedule Book

Allows viewing the schedule book

Schedule in Non-working Time
Slot

Allows scheduling appointments in non-working timeslots from
the schedule book

Stat

Allows setting STAT levels for a study or order from the worklist

Status Validation

Allows validating a study in the Validation screen when validation
rules are set within the Study Status workflow

Study CPT Update

Allows updating the CPT of a study

Study Education Material

Allows opening the Educational Material tab in the Edit Study
screen
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Teaching Study

Allows creating a DICOM teaching study from the worklist and
within the viewer

Transcription

Allows editing report transcriptions

ExaTrans2 Multipanel

Allows using Exa Trans2 in the multipanel, and using the
multipanel without Exa Trans2.

Vehicle Assignments

Allows viewing the list of scheduled/dispatched vehicles in using
Mobile RAD

Setup

Appointment Types

Allows adding, editing, and deleting appointment types.

Cognitive Status

Allows adding, editing, and deleting cognitive statuses.

CPT

Allows adding, editing, and deleting CPT codes

Custom Forms

Allows adding, editing, and deleting custom forms, and attaching
them to studies

DB Totals

Allows using the DB Totals function

DICOM Receiver Rule

Allows creating and managing DICOM receiver rules

DM List

Allows viewing the DM Manager and list of DMs

DM New

Allows creating a new view in the DM Manager

EDI Translations

Allows creating and managing EDI translations

Editor Template

Allows creating, editing, and deleting Editor templates

EDI Rule

Allows creating and managing EDI rules

Email Template

Allows creating and assigning email templates for the
Confirmation screen

Notification Templates

Allows creating and assigning templates sent to referring
physicians

Cover Sheets

Allows creating and assigning cover sheets for approved reports

Exam Authorization

Allows opening the Exam Authorization tab

Export Summary

Allows exporting summary totals

Facility

Allows adding, editing, and deactivating facilities

Market

Allows configuring regional markets

Fee Schedule

Allows creating and editing billing fee schedules and contracts

Facility Fee Schedule

Allows creating a fee schedule based on facility and modality for
the Fees by Facility and Modality report

Provider Pay Schedule

Allows creating a pay schedule for radiologists, which is used in
the Fees by Radiologist and Modality report

Provider Location Information

Allows managing provider location information
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Form Builder

Allows creating and editing electronic study forms, and
managing their attachment

Functional Status

Allows adding, editing, and deleting functional statuses

Gadgets

Allows adding, arranging, and viewing gadgets within the user's
dashboard

Hanging Protocol Groups

Allows editing DM (hanging protocol) settings for user groups,
modalities, and other categories

SR Report Queue

Allows opening the Structured Report Queue tab, which shows
the status of outbound DICOM SRs

Issuers

Allows adding and editing issuers of patient IDs

1ICD

Allows adding, reloading, and importing ICD, SNOWMED, and
LOINC code files

Insurance Provider

Allows adding, editing, and deleting insurance providers and
assigning them to a facility

Matching Rules

Allows creating rules for matching DICOM studies

Macro Notes

Allows configuring macro notes

Modality

Allows adding, editing, and reordering modality priority

Modality Room

Allows adding and editing modality rooms

Monthly Goals

Allows creating and editing monthly study count goals by
modality for the Monthly Goals operational report

No Shows

Allows setting an appointment to a no-show status from the
worklist and schedule book

Ordering Facility

Allows adding and editing ordering facilities

Patient Portal Log

Allows viewing Patient Portal activity

Allows creating and editing place of service mappings for POS

FOE e codes, addresses, and mobile dispatching addresses
Billing Rules anIIC(?”vzisezddlng, editing, and deleting billing rules for ordering
Provider Allows adding, editing, and importing resources such as referring

providers, reading providers, and technologists

Provider Group

Allows adding and editing groups of providers

Provider Organizations

Allows adding and editing provider organizations

Queue

Allows viewing the status of outbound DICOM studies

Rcopia Transactions

Allows viewing Rcopia transactions

Report Template

Allows user to create and edit report headers for approved
reports within the Report Template tab
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Report Queue

Allows resending and viewing the status of outbound emails and
faxes such as approved reports, notifications, scanned
documents, and study forms

SR Report Queue

Allows opening the Structured Report Queue tab, which shows
the status of outbound DICOM SRs

Transcription Template

Allows adding, editing, deleting, and associating templates with
facilities, modalities, and study descriptions used for transcription

Routing Rules

Allows creating routing rules for DICOM studies to send, print, or
perform an HL7 action

Schedule Block

Allows adding and editing schedule blocks that display on the
schedule book and Find Slots screens

Schedule Filter

Allows adding and editing filters of the schedule book

Schedule Rules

Allows adding and editing individual rules within a schedule
template

Allow Editing of Display Block
Colors

Allows editing the color of blocks on the schedule book

Schedule Templates

Allows adding and editing scheduling templates

Study Filter

Allows adding, editing, and deleting worklist study filters

Update Global Study Filters

Allows updating global and shared worklist filters

Study Flag

Allows adding and editing study flags

Study Status

Allows adding study statuses and associating them with study
flows

Study Status - Read Only

Allows opening the Study Status tab to view study statuses and
flows

Templates

Allows adding and editing structured reporting templates

Auto Suggestions

Allows adding and editing auto suggestions for structured
reporting

Keywords

Allows adding and editing keywords used for structured
reporting

Image Hotspots

Allows navigating through a cardiac US cine series

SR Mapping

Allows adding and editing mappings of DICOM properties to
structured reports

Update URLs

Allows adding and updating Rcopia URLs

Allows viewing which users are currently logged on, and

Users Online o .

terminating connections
Vaccines Allows adding, editing, and marking the inactive vaccines list
Vehicle Log Allows opening the Vehicle Log tab in Log Setup
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Vehicle Registration

Allows adding and managing available vehicles to dispatch in
Mobile RAD

Vehicle Tracking

Allows viewing the location of a vehicle

Locked Slots

Allows locking and unlocking slots (scheduling time ranges) for
scheduling

Insurance Provider Payer Type

Allows creating and editing payer type groups or categories that
can be associated to insurance companies

Provider Level Codes

Allows creating and editing provider level codes and percentages
to associate with CPT codes, which are used in the Reading
Provider Fees report

Portal Configurations (Read

Only)

Allows viewing portal configuration settings.

Portal Configurations

Allows configuring links to appear on the patient, provider, and
attorney portals.

NDC Codes Allows configuring NDCs.
User Mgmt. AD Groups Allows adding, editing, or deleting AD groups.
AD Users Allows adding, editing, or deleting AD users.
User Allows managing individual user access to the system

User Assigned Patients

Allows viewing the list of patients who are currently assigned to
specific users

User Assigned Studies

Allows viewing the list of studies that are currently assigned to
specific users

User Group

Allows creating, managing, and assigning document types and
user roles to user groups

User Role

Allows creating and managing user rights

Copy Profile Settings

Allows copying profile settings from one user to another

External Apps

Allows configuring Exa PACS/RIS to work with external
applications

Viewer Options

Cardiogram Settings

Allows configuring cardiogram settings in Viewer Settings

External Tools

Allows configuring options in the External Tools tab in Viewer
Settings

General Information

Allows configuring options in the General tab of Viewer Settings

Interface Settings

Allows configuring options in the Interface tab of Viewer Settings

Mammography Options

Allows configuring options in the Mammography tab of Viewer
Settings

Modality Options

Allows configuring options in the Interface tab of Viewer Settings
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Allows configuring options in the Overlays tab of Viewer Settings

Tools Settings

Allows configure options in the
Tools tab of Viewer Settings

Description of reports

The following table lists all of the reports available on the Exa platform. Some reports may not be
available to you depending on your product and configuration.

Billing/Reports

Aged AR Detail

AR aging by facility, responsible party, and payer by cutoff
date and selected facilities, in detail

Aged AR Summary

AR aging by facility, responsible party, and payer by cutoff
date and selected facilities

Charges Charges for reconciling and reviewing the charges populated
for any date of service
Claim Activity Detailed claim activity history by claim date range

Claim Inquiry

All submitted claims, and order payments and balances

Claim Transaction

All claims, and claim payments and balances

Collections

Claims in the Collections Review status

Credit Balance Encounters

Credit balance encounters

Diagnosis Count

Aggregate diagnosis count by ICD code and facility, by order
date range

Modality Summary

Modality summary

Monthly Recap

Monthly recap

Patient Statement

Patient statement

Patients by Insurance

Patients seen within a date range by insurance

Payer Mix

Payer mix

Payments

Totals by payment and payer type, and how each charge line
item is applied by accounting date range

Payments by Insurance Company

Calculated payments to each insurance company, by patient

Payments Realization Rate Analysis

Accounts with a zero balance

Procedure Analysis by Insurance

Procedures by insurance

Procedure Count

Number of procedures approved by radiologist fee schedule

Reading Provider Fees

Reading provider fees
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Referring Provider Count

Referring provider count

Referring Provider Summary

Referring doctor summary information

Transaction Summary

Transaction summary

Cancellation Reason

Reports - Daily Schedules Information on studies performed by day
Schedule &
Reports Export Completed Studies CSV export of patient, study, and insurance details for
completed or approved studies
Marketing Rep Activities Notes and activities that marketing representatives enter
about referring physicians
Unsigned Orders not signed by referring physician. No longer used.
Operations Statistics on canceled studies with cancellation reason as a

key filtering criterion.

Scheduler Activity

Number of orders (based on the current order status) by
time of day that a user ordered, scheduled, rescheduled, or
canceled, by facility and date range

Unfinished Studies

not having selected study statuses, by facility and date range

Referrals Variance

Number of studies referred by referring physicians in the
past 13 months, by facility, modality, and month

Studies Breakdown

Number of studies by facility, modality, study date, and study|
status

Studies by Modality

Aggregate study count by facility, modality, study date, and
study status

Studies by Modality Room

Aggregate study count by facility and modality room

Modality Breakdown

Number of studies performed based on CPT or appointment
type, by modality

Technologist Productivity

Number of studies performed per technologist by facility,
modality, appointment type, and procedure code

Peer Review Operational

Progress and results of peer reviews performed

Fees by Radiologist and Modality

Summary and breakdown of fees for a modality, by
radiologist

Turnaround Time (TAT) - Calculated

Shows turnaround time (TAT) calculated based on selected
date, type, and study's approved date, by date range,
facilities, and/or ordering facilities

Relative Value Units

CPT and RVU totals for reports signed off, by date range

Referring Physician Study Count

Number of studies referred by referring physicians by date
range

Completed Schedules

Shows information about completed studies
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Monthly/Daily Study Goals

Number of studies performed in the month compared to the
goal set in Monthly Goals Setup

STAT Tracking

Number of studies marked as STAT

Transcription Study Count

Aggregate study count of reports transcribed by
transcriptionists, by facility, modality, and study date

Insurance vs LOP

letter of protection/personal injury studies

Aggregate study count by modality for insurance paid vs

Marketing Rep Export

referring physicians and marketing reps

Study information, bill fees, and allowed amounts for

Audit Trail Break the glass Audit Trail report
Same Last Name User Audit Alberta only.
Patients Patients Worksheet Patient and study face sheets in form
My Reports My Reports Allows opening the My Reports tab to view operational

reports

Settings in the claim entry screen

The following table describes the settings shown in the Claim Creation screen.

Charges Date

Claim entry date, automatically assigned.

Accession No.

Study accession number, automatically assigned.

CPT Description

Type-to-search or select by CPT code.

P1.--P4

Diagnosis pointers link the diagnosis code to a CPT. Type the
first diagnosis pointer in P1, and then add additional pointers
as necessary.

M1---M4

A modifier acts as a shortcut for making a pre-defined change
to a claim. Type the first modifier in M1, and then add
additional modifiers as necessary.

Units

Type the number of procedures of the selected CPT that were
performed.

Bill Fee

The pre-configured charge for the procedure. Edit as needed.

Total Bill Fee

The bill fee multiplied by the units.

Allowed

The amount per-unit allowed by the insurance provider as
configured in the billing fee schedule.

Total Allowed

The total amount allowed by the insurance provider as

configured in the allowed fee schedule.
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Auth No. Type the authorization number provided by the insurance
provider.
Exclude Select to exclude the charge from an invoice.
Claims Study Date Automatically assigned.
Claim Date Claim entry date, automatically assigned.
Facility Name Select the name of the facility for scheduling purposes. It may
or may not be the same as the service facility.
Billing Provider Select the provider issuing the invoice for the procedure.
Rendering Provider Select the provider who performed the procedure.
Referring Provider Select the referring provider.
Service Facility Select the facility where the procedure was performed. For
Location/Ordering mobile billing, select the ordering facility.
Facility
POS Type Select the place of service code for the service facility.
Diagnosis Codes Select and add all relevant ICD diagnosis codes.
Insurance Existing Insurance Select a previously configured insurance profile, if any.
(Primary,
Secondary, and | Carrier Select the insurance carrier. The carrier’s address and other
Tertiary) information is filled in automatically.
Policy No. Type the insurance policy number.
Group No. Type the insurance group number.

Coverage Start/End
Date

Type the start and end dates of coverage, from the patient’s
insurance profile.

Relationship

Select the relationship of the patient to the policy holder.

Subscriber Name

Type the name of the policy holder.

DOB Select the date of birth of the policy holder.
Gender Select the gender of the policy holder.
Address:--- Type or select the address, city, state, and postal code of the

policy holder.

Service Type

Available when not using ImagineSoftware.

Select the service type to which the procedure belongs.

Benefit On Date

Available when not using ImagineSoftware.

Select the date for which you want to verify eligibility.

Eligibility/Estimation

Select to verify eligibility and/or estimate coverage.
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Patient’s Condition Is
Related To:

Select a source of the condition if relevant for insurance
purposes.

Accident State

If you selected a source previously, type the state/province in
which the accident (source) occurred.

Date of illness Onset,
Injury/Accident, or
Pregnancy (LMP)

Select the date of onset, accident, or first symptoms. In the
Other Date box, enter additional dates related to the accident
or injury, if needed.

Dates Patient Unable
to Work at Current
Occupation

Select a date range in the From Date and To Date boxes.

Hospitalization Patient
Related to Current
Services

Select a date range in which the patient was hospitalized, if
relevant.

Claim Notes Enter notes for the claim. How different from Billing notes.

Outside Lab Select if entering a claim for a lab external to the current
facility.

Original Ref The original reference number returned by Medicaid or

Medicare if they are the primary payer. This number can be
submitted to a secondary payer.

Claim Authorization
No.

Type the claim authorization number.

Frequency If you must submit a corrected claim to the insurance
provider, use this option to code it as such.

Billing Summary | [Amounts] Totals for fees charged, payments made, adjustments, claim
balance, allowed amounts, other payments, and refunds.

Claim Status Select a claim status. You can use the status selected here for
sorting in the Claims screen.

Billing Notes Type notes to appear in the Notes column of the Claims
screen. This is different from Claim notes, which are
submitted with the claim.

Billing Codes Select a pre-configured billing code to flag claims for your
own specific purposes.

Billing Class Select a pre-configured billing class to flag claims for your
own specific purposes.

Responsible Select the party responsible for payment. For mobile billing

this is especially useful to select if the ordering facility and
service location are different.

Payments

Accounting Date

The entry date of the payment, assigned automatically.

Payer Name

Select the payer.

Pymt. Mode

Select the type of payment.
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Check/Card No. If the payment mode is “Check,” type the check number.

Apply Select to apply the payment to the current claim.

This Pay. A reference value. Select the Apply button to enter payment
information.

This Adj. A reference value. Select the Apply button to enter an

adjustment amount.

Payment ID Automatically assigned serial number for the payment.

NEW PAYMENT Select to add a new payment.

See also:

Add codes and other basic data

Configure procedure codes
Verify eligibility of preorders and studies with PokitDok

Verify eligibility and estimate coverage with ImagineSoftware

Settings in insurance profile screens

The settings related to insurance profiles are slightly different depending on which of the following screens
you use to view them.

1. Edit Study > Insurance Profile > Add

2. Edit Study > Insurance Profile > Edit

3. New Appointment > Insurance
4, Patient > Insurance Profiles > AddEdit

The following table lists all settings that are available.

Set As Default Available only from the patient chart and when scheduling.

Select to set the current policy as the default policy. Useful when the
patient has multiple policies at the same level.

Level Select whether the insurance is the patient's primary, secondary, or
tertiary policy.

Inactive Select to inactivate the policy while retaining its information.

The Valid To Date is automatically set to the current date.

Existing Insurance Not available on all insurance screens. If you entered insurance for the
patient previously, you can select it here to automatically fill in other
options.
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Select the insurance carrier.

Insurance Provider Type

Entered automatically.

Policy Number

Type the patient's insurance policy number.

Group No.

Type the insurance group number of the policy.

Pre-Cert. Phone / Fax

Type contact information getting pre-certification.

Accept Assignment

Select if the insurance policy can accept assignments.

Address / Phone No.

The contact information of the insurance carrier.

Website

The website of the insurance carrier.

Group Name

Type the name of the insurance group.

Valid From/To Date

Select the period during which the current policy is effective.

Medicare Ins. Type

Select the Medicare insurance type of the policy.

Available after you save the profile.

Relationship

Select an emergency contact person for the patient.

Subscriber Name

Type the name of the insurance policy subscriber.

Sex Select the sex of the subscriber.

Country Select the country of the subscriber.
Address Type the address of the subscriber.

DOB Select the date of birth of the subscriber.

Employee Status

Select the employment status of the subscriber.

Work / Home Phone

Type the phone numbers of the subscriber.

Measurement accuracy

limits

Length Ruler mm +£2 mm
Angle Protractor ° +2°
Area Calculated cmA2 +5%
Ratio Calculated +2%
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Viewer toolbar tools

The following table lists all toolbar tools that are available in the viewer. See corresponding topics for the
functions of the tools.

=18

3D Ray Draws a 3D ray on an image. Select to place a vertex on one plane, and

the ray extends through the image on all planes.
) 3D Cursor Displays a cursor in other open planes that follows the motion of the

cursor in the active plane.

3D Angle Click three points to create the angle. The angle appears at the same
coordinates on all series with the same frame of reference.

3D Measure Click two points (or drag and click). The measurement appears at the
same coordinates on all series with the same frame of reference.

3D Point Click to add the point. The point appears at the same coordinates on all
series with the same frame of reference.

3D ROI Available in a future release.

AR Plots points to represent angular rotation.

Actual Image Siz¢g

Displays images in their real-life anatomical dimensions.

Angle Marker

Measures and annotates an angle.

Arrow

Draws an arrow.

A CEH H H H

Auto W/L

Automatically optimizes the W/L.

Bone Enhance

Controls contrast between bone and other tissues.

CAD

Displays CAD findings, with a button menu for selecting specific findings.
Available when CAD findings are present in the opened study.

Center Point

Click two points. The center point between them is indicated.

BE 32

Change Slice Sets the slice thickness.
Thickness
@ Circle Draws a circle.
CL CLAHE Contrast limited adaptive histogram equalization. Turns CLAHE mode
on/off. Improves image contrast.
Close Series Keyboard shortcut for the Close Series option in the image cell's upper-
right shortcut menu.
Close Study Keyboard shortcut for Partial Close.
Cobb Angle Measures a Cobb angle.

)

Context Menu

Displays the view shortcut.
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Context Tool

Function

Displays a linked image at the same X, Y, Z angle as the current image.

IR

CT Ratio Displays the angle between two lines. Use to calculate the angle between
vertebra.
Curve Click two points to estimate curvature from the center of the end
vertebrae to the center of the apical vertebrae.
Cutlines Shows/hides cutlines, if present.
Default Selects the standard pointer tool.

Bl Ed| @

Delete All Image
Annotations

Deletes all annotations.

Delete Series
Annotations

Deletes all annotations in the current series.

Available only in shortcut menu.

Delete Study
Annotations

Deletes all annotations in the current study.

Available only in shortcut menu.

Deselect Last
Annotation

Deselects the last-selected annotation.

Available only in shortcut menu.

DICOM Print

Sends the image to a DICOM printer.

DICOM Values

Displays a list of DICOM values associated with the current image.

NQH @A

DM Settings Opens display management settings.

Dot Draws a dot.

Edit Turns Edit mode on/off. Edit mode allows editing of previously set
annotations.

Ellipse Draws an ellipse.

External Tools

Reserved for opening an external application.

0 O Ne

Fit to Window Restores original zoom level.

Flip Flips the image across its horizontal or vertical axis (hover over the tool
to select between axes).

Frames Selects the number and arrangement of frames to display in the viewing
area.

FH Measure Takes freehand measurements.

EOT

Freehand ROI

Freehand-draws an ROI.

T
H H =

Histogram

Displays a histogram.
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HO Angle

Function

Draws a horizontal orthogonal angle.

Horizontal Line

Draws a horizontal line.

HU

Displays the pixel value in Hounsfield Units.

Invert Color

Inverts black/white values.

CIGIGILIL]

L Marker Adds an L (left) marker.

Line Draws a straight line.

Link Auto Links two or more series that are open.

Link Manual Links user-specified frames between panels.

M Compare Measurement comparison. Click a first and second point, then double-

click a third point. Displays the distances between the points.

Magnifying Glass

Displays a movable zoomed area.

NHEEELE

Measure Measures between two specified points.

MPR Multiplanar reformation. Select to generate and display coronal, sagittal,
and MIP (maximum intensity projection) stacks from an axial image.

Next Series Keyboard shortcut for moving to the next available series in the study.

One to One Displays the image in its original DICOM size.

Open Next Study

Keyboard shortcut for the Auto Open Next Study option.

11

ﬂ Overlay Turns overlays on/off.

Pan Drags the image any direction.

n Patient Opens an independent window for viewing, scanning in, and attaching
Documents patient documents. Turns blue when documents are available.

Pencil Freehand-draws a line.

Play Frames Starts cine looping.

Previous Series

Keyboard shortcut for moving to the previous series in the study.

Print Images

Sends images to a non-DICOM printer.

Prior Reports

View reports. Turns blue when reports are available.

R Marker

Adds an R (right) marker.

= aan

Radial Angle

Draws a radial angle, which is the angle of the distal radial surface with
respect to a line perpendicular to the shaft.
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Radial Length

Function

Draws a radial length.

Rectangle

Draws a rectangle.

Reset Frame

Undoes all unsaved changes to the image within the active viewing cell.

Reset Linked
Series

Removes any linkages.

Reset Stack

Restore images in a stack to their last-saved ordering.

Reset Viewer

Reverts non-permanent modifications to images in the viewer (zoom,
rotation, Window/Level etc.) to their original state.

ROI

Draws an ellipse to specify an ROI.

G H B0 E Q) S

Rotate Right

Rotates the image 90 degrees clockwise.

Hover over the rotate button to reveal the rotate left button.

[@

Rotate Left

Rotates the image 90 degrees counterclockwise. Hover over the rotate
button to reveal the rotate left button.

Save Annotations

Saves the current state of annotations.

Scroll/Span
Images

Switches between moving and spanning.

Set Key Image

Sets the current image as a key image.

Settings

Displays the settings dialog.

Show Prior List

Opens a dialog with a list of priors that you can select to display in the
prior bar.

[ § B H 8[

Shutter Box

Adds an rectangular shutter.

[
X
m

Shutter Ellipse

Draws an elliptical shutter.

Shutter Freehand

Draws a freehand shutter.

Spine Label

Adds vertebrae labels to spinal images.

Spine Label Short

Adds vertebrae labels from common starting points.

Spine Label 3D

Adds vertebrae labels on all series with the same frame of reference.

NNNNH

Spine Label 3D
Short

Adds vertebrae labels from common starting points on all series with the
same frame of reference.

N

Spine Label Quick]
3D

Adds vertebrae labels to the same anatomy on all series with the same
frame of reference.

Spine Label Quick]
3D Short

Adds vertebrae labels from common starting points to the same anatomy
on all series with same frame of reference.
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Study Notes

Displays a dialog for reading/writing notes.

Text

Draws text.

Toggle
Annotations

Shows/hides annotations.

Toggle DICOM
Overlays

Shows/hides DICOM overlays.

Transcription

Opens an independent dictation and transcription window.

Triangulation

Displays the context tool at the same coordinates on all series with the

eXQ-PLATFORM

same frame of reference.

unq Creates a teaching study.

Vertical Line Draws a vertical line.

Window/Level Adjusts the window/level.

Zoom Zooms the image in/out.

BEEEHA Oa H HHEE

Details on Linked Reporting

Statuses of linked reports

e Any activity related to retaining the STAT level of a main study also applies to any of its linked

studies.

any of its linked studies.

When you unlink an approved study, the study reverts to Unread status.
When a main study changes to Approved status, so do its linked studies. In addition:
¢ The order status of the linked studies changes to Check-Out.

Any activity related to TAT recording (approval time) on a linked main study also applies to

e The approving physician and/or pre-approving physician and approved date are added

to the main and linked studies.

Draft
Transcribed
Pre-Approved
Dictated

Approved-Coded (APCD status)

change to the same status, including the following.
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Draft - Addendum
Transcribed - Addendum
Approved - Addendum

Dictated - Addendum

When you right-click a main study and select Exam > Reset Transcription, the main study and
linked studies are reset to Unread status.

When you change a main study from Approved to an earlier status, you are prompted to
unlink its linked studies. The main study changes to the selected status, and the linked studies
change to Unread status. The report remains with the main study.

When you change the status of a linked study, you are prompted to unlink it from the main
studies. The linked study changes to the selected status, and no other studies are affected.
When you reset the transcription of a main study, this resets the transcription for the main and
linked studies, and sets their statuses to Unread. The studies remain linked.

When you reset a main study with an approved report, you are prompted to unlink its linked
studies. The main study changes to Scheduled status, and the previously linked studies
change to Unread status.

When you reset a linked study with an approved report, you are prompted to unlink it from
the main study. The study changes to Scheduled status, and other studies are unaffected.

Considerations when transcribing linked studies

When transcribing a main or linked study, the transcription lock is applied to the main study
and all linked studies (in both Exa Trans and WebTrans). The following actions release the
transcription lock on all studies:

Close the transcription
Sign out of Exa PACS/RIS
Approve the study (E-sign and Approve, Approve and Next, or Pre-Approve)

Using Skip or Not Approve

Immediately after you link studies, Exa Trans and WebTrans updated accordingly, even if a
transcription is open. This includes updating of the report header with information from the
linked studies.

Exa Dictation audio files are available in the viewer and in WebTrans for all main and linked
studies.

Which reports can you link?

When you select to link reports, Exa PACS/RIS automatically displays a list of reports that are
available to link. These studies:

500-000594A 510



Exa® PACS/RIS 1.4.32_P5 User's Manual

e Have a study date 3 days before or after the main study

e Have a status other than Ordered, Cancelled, Rescheduled, No Show, Read, or Approved

e Are from the same facility as the main study

Mammography views

In mammography there are two main view "families," CC and MLO. Each family contains multiple sub-

views.

eXQ-PLATFORM

CC Family

MLO Family

Craniocaudal
Superior — Inferior

Mediolateral Oblique
Superomedial —

Craniocaudal
Superior — Inferior
C-Arm Angle: 0 degrees

e

CcC MLO
+ e C-Arm Angle: 0 degrees Inferomedial
.‘ e C-Arm Angle: 30-60
5 degrees
o Exaggerated Mediolateral

Medial-Lateral
C-Arm Angle: 0 degrees

XCCL

Ll

Exaggerated
Craniocaudal Lateral
Superior — Inferior
C-Arm Angle: O degrees

-

Lateromedial Oblique
Inferolateral — Superomedial
Oblique

C-Arm Angle: 90-180
degrees

XCCM

Ll

Exaggerated
Craniocaudal Medial
Superior — Inferior
C-Arm Angle: 0 degrees

Lateromedial
Lateral-Medial
C-Arm Angle: 90 degrees

From Below:
Caudocranial

Inferior — Superior
C-Arm Angle: 0 degrees

oA

Superolateral to
Inferomedial Oblique
Superomedial —
Inferomedial Oblique

C-Arm Angle: 1-90 degrees

The following views are also available:

ID - Implant displacement
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CV - Cleavage view
AT - Axillary tail

RL - Rolled lateral
RM - Rolled medial
RI - Rolled inferior
RS - Rolled superior
MAG - Magnification
S - Spot compression
TAN - Tangential
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Install and configure tools

Add the Chrome extension

You can add an extension that configures your Chrome browser to work with multiple monitors. After
adding the extension, you can configure display settings for the monitors you will use.

Procedure

1. Onthe burgerE menu, on the TOOLS submenu, select CHROME EXTENSION.
2. On the Chrome_MultiMonitor page, select Add to Chrome.

Note: If the '"Add Chrome_Multimonitor? message appears, select Add extension.

3. On the worklist, on the upper toolbar, select the settings E button, and then in the button
shortcut menu, select Viewer Settings.

Monitors on System 3 C, &

4. On the GENERAL tab, under Display Settings:

a. Select the Monitors on System box

=

b. Select the refresh ‘-~ button

c. Select the identify <= button.
5. In the table of monitors:
a. Inthe Monitor column, select all monitors that you want to use.
b. Inthe Current column, select the monitor to hang current images and thumbnails.
c. Inthe Prior column, select the monitor to hang prior images and thumbnails.

Note: When using a hanging protocol, the Current and Prior settings in the table only control
where the thumbnails hang.

6. Optional. In the Orders column, select an item to auto-open in the monitor.

7. Select SAVE.

Install Exa Trans
Radiologists who use Dragon for transcription must install Exa Trans.

Procedure

1. Onthe burgerE menu, on the TOOLS submenu, select EXA TRANS.
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Note: Chrome downloads ExaTransSetup.msi in the lower left corner of the browser. Wait until
the download is finished before continuing.

2. Select ExaTransSetup.msi. Windows installs Exa Trans.

Note: If the Windows protected your PC dialog appears, select More info, and then select Run
anyway.

Install Exa Dictation
Radiologists who use Dragon for dictation must install Exa Dictation.

Procedure

1. Onthe burgerE menu, on the TOOLS submenu, select EXA DICTATION.

Note: Chrome downloads exa_dictation_setup.msi in the lower left corner of the browser. Wait
until the download is finished before continuing.

2. Select exa_dictation_setup.msi.
3. Windows installs Exa Dictation.

Note: If the Windows protected your PC dialog appears, select More info, and then select Run
anyway.

Install OPAL tools

Many functions in Exa PACS/RIS require that you first install OPAL tools, such as CD import and CD
burning.

Procedure

1. Onthe burgerE menu, on the TOOLS submenu, select OPAL TOOLS.

Note: Chrome downloads OpalToolsSETUP.exe in the lower left corner of the browser. Wait until
the download is finished before continuing.

2. Select OpalToolsSETUP.exe. Windows installs Opal tools.

Note: If the User Account Control dialog appears, select Yes.

Install OPAL Viewer

Exa PACS/RIS uses a server-side viewer, but you can also install the client-side Opal viewer.

Procedure

1. Onthe burgerE menu, on the TOOLS submenu, select OPAL VIEWER.
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Note: Chrome downloads ExaClientViewerSETUP.exe in the lower left corner of the browser. Wait
until the download is finished before continuing.

Select ExaClientViewerSETUP.exe. Windows installs the Opal viewer.

Note: If the Windows protected your PC dialog appears, select More info, and then select Run
anyway.

Install Exa Scans

With Exa Scans, you can scan paper and other media and attach the scans to studies as DICOM data.

Prerequisites: You must uninstall any existing version of Exa Scans before installing a new one.

Procedure

1.

© N o u

On the burgerE menu, on the TOOLS submenu, select EXA SCANS.

Chrome downloads exa_docscan_setup.msi in the lower left corner of the browser. Wait until the
download is complete before continuing.

Select exa_docscan_setup.msi.

Note: If the Windows protected your PC dialog appears, select More info, and then select Run
anyway.

In the Welcome to the EXA Document Scan Setup Wizard, select Next.

On the End User License Agreement page, select I accept the terms in the License
Agreement checkbox, and then select Next.

On the Destination Folder page, select Next.
On the Ready to Install EXA Document Scan page, select Install.
If the User Account Control dialog appears, select Yes.

On the Completed the EXA Document Scan Setup Wizard page, select Finish.

Install Exa Launch

Exa Launch is a background application that prepares studies to be opened by third-party applications
such as PenRad, PowerScribe 360, and MModal.

Procedure

1.

2.

On the burgerE menu, on the TOOLS submenu, select EXA LAUNCH.
Chrome downloads ExaLaunchExtApp.msi in the lower left corner of the browser.

Wait until the download is complete, and then select ExaLaunchExaApp.msi.
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3. Ifthe UAC prompt appears, select YES.

Install Exa Tool
Exa Tool is a client side background application that facilitates opening of studies in OrthoView.
Prerequisite: Install local cache.

Procedure

1. Onthe burgerE menu, on the TOOLS submenu, select EXA TOOL.
2. Wait until the download is complete, and then run exa_tool_setup.msi.

3. Follow the on-screen prompts.

Install local cache
Local cache is a service that manages the copying of studies from the server to your local workstation for

local use.

Configure the server

1. Onthe burgerE menu, select SETUP.
2. On the OFFICE menu, select DICOM.

3. On the AE Title tab, select Add, and then enter the following settings.

AE Type Local Cache
AE Title (Remote) [Name with no spaces]
Description [Friendly descriptive name]

4. Select SAVE.

Configure the client

1. Onthe burgerE menu, on the TOOLS submenu, select CLIENT SERVICE.

Result: Your browser downloads exa_localcache_setup.msi to its specified folder for downloads
(usually the Windows Downloads folder).

2. Run exa_localcache_setup.msi and follow the prompts to install it.

3. Inthe Exa PACS/RIS worklist, select Settings E and select Local Service Settings.

4. In the Rendering Options screen, under Prefetch Configuration, enter the following settings.
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5.

6. Select ACTIVATE.

eXQ-PLATFORM

Shortcut

AE Title Type the AE Title (Remote) name that you created in “Configure the server."
User Name Type a user nhame with user rights to access studies on the server.

API URL Type the address of the server hosting the studies that you want to locally cache.
Debug Mode Select to add additional troubleshooting information to logs.

Disable Oncall Leave cleared.

In the Rendering Options screen, under General Configuration, enter the following settings.

API Timeout

Shortcut

Type the number of seconds to keep the connection to the server open.

Study Timeout

Type the number of hours to keep the imageservice/study thread open.

Prefetch Interval

Type the number of minutes keep to studies in the send queue.

Cache Timeout

Type the number of days to keep locally cached studies before purging.

Cache Directory

Type the fully qualified path to the local cache

(default = c:¥viztek¥exa¥cache¥localcache)

Study Count

Type the maximum number of studies to keep in local cache.

RAM Usage

Type the maximum number of megabytes of RAM to use for prefetching and local
rendering.

Max Threads

Type the number of simultaneous threads available to download studies.

Parallel Prefetch

Leave blank.

Cache Disk Usage

Move the slider to set the maximum percentage of hard disk to use for prefetching and
local rendering.

Oncall Interval

Type the number of minutes to elapse before checking for new studies to prefetch.

Prefetch Priors

Select to include priors when prefetching.

Enable Skinline
Detection

Select to make Skinline Detection available when viewing prefetched studies.

Add a trusted IP or URL

If access to an external server is needed to access to third-party apps, add the IP address or URL of the
external server to a list of trusted resources as follows.

Procedure

1.

On the Exa PACS/RIS server, use File Explorer to go to the ...web\config directory.
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2. In Notepad, open the express.js file.

3. In the app.use(helmet.contentSecurityPolicy({ area, under scriptSrc, add the IP or URL as in
the example in the following figure.

. locals.csplonce

4. In Control Panel, select Administrative Tools, and then double-click Services.
5. 1In the list of services, select exa_web.

6. Use the toolbar to stop, and then start the service.

Location and contents of screens
Burger menu

The burger menu contains the following options.

Burger > Worklist
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DILLING

PAYMENTS
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SETUP

FORTAL REG. LISERS

INTERFACE

Burger > SETUP
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Burger > BILLING
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Wirlek, Pacsy

RAEHIOARD

WORKLIST

PATIENT ARRIVAL WOAKLIET
PATIENT

QUERY!RETRIEVE

SCHEDIALE

EELING

PAYMENTE

REFPORTS

BETL®

POHTAL REQ. LLSERS

INTERFACT

()

PRI, AP

Worklist
Worklist > ALL STUDIES

= Worklist

ALL STUNNES

Worklist > Settings > User Settings

500-000594A 521



Exa® PACS/RIS 1.4.32_P5 User's Manual eXQ-PLATFORM

User Settings
Viewer Settings

Local Service Settings

Worklist > Settings > Viewer Settings

User Settings

Viewer Settings

Local Service Setfings

Worklist > Settings > Local Service Settings

User Settings

Viewer Settings

Local Service Setfings

Worklist > PACS Actions
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PACS ACTIONS

Mew Study

Walk-ln Appointment
CD Bumn

Compare Study
Merge/Split

Import Images
Furge All Deleted

Export Worldist

S ——
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Office menu

The setup area (or "office") menu contains the following options.

OFFICE > Office

FProviders & Resources

Co Scheduling & Codes
m DICOM
Billing
Meaningful Use
User Management
General

HL7
Co
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Billing

Billing > Claims

CLAIMS

ALL CLAIMS
STLFY DATIE
12/ 1 5HT03 - 9V NS
012023

U WSl oxmeoes

Wl E onviraazd

Billing > Setup

Ol AP DATE

et ol Bl 1 e

LmanE

SRR

CL AR NUMTER

PRCTIERT RAMI

Test, Richard

Tt JH

el Hady

ELECTROMIC CLAIM (E04)

CLEARMNOBENZE

[IN8];}
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Warker Compersation Boad CireciE

Fatient
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PATIENT MAME

Test, Richard
Test, Jiil

Test, Judy
Test, Judy
Test, Judy
Test, Stephans
Test, Stephane
Test, Stephane

Test, Helen

VALIDATE

CLEARI!

all

Warker C

Refresh Setlings

Adjustment Codes
Billing Codes
Billing Classes
Claim Status

Collections Pracess

Delay Reasons

Billing Providers
Provider Id Code Qualifiers

Billing Meszages
Fayment Reasons
CAS Group Codes
CAS Reazon Codes

Status Color Codes

Billing Validations
EDI/ERA Templates
EDI Clearinghouses
Insurance Mapping
Printer Templates

Auto Billing
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Screens in the Edit Study screen
Edit Study > PATIENT INFORMATION
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